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Preface

Intended Audience
Welcome to Release 12.2 of the Oracle iSupport Implementation and Administration Guide.

This guide is intended for personnel who are responsible for implementing and 
administering the Oracle iSupport application.

This guide assumes you have a working knowledge of the following: 

• The principles and customary practices of your business area 

• Oracle iSupport

• JTT

To learn more about JTT applications, refer to the Oracle E-Business Suite CRM 
System Administrator's Guide.

• The Oracle Applications graphical user interface

To learn more about the Oracle Applications graphical user interface, read the 
Oracle E-Business Suite User's Guide.

See Related Information Sources on page xvi for more Oracle E-Business Suite product 
information. 

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc.

http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc


xvi

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support 
through My Oracle Support. For information, visit http://www.oracle.
com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=trs if you are hearing impaired. 

Structure
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6  Integrating Oracle iSupport with Oracle Workflow
7  Integrating Oracle iSupport with the Oracle Applications Framework (OAF)
8  Integrating Oracle iSupport with Oracle Knowledge (InQuira)
9  Using Oracle iSupport
10  Administering Oracle iSupport
11  Overview of Oracle Marketing Encyclopedia System
A  System Profile Options
B  Lookups
C  Seeded Information
D  Custom Look and Feel Configuration
E  Configuration of AK Regions
Glossary

Related Information Sources
You can choose from many sources of information, including online documentation, 
training, and support services, to increase your knowledge and understanding of Oracle
iSupport.

Integration Repository
 The Oracle Integration Repository is a compilation of information about the service 
endpoints exposed by the Oracle E-Business Suite of applications. It provides a 
complete catalog of Oracle E-Business Suite's business service interfaces. The tool lets 
users easily discover and deploy the appropriate business service interface for 
integration with any system, application, or business partner. 

 The Oracle Integration Repository is shipped as part of the Oracle E-Business Suite. As 
your instance is patched, the repository is automatically updated with content 
appropriate for the precise revisions of interfaces in your environment. 
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Online Documentation
All Oracle E-Business Suite documentation is available online (HTML or PDF).

• PDF - See the Oracle E-Business Suite Documentation Library for current PDF 
documentation for your product with each release. The Oracle E-Business Suite 
Documentation Library is also available on My Oracle Support and is updated 
frequently

• Online Help - Online help patches (HTML) are available on My Oracle Support.

• Release Notes - For information about changes in this release, including new 
features, known issues, and other details, see the release notes for the relevant 
product, available on My Oracle Support.

• Oracle Electronic Technical Reference Manual - The Oracle Electronic Technical 
Reference Manual (eTRM) contains database diagrams and a detailed description of
database tables, forms, reports, and programs for each Oracle E-Business Suite 
product. This information helps you convert data from your existing applications 
and integrate Oracle E-Business Suite data with non-Oracle applications, and write 
custom reports for Oracle E-Business Suite products. The Oracle eTRM is available 
on My Oracle Support.

Guides Related to All Products

Oracle E-Business Suite User's Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle Projects (and any 
other Oracle Applications products). This guide also includes information on setting 
user profiles, as well as running and reviewing reports and concurrent programs.

You can access this user's guide online by choosing "Getting Started with Oracle 
Applications" from any Oracle Applications help file.

Guides Related to This Product

Oracle Advanced Pricing Implementation Guide
This guide show you how to define pricing rules that service the pricing requirements 
of Oracle applications. Pricing rules control the pricing actions that are applied to 
customer transactions such as price lists, price agreements, formulas, and modifiers. 
With Oracle Advanced Pricing, you can attach qualifiers to a price list that enables an 
item have more than one price list. You can also set up block pricing, promotional 
limits, multiple currency conversion, and multiple contexts per sales order.



xviii

Oracle Advanced Pricing User's Guide
Oracle Advanced Pricing calculates prices including promotional prices for Oracle 
Order Management and other Oracle Applications based on pricing rules, pricing 
relationships, item hierarchies, usage brackets, and deals and promotions. 

Oracle Marketing Implementation Guide
Oracle Marketing provides the tools necessary to automate the planning, budgeting, 
execution, and tracking of your marketing initiatives. It provides a single repository of 
customer information that enables you to analyze, personalize, refine, and target your 
campaigns to better align with sales. You can set up fatigue rules to define contact limits
by time period and by channel.

Oracle Marketing User Guide
This guide tells you how to create marketing programs, execute campaigns across 
multiple customer interaction channels such as Web, email, direct mail, and 
telemarketing, and monitor the performance of these programs. With Oracle Marketing,
you can generate prospective customer lists and assess the effectiveness of these lists, 
and manage marketing collateral and marketing budgets.

Oracle Receivables User Guide
This guide provides you with information on how to use Oracle Receivables. Use this 
guide to learn how to create and maintain transactions and bills receivable, enter and 
apply receipts, enter customer information, and manage revenue. This guide also 
includes information about accounting in Receivables. Use the Standard Navigation 
Paths appendix to find out how to access each Receivables window. 

Oracle Trade Management Implementation Guide
This guide provides detailed functional and integration setup information for Oracle 
Trade Management, which can be used by technical consultants, application 
administrators, and implementation team members.

Installation and System Administration

Oracle Alert User's Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle E-Business Suite data.

Oracle E-Business Suite Concepts
This book is intended for all those planning to deploy Oracle E-Business Suite Release 
12.2, or contemplating significant changes to a configuration. After describing the 
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Oracle E-Business Suite architecture and technology stack, it focuses on strategic topics, 
giving a broad outline of the actions needed to achieve a particular goal, plus the 
installation and configuration choices that may be available.

Oracle E-Business Suite CRM System Administrator's Guide
This manual describes how to implement the CRM Technology Foundation (JTT) and 
use its System Administrator Console.

Oracle E-Business Suite Developer's Guide
This guide contains the coding standards followed by the Oracle E-Business Suite 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle E-Business Suite user interface described in the Oracle 
E-Business Suite User Interface Standards for Forms-Based Products. It also provides 
information to help you build your custom Oracle Forms Developer forms so that they 
integrate with Oracle E-Business Suite. In addition, this guide has information for 
customizations in features such as concurrent programs, flexfields, messages, and 
logging.

Oracle E-Business Suite Installation Guide: Using Rapid Install
This book is intended for use by anyone who is responsible for installing or upgrading 
Oracle E-Business Suite. It provides instructions for running Rapid Install either to carry
out a fresh installation of Oracle E-Business Suite Release 12.2, or as part of an upgrade 
to Release 12.2.

Oracle E-Business Suite Maintenance Guide
This guide contains information about the strategies, tasks, and troubleshooting 
activities that can be used to help ensure an Oracle E-Business Suite system keeps 
running smoothly, together with a comprehensive description of the relevant tools and 
utilities. It also describes how to patch a system, with recommendations for optimizing 
typical patching operations and reducing downtime.

Oracle E-Business Suite Security Guide
This guide contains information on a comprehensive range of security-related topics, 
including access control, user management, function security, data security, and 
auditing. It also describes how Oracle E-Business Suite can be integrated into a single 
sign-on environment.

Oracle E-Business Suite Setup Guide
This guide contains information on system configuration tasks that are carried out 
either after installation or whenever there is a significant change to the system. The 
activities described include defining concurrent programs and managers, enabling 
Oracle Applications Manager features, and setting up printers and online help.
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Oracle E-Business Suite User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle E-Business 
Suite development staff. It describes the UI for the Oracle E-Business Suite products and
tells you how to apply this UI to the design of an application built by using Oracle 
Forms.

Other Implementation Documentation

Oracle Workflow Administrator's Guide
This guide explains how to complete the setup steps necessary for any Oracle 
Applications product that includes workflow-enabled processes, as well as how to 
monitor the progress of runtime workflow processes.

Oracle Workflow Developer's Guide
This guide explains how to define new workflow business processes and customize 
existing Oracle Applications-embedded workflow processes. It also describes how to 
define and customize business events and event subscriptions.

Oracle Workflow User's Guide
This guide describes how Oracle Applications users can view and respond to workflow 
notifications and monitor the progress of their workflow processes.

Oracle E-Business Suite Flexfields Guide
This guide provides flexfields planning, setup and reference information for the Oracle 
Projects implementation team, as well as for users responsible for the ongoing 
maintenance of Oracle Applications product data. This guide also provides information 
on creating custom reports on flexfields data.

Oracle E-Business Suite Diagnostics User's Guide
This guide contains information on implementing, administering, and developing 
diagnostics tests in the Oracle E-Business Diagnostics framework.

Oracle E-Business Suite Integrated SOA Gateway User's Guide
This guide describes how users can browse and view the integration interface 
definitions and services that reside in Oracle Integration Repository.

Oracle E-Business Suite Integrated SOA Gateway Implementation Guide
This guide explains the details of how integration repository administrators can manage
and administer the entire service enablement process based on the service-oriented 
architecture (SOA) for both native packaged public integration interfaces and composite
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services - BPEL type. It also describes how to invoke Web services from Oracle E-
Business Suite by working with Oracle Workflow Business Event System, manage Web 
service security, and monitor SOAP messages.

Training and Support

Training
Oracle offers a complete set of training courses to help you and your staff master Oracle
Projects and reach full productivity quickly. These courses are organized into functional
learning paths, so you take only those courses appropriate to your job or area of 
responsibility.

You have a choice of educational environments. You can attend courses offered by 
Oracle University at any of our many Education Centers, you can arrange for our 
trainers to teach at your facility, or you can use Oracle Learning Network (OLN), Oracle
University's online education utility. In addition, Oracle training professionals can tailor
standard courses or develop custom courses to meet your needs. For example, you may 
want to use your organization structure, terminology, and data as examples in a 
customized training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals provides
the help and information you need to keep Oracle Projects working for you. This team 
includes your Technical Representative, Account Manager, and Oracle's large staff of 
consultants and support specialists with expertise in your business area, managing an 
Oracle server, and your hardware and software environment.

Do Not Use Database Tools to Modify Oracle E-Business Suite Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle E-Business Suite data 
unless otherwise instructed. 

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data. 

Because Oracle E-Business Suite tables are interrelated, any change you make using an 
Oracle E-Business Suite form can update many tables at once. But when you modify 
Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you 
may change a row in one table without making corresponding changes in related tables.
If your tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle E-Business Suite. 

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite 
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automatically checks that your changes are valid. Oracle E-Business Suite also keeps 
track of who changes information. If you enter information into database tables using 
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
record of changes. 
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1
 Introduction to Oracle iSupport

This chapter covers the following topics:

• Oracle iSupport Overview

• Users

• Oracle iSupport Homepage

• Service Request

• Knowledge Base

• Technical Library

• Account Management

• Products Repository

• Customer Communications

• Business Flows

• User Profile

• User Management

• Multi-Party Access

• Site Management

• Configurability

Oracle iSupport Overview
Oracle iSupport is an Internet-based customer support application that enables service 
organizations to provide self-service customer support online.

Oracle iSupport drives service profitability by decreasing the number of calls coming 
into the contact center. This secure self-service web portal gives customers and 
employees immediate customer service 24x7. Its sophisticated knowledge management 
system provides the information needed to solve problems, leading to increased 
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customer satisfaction. 

Key benefits: 

• Enables organizations to provide targeted support to their users by utilizing the 
multiple sites capabilities

• Enables customers and employees to solve problems themselves through a 
searchable knowledge base 

• Reduces agent-assisted contacts with customers by giving them the ability to review
and track orders, payments, shipments, contracts, returns, and repair orders

• Saves costs by enabling customers to register their products, manage their product 
configurations, and create and track product returns 

• Provides complete customer care through integration with Oracle E-Business Suite 
applications

Users
Oracle iSupport supports these types of users:

• Primary User is a business customer user (B2B) and has privileges to manage users 
belonging to his organization.

• Business User (business to business (B2B))

• Individual User (business to consumer (B2C))

• Oracle Applications System Administrator

• Oracle iSupport Administrator

• Employee User: Employee of the service organization

Oracle iSupport supports only those employee users who access Oracle iSupport to 
request service and to meet their support needs. Oracle iSupport is not intended for 
support agents.

Employee users access Oracle iSupport through a responsibility with a feature set 
that provides self service to workers in an enterprise. 

• Contingent Worker: Contingent worker in the service organization

All workers in an enterprise can be categorized either as employees or contingent 
workers. Employees are workers who are directly employed by the enterprise, paid 
by payroll, and eligible for benefits. By contrast, contingent workers, or contractors, 
by which they are more commonly known, are workers who do not have a direct 
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employment relationship with the enterprise. They may perform work for the 
enterprise as part of a commercial relationship that exists between the enterprise 
and a supplier. Thus they are paid by accounts payable to either an agency that 
then employs them or directly to the contractors if they are self-employed. They 
also may perform work for the enterprise if they are interns or volunteer workers 
and thus have no relationship with a supplier. 

Contingent workers access Oracle iSupport through a responsibility with a feature 
set that provides self service to workers in an enterprise.

• Knowledge Management Administrator User

Users are classified into user types for self registration purposes. User types can be 
defined to meet the specific needs of an implementing organization. For details about 
the setup of user types, refer to User Management, page 1-12. 

Oracle iSupport Homepage
The Oracle iSupport home page provides links to other support areas and functions. 
Users can personalize the content and the layout of this page according to their 
preferences.

A user can view alerts and other system messages published by the merchant, links to 
service requests, knowledge base, and content from MES. The user also has the option 
of having the contents of his home page e-mailed to him; this is known as home page 
subscription.

A merchant can use the home page setup capabilities to provide access to different 
content (bins) to different sets of users. The merchant has the option of making some 
home page content mandatory.

For more information, see the Setting up iSupport Homepage topic area in this guide's 
Implementation Tasks chapter.

A typical business scenario is:

• Customer logs in to Oracle iSupport and access the Homepage (the initial landing 
page).

• Customer views Alerts, company news, or other content provided by the 
administrator.

• Customer accesses Content hyperlink to personalize content.

• Customer accesses Layout hyperlink to personalize the layout of content.

• Customer selects Edit hyperlink on Service Request Quick Links, Service Request 
(saved views), and/or Quick Links bins to personalize the content of these bins.
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Service Request
Oracle iSupport enables users to manage their service request activity online. This 
functionality is available if the merchant sets up the service request functionality 
detailed in the chapter, Integrating Oracle iSupport with Service Request. Additional 
support features can be realized by implementing Oracle Knowledge Management and 
the Products and Returns features. See the chapters, Integrating Oracle iSupport with 
Oracle Knowledge Management and Integrating Oracle iSupport with Products and Returns 
for more information.

After the service request information has been entered, it is validated by Oracle 
TeleService and assigned a unique tracking number for future reference. Merchants can 
enforce product selection and knowledge base searching during the service request 
process. Merchants can configure the service request creation flows and the various 
service request interfaces based on context.

An administrator can configure the service request creation flow based on the context of
application, responsibility, service request type, or a combination of responsibility and 
service request type, giving the service organization a very high level of flexibility. A 
global content also exists for use by the service organization and to ensure backward 
compatibility with previous releases.

With the configurable service request interface feature, an administrator can control the 
display of regions and attributes, based on the context values mentioned above, on a 
service request page during creation or update. For example, a merchant can show or 
hide regions and attributes, make fields required or not, and move selected sections 
among pages. This functionality utilizes the AK regions repository for storing the 
metadata. 

A typical business scenario is:

• Customer logs in to Oracle iSupport.

• Customer queries the knowledge base directly for troubleshooting help prior to 
creating a new request.

• Customer selects the type of the problem (service request type) being experienced. 

• Customer accesses the Create Service Request page and enters contact and service 
request details. Customer may also attach any type of files to the service request.

• After the service request is submitted, the system returns a tracking number to the 
customer. At the end of the service request submission process, customers have the 
option of adding the service request link to the Homepage, and having the service 
request details sent to the e-mail address that is set up in their Personal Profile.

• After service request submission, customers can view, close, update, attach 
additional files, and conditionally re-open their closed service requests. Customers 
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can escalate the service request if the progress of the service request resolution does 
not meet their expectations.

Note: Customers can view only service requests whose request 
type is mapped to the customer's current responsibility.

• The customer can also save the information entered in creating this service request 
as a service request template. The saved data can be used to create future service 
requests.

Knowledge Base
Oracle Knowledge Management implementation allows access to the known 
problems/solutions database, and permits users to locate technical documents, 
including white papers, user guides, and FAQs. The merchant benefits by increased 
knowledge among customers and reduced call center activity. The Oracle Knowledge 
Management user interface is easy to use and features flexible search and browse 
capabilities. For additional information, see the Oracle Knowledge Management 
Implementation and Administration Guide and Integrating Oracle iSupport with Oracle 
Knowledge Management chapter of this guide.

A typical business scenario is:

• Customer logs in to Oracle iSupport. Customer views Alerts and Company News 
on the Homepage.

• Customer accesses the knowledge base from the Homepage or by using the Support
page.

• Customer user browses the knowledge.

• Customer uses either basic or advanced search functions to locate answers.

• Customer views solution detail, and can add a link to the Homepage if desired.

• The service organization can provide access to different knowledge to different sets 
of users by utilizing the knowledge security feature.

Technical Library
With the Oracle Marketing Encyclopedia system (MES), an organization can manage 
content of different types. This content may include, for example, white papers, user 
guides, and frequently asked questions. Oracle iSupport leverages this repository to 
provide access of this content to users. For example, guest users can view documents 
listed under the MES category tied to the guest user responsibility on the Technical 
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Library page.

The Technical Library provides integrated searching and browsing of MES content 
capabilities to users. Users can only browse and search the content made accessible by 
the merchant to them based on setup. This functionality is available to all types of users 
including the guest users. 

Account Management
Oracle iSupport's optional account management functionality allows customer users to 
view detailed transaction history and status, and to create returns. Integration with 
Oracle Order Management, Oracle Shipping, Oracle Payables, Oracle Receivables, 
Oracle Install Base, Oracle Depot Repair, and Oracle iStore applications allows a user to 
view orders, invoices, payments, and shipping information, as well as to create return 
material authorizations (RMAs). Integration with Oracle Service Contracts, if these 
optional modules are implemented, provides a view of contracts, entitlements, service 
programs, and warranties.

If all required applications are implemented, this functionality allows customers to 
service their own account needs. For more information, see the chapter Integrating 
Oracle iSupport with Products and Returns. For setting up Contracts functionality, refer to 
Oracle Contracts Implementation and Administration Guide, and Oracle Service Contracts 
Implementation Guide.

A typical business scenario is:

• Customer user logs in to Oracle iSupport.

• Using the Accounts tab, the customer user has online, real-time access to 
information regarding account data, including:

• Orders

• Shipments

• Invoices

• Payments

• Contracts

• Returns

• Products that the user owns

• Repair Orders
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Products Repository
Oracle Install Base is a repository of products owned by a customer, including purchase
date, product attributes, and applicable service agreements. Oracle Install Base 
maintains information about purchased products in a tree structure showing all of the 
parent and child assemblies. It allows users to drill down to view detailed product 
information. Oracle Install Base tracks, updates, and maintains product configurations 
whenever a new part or component is installed or replaced. Oracle Install Base also 
allows users to register their products online. It also allows the grouping of customer 
products into systems for ease of service. Oracle Install Base tracks serialized and non-
serialized products, and provides powerful search capabilities. Support organizations 
benefit from having customers who are informed about their transaction and product 
histories and applicable contracts.

Required integration with Oracle Inventory, as well as optional integration with Oracle 
Bills of Material, further facilitate access to product information. With Products 
functionality, users can manage and track products themselves online, thus decreasing 
calls to customer service centers and increasing customer control over management of 
product information. For more information, see the chapter Integrating Oracle iSupport 
with Products and Returns.

A typical business scenario is:

• Customer logs in to Oracle iSupport.

• Customer accesses the information about the products that he owns from the 
Products tab.

• Customer reviews product details and/or adds products to Oracle Install Base.

Customer Communications
The Web call-back (Call Me) feature allows customer users to submit call-back requests 
through the Internet with the Oracle iSupport user interface. The Surveys feature allows
service organizations to gather relevant customer feedback.

A service organization can run real-time, dynamic, and targeted campaigns on Oracle 
iSupport to up sell, cross sell, and dramatically increase revenues and build customer 
loyalty. Integration of Oracle iSupport with Oracle Marketing (eMerchandizing) 
delivers personalized content to the Oracle iSupport user interface based on pre-defined
campaigns. The right campaign is shown to a customer user based on defined 
campaigns and their audience, rule set, and postings. An audience segment is a group 
of users. For example, users who live in New York belong to the New York segment 
tied to campaigns. The campaign message defined in Oracle eMerchandizing can be 
displayed by the merchant on various Oracle iSupport pages using the sections 
provided on these pages.



1-8    Oracle iSupport Implementation and Administration Guide

If a merchant has implemented the multiple sites capabilities in Oracle iSupport, these 
messages can also be displayed in bins on the site dashboard, through the use of the 
Oracle iStore template manager functionality.

The out-of-the-box display templates that are candidates for marketing postings 
include:

• Section page bins

• Item page bins

• Shopping cart page bins

Business Flows
This section contains end-user business flows to provide an overview for implementers 
and administrators.

The business flow called Click to Inquiry: Service Requests and Their History has the 
following general scenario:

Log in with your user name and password.

1. View your service requests.

2. Optionally, review service request history.

The business flow called Click to Inquiry: Dispatch Status has the following general 
scenario:

Log in with your user name and password.

1. View your service requests.

2. Optionally, review service request history.

3. Optionally, confirm your address.

4. Review the status of resolution actions (field service tasks).

5. Optionally, add a note.

6. Optionally, request an escalation.

The business flow called Click to Inquiry: Returns Status has the following general 
scenario:

Log in with your user name and password.

1. View your service requests.
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2. Optionally, review service request history.

3. Review the status of returns.

4. Optionally, add a note.

5. Optionally, request an escalation.

The business flow called Click to Inquiry: Repair Status has the following general 
scenario:

Log in with your user name and password.

1. View your service requests.

2. Optionally, review service request history.

3. Review the status of repairs.

4. Optionally, add a note.

5. Optionally, request an escalation.

The business flow called Click to Inquiry: Confirm Charges has the following general 
scenario:

Log in with your user name and password.

1. View your service requests.

2. Optionally, review service request history.

3. Review the status of repairs.

4. Confirm charges.

5. Close the service request.

The business flow called Click to Issue for Field Service has the following general 
scenario:

Log in with your user name and password.

1. Optionally, describe the problem and the product.

2. Optionally, view the knowledge base.

3. Optionally, view potential solutions.

4. Optionally, indicate if solutions are useful.
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5. Identify the product or instance.

6. Identify the request type and urgency.

7. Optionally, answer questions regarding the problem.

8. Optionally, upload attachments.

9. Optionally, confirm contact information.

10. Confirm incident, billing, and shipping addresses.

11. Review the service request.

12. Optionally, create a service request.

13. Review confirmation information.

14. Optionally, e-mail the service request details to yourself.

15. Optionally, bookmark the request search.

The business flow called Click to Non-Resolution has the following general scenario:

Log in with your user name and password.

1. View your service requests.

2. Optionally, review service request history.

3. Add a note.

The business flow called Click to Resolution: Issue Resolved has the following general 
scenario:

Log in with your user name and password.

1. View your service requests.

2. Optionally, review service request history.

3. Optionally, view potential solutions.

4. Optionally, indicate if the solutions are useful.

5. Optionally, review attachments.

6. Close the service request.

7. Provide a closure reason.
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The business flow called Click to Resolution: Issue Not Resolved has the following 
general scenario:

Log in with your user name and password.

1. View your service requests.

2. Optionally, review service request history.

3. Optionally, view potential solutions.

4. Optionally, indicate if the solutions are useful.

5. Optionally, review attachments.

6. Add a note to change the status to Unresolved.

7. Optionally, request an escalation.

User Profile
The Oracle iSupport System Administrator or Primary User can administer a wide 
range of user profile data, including:

• Changing/Resetting Password

• Adding/Changing Contact Points (Phone/Email/Fax)

• Adding/Changing Address Information

• Setting General Preferences

• Changing Default Responsibility

• Changing Default Customer Account

• Setting up Home Page E-mail Subscription

• Setting User Signature for Forums

• Adding/Changing Company Information

• Viewing Administrator Information

While using the multiple sites framework in Oracle iSupport, a system administrator or 
a primary user cannot perform some of these functions for other users. The functions 
that they cannot perform are as follows:

• Changing a user's contact points and addresses 
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• Setting general preferences

• Changing default responsibility

• Setting up a user's signature for forums

User Management
User management is the process of approving the self service registration requests of 
users or creating user accounts for existing party contacts to enable them to access 
applications. Thereafter, user management maintains the user in the system by granting
or revoking privileges, accounts, customer profile information, and party relationships 
based on a set of business requirements. User management involves registering new 
users, modifying existing users, approving or rejecting user registration requests, 
setting up enrollments and registration templates, assigning users to business accounts, 
and more. Oracle CRM Technology Foundation (JTT) supplies the technology stack for 
performing most of the background setups and processes for user management.

Oracle iSupport uses the user management pages of the Oracle iStore application. 
Oracle iStore provides a comprehensive set of user management capabilities, including 
the ability to register users, configure registration pages, approve users, and manage 
user profile information. This functionality leverages the JTT user management 
framework as a foundation for the setup, which includes the user types, enrollments, 
and approval processes. Thus, the primary user has access to the Oracle iStore user 
management pages including:

• Contact and User Management 

• Pending User Approvals 

• Role Management 

• Site Assignment 

• Enrollment Management 

• For details of user management with sites, refer to the Oracle iStore Implementation 
and Administration Guide.

Note: The information in this section is meant to give you an 
overview of the concepts of the JTT user management framework. 
You can find specific and comprehensive information in the Oracle 
E-Business Suite CRM System Administrator's Guide.

The JTT user management framework has four main components:

User Types, page 1-13



 Introduction to Oracle iSupport    1-13

1. Enrollments, page 1-17

2. Templates at user-type level and enrollment level, page 1-18

3. Approval Process, page 1-18

User Types
Users are classified into user types for registration purposes. User types are defined to 
meet the specific needs of an organization, and they reflect a broad category of users. 
User types allow flexible, extendible ways to define, categorize, and implement the 
behavior of users. User types can be tied to enrollments (subscription services), default 
responsibilities, and default roles.

The following sections discuss seeded user types that pertain to Oracle iSupport, 
including:

• Primary User (organization contact), page 1-13

• Business User (business to business (B2B)), page 1-14

• Individual User (business to consumer (B2C)), page 1-14

• Partial User, page 1-14

• Partner User, page 1-14

Refer to Appendix B for the technical names of these seeded user types together with 
their associated roles, responsibilities, and enrollments. See Other Users, page 1-14 for 
a discussion of Oracle iSupport users who are not registered or approved with the user 
management framework.

Primary User (Organization Contact)
Seeded as a user type in the JTT user management framework, the primary user is also 
known as the customer administrator. This user typically:

• Approves other users within his party/organization

• Assigns accounts to users (Party Accounts), that is, controls access to accounts

• Adds/modifies responsibilities to users within his party/organization

• Adds/modifies roles to users within his party/organization

The JTT user management framework supports any number of primary users for an 
organization.

The Oracle iSupport administrator for a merchant typically approves the initial primary
user.
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A primary user can approve the registration request submitted by another user as a 
primary user. This depends on the approval hierarchy defined for the user type/ 
enrollment.

Business User (Business to Business)
Seeded as a user type in the JTT user management framework, this user is a typical 
business-to-business user, associated with an organization other than the merchant 
utilizing Oracle iSupport.

Individual User (Business to Consumer)
Seeded as a user type in the JTT user management framework, this user type is an 
individual person with no relationship to an organization. Individual users generally 
self-register over the Internet. They are approved automatically by the application 
(unless this setting is changed by the administrator in the framework) and assigned the 
default role and responsibility that the administrator specifies for this user type during 
application setup configuration. 

Partial User
A partial user is one who is an existing logged-in user who registers for access to 
applications without the need to create a new user account. This partial registration 
applies to both individual and business users.

Partner User
Partner User is for users who have already registered to be a partner. Through partial 
registration, they can request the iSupport roles and privileges so they can use the 
iSupport application.

Other Users
In addition to the seeded JTF User Types (Primary, Business, Individual), the merchant 
implementing Oracle iSupport receives a system administrator login/password and 
creates a user called the Oracle iSupport Administrator. In addition, he can choose to set
up employee users, Oracle Knowledge Management administrator-users, survey 
administrators, and guest users. These users are discussed below.

• Oracle Applications System Administrator, page 1-15

• Oracle iSupport Administrator, page 1-15

• Employee User, page 1-15

• Knowledge Management Admin User, page 1-16

• Survey Administrator, page 1-16

• Guest User, page 1-16
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Oracle Applications System Administrator
The System Administrator (SA) role is common to all Oracle Applications and comes 
seeded with the applications. This is the highest-level user. This user comes with a 
sysadmin login and password (sysadmin/sysadmin). Oracle recommends that you 
change the password for this user at earliest convenience. For more information, see:

• Oracle E-Business Suite Setup Guide

• Oracle E-Business Suite Concepts

• Oracle E-Business Suite CRM System Administrator's Guide

Oracle iSupport Administrator
The merchant implementing Oracle iSupport uses the sysadmin login to set up the 
Oracle iSupport Administrator. This is a required user. The Oracle iSupport 
Administrator is a user chosen by the merchant to perform routine but high-level 
administrative tasks, such as:

• Setting up users and assigning appropriate roles and responsibilities

• Setting up the application home page

• Setting up Service Request 

• Setting up the Products tab/Install Base

• Setting up Knowledge Management

• Setting up Accounts Management functionality

• Setting up Forums

• Setting up Web Call-Back

• Setting up Surveys

Instructions for setting up this user are in this guide.

Employee User
The Employee User is not seeded as a User Type in the JTT user management 
framework, but is supported by Oracle iSupport. The employee user is not seeded 
because the self registration functionality does not support the registration of 
employees belonging to the support organization. This type of user is an employee of 
the merchant using Oracle iSupport. This user is set up through the Forms interface by 
the Oracle iSupport Administrator. For information on setting up this type of user, see 
the Setting up iSupport Users topic in the Implementation Tasks chapter of this guide. 
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Knowledge Management Administrator-User
This is a user who performs Knowledge Management setup and management. This user
type is not seeded in the JTT user management framework. This user is required only if 
the merchant will use the Knowledge Management functionality. For more information,
see the Integrating Oracle iSupport with Oracle Knowledge Management chapter of this
guide.

Survey Administrator
This is a user who performs Surveys setup and management. This user type is not 
seeded in the JTT user management framework. This user is required only if the 
merchant will use Surveys. For more information, see the Configuring Surveys , page 
10-23topic of this guide.

Guest User
A guest user is a user who comes to the Oracle iSupport site and does not already have 
an approved registration with iSupport. With the guest user facility, unregistered users 
can access certain features in Oracle iSupport. For example, a guest can access the self-
service support web site and review solutions to problems in Oracle iSupport. The 
Oracle iSupport and Oracle iStore applications use the same guest user account to 
enable the guest user functionality.

Based on the roles and responsibility assigned to a guest user, the guest user can access 
the following features:

• View the home page for a guest user

• View technical library content accessible to a guest user

• Search, browse, and view solutions accessible to a guest user 

Consistent with the single sign-on procedures for all Oracle applications, users log in, 
are checked for necessary privileges, and, as appropriate, may be invited to request 
partial registration through the Guest User page to gain access to protected pages of 
iSupport.

Authenticated Guest User
The application also supports the concept of an authenticated guest user. An 
authenticated guest user is essentially a user that has logged into the system but lacks 
iSupport permissions to view any iSupport protected page. If authenticated users 
without the proper iSupport permissions want to see the iSupport public or guest 
pages, they can do so as if they are a guest. The content of the pages are the same as 
those of a guest user. Only the menu is slightly different because such users are already 
logged in. 
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Enrollments
Enrollments are application-specific services at the user-type level. These services 
include the registration templates, page 1-18, roles, page 1-17, responsibilities, page 1-
17, and approval definitions at the enrollment level. Oracle User Management provides
four types of enrollment available for a User Type:

• Automatic

• Self-service

• Delegation only

• Self-service and delegation

One enrollment corresponds to one or zero responsibility, one or zero template (see 
Templates, page 1-18), one or zero workflow, and zero or more roles.

For more information on enrollments, see the Oracle E-Business Suite CRM System 
Administrator's Guide.

Understanding Responsibilities
Oracle Application Foundation Responsibilities define application privileges. They 
control menu hierarchy available to a particular user. During the registration process, 
users are granted access to one or more responsibilities, depending upon the 
services/enrollments to which they subscribe and the merchant policy. Typically, 
individual consumers are given access to only one responsibility. With one 
responsibility, users do not need to know about the existence of responsibilities.

Responsibilities originally contained some security elements at the function level. Those
turned out not to be sufficient for the CRM HTML applications, and now these security 
elements are included as roles/permissions infrastructure.

For more information, see the Oracle E-Business Suite CRM System Administrator's Guide.

Understanding Roles
A role is a collection of page- and function-level permissions. A permission is the 
smallest unit making up a role, and one or more permissions make up each role. 
Permissions dictate exactly which actions a user can perform. Users registering are 
assigned a default role or roles based on user type and enrollments. Additional roles 
can be assigned according to business needs. 

For more information, see the Oracle E-Business Suite CRM System Administrator's Guide.

Modifying Seeded Enrollments
The seeded enrollments can be modified, and you can also create new enrollments. For 
more information, refer to the Oracle E-Business Suite CRM System Administrator's Guide.
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Templates
Applications require different pieces of information to register various user types. 
Registration of a sales representative might require the sales territory, while a consumer
registration would need to include the credit card number. Registration data is being 
stored in different tables - some is common data and is stored (mostly) in the Trading 
Community Architecture (TCA); the rest is stored into application-specific tables. 

Registration templates, which can be one JSP or multiple pages, accommodate these 
information-gathering requirements. The registration pages rendered to a user depend 
on the user type and the services/enrollments the user is subscribing to. Registration 
templates refer to JSP files that are used to capture the registration information that is 
particular to a user type.

Characteristics of registration templates include:

• JSPs associated to a template handler to execute the logic on data captured through 
JSP pages

• Can be tied to enrollments

• Are set up by the application administrator during implementation

• Can consist of one page or many pages

Defining New Registration Templates
New registration templates can be created using the System Administrator Console. For
more information, refer to the Oracle E-Business Suite CRM System Administrator's Guide .

Approval Process
Approval is a step in the registration process whereby users and/or their enrollments 
are confirmed by an approving authority. After the approval process is completed, the 
system automatically grants the appropriate default role(s) and responsibility (based on
User Type and/or Enrollments) that allow access to the application.

The approval process uses Oracle Workflow to track and route the request to each 
approver set up in the approval definition. The process informs the approvers of the 
request type (user type or enrollment) and what action is required.

Who Can Be an Approver?
Foundation approvers are application users who have one of the following permissions:

• JTF_REG_APPROVAL or JTF_SECURITY_ASSIGN_ROLE (System Administrator) 
permission.

• JTF_APPROVER (Request Owner) permission

• JTF_PRIMARY_USER_SUMMARY (Primary user) permission 
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The Primary User must also have the JTF_PRIMARY_USER responsibility to access the 
approval page. 

Oracle iSupport user approvers are the Oracle iSupport Administrator and the Primary 
User(s). See the Seed Data appendix for their appropriate roles and permissions.

Defining a New Approval Process
New approval processes can be defined on the System Administrator Console. For more
information, refer to the Oracle E-Business Suite CRM System Administrator's Guide .

Multi-Party Access
With the multi-party access feature, an iSupport B2B user can view and perform 
transactions for multiple parties using a single login id. The user can log in to the 
application and view or perform transactions for his default party, and then use the 
switch party mechanism to perform transactions for another party. The user must have 
access to the parties to be able to do the transactions.

Oracle iSupport Administrator and/or Primary User can grant access to multiple parties
and the associated accounts to the business users. They can typically:

• Enable multi-party access 

• Add, remove, enable, or disable access to a party

• Change the default party

• Add or remove party account access

• Enable service request search across multiple parties

Related Topics
Setting Up Multi-Party Access, page 3-27

Site Management
Merchants (Service organizations) have an option to leverage the multi site capabilities 
to provide targeted support to their users by defining and organizing their online 
support into multiple sites. This functionality in Oracle iSupport is provided by Oracle 
iStore multiple sites (Speciality Store/ Sites). It allows a seamless inter-navigation 
between Oracle iStore, Oracle iSupport, and Oracle Partners Online. The main features 
provided by Site Management Framework include:

• Multiple support sites using a single instance

• Improved navigation between iStore, iSupport, and Partners Online while 
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maintaining context of the user, account, language, and site 

• iSupport, iStore, and Partners Online functions in a single site

• Different branding for each site

• Single Sign On

• Improved self service registration, user profile, and user management

• Common, unified, and central site administration capabilities 

Merchants (Service Organizations) who do not wish to use the multiple sites capabilities
can implement Oracle iSupport in the conventional manner.

Oracle iSupport uses the Oracle iStore multiple site functionality, which includes the 
site definition, the site selection page, the dashboard, and the template manager for 
configuring the template pages.

Site functionality can be used only for guests and customers' users (users who are tied 
to a party) including customers' primary users when an organization is implementing 
sites. 

Employee users use the Applications login to login into the application and use the 
mechanism of switching responsibility to access application under different 
responsibilities.

In the context of Oracle iStore, a site is any site that the site administrator (manager) 
creates using the Oracle iStore Site Administration UI. When you create a site in the 
Oracle iStore Site Administration UI, it is uniquely identified by a Site ID (also called 
Minisite ID).

Sections Overview
With the Oracle iStore section hierarchy, you can organize your sites into logical 
sections connected in parent-child relationships, and re-use these sections, their product
associations, and their content in multiple sites.

The majority of section creation and maintenance tasks are performed using the 
Sections and Products pages, which are accessible as a user logs in with an Oracle iStore
administrator responsibility.

In combination with the Display Templates, your site sections, connected in a hierarchal
fashion, help determine the browsing path for the customer in your sites. All driven 
from the main Root section, together the sections, subsections, and products in your 
sites form a tree-like structure. After you create a section, you can use it in any number 
of sites. You also can choose to exclude certain sections from sites.

Using the site administration pages, you can:

• Create sections
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• Duplicate existing sections, including all products and content

• Assign Display Templates to sections to determine the layout of the sections

• Assign products to sections -- either automatically or manually

• Assign or exclude sections to/from site(s)

• Preview sections in the context of the specialty site(s) in which they will appear

• Delete sections

• Rename sections

• Use the search utility to search for sections

Section Templates
Sections and their associated products appear in the Customer page in the context of the
display templates in which they appear. In addition to the display templates, section 
appearance is affected by the structure of your section hierarchy, any section-product 
associations, and any content that you have associated with a section or product.

Template Manager
If you implement Oracle iStore with Oracle iSupport, then you can use the Oracle iStore
template manager to configure Oracle iStore pages. With the template manager, you can
link your own JSP files to seeded templates to present content that is not provided by 
the Oracle-supplied files. For example, the template manager enables you to create 
brandable registration pages and an overall common look and feel throughout your 
site. For details, refer to the Oracle iStore Implementation and Administration Guide.

Dashboard
A dashboard appears when a user selects a site - responsibility combination from the 
site selection page.This Site Dashboard allows service organizations to:

• Configure the layout of the dashboard and publish targeted content for users 
utilizing the template manager

• Publish bins that provide links to other applications based on a user's 
responsibilities and sites definition. For example, by using the Oracle iSupport 
related Bins on the site dashboard, users can navigate to Oracle iSupport to manage 
and create service requests.

• Publish application specific bins, for example, a bin to search the knowledge base 
and a bin to allow partner to enroll in targeted programs

• Support multi-language and globalization capabilities
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Because the dashboard is integrated with Oracle Content Manager, it enables an 
administrator to show content from Oracle Content Manager on the dashboard. 

The dashboard is a template page. It provides customers an ability to put their own 
content in their own style and present it to their customers. Several seeded bins are 
available on this page that an organization can use or it can define its own custom 
content. The content on the dashboard can be configured using the template manager 
mapping between a template page, site, and language. This page is also integrated with 
content manager and can pull in content from the content manager. 

Configurability
Oracle iSupport provides several ways to configure your site's appearance:

• Style sheet

You can design and use different style sheets to control the display of HTML pages.

• Custom menu

You can write a new menu renderer by implementing a JTT custom menu class and 
associating it with different Oracle iSupport responsibilities.

• Regions on a page and page flows

For service requests, you can configure the content of page regions, the regions that 
pages display, and the pages that appear in the create-service-request flow.

• Page-level configurability

You can configure the look and feel ofOracle iSupport JavaServer Pages (JSPs) for 
different users without customizing these pages directly. This is accomplished by 
putting customized material in the top, left, right, and bottom sections of the 
original content pages that Oracle supplies. Pages include those from the following 
areas:

• Service request

• Orders

• Invoices

• Payments

• Shipments

• Returns

• Language
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If you simply want to display the same information in a different language, then 
you can use JSP and AK regions or FND messages for translation. You can find 
steps to use AK regions and FND messages in documentation for Oracle self-service
Web applications.
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2
 Dependencies and Integration Points

This chapter covers the following topics:

• Overview of Dependencies

• Mandatory Dependencies

• Software Installation

• Oracle Application Object Library

• Oracle CRM Technology Foundation

• Oracle Workflow

• Oracle Trading Community Architecture

• Oracle CRM Application Foundation

• Conditional Dependencies

• Oracle TeleService

• Oracle Inventory and Oracle Install Base

• Oracle Enterprise Asset Management

• Oracle Bills of Materials

• Oracle Receivables

• Oracle General Ledger

• Oracle Human Resource Management System

• Oracle Order Management

• Oracle Quoting and Order Capture APIs

• Oracle Purchasing

• Oracle iStore

• Oracle Contracts Suite

• Oracle Customer Care
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• Oracle Knowledge Management

• Oracle Marketing Encyclopedia System

• Web Call-Back Dependencies

• Oracle iMarketing

• Oracle Scripting

Overview of Dependencies
Because Oracle iSupport is integrated with multiple Oracle modules that supply varied 
data and functionality, merchants can choose which modules to implement based on 
their specific business requirements. These integrated modules present many 
dependencies to Oracle iSupport.

Dependencies are classified as either mandatory, meaning that Oracle iSupport cannot 
function without them, or conditional, meaning that they supply additional 
functionality, but are not required to run Oracle iSupport. The Mandatory and 
Conditional Dependencies sections in this chapter provide overviews of these 
dependencies.

For documentation and training related to these modules, see the Preface to this guide.

Mandatory Dependencies
Oracle iSupport relies on several Oracle E-Business Suite modules for its data and 
functionality. The modules that must be installed and set up for Oracle iSupport to 
function properly are discussed in the following paragraphs.

Software Installation
Your installation needs will vary depending upon whether you are doing a fresh 
installation (no previous Oracle applications installed), a multi-application upgrade 
using a Family Pack or Maintenance Pack, a multi-application upgrade involving 
several patches, or simply installing a single patch. In general, this documentation is 
written assuming that you are doing a fresh installation.

If you are installing Oracle Applications release 12 for the first time, or upgrading to 
release 12 from a previous release, use the appropriate version of Oracle Rapid Install as
documented in:

•  Oracle E-Business Suite Installation Guide: Using Rapid Install

• Oracle E-Business Suite Upgrade Guide

• Oracle E-Business Suite Release Notes for this release
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Oracle Application Object Library
The Oracle Application Object Library is a required dependency of all Oracle 
applications. Supplying technology and common libraries for Oracle applications, 
Oracle Application Object Library allows user creation, responsibility creation and 
maintenance, and the assignment of responsibilities to users. 

Oracle CRM Technology Foundation
Oracle CRM Technology Foundation (JTT) is a prerequisite for implementation of any 
Oracle CRM module. JTT provides Java-based infrastructure software that is used to 
develop e-business solutions such as Sales, Marketing, Service, E-Commerce, Contracts, 
and Interaction Center applications. It offers a common platform for developing 
applications with HTML, XML, and Java. It also provides user-friendly screens for 
centralized setup and administration. This web-based interface is called the System 
Administrator Console. For more information, see the Oracle E-Business Suite CRM 
System Administrator's Guide.

Oracle Workflow
In all Oracle applications, Oracle Workflow provides the ability to send e-mail 
notifications, and allows you to define various workflow processes required for normal 
business operations. Oracle Applications comes with Oracle Workflow (WF) already 
installed as part of the Applications Object Library. For details on how Oracle iSupport 
uses Oracle Workflow, please see the chapterIntegrating Oracle iSupport with Oracle 
Workflow, page 6-1.

Oracle Trading Community Architecture
The Oracle Trading Community Architecture consists of a database schema, APIs, and 
data quality management utilities that allow you to capture and exploit valuable 
information about your commercial community: organizations, people, places, and the 
network of relationships that bring them together. Oracle Trading Community 
Architecture is used by both Oracle ERP and Oracle CRM applications. For this release, 
Oracle's customer model is based on Oracle Trading Community Architecture. 

Some APIs for Oracle Trading Community Architecture are published as part of this 
release. Refer to Oracle Trading Community Architecture Technical Implementation Guide for
API details.

Oracle CRM Application Foundation
The CRM Application Foundation (JTA) consists of several supporting CRM 
applications. Some of those that Oracle iSupport requires are Assignment Manager, 
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Notes, Resource Manager, and Territory Manager. For more information, see 
"Integrating Oracle iSupport with Service Request," Oracle Trading Community 
Architecture Technical Implementation Guide, and Oracle Common Application Calendar 
Implementation Guide.

Conditional Dependencies
Oracle iSupport relies on several other Oracle applications to extend its functionality. 
The applications that are conditional to Oracle iSupport are discussed in the following 
paragraphs.

Oracle TeleService
A Forms-based product, Oracle TeleService contains the bulk of the service request 
functionality for Oracle iSupport. Integration with Oracle TeleService allows customers 
to use Oracle iSupport to submit, view, edit, and re-open their service requests online. 
In other words, Oracle iSupport makes it possible for customers and employees to log 
and monitor their service requests. Integration with Oracle TeleService also makes it 
possible for an agent to step in and help any customers who cannot resolve problems on
their own. Setup information is in the chapter Integrating Oracle iSupport with Service 
Request, page 4-2.

Oracle Inventory and Oracle Install Base
Oracle Inventory supplies the infrastructure that contains an organization's entire 
product repository and configuration. It integrates closely with Oracle Install Base, 
which is the repository of customer- or party-purchased products. Both Oracle 
Inventory and Install Base are required for full service request functionality in Oracle 
iSupport. Both applications also supply product information during retrieval of account
information on the Oracle iSupport Account tab. Setup information is in the chapter 
Integrating Oracle iSupport with Products and Returns, page 5-1.

Oracle Enterprise Asset Management
Agents and employee users can create service requests for work orders of internal assets
tracked in Oracle Enterprise Asset Management. Enterprise Asset Management 
specializes in maintaining internal assets using a preventive maintenance schedule. 
More specifically, agents and employee users of Oracle iSupport have the following 
abilities regarding service requests for these assets:

• Creating

• Viewing
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• Updating

• Searching

• Creating and saving a view that references an asset in Oracle Enterprise Asset 
Management

For setup details of integrating Oracle iSupport with Oracle Enterprise Asset 
Management, see Enabling Employees to File Service Requests for Assets, page 3-48.

Oracle Bills of Materials
Oracle Bills of Materials allows you to configure groups of products into coordinated 
and complementary systems. Oracle Bills of Materials allows the creation of products 
containing multiple components and subcomponents. It integrates with Oracle 
Inventory and Oracle Install Base. Setup information is in the chapter Integrating Oracle
iSupport with Products and Returns, page 5-1.

Oracle Receivables
Oracle Receivables provides four integrated workbenches that you can use to perform 
most of your day–to–day Accounts Receivable operations. You can use the Receipts 
Workbench to perform most of your receipt–related tasks and the Transactions 
Workbench to process your invoices, debit memos, credit memos, on–account credits, 
chargebacks, and adjustments. The Collections Workbench lets you review customer 
accounts and perform collection activities such as recording customer calls and printing
dunning letters. The Bills Receivable Workbench lets you create, update, remit, and 
manage your bills receivable. Refer to the volumes of the Oracle Receivables User Guide 
for setup information.

Oracle General Ledger
Oracle iSupport uses General Ledger to set up ledgers and books, store exchange rates, 
and store related business information. Refer to Oracle General Ledger User Guide for 
complete setup information.

Oracle Human Resource Management System
Oracle Human Resources Management System provides employee data for CRM and 
ERP applications. This application is mandatory only if a service organization wants its 
employees to log in and use Oracle iSupport as an online help desk.
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Oracle Order Management
Oracle Order Management processes orders booked in Oracle Quoting, Oracle iStore, 
and Oracle Order Management itself. Oracle Order Management and Oracle Quoting 
are both integral applications for returns functionality in Oracle iSupport. Oracle Order 
Management integrates with Oracle Advanced Pricing for determining prices of goods 
sold and Oracle Shipping for shipping execution. Oracle Order Management uses 
Oracle Receivables for keeping records of customers and invoices, and capturing 
payments. Oracle Order Management also depends on Oracle General Ledger. Setup 
information is in the chapter Integrating Oracle iSupport with Products and Returns, 
page 5-1.

Oracle Quoting and Order Capture APIs
Orders quoted in Oracle Quoting are sent to Oracle Order Management for processing. 
These orders then can be viewed within the Oracle iSupport Account tab. There are 
three parts to quoting: Oracle Quoting for forms, Oracle Quoting for HTML, and Oracle 
Order Capture APIs. All of these coordinate in the returns process, and Oracle Order 
Capture APIs are essential to returns functionality in Oracle iSupport. Setup 
information is in the chapter, Integrating Oracle iSupport with Products and Returns, 
page 5-1.

Oracle Purchasing
The Receipts form of Oracle Purchasing receives returns created in Oracle iSupport. 
Setup information is in the chapter, Integrating Oracle iSupport with Products and 
Returns, page 5-1.

Oracle iStore
With the Oracle iStore application, merchants can set up Internet storefronts that 
capture and process customer orders. Orders placed in Oracle iStore can be viewed 
within the Oracle iSupport Account tab. Oracle iStore and Oracle iSupport leverage the 
same pages for displaying information about orders, invoices, payments, shipments, 
returns, and for creating returns. For implementation with sites, Oracle iSupport uses 
the common site framework of Oracle iStore as defined in the Oracle iStore 
Implementation and Administration Guide. This framework comprises the following 
elements:

• Login 

• Logout 

• Registration
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• Site Definition

• Section Hierarchy

• Section Layout 

• Template Manager 

• Site Dashboard Bins

• Profile Management

• User Management

• Returns Creation

• Pages such as Orders, Invoices, Payments, Shipments, and Returns

Setup information for sites is contained within the Oracle iStore Implementation and 
Administration Guide.

For implementation without sites, by default, all order tracker menus in the following 
Oracle iSupport responsibilities that have access to the Account menu tab are disabled:

• IBU_BUSINESS_USER_RESP (Oracle iSupport Business User)

• IBU_INDIVIDUAL_USER_RESP (Oracle iSupport Individual User)

• IBU_PRIMARY_USER_RESP (Oracle iSupport Primary User)

To enable Order tracker pages in these responsibilities:

Log into Oracle Forms with the sysadmin responsibility.

1. Query up one of the responsibilities listed above.

2. Remove the following entries in the Menu Exclusion section:

• IBU_INQ_ORDERS

• IBU_INQ_INVOICES

• IBU_INQ_PAYMENTS

• IBU_INQ_RMAS

Oracle Contracts Suite
Oracle Contracts Suite - made up of Oracle Contracts Core and Oracle Service Contracts
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- provides a complete range of contracts creation, service, organization, and 
termination. Oracle iSupport relies on the Contracts Suite to provide data about 
customer entitlements, service contracts, warranties, extended warranties, and response
commitments. This data is retrieved by Oracle iSupport when customers view account 
information. See Oracle Contracts documentation for setup information.

Oracle Contracts Core
Oracle Contracts Core is both an application that provides supporting master 
agreements and a foundation for all other Oracle Contracts modules. The generic 
functionality required by all types of contracts is contained in the Oracle Contracts Core
foundation layer, such as contract access control, renewal, termination, and notification 
management. 

Oracle Service Contracts 
Oracle Service Contracts creates and manages service contracts, warranties and 
extended warranties; provides visibility to contract entitlements; and acts upon 
contractual commitments within the contract. Oracle Service Contracts builds upon the 
foundation of Oracle Contracts Core and adds functionality to meet the specific needs 
of the service industry, such as coverage terms and entitlement checking.

Oracle Customer Care
The Oracle Customer Care part of Oracle TeleService is composed of four modules:

• Contact Center

• Relationship Plans

• Customer Profile/Dashboard

• Critical Customer Management

These modules allow customer support agents to manage many aspects of support, 
including real-time interactions, information retrieval, customer creation, historical 
views, service request creation, knowledge base data retrieval, product management, 
and relationship plans. When a customer requests a call back, the application, at the 
time of a call back, provides the agent information about the customer using the contact 
center 

Oracle Customer Care integrates with several ERP and CRM modules to support and 
extend its functionality. Setup information can be found in the Oracle TeleService 
Implementation and User Guide.
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Oracle Knowledge Management
In Oracle iSupport, Oracle Knowledge Management provides knowledge base searches 
during service request creation, the display of frequently used solutions on the home 
page, and knowledge base searches from the Support tab. With the optional installation 
of Oracle Enterprise Search, Knowledge Management also provides searches through 
unstructured files and Web pages. Knowledge Management Setup information is in the 
Oracle Knowledge Management Implementation and Administration Guide.

Oracle Marketing Encyclopedia System
In Oracle iSupport, Oracle Marketing Encyclopedia System provides functionality for 
publishing information to the home page Alerts bin, displaying other optional home 
page content, and searching and browsing the technical library. See chapter 9 for setup 
information.

Web Call-Back Dependencies
The Web Call-Back (Call Me) feature allows users to submit a call-back request through 
the Oracle iSupport user interface. The web call-back requires implementation of the 
Oracle Interaction Center suite of applications and the purchase of call center hardware.
It also requires the implementation of Oracle Universal Work Queue, Oracle Customer 
Care, and Oracle CRM Foundation Notes module. For further information, see the 
Setting up iSupport Web Call-Back, page 3-49 in the Implementation Tasks chapter.

Oracle iMarketing
The eMerchandizing feature of Oracle iMarketing provides the ability for a service 
organization to show dynamically different campaign messages defined in an Oracle 
application to the customer users of their various support sites. Oracle iSupport 
supports both the classic and the newer lite version of eMerchandizing. The setups for 
the Oracle iMarketing classic and lite versions are different. Refer to the Oracle 
Marketing Implementation Guide for details. For Oracle iSupport setup steps to achieve 
integration with iMarketing, see Setting Up Integration with Oracle iMarketing, page 3-
49.

Oracle Scripting
Oracle iSupport uses Oracle Scripting to provide Surveys functionality. Oracle Scripting
also presents scripts to the desktop of an Interaction Center agent to aid customer 
service. For further information, see the Setting Up Oracle iSupport Surveys topic, page 
3-43, in the Implementation Tasks chapter.
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3
 Implementation Tasks for Oracle iSupport

This chapter covers the following topics:

• Overview of Implementation Tasks

• Confirming General Oracle Applications Setups

• Confirming Oracle Trading Community Architecture Setup

• Confirming Oracle Receivables Setup

• Defining Employees

• Confirming Oracle Foundation Technology Stack Setup

• Performing System Administration Setups

• Confirm Menus/Functions Setup

• Understanding Responsibilities and Roles

• Set Up Profile Options

• Set Up Properties

• Setting Up Oracle Workflow

• Setting Up CRM Foundation

• Setting Up CRM User Management Framework

• Setting Up Enrollments

• Setting Up Registration Templates

• Setting Up Approval Processes

• Setting Up Oracle iSupport Users

• Setting Up Oracle iSupport Administrator

• Steps to Assign Additional Roles and Responsibilities

• Setting Up Language Associations

• Setting Up an Oracle iSupport Primary User



3-2    Oracle iSupport Implementation and Administration Guide

• Setting Up Employee User

• Setting Up Business (B2B) User

• Setting Up Individual (B2C) User

• Setting Up Knowledge Management Administrator-User

• Setting Up Survey Administrator-User

• Setting Up Guest User

• Setting Up Multi-Party Access

• Setting Up Sites

• Setting Up Oracle iSupport Homepage

• Designing the Mandatory Content of the Home Page

• Designing the Default Content of the Home Page

• Editing Content Properties

• Adding Content to the Home Page

• Adding Oracle Marketing Encyclopedia System Content

• Deleting Content from the Home Page

• Enabling Homepage Subscription E-Mails

• Setting Up Service Request

• Setting Up Oracle Knowledge Management

• Setting Up Oracle iSupport Forums

• Creating Categories

• Creating Forums

• Restricting Access to Categories or Forums

• Creating Forum Moderators

• Deleting Forum Moderators

• Setting Up Marketing Encyclopedia System

• Setting Up Account Inquiries

• Setting Up Oracle iSupport Surveys

• Setting Up Oracle Scripting

• Create Surveys in Oracle Scripting

• Assign Survey Administrator Responsibility to an Oracle iSupport User

• Set Up Oracle iSupport Survey in iSurvey

• Make Survey Available in Oracle iSupport
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• View Survey Results

• Enabling Employees to File Service Requests for Assets

• Setting Up Integration with iMarketing

• Setting Up Oracle iSupport Web Call-Back

• Setting Up Customer Care

• Setting Up Page-Level Look and Feel

• General Steps to Perform JSP Configuration

• Mapping Customized JSPs to Customizing Functions

• Mapping Page-Level Configuration Functions to Responsibilities

• Setting Up Custom Menus

Overview of Implementation Tasks
Oracle iSupport relies on other Oracle applications for its functionality. In order to 
successfully implement Oracle iSupport, you must set up its mandatory dependencies, 
and optionally, its conditional dependencies.

The tasks described in this guide assist your setup of Oracle iSupport, Release 12. Many 
companies installing Oracle iSupport already are running some of the mandatory 
and/or conditional Oracle applications. For them, Oracle iSupport is an add-on or 
upgrade. Thus, depending upon your particular situation, you may or may not need to 
perform all of the tasks listed here.

Confirming General Oracle Applications Setups
Your setup steps for Oracle iSupport depend upon whether you are creating a fresh 
install of Oracle Applications or upgrading to the current release from a previous 
release. The steps in this section are confirming setups of applications that all Oracle 
applications depend upon. For details, refer to Oracle E-Business Suite Installation Guide, 
Oracle E-Business Suite Upgrade Guide, and Oracle E-Business Suite Setup Guide.

Confirming Oracle Trading Community Architecture Setup
Ensure the setup of the following in the model for the Oracle Trading Community 
Architecture:

• Parties

• Party Relationships

• Locations
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• Contact Points

• Customer Attributes

Refer to current Trading Community Model documentation for additional details.

Confirming Oracle Receivables Setup
Confirm the setup of Oracle Receivables.

Refer to the Oracle Receivables Implementation Guide.

Defining Employees
Define or confirm the definitions of your employees in Oracle Human Resources 
Management System (HRMS) or another HR application.

For Oracle Human Resources Management System documentation, refer to Oracle 
HRMS guides.

Confirming Oracle Foundation Technology Stack Setup
Confirm the setup of the technology stack. Refer to any Oracle Foundation Technology 
Stack documentation that is available on My Oracle Support. 

Performing System Administration Setups
The merchant implementing Oracle iSupport receives a system administrator login and 
uses that login in the setup of the application. The system administrator username and 
password that are seeded are: sysadmin/sysadmin. It is recommended that you change 
this password to something unique.

Some of the setups listed here are optional. Refer to the text for details.

Confirm Menus/Functions Setup
The menus on the Oracle iSupport HTML UI are seeded in Oracle Application Object 
Library (AOL). They are linked to the seeded Functions in AOL. It is optional to confirm
the setup of menus and functions. 

You can define your own menus and responsibilities. For a list of seeded menus and 
functions in Oracle iSupport, see the Seeded Data appendix.

Confirm Functions
Functions link to coding within specific JSPs and to application menus. Those necessary
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for Oracle iSupport are seeded in AOL. To view Functions in AOL, log into Oracle 
Applications as sysadmin and navigate to System Administrator > Application > 
Function. From there, query for function names that begin with IBU_.

Confirm iSupport Menus
Each menu in Oracle iSupport links to a function or another menu. Confirming menus 
is not mandatory. To view menus in AOL, log into Oracle Applications as sysadmin 
and navigate to System Administrator > Application > Menus. From there, query for 
menu names that begin with IBU_.

For additional information, see the Oracle E-Business Suite Setup Guide.

Understanding Responsibilities and Roles
Responsibilities are defined for application security and determine which menus a user 
will see. Roles are collections of permissions which allow users to perform various 
functions. Roles and responsibilities must be assigned to users to be effective. 

If you are using the CRM User Management Framework for user setup, responsibilities 
and roles are seeded within each User Type. As each user is approved, the roles and 
responsibilities that are assigned depend upon your setup of the user framework. Refer 
to the Oracle E-Business Suite CRM System Administrator's Guide for more information on
what is seeded by user type, and how to customize user types. 

The Oracle iSupport module has its own seeded responsibilities and roles that you can 
use. Setup steps for creating users are in the Setting Up Oracle iSupport Users section, 
page 3-12. Refer to the Seeded Data appendix for Oracle iSupport roles and 
responsibilities that ship with the application.

Refer to AOL documentation for information on how to set up new responsibilities, 
roles, and permissions, or to customize existing ones.

Set Up Profile Options
Profile options are seeded within all Oracle applications, and each module has its own 
specific set of profile options. Although all profile options are seeded, there are some 
settings that must be performed by sysadmin. See the Profile Options appendix for 
details.

Set Up Properties
There are two sets of key components for Oracle iSupport that must be set. These are:

• Company key components

This information is used for constructing the e-mail body for notifications that are 
sent out as part of the home page e-mail subscription functionality.
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• Quick Find window key components

You can enable or disable the searches in Quick Find based on responsibility.

Steps
1. Log in to Oracle Applications as sysadmin/sysadmin.

2. Navigate to Settings > System > Advanced. Select Oracle iSupport's product code, 
IBU, from the View LOV.

3. Set the following company key components to appropriate values. These properties 
are used while sending out Home Page subscription e-mails: 

• COMPANY_ADDRESS

• COMPANY_EMAIL ADDRESS

• COMPANY MERCHANT_NAME

• COMPANY_NAME

• COMPANY_URL

4. To confirm the setup of the Quick Find window items, verify that the following 
values are set for search.factories by clicking search.factories: 

• oracle.apps.ibu.requests.bean.RequestSearchFactory

• oracle.apps.ibu.knowledge.bean.TechLibSearchFactory

• oracle.apps.ibu.communities.bean.MyForumSearchFactory

• oracle.apps.csi.qk.CsiqkInstanceFactory

• oracle.apps.cs.knowledge.bean.SolutionSearchFactory

• oracle.apps.cs.knowledge.bean.SolutionCategorySearchFactory

5. Next, verify that the Quick Find window key components are set according to what 
your business processes require. Remove any items that you do not wish to use

• When deleting items, be sure to remove the pairs of items that end in .
categories and .desc.

Here is an example of what the seeded components will be:

Oracle Install Base*:
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• service.oracle.apps.cs.inquiries.bean.IBSearchFactory.categories

The value of this component is Install Base.

• service.oracle.apps.cs.inquiries.bean.IBSearchFactory.desc

The value of this component is IBSearch.item.

Forums:

• service.oracle.apps.ibu.communities.bean.MyForumSearchFactory.categories

The value of this component is Forums.

• service.oracle.apps.ibu.communities.bean.MyForumSearchFactory.desc

The value of this component is MyForumSearch.item.

Oracle Knowledge Management:

• service.oracle.apps.ibu.knowledge.bean.SMSSearchFactory.categories

The value of this component is Solutions.

• service.oracle.apps.ibu.knowledge.bean.SMSSearchFactory.desc

The value of this component is SMSSearch.item.

Marketing Encyclopedia System (MES):

• service.oracle.apps.ibu.knowledge.bean.TechLibSearchFactory.categories

The value of this component is Library.

• service.oracle.apps.ibu.knowledge.bean.TechLibSearchFactory.desc

The value of this component is TechLibSearch.item.

Service Request:

• service.oracle.apps.ibu.knowledge.bean.RequestSearchFactory.categories

The value of this component is Service Requests.

• service.oracle.apps.ibu.knowledge.bean.RequestSearchFactory.desc

The value of this component is RequestSearch.item.

Service Request Number

• service.oracle.apps.ibu.requests.bean.RequestSRNumSearchFactory.categories

The value of this component is Service Request Number.

• service.oracle.apps.ibu.requests.bean.RequestSRNumSearchFactory.desc



3-8    Oracle iSupport Implementation and Administration Guide

The value of this component is RequestSRNumSearch.item.

6. For any responsibility, set this up manually:

ui.nav.logout.disabled.resp.<responsibility key> = true.

Additional Information: *By default, the responsibility iSupport: 
iSupport Self-Service Helpdesk does not contain the Install Base 
category under the Quick Find window. You must set this up manually
because it cannot be shipped out of the box. To do so, create a JTT 
property called search.factories.<respid of isupport self-service 
helpdesk responsibility> and then add the categories that you want 
exposed to this responsibility.

Setting Up Oracle Workflow
See the chapter in this guide Integrating Oracle iSupport with Oracle Workflow, page 6-
1, or refer to Oracle Workflow Administrator's Guide.

Setting Up CRM Foundation
Set up and/or confirm the setup of the CRM Foundation software suite. Oracle iSupport
service request functionality uses the Notes, Resources, and Assignment Manager 
modules. Oracle Knowledge Management functionality also uses Notes and Resources. 
Thus, at a minimum, you should be familiar with the setup and functionality of Notes, 
Resources, and Assignment Manager. For information on the Oracle iSupport-specific 
setups related to these modules, see these sections:

• Setting Up Oracle Knowledge Management

• Integrating Oracle iSupport with Service Request

Refer to Oracle E-Business Suite CRM System Administrator's Guide, Oracle Common 
Application Calendar Implementation Guide, and Oracle Trading Community Architecture 
Technical Implementation Guide for details.

Setting Up CRM User Management Framework
The Oracle CRM User Management Framework consists of enrollments, approval 
processes, registration templates, and user types. These components provide a flexible 
framework for user creation, approval, management, and information gathering.

The user management framework is an optional but recommended integration for your 
organization. Although the framework is installed automatically when you install CRM 
Foundation modules, you need to perform some setups. 
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The information in this section is meant to give you an overview of the user 
management framework concepts. For more information, refer to the Oracle E-Business 
Suite CRM System Administrator's Guide.

Setting Up Enrollments
Enrollments are application-specific services at the user level. These services include the
registration templates, page 1-18, roles,, page 1-17 responsibilities, page 1-17, and 
approval definitions that are tied to user types. Oracle User Management provides four 
types of enrollment available for a user type:

• Automatic

• Self-service

• Delegation only

• Self-service and delegation

One enrollment can equal: 

• 0 or 1 responsibility - You can link no more than one responsibility to an 
enrollment.

• 0 or 1 template - You can link no more than one registration template to an 
enrollment.

• 0 or 1 workflow - You can link no more than one workflow process to an 
enrollment.

• 0 or more roles - You can link any number of roles to an enrollment.

For more information on enrollments, see the Oracle E-Business Suite CRM System 
Administrator's Guide.

Sample Registration/Enrollments Scenario for a Business User
User A accesses the HTML login page and begins self-registration. The first registration 
page that he sees is a list of user types (such as Primary User, Business User, Individual 
User). User A selects Business User as his user type. The user type selection determines 
which implicit enrollments (default role and responsibility tied to his user type) he will 
get from the JTT user management framework. 

During implementation or setup, the application administrator (sysadmin) must 
configure User Types and implicit enrollments on the System Administrator Console. 
The administrator may also set up enrollments to which users can subscribe. 

Continuing with registration, User A enters his customer number (provided by his 
application administrator), his name, address information, and so on. He chooses a 
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unique username and password.

In the next page, User A is presented with a list of enrollments, such as Self-Service 
Support Over the Web (for Oracle iSupport), and Oracle iStore. These are explicit 
enrollments. He can select none, one, or all listed enrollments. If User A selects no 
enrollments, he receives only the implicit enrollments (the default role and 
responsibility) tied to the Business User Type. Other roles and responsibilities can be 
manually added later to his username by the Oracle iSupport Administrator.

The registration request enters the approval process. The JTT user management 
framework comes with seeded approval processes that leverage Oracle Workflow for e-
mail notifications. If User A logs in to the application before he is approved, then he 
sees a page that tells him that his approval is pending.

After User A is approved, he receives an e-mail notifying him of his approval, and then 
he can log in to the HTML login page. His application landing page depends upon the 
default responsibility assigned to him when he logs in.

Seeded Self-Service Support Over the Web Enrollment
The enrollment tied to Oracle iSupport is called the Self-Service Support Over the Web 
Enrollment. It is seeded within the CRM User Management Framework.

An appendix table, page C-10 shows seeded Oracle iSupport user responsibilities for 
Self-Service Support Over the Web Enrollment. Responsibilities that contain the word 
"site" in their titles are used in cases where a user registers using the Oracle iStore 
registration page.

The section Oracle iSupport Enrollments, page C-14 lists the responsibilities, roles, and 
other information for seeded Oracle iSupport enrollments for Self-Service Support Over
the Web Enrollment.

Modifying Seeded Enrollments
The seeded enrollments can be modified, and you can also create new enrollments. For 
more information, refer to the Oracle E-Business Suite CRM System Administrator's Guide .

Setting Up Registration Templates
Applications require different pieces of information to register various user types. 
Registration of a sales representative might require the sales territory, while a consumer
registration would need to include the credit card number. Registration data is being 
stored in different tables - some is common data and is stored (mostly) in the Trading 
Community Architecture (TCA); the rest is stored into application-specific tables. 

Registration templates, which can be one JSP or multiple pages, accommodate these 
information-gathering requirements. The registration pages rendered to a user will 
depend on the user type and the services/enrollments the user is subscribing to. 
Registration templates refer to JSP files that are used to capture the registration 
information that is particular to a User Type.
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Characteristics of registration templates include:

• JSPs associated with a template handler to execute the logic on data captured 
through JSP pages

• Can be tied to enrollments

• Are set up by the application administrator during implementation

• Can consist of one page or many

Defining New Registration Templates
New registration templates can be created using the JTF sysadmin console. For more 
information, refer to the Oracle E-Business Suite CRM System Administrator's Guide.

Setting Up Approval Processes
Approval is a step in the registration process whereby users and/or their enrollments 
are confirmed by an approving authority. After the approval process is completed, the 
system automatically grants the appropriate default role(s) and responsibility (based on
User Type and/or Enrollments) that allow access to the application.

The approval process uses Oracle Workflow to track and route the request (via an e-
mail message) to each approver set up in the approval definition. The e-mail informs 
the approvers of the request type (user type or enrollment) and what action is required.

Seeded JTF Approval Processes
User Type seeded approval processes are:

• Individual User - No approval required

• Business User - Approval notification sent to Primary User(s)

• Primary User - Approval notification sent to Oracle iSupport Administrator, or 
System Administrator

Who Can Be an Approver?
• Request Owner - This user is the current approver based on the approver list and 

current state of workflow defined for given approval. The Request Owner will only 
be able to approve the requests that are owned by him. This user should have 
JTF_APPROVER permission.

• Oracle Applications System Administrator (sysadmin) - The sysadmin will see 
and be able to approve all pending requests. Users who have the 
JTF_REG_APPROVAL permission are considered sysadmins. The Oracle iSupport 
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Administrator role (IBU_SYSTEM_ADMIN) has the JTF_REG_APPROVAL 
permission.

• Oracle iSupport Administrator - The Oracle iSupport Administrator sees a list of 
pending approvals. Users who have the IBU_SYSTEM_ADMIN role are considered 
to be the Oracle iSupport Administrator.

For primary users to see the list of pending approvals in their company, the 
administrator must do the following setup:

1. Create a dummy user JTA_DUMMY through the fnd_user window.

2. Assign CRM_PRIMARY_USER responsibility to this user.

3. Assign the JTF_APPROVER role to this user.

4. Set this user to be the value of the JTF_PRIMARY_USER profile option.

• Primary User - This user can view and approve the requests that are assigned to the
Primary User role, as well as the requests owned by the Primary User. The requests 
assigned to the Primary User role are filtered based on the current approver's 
organization. Primary Users need the JTF_PRIMARY_USER_SUMMARY role to 
view the pending requests page showing their list of users waiting approval. 
Requests assigned to the Primary User role are identified by the 
JTF_PRIMARY_USER profile option, which should be set to a predetermined 
username or an FND dummy user. The name used for the Primary User Role needs 
to be in the approval hierarchy if the primary user is needed for approval.

For a primary user to see the list of pending approvals in his company, the 
administrator must do the setup described under the section about the Oracle 
iSupport Administrator.

A primary user does not see any listing on the pending approvals page unless his 
turn in the approval process. For example, if the approval chain is A, B, C, where C 
is the JTA_DUMMY, then only after A and B has approved the user will the 
primary user see this in his pending approval window.

Defining a New Approval Process
New approval processes can be defined on the JTF sysadmin console. For more 
information, refer to the Oracle E-Business Suite CRM System Administrator's Guide.

Setting Up Oracle iSupport Users
Oracle iSupport uses the Oracle CRM User Management Framework. Because Oracle 
iSupport also has its own user responsibilities and roles, this section contains 
information on setting up Oracle iSupport users exclusive of the new framework. See 
Setting up Oracle CRM User Management Framework, page 3-8 for more information 
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on its functionality.

Setting Up Oracle iSupport Administrator
The merchant implementing Oracle iSupport uses the sysadmin login to set up the 
Oracle iSupport Administrator. This is a required user and is not one of the seeded user 
types within the CRM User Management Framework. 

The Oracle iSupport Administrator responsibility, iSupport System Administrator, is 
seeded in AOL. This responsibility has the responsibility key IBU_SYS_ADMIN.

The menu assigned to this responsibility is called iSupport Administration Root 
(IBU_SYS_ADMIN_TOP_MENU). See Oracle E-Business Suite Setup Guide for more 
information on building menus and creating responsibilities.

The Oracle iSupport Administrator typically performs routine but high-level 
administrative tasks, such as:

• Setting up users and assigning appropriate roles and responsibilities

• Setting up the application homepage

• Setting up optional service request functionality

• Setting up optional products and returns modules

• Setting up optional knowledge management modules

• Setting up optional accounts functionality

• Setting up iSupport forums

• Setting up iSupport Call Me (web call-back)

• Setting up iSupport Surveys/Feedback feature

Oracle iSupport Administrator functions are accessible by using the Oracle iSupport 
Administrator username and password on the Applications login page, and then 
selecting the Administration button in the top-right of the window.

Steps to Set Up Oracle iSupport Administrator
Follow the steps below to set up the Oracle iSupport Administrator.

Prerequisite:
Employees have been defined using Oracle Human Resources Management System or 
another human resources application. For Oracle HRMS documentation, refer to the 
Oracle HRMS Enterprise and Workforce Management Guide.
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Associate User Name with Employee and Assign Responsibility
1. Log in to the Oracle Forms application as sysadmin. Select System Administrator 

responsibility. Navigate to Security > User > Define. The Users window opens.

2. In the Users window, enter the username for the Oracle iSupport Administrator. An
example is IBUADMIN. (IBU is the product code for Oracle iSupport.)

3. Associate the user with an employee by using the Person LOV in the User Form. 
Select the desired association by double-clicking on the employee name.

4. Tab to Password field and enter a password. Tab to clear the field and re-enter the 
same password to validate.

5. In the Responsibilities tab, select the IBU_SYS_ADMINresponsibility. 

6. Save changes.

7. Still using System Administrator responsibility, navigate to Profile > System. 

8. Query with the username in the username field and JTF%DEF% in the Profile field.

9. Set the following profile option at the user level for the administrator:

• JTF_PROFILE_DEFAULT_APPLICATION - 672

This tells the system that the default application for this user is Oracle iSupport,
whose application ID is 672.

10. Find the responsibility ID for the IBU_SYS_ADMIN responsibility (see steps below) 
and enter that value as the JTF_PROFILE_DEFAULT_RESPONSIBILITY value. Set 
at user level. 

This tells the system that the default responsibility for this user is 
IBU_SYS_ADMIN.

11. Save and close the window.

Finding Responsibility ID
Use the following steps to find theRESPONSIBILITY_ID value of a responsibility. See 
the Profile Options appendix for details on determining APPLICATION_ID values -- The
application ID is used when setting system profile values.

1. In Oracle Forms as System Administrator, navigate to Security > Responsibility > 
Define. The Responsibilities window opens.

2. From the top menu, select View > Find. Search for the IBU_SYS_ADMIN 



 Implementation Tasks for Oracle iSupport    3-15

responsibility. After this is found, highlight the responsibility, and select Ok in the 
search window. The Responsibilities window is populated with the information for 
the responsibility.

3. With the cursor in any field of the record, select Help > Diagnostics > Examine. The 
Examine Field and Variable Values window opens.

4. In the Examine Field and Variable Values window, select RESPONSIBILITY_ID 
from the Field LOV. The Value field displays the value of RESPONSIBILITY_ID.

Assign Role(s)
1. Navigate to Users > Registration > User Maintenance.

2. Find the user who will be the Oracle iSupport Administrator. Select the underlined 
hyperlink of the username. 

3. Select Roles. Assign IBU_SYSTEM_ADMIN and IBU_REG_USER to the user.

4. Select Update.

5. Log out.

Verification
1. Log in to the Applications login as the Oracle iSupport Administrator just created.

2. Verify that appropriate menus are displayed. The Oracle iSupport Administrator 
has the following main tabs on the UI: 

• Home

• Support (subtabs: Top Solutions, Technical Library, Forum, Service Requests)

3. Under Profile, the Oracle iSupport Administrator has access to the following links:

• Personal Profile

• Contact Points

• Addresses

• Display Preferences

• Accounts

• Support

• My Enrollments
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• A section for Company Information.

4. Select the Administration button at the top of the window. Verify that the Oracle 
iSupport Administrator can access the following administrator tabs:

• User (subtabs: User, Pending Approvals)

• Homepage (subtabs: Content, Subscription)

• Support (subtabs: Request template, Call Me, Survey, Technical Library, User 
Group, Supported Languages)

• Forum (subtabs: Category, Forum, Messages, User Group)

• MES

Steps to Assign Additional Roles and Responsibilities
After you have set up the Oracle iSupport Administrator, you can use that user to 
assign additional responsibilities and/or roles to users. 

Remember, as a CRM User Management Framework User Type is approved, the system
automatically gives those users a default role(s) and a default responsibility. Which 
roles and responsibilities are granted depends upon how you have configured the user 
management framework, including what roles and responsibilities are linked to the 
User Type and Enrollment selected during registration. 

If you are creating custom users or if you need to assign additional responsibilities or 
roles to users, then use the following steps:

1. Log into Oracle iSupport as the Oracle iSupport Administrator.

2. Navigate to Administration > User. 

3. Search for the user whom you wish to modify.

4. Select the underlined link of the username.

5. In the Personal Profile window, select either Roles or Responsibilities as 
appropriate.

6. Assign the roles/responsibilities as desired.If you assign additional responsibilities, then
be sure to select a default responsibility.

Note: The default responsibility that is active at the time a user logs
in to the Applications login determines which application he 
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initially accesses. The user can change this default by accessing the 
Profile > Preferences menu in Oracle iSupport.

Setting Up Language Associations
Use this procedure to associate an installed application language with a responsibility.

Steps
1. Log into Oracle iSupport as the Oracle iSupport Administrator.

2. Navigate to Administration > Support > Supported Languages.

3. Select a responsibility from the Select Responsibility LOV, and click GO. A list of 
candidate languages appears.

4. In the Enable As a Supported Language column, select the check box for languages 
that you want to associate with the responsibility. Clear a check box to remove the 
association.

5. Use the Restore button as needed return the selections to the state that they were 
just after the last update. Then continue you selection and deselection.

6. Click Update. A confirmation message appears to say that your selection has been 
saved.

Setting Up an Oracle iSupport Primary User
The Oracle iSupport Primary User typically:

• Approves other users within his party/organization

• Adds/modifies responsibilities to users within his party/organization

• Adds/modifies roles to users within his party/organization

The primary user can be approved by another primary user with the same 
responsibility as that of an Oracle iSupport Primary User for the party (organization) to 
which the primary user belongs, or by the Oracle iSupport Administrator.

Steps to Set Up an Oracle iSupport Primary User
Follow the steps below to set up the Oracle iSupport Primary User.
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Registration
1. Select the Register link on the Applications login. Or, have the user self-register 

using the Register link.

Note: If you have already set up this user through the Oracle Forms interface, 
Oracle Human Resources Management System (HRMS), or your company's own 
HR application, then you may skip the Registration step. Instead, associate an 
employee with a user name in the Forms application (as you did with the 
administrator-user), and assign the iSupport Primary User responsibility there. This
has the responsibility key IBU_PRIMARY_USER_RESP.

2. If you are registering your company for the first time, select Register your company 
link. 

3. Enter the company information in the Business Information section. Enter 
information about the primary user in the Personal Information section. Make a 
note of the user name and password.

4. In the Available Enrollments table, select the Self-Service Support Over the Web 
option.

Note: The Enrollments window brings in the CRM User Management Framework. 
The default roles and responsibilities linked to the Self-Service Support Over the 
Web enrollment will be assigned to this user upon approval. See the topic, Seeded 
Self-Service Support Over the Web Enrollment, page 3-10, for default roles and 
responsibilities that are seeded by user type for this enrollment.

5. Click Submit.

If the company is already registered, select Register as a user of an existing company 
link. Enter the registry ID and information about the primary user. Select Self-Service 
Support Over the Web and click Submit.

Approval
1. Log in to the Applications login page as sysadmin. 

Note: It is possible to set up a user other than sysadmin to be the approver. For 
more information, refer to the Oracle E-Business Suite CRM System Administrator's 
Guide. Depending on setup, you may be asked to pick a responsibility before you 
can proceed. Choose the CRM HTML Administrator responsibility. 

2. Navigate to Users > Registration > Pending Approvals. 

3. In the Request Summary window, select the appropriate underlined username.

4. Fill in the mandatory information. Select Next.

5. Select the Accounts button. Choose the company account(s) to associate with the 
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user. Select Next.

6. Enter any comments in the Comments area. Select Accept.

Verification
1. At the Applications login page, log in as the Primary User just created.

2. Verify that appropriate menus are displayed. The Primary User has access to the 
following main tabs on the UI: 

• Home

• Account (subtabs: Orders, Invoices, Payments, Contracts, Returns, Products, 
Repair Orders)

• Support (subtabs: Top Solutions, Technical Library, Service Requests)

3. Under the Profile button, the Primary User has access to the following links:

User Profile:

• Personal Profile

• Contact Points

• Addresses

• Display Preferences

• Accounts

• Support

• My Enrollments

Company Profile:

• Information

• Contact Points

• Addresses

• Administrators

4. Select the Administration button at the top of the window. Verify that the Primary 
User can access the following administrator tabs:

• User
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• Pending Approvals

• Party Access

Setting Up Employee User
This type of user is an employee of the merchant using Oracle iSupport. This user is set 
up through the Forms interface and approved by the Oracle iSupport Administrator or 
the Primary User for the Employee User's organization.

Steps to Set Up Employee User
Follow the steps below to set up this user.

Prerequisite:
Employees have been defined using Oracle Human Resources Management System or 
another HR application. For Oracle HRMS documentation, refer to the Oracle HRMS 
Enterprise and Workforce Management Guide.

Steps
1. Log into Oracle Forms application as sysadmin. Select System Administrator 

responsibility.

2. Navigate to Security > User > Define. The Users window appears.

3. Enter a Username for the user. For example, you could use the first initial and last 
name of the employee.

4. On the User window, associate the new username with an employee: Click in the 
Person field on the User window. Search for the employee by clicking on the LOV 
field {...}, entering a partial value and clicking Find. Select the employee by double-
clicking the employee name.

5. In the Password field, enter a password for the username. Use the Tab key to clear 
the Password field, and then re-enter the password to validate.

6. If desired, limit the number of days this password will be valid by entering a value 
in days in either the Accesses or Days fields. The user will be prompted to change 
this password after x number of days/accesses, where x represents the value that 
you entered in the Days field or Accesses field. If you select None, the user will not 
be required to change the password.

7. In the Responsibility tab, click in the Responsibility field. Select the LOV {...} that 
appears, and enter %iSupport% to query for Oracle iSupport responsibilities.
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8. Choose the iSupport Employee User responsibility.

9. Under Effective Dates, enter an the effective date in the From field. If desired, enter 
an end-date for the user in the To field. Leave the To field blank to create the user 
with no end-date.

10. Save and close the window.

Assign Role(s) and Default Responsibility
1. Log in to the Applications login page as Oracle iSupport Administrator. Navigate to

Administration > User.

2. Search for the user. After you find the user, select the underlined hyperlink of the 
username. The Personal Profile page appears.

3. Select Roles. Assign IBU_REG_USER and IBU_EMPLOYEE to the employee.

4. Save your work.

5. Return to the Personal Profile page. Select Responsibilities and assign iSupport 
Employee User as the default responsibility for this user. This responsibility has the 
key IBU_EMPLOYEE_USER_RESP. 

6. Save your work.

Note: When setting up new users of the Install Base functionality, 
please add the role, CSI_END_USER, to them. This role contains 
the required permissions for Oracle Install Base general users.

Set Related Profile Options
Set the profile option Oracle iSupport: Internal Organization for Employee Created 
Service Requests. For more information, see the Profile Options appendix, page A-6.

Verification
1. At the Applications login page, log in as the user just created.

2. Verify that appropriate menus are displayed. The Employee User has the following 
main tabs on the UI: 

• Home

• Support (subtabs: Ask Me, Top Solutions, Technical Library, Forum, Service 
Requests)

3. Under the Profile button, the Employee User has access to the following links:

User Profile:
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• Personal Profile

• Contact Points

• Addresses

• Support

Setting Up Business (B2B) User
B2B (business users) are generally customers who have accounts on the merchant and 
are not associated with the merchant's company. These users select the Register Here 
link on the Applications login page to register. 

Steps to Set Up B2B User
Follow the steps below to set up this user.

Registration
1. Select the Register Here link on the Applications login. Or, have the user self-

register using the Register Here link.

2. Select Business User from the list of User Types. Select Next.

3. Enter the company ID in the textbox and Submit. The company ID is a unique 
number assigned during company registration. 

4. Enter required information on the User Registration window. Make a note of the 
username and password. Select Next. The Available Enrollments window appears.

5. In the Enrollments window, select Self-Service Support Over the Web and select 
Next. A confirmation message appears. Select Next.

Note: When setting up new users of the Oracle Install Base 
functionality, add the role CSI_END_USER to them. This role 
contains the required permissions for Oracle Install Base general 
users.

Approval
1. Log in to the Applications login page as sysadmin. Navigate to Users > Registration 

> Pending Approvals. 

2. In the Request Summary window, select the appropriate underlined username.

3. Fill in the mandatory information. Select Next.
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4. Select the Accounts button. Choose the company account(s) to associate with the 
user. Select Next.

5. Enter any comments in the Comments area. Select Accept.

Verification
1. At the Applications login page, log in as the user just created.

2. Verify that appropriate menus are displayed. The B2B User will have the following 
main tabs on the UI: 

• Home

• Account (subtabs: Orders, Invoices, Payments, Contracts, Returns, Products, 
Repair Orders)

• Support (subtabs: Ask Me, Top Solutions, Technical Library, Forum, Service 
Requests)

3. Under the Profile button, the B2B User has access to the following links:

User Profile:

• Personal Profile

• Contact Points

• Addresses

• Display Preferences

• Accounts

• Support

• My Enrollments

Company Profile:

• Information

• Contact Points

• Addresses

• Administrators
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Setting Up Individual (B2C) User
The B2C (individual users) is typically an individual person with no relationship to the 
organization using Oracle iSupport. B2C users will normally be self-registering over the
Internet, using the Register Here link on the Applications login page.

A B2C user's seeded approval process in the CRM User Management Framework is 
automatic. B2C users thus can access the application immediately after registering, 
unless you set up a separate approval process.

Steps to Set Up B2C User
Follow the steps below to set up this user.

Registration
1. Select the Register Here link on the Applications login. In the list of available user 

types, select Individual User. Select Next.

2. Enter required information on the User Registration window. Make a note of the 
username and password. Select Submit. The Available Enrollments window appears.

3. Select Self-Service Support Over the Web and select Next. A confirmation message 
appears. 

Verification
1. At the Applications login page, log in as the user just created.

2. Verify that appropriate menus are displayed. The B2C User has the following main 
tabs on the UI: 

• Home

• Account (subtabs: Orders, Invoices, Payments, Contracts, Returns, Products, 
Repair Orders)

• Support (subtabs: Ask Me, Top Solutions, Technical Library, Forum, Service 
Requests)

3. Under the Profile button, the Employee User has access to the following links:

User Profile:

• Personal Profile

• Contact Points

• Addresses
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• Display Preferences

• Accounts

• Support

• My Enrollments

Setting Up Knowledge Management Administrator-User
This is an administrator-user who performs Oracle Knowledge Management setup and 
management. This user is required only if a merchant uses the Knowledge Management
functionality. Often the Oracle iSupport Administrator is set up to perform this 
function. For more information, see the Oracle Knowledge Management Implementation and
Administration Guide.

Setting Up Survey Administrator-User
This is a user who performs Surveys setup and management. This User Type is not 
seeded in the JTT user management framework. This user is required only if a merchant
uses Surveys. For more information, see the Setting Up iSupport Surveys , page 3-43
topic of this chapter.

Setting Up Guest User
A guest user is one who comes to the Oracle iSupport site and does not log in explicitly. 
Use this procedure to set up a guest user.

Steps
1. Create the fnd user.

2. Create any parties and accounts that must be linked to this user.

3. Set the appropriate value in the profile option Oracle iSupport: Guest User 
Responsibility Name, whose default value is iSupport Guest Responsibility.

4. Set the appropriate value in the profile option Oracle iSupport: Authenticated Guest
User Responsibility Name.

5. Set the appropriate value in the profile option Oracle iSupport: Option to Display 
Quick Find to a Guest User, whose default value is N. If you decide to display the 
Quick Find menu to guest users, then also set up the appropriate search categories 
that can be displayed to guest users.
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6. Set the appropriate value for the guest user in the profile option 
JTF_DEFAULT_RESPONSIBILITY.

7. Add the responsibilities IBU_GUEST_USER_RESP and 
IBU_AUTH_GUEST_USER_RESP to the guest user.

8. Assign the proper role to the guest user. The role IBU_GUEST_USER is shipped out
of the box. Note that any permission assigned to the guest user role is granted to all 
other users.

9. Set the guest user name and password with the Oracle Application Object Library 
profile option GUEST_USER_PWD in the format <user_name>/<password>.

10. Set up the guest user group. The required SQL is the following:
select party_id from hz_parties where party_id in ( Select 
customer_id from fnd_user where user_name in (select upper(b.
attribute_value) from jtf_perz_data a, jtf_perz_data_attrib b where 
a.perz_data_type ='JTF' and a.perz_data_name = 'guest_username' and 
a.perz_data_id = b.perz_data_id))

11. Run the concurrent program IBU_PRODUCT_UUGCP to populate the user group 
users.

12. If you want to hide certain categories from the Quick Find drop down, then set up 
the categories in the JTT system administrator console.

13. Hide the Logout button by creating the property in the JTT system console under 
iSupport. By default this is set up for IBU_GUEST_USER_RESP. If you up a 
different responsibility for the guest user, then set this up manually:
ui.nav.logout.disabled.resp.<resp key> = true;

14. If you want to use the home page, ibuhpage.jsp, as the login page for normal 
registered users, then modify the JTT property to set the .logout.page property to 
point to this JSP, and set this URL to be used to access Oracle iSupport. Otherwise, 
inform guest users of a special URL to use for guest user access.

15. Do not expose any functionality to guest users that have not been guest enabled.

16. If you do not want to expose all guest-enabled pages to guest users, then explicitly 
remove the corresponding permissions from the guest user role.

17. Optionally customize the message IBU_G_LOG_NOTE. This message is displayed 
to guest users, if the guest user feature is enabled, on the right hand side of Oracle 
iSupport pages. If you do not want to display the message, then set this message to 
"null."
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Note: Oracle iSupport uses same guest user that Oracle iStore uses. 
If Oracle iStore is being used, then you do not need to create a guest
user, but you still need to do the other setups.

Setting Up Multi-Party Access
To set up multi-party access you must do the following:

Setup Profile option
Set the value of the profile option, Oracle iSupport: Enable Multi Party Access, to Yes at 
Site level. 

Setup Responsibility
Set up menus for iSupport Administrator, Primary User, and business user to enable 
multi-party access pages. Out of the box menus are not setup for any responsibility to 
access UIs for multi-party. New functions and menus have been seeded for multi-party 
access feature.

To make the Party Access Menu visible to the Administrator as well as the Primary 
User, you need to navigate to System Administrator > Responsibilities. Once the Oracle 
Forms are opened:

For Administrator:

1. Query for iSupport Administrator - JTF Administration responsibility.

2. From the Menu Exclusions tab remove the function IBU_PARTY_ACCESS_FN and 
select Save.

For Primary User:

1. Query for iSupport Primary User responsibility.

2. From the Menu Exclusions tab remove the function IBU_PARTY_ACCESS_FN and 
IBU_SWITCH_PARTY_FN and select Save.

For Business User:

1. Query for iSupport Business User responsibility.

2. From the Menu Exclusions tab remove the function IBU_SWITCH_PARTY_FN and 
select Save.

Assign Permissions
Assign the following permissions to the iSupport Administrator, Primary User and 
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business user roles.

For iSupport Administrator:

1. Select IBU_SYSTEM_ADMIN role and assign the following permissions to it:

• IBU_PARTY_USERS

• IBU_SEARCH_PARTY

• IBU_PARTY_ACCESS

• IBU_ASSOCIATE_PARTY

• IBU_PARTY_ACCOUNT_ACCESS

• IBU_PARTY_ACCOUNTS_VIEW

• IBU_PARTY_ACCESS_VIEW

• IBU_PARTY_REMOVE_VIEW

• IBU_DEFAULT_PARTY_VIEW

2. Ensure that the role IBU_SYSTEM_ADMIN is assigned to the iSupport 
Administrator. 

For iSupport Primary User:

1. Select IBU_PRIMARY_USER role and assign the following permissions to it:

• IBU_PARTY_USERS

• IBU_SEARCH_PARTY

• IBU_PARTY_ACCESS

• IBU_ASSOCIATE_PARTY

• IBU_PARTY_ACCOUNT_ACCESS

2. The permissions listed below may or may not be assigned to the Primary User. 
These permissions are for viewing the Accounts, Party Access, Remove Party, and 
Default Party columns respectively in the Party Access page.

For example, if IBU_PARTY_ACCOUNTS_VIEW permission is not given to the 
Primary User then he will not be able to view the accounts column.

• IBU_PARTY_ACCOUNTS_VIEW
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• IBU_PARTY_ACCESS_VIEW

• IBU_PARTY_REMOVE_VIEW

• IBU_DEFAULT_PARTY_VIEW

3. Ensure that the role IBU_PRIMARY_USER is assigned to the iSupport Primary 
User.

For iSupport Business User:

• Select IBU_Business_USER role and assign it the IBU_SWITCH_PARTY permission.

Grant Multi-Party Access
Follow the steps below to grant multi-party access to the business user.

Steps
1. Log in to the Applications login page as Oracle iSupport Administrator or Primary 

User.

2. Navigate to iSupport Administrator - JTF Administration > Administration. 

3. Select the Party Access tab. The Party Access for Business Users page appears. Here 
you can add, remove, enable, or disable parties to the access list of a business user.

4. Find the user for whom you wish to provide party access and click Go.

5. Click the Party Access icon and the Party Access page appears.

6. The Party Access page displays the list of parties that the user has access to.

7. Click the Associate Party icon, and the Associate Party page appears with a list of 
parties.

8. Select one or more parties that you wish to add to the user, and click Save.

Grant Account Access
Follow the steps below to grant account access to the business user.

Steps
1. Log in to the Applications login page as Oracle iSupport Administrator or Primary 

User.
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2. Navigate to iSupport Administrator - JTF Administration > Administration.

3. Select the Party Access tab. The Party Access for Business Users page appears.

4. Find the user for whom you wish to provide party account access and click Go.

5. Click the Party Access icon and the Party Access page appears.

6. The Party Access page displays the list of parties that the user has access to. 

7. Click the Account icon to assign account access to the user for the selected party. 

8. Select one or more accounts and click Save.

Switch Party
A business user must use this procedure to switch parties.

Steps
1. Log in to the Applications login page as an iSupport B2B user.

2. The Home page for the active party appears.

3. Click the Switch Party link. The Party Context page appears with the list of parties 
that you have access to.

4. Select a party and click Set Party Context. The party that you select becomes the 
active party. 

Search Parties
Multi-party search enables a Business User to search service requests across all parties 
that the user has access to. To search across multiple parties, you must enable the 
IBU_CF_SR_PARTY attribute for the following AK regions:

• IBU_CF_SR_VW_FILTER

• IBU_CF_SR_VW_DSPL_OPTS_VALUES

• IBU_CF_SR_VW_SLTD_DSPL_OPTS – enable this to display the Party attribute 
under Selected Options

The above AK regions are used in the Create Service Request View and Search Service 
Request pages.
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Steps
Follow the steps below to search service requests across multiple parties:

1. Log in to the Applications login page as an iSupport B2B user.

2. The Home page for the active party appears.

3. To display the service requests on the Support tab, click the Service Requests 
secondary tab.

4. Click the Personalize button.

5. Open a Service Request View or click the Create View button. You can create 
service request views to define search criteria.

6. The Update/Create Service Requests View page appears. In the Display Options 
section, the search criterion contains a Party field.

Note: The system switches the party if a service request belongs to a 
party that is not an active party. For example, X is the active party and 
the service request you are searching for belongs to party Y. When you 
open a service request belonging to party Y, the system switches active 
party from X to Y before displaying the service request details.

Setting Up Sites
The optional site management framework enables multiple support sites for guest 
(anonymous) and customer users and provides the following features:

• Multiple support sites using a single instance

• Improved navigation between Oracle iStore, Oracle iSupport, and Oracle Partners

• Support and store functions in a single site

• Single sign on

• Improved self service registration

• Improved user profile

• Improved user management

For implementation with sites, Oracle iSupport uses the common site framework of 
Oracle iStore. This framework comprises the following elements:
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• Login 

• Logout 

• Registration

• Site Definition

• Section Hierarchy

• Section Layout 

• Template Manager 

• Site Dashboard Bins

• Site Security

• Profile Management

• User Management

• Returns Creation

• Pages such as Orders, Invoices, Payments, Shipments, and Returns

For site setup instructions, refer to the Oracle iStore Implementation and Administration 
Guide, which contains scenarios that are specific to Oracle iSupport.

Setting Up Oracle iSupport Homepage
The Homepage is a work page and the application landing page for the user. Here, 
users can store service request and knowledge base links, as well as receive system 
alerts and other data that the merchant chooses to display. Options for Homepage setup
include:

• Use default settings shipped with the application (some basic setups are required).

• Add bins from a pre-defined selection that ships with the application.

• Add content from Oracle Marketing Encyclopedia System.

• Disable content.

• Make content a required item (mandatory) on UI.

• Change display of mandatory content on UI.
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The sections that follow discuss Homepage options.

Designing the Mandatory Content of the Home Page
You can set information on the home page as mandatory. Mandatory content has the 
following characteristics:

• Cannot be disabled by users

• Always appears at the top of the column that it is in

• Can be displayed as wide-format or narrow-format

Follow the steps below to change content to mandatory and choose its layout.

Steps
1. Log in to the Applications login page as the Oracle iSupport Administrator.

2. Navigate to Administration > Homepage. The Manage Home Page Content Page 
appears. 

3. Select the Mandatory Layout tab. The Mandatory Layout by Responsibility page 
appears. 

Here you can define a mandatory layout for the home page for different 
responsibilities like iSupport Individual User, iSupport Employee User, and 
iSupport Guest User. 

4. In the Select Responsibility LOV, select a responsibility and click Select. The page 
updates itself with the current layout information for that responsibility.

5. In the Mandatory Layout for Selected Responsibility region, use the arrows to move
selected bins to design the desired layout for the home page for the selected 
responsibility.

6. Select Save. A confirmation message appears at the top of the page.

Designing the Default Content of the Home Page
Although the application provides default page layouts for all responsibilities, you can 
personalize these defaults. Users can further personalize them. 

Follow the steps below to change the default content and choose its layout.
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Steps
1. Log in to the Applications login page as the Oracle iSupport Administrator.

2. Navigate to Administration > Homepage. The Manage Home Page Content Page 
appears. 

3. Select the Default Layout tab. The Default Layout by Responsibility page appears. 

Here you can define a default layout for the home page for different responsibilities
like iSupport Individual User, iSupport Employee User, and iSupport Guest User. 

4. In the Select Responsibility LOV, select a responsibility and click Select. The page 
updates itself with the current layout information for that responsibility.

5. In the Default Layout for Selected Responsibility region, use the arrows to move 
selected bins to design the desired layout for the home page for the selected 
responsibility.

6. Select Save. A confirmation message appears at the top of the page.

Editing Content Properties
Follow these steps to edit the properties of a content bin.

Steps
1. Log in to the Applications Login page as the Oracle iSupport Administrator.

2. Navigate to Administration > Homepage > Content. The Manage Home Page 
Content page appears. 

3. To edit a particular bin, select its link under Content Display Name. The Edit 
Content page appears.

4. In the Content Properties region, use the fields and LOVs to define the general 
characteristics of the bin and the default number of rows displayed. You can define 
the content to be shown on the home page by associating a java, PL/SQL or HTML 
source to the content.

5. In the Content Access Control region, select the responsibilities with which you 
want to associate this content.

6. Click Associate Responsibility to add additional responsibilities to the list as 
needed.

7. Select Update to save your changes. 
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Adding Content to the Home Page
Follow these steps to edit the properties of a content bin.

Steps
1. Log in to the Applications Login page as the Oracle iSupport Administrator.

2. Navigate to Administration > Homepage > Content. The Manage Home Page 
Content page appears. 

3. To add a new bin, click Define Content. The Define Content page appears.

4. In the Content Properties region, use the fields and LOVs to define the general 
characteristics of the bin and the default number of rows displayed. You can define 
the content to be shown on the home page by associating a Java, PL/SQL or HTML 
source to the content. 

See the section "Seeded Classes for Seeded Bins", page C-72 in the Seeded Data 
chapter for a table of the available Java source files for seeded bins. Use these class 
files to create new bins if these bins are removed from the default setup. Enter the 
java class name in the Content Source Name field in the Content Properties region.

5. In the Content Access Control region, select the responsibilities with which you 
want to associate this content.

6. Click Associate Responsibility to add additional responsibilities to the list as 
needed.

7. Select Save to save your changes. 

Adding Oracle Marketing Encyclopedia System Content
Oracle Marketing Encyclopedia System (MES) supplies some data for the home page, 
for example, the Alerts and Company News bins. You can also publish other types of 
information in MES and select it as home page content in Oracle iSupport. 

Prerequisites
• Set up MES.

• Publish content within MES.

For details on implementing Oracle Marketing Encyclopedia System, see chapter 9. 



3-36    Oracle iSupport Implementation and Administration Guide

Steps
1. Log in to Oracle Applications as the Oracle iSupport Administrator.

2. Navigate to Administration > Homepage > Content. 

The Manage Home Page Content page appears and shows the content including 
content from MES.

3. Click Add Content from MES. The Add Content from MES page appears.

4. Select the check box for any content that you wish to add.

5. Adjust the default rows as desired.

6. Click Add Content. 

The Manage Home Page Content page appears and shows your added content and 
a confirmation message.

Deleting Content from the Home Page
Deleting content from the Content Administration page removes content from current 
home pages. Use this procedure to delete a content bin.

Steps
1. Log in to Oracle Applications as the Oracle iSupport Administrator.

2. Navigate to Administration > Homepage > Content. 

The Manage Home Page Content page appears and shows the content.

3. Select the check box for the content that you want to delete.

4. Click Delete. The page reappears with the selected content deleted.

Enabling Homepage Subscription E-Mails
The Subscription E-Mails feature of Oracle iSupport allows users to receive Homepage 
content in an e-mail window. This can be useful if a user is unable to access the 
Homepage for a period of time. 

Prerequisites
• The e-mail subscription feature must be activated for the user who is to receive the 

e-mails. Navigate to Profile > Support; select content and delivery frequency as 
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desired.

• You must be running Oracle Workflow to enable this feature. For more information,
refer to the chapter in this guide, Integrating Oracle iSupport with Oracle Workflow.

Setting Up the Message Body in Oracle Workflow
Using Oracle Workflow, open the workflow item type iSupport Home Page 
Subscription and modify the message body that lies under the message node 
Subscription Message. For further instructions, refer to the Oracle Workflow User's Guide.

Running Concurrent Programs
In Oracle (Forms) Applications, run the Notification Mailer and 
IBU_PRODUCT_EMGEN concurrent programs. See Oracle E-Business Suite Concepts for 
more information on running concurrent programs. For more information on Oracle 
Workflow, see the chapter in this guide, Integrating Oracle iSupport with Oracle Workflow. 
In addition, refer to the Oracle Workflow User's Guide. 

Setting Up Service Request
See the chapter Integrating Oracle iSupport with Service Request.

Setting Up Oracle Knowledge Management
Oracle Knowledge Management is a comprehensive information management system 
that allows you to manage internal and external information using Oracle intelligent 
knowledge capture, storage, and distribution tools. It is a problem and solution 
management system and database. The solutions are separated by different criteria so 
that each solution has a specific meaning that relates directly to the issues being 
searched. 

Oracle Knowledge Management allows easy solution capture and rapid access to new 
solutions. It is also designed to provide focused results and to reduce the cost of 
providing service while increasing customer satisfaction, thus helping companies 
compete in the marketplace.

For users of Oracle iSupport, Oracle Knowledge Management is important to browse, 
search, and write technical content. Some of the implementation tasks are the setup of 
the following:

• Solution categories

• Solution category groups

• Solution visibility
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You are required to log into Oracle Knowledge Management to set up solutions. For 
details on setting up Oracle Knowledge Management, see the Oracle Knowledge 
Management Implementation and Administration Guide. 

Setting Up Oracle iSupport Forums
The sections below details steps for setting up Oracle iSupport interactive forums.

Creating Categories
Categories help to organize forums into topic areas. Oracle iSupport allows you to set 
up as many categories as you wish. The steps below describe how to create a category.

Steps
1. At the Applications Login, log in as the Oracle iSupport Administrator.

2. Navigate to Administration > Forum > Category > Create. The Create New 
Category window appears.

3. You can choose to have the category exist at the topmost (root) level, or you can 
structure the category to be a sub-category of another category.

Of course, the very first category that you create will be at the Category Root level. 
Thus, for the first one, leave the Choose a parent category field set to Category Root.

Guidelines for creating additional categories:

• Leave the drop-down menu set to Root to create a category at the top-most 
level.

• Select the parent category to create a sub-category within a category.

4. Enter a name for the Category in the Enter the name of the new category field.

5. Select an Access Type. Access type determines who can view the category on the 
UI. Access options are:

Open - All users can view/access.

Restrict - Only members of a usergroup can view/access. For more information, see 
Restricting Access to Categories or Forums, page 3-39.

Close - This option closes the category or forum to all users except the Oracle 
iSupport administrator. It can be utilized as a temporary state for a category or 
forum while the administrator is performing maintenance or setup tasks relating to 
the category or forum. It can also be used to permanently disable a category or 
forum.
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6. Select Create. Respond to the confirmation message.

Creating Forums
Forums are focussed topic areas within broader categories. There is no limit to the 
number of forums you can create within any given category or sub-category. Follow the
steps below to create a forum. 

Steps
1. At the Applications Login, log in as the Oracle iSupport Administrator.

2. Navigate to Administration > Forum > Forum > Create. The Create New Forum 
window appears.

3. From the drop-down list, select the category within which you wish the forum to 
reside.

4. Enter a name for the forum in the Enter forum name field.

5. Select an Access Type:

Open - All users can view/access.

Restrict - Only members of a usergroup can view/access. For more information, see 
Restricting Access to Categories or Forums, page 3-39.

Close - This option closes the category or forum to all users except the Oracle 
iSupport administrator. It can be utilized as a temporary state for a category or 
forum while the administrator is performing maintenance or setup tasks relating to 
the category or forum. It can also be used to permanently disable a category or 
forum.

6. Select Create. Respond to the confirmation message.

Restricting Access to Categories or Forums
In Oracle iSupport, the administrator has the ability to create categories and forums that
only members of a usergroup can view and access. 

Note: Note: Restricted categories and forums do not appear to users 
who are not members of the usergroup associated with the restricted 
category/forum. You should inform users of the existence and nature of
restricted areas so that they can request inclusion in them, if 
appropriate.
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Set Restricted Access on Category or Forum
Use the procedures below to set the Access Type of Restricted on a category or forum.

Prerequisite
A category or forum has been created.

Steps
1. Log in to the Applications Login window as the Oracle iSupport Administrator. 

2. Navigate to the Forum tab.

3. To change the access type of a category, navigate to Category > Modify Status. To 
change the access type of a forum, navigate to Forum > Modify Status. The Modify 
Access Status page appears for either forums or categories.

4. In the Modify Access Status page, select the category or forum you wish to restrict.

5. In the Choose access type area, select the Restricted radio button. 

6. Select Next or Modify, depending upon which button appears. Respond to the 
confirmation message.

Create Usergroup
Follow the steps below to set up a usergroup to associate with the restricted category or 
forum. Only the usernames that are associated with the usergroup will be able to view 
the category or forum.

Steps
1. Log in to the Applications Login window as the Oracle iSupport Administrator. 

2. Navigate to Administration > Support > Usergroup > Create.

3. Enter a unique name for the usergroup in the Name field.

4. Select a effective date for the usergroup using the Start Date calendar icon.

5. Select an ending date for the usergroup using the End Date calendar icon. 

You can also end date a usergroup to disable it.

6. Enter a brief description for the usergroup in the Description text field.

7. In the SQL statement field, enter an appropriate SQL statement.
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Sample SQL Usergroup Select Statement

select EMPLOYEE_ID from FND_USER where EMPLOYEE_ID > 0

This select statement retrieves all employee IDs greater than zero (i.e., all 
employees) from the fnd_user table.

Note: Usergroup select statements support PARTY_ID and EMPLOYEE_ID, but not
USER_ID.

8. Select Save.

Running Usergroup Creation Program 
To populate necessary tables in the database, run the concurrent program Usergroup 
Creation Program (short name is IBUUG). This concurrent program must be run each 
time you update or add users to a usergroup.

Associate Usergroup to Restricted Category/Forum
Follow the steps below to associate a usergroup with a restricted category or forum.

Prerequisites
• A restricted category or forum has been created. 

• A usergroup has been created. 

• The usergroup creation concurrent program has been run.

Steps 
1. At the Applications Login, log in as the Oracle iSupport Administrator.

2. Navigate to Administration > Forum > Usergroup > Associate.

3. Choose a category or forum from the drop-down list.

4. Select a Usergroup to associate with the Forum. 

5. Select Associate.

6. A confirmation window appears.

Creating Forum Moderators
A Forum Moderator is a user designated to handle specific administrative tasks for 
message threads (groups of related messages). 
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Forum moderators can:

• Change the status (open or closed) of a message thread

• Change the distribution (public or internal) of a message thread - internal threads 
can only be viewed by employee users

• Delete message threads

Forum moderators cannot:

• Change access type of a category or forum

• Set up usergroups for restricted categories or forums

• Create forums or categories

• Move message threads from one forum to another

Steps for creating forum moderators are below. 

Steps
1. Log in to the Applications Login window as the Oracle iSupport Administrator. 

2. Navigate to Administration > Forum > Forum > Modify Attributes.

3. From the drop-down list, select a Forum where you wish to add a Moderator.

4. Select Next. The Modify Forum Attributes window appears. 

5. Select the Add button under Moderator List area. The Add Moderator window 
appears.

6. Enter the name of the user who will be the Forum moderator. 

If necessary, search for the user:

1. Enter partial search criteria, using % as a wildcard

2. Select the radio button next to the appropriate username

7. After you have entered the appropriate name in the textbox, select Add. A 
confirmation message appears.

Deleting Forum Moderators
Use the steps below to remove a moderator from a forum.
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Prerequisite
A forum moderator has been created.

Steps
1. Log in to the Applications Login page as the Oracle iSupport Administrator. 

2. Navigate to Administration > Forum > Forum > Modify Attributes. The Modify 
Forum Attributes page appears.

3. From the drop-down list, select the forum from which to remove a moderator.

4. Select Next. The Modify Forum Attribute page appears.

5. Select a moderator to remove. 

6. Under Moderator List, select Delete.

Setting Up Marketing Encyclopedia System
Oracle Marketing Encyclopedia System (MES) is required for technical library 
functionality in Oracle iSupport. It also supplies the Alerts bin content. Refer to chapter 
9 for setup details.

Setting Up Account Inquiries
See the chapter in this guide Integrating Oracle iSupport with Products and Returns, 
page 5-1.

Set up and/or confirm the setup of Oracle Contracts Core, Oracle Service Contracts, and 
Oracle Sales Contracts. There are no contracts setups specific to Oracle iSupport. See the
 Oracle Contracts Implementation and Administration Guide for setup information.

Setting Up Oracle iSupport Surveys
The Surveys functionality of Oracle iSupport allows you to survey usergroups on topics
of your choice. Surveys require you to set up Oracle Scripting. Follow the steps below to
implement Surveys.

Setting Up Oracle Scripting
Oracle Scripting presents scripted messages which guide interaction center agents 
through their interactions with customers. With Scripting, Oracle introduced the survey
component of Oracle Scripting, called iSurvey. Through the Scripting Survey 
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component, enterprises can create, manage, and report on surveys to evaluate customer 
satisfaction, gain customer input on new initiatives, and gain other feedback from 
survey respondents. Oracle Scripting is one application module of Oracle's Interaction 
Center Suite of Applications.

Oracle Scripting consists of the following components: 

• Scripting Engine - The simple graphical user interface that displays a script at an 
agent's workstation via a browser or within an Oracle Window. 

• Scripting Author - A script and survey development studio which is downloaded 
to a user's workstation. Scripting Author uses visual layouts to allow a script 
developer to create, modify, and deploy scripts for agents at the interaction center. 

• Survey Component - An HTML user interface providing web-based surveys that 
can be deployed on the Internet, via email messages or direct links on enterprise 
web sites. The survey component contains all the tools needed to manage lists, set 
up survey campaigns, and provide result information. 

Set up Oracle Scripting according to the Oracle Scripting Implementation Guide. 

Create Surveys in Oracle Scripting
Oracle iSupport uses only the non-list-based types of surveys. 

Create scripts in Oracle Scripting according to the steps and guidelines documented in 
the Oracle Scripting Implementation Guide. 

Assign Survey Administrator Responsibility to an Oracle iSupport User
Assign the responsibility, Survey Administrator, to either an existing Oracle iSupport 
user (such as the Oracle iSupport Administrator), or to a special user created just for 
this purpose. See the Implementation Tasks chapter of this guide, Setting up iSupport 
Users, page 3-12 section, for details on how to set up users.

Steps
1. Log into Oracle iSupport as the Oracle iSupport Administrator.

2. Select Administration > User. Search for the user who will be the Survey 
Administrator, whether this is you as the Oracle iSupport Administrator or another 
user. Select the underlined hyperlink of the username.

3. In the Personal Profile Screen, select Responsibilities. 

4. In the Responsibilities window, select the underlined hyperlink of the word, 
Select. A list of responsibilities appears. If necessary, search for the Survey 
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Administrator responsibility. After you find it, select the Survey Administrator 
responsibility. 

Note: Do not set the Survey Administrator responsibility as the default unless you 
wish to force the user to log into iSurvey the next time the user logs in to the HTML 
Applications Login.

5. Save your work.

Set Up Oracle iSupport Survey in iSurvey
Surveys have three parts:

• Header - this is the header area of the survey

• Error - this is the error page that is displayed when an error occurs during the 
survey

• Final - this is the final page displayed to the user after the survey is complete

All of these parts you create as JSPs in the steps outlined in this section.

Follow the steps below to set up Surveys in the Oracle iSurvey module.

Steps
1. Log in to the Applications Login page as the user with Survey Administrator 

responsibility. 

If you are already in Oracle iSupport, you can change current responsibility: 
Navigate to Profile > Preferences and select the Survey Administrator responsibility
from the Current Responsibility LOV on the General Preferences page. Select 
Update.

2. Navigate to Survey Campaign > Survey Resources. In the Resources window, select 
Create.

3. In the Create Resource window, create a Header page, a Final page, and an Error 
page according to the steps and guidelines documented in the Oracle Scripting User 
Guide, with the following exception:

• Be sure to enter ibupfbgl.jsp in the File Name field for the Final page file. This is
the Oracle iSupport JSP which lists the surveys you set up.

4. Navigate to Survey Campaign > Survey Campaign. Select Create. 

5. In the Create Survey window, select the appropriate script using the Go button and 
the % as a wildcard.
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6. Continue creating the survey by following the steps and guidelines documented in 
the Oracle Scripting User Guide, with the following exception:

• For the Final page field, using the Go button, select the resource, Oracle 
iSupport JSP (ibupfbgl.jsp), created in step 3 above.

7. Select Create to save the survey.

8. Navigate to Survey Campaign > Cycle and set up a cycle to associate with the 
survey by following the steps and guidelines documented in the Oracle Scripting 
User Guide.

9. Navigate to Survey Campaign > Deployment and create a deployment for the 
survey by following the steps and guidelines documented in the Oracle Scripting 
User Guide.

10. Deploy the survey by clicking on the Deploy button. Oracle iSupport will only 
display surveys which have the status of Active and whose dates fall within current
dates. See the Oracle Scripting User Guide for additional information.

Make Survey Available in Oracle iSupport
After you have created the survey in iSurvey, you need to select it in Oracle iSupport 
and then associate a usergroup(s) to the survey. Follow the steps below to activate the 
survey in Oracle iSupport. This section contains three parts:

• Set up usergroup.

• Run Usergroup Creation concurrent program.

• Select Survey and Usergroup in iSupport.

Set Up Usergroup
Follow the steps below to set up a usergroup to associate with any surveys that you 
have created in iSurvey. Only the usernames that are associated with the usergroup(s) 
selected will be able to view the surveys that you have created.

Steps
1. Log in to the Applications Login window as the Oracle iSupport Administrator. 

2. Navigate to Administration > Support > Usergroup > Create.

3. Enter a unique name for the usergroup in the Name field.

4. Select a effective date for the usergroup using the Start Date calendar icon.
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5. Select an ending date for the usergroup using the End Date calendar icon. 

You can also end date a usergroup to disable it.

6. Enter a brief description for the usergroup in the Description text field.

7. In the SQL statement field, enter an appropriate SQL statement.

Sample SQL Usergroup Select Statement

select EMPLOYEE_ID from FND_USER where EMPLOYEE_ID > 0

This select statement retrieves all employee IDs greater than zero (i.e., all 
employees) from the fnd_user table.

Note: Usergroup select statements support PARTY_ID and EMPLOYEE_ID, but not
USER_ID.

8. Select Save.

Run Usergroup Creation Concurrent Program 
To populate necessary tables in the database, run the concurrent program Usergroup 
Creation Program (short name is IBUUG). This concurrent program must be run each 
time you update or add users to a usergroup.

Select Survey and Usergroup to Associate to Survey
Use the following steps to associate the usergroup(s) with surveys that you have 
created in iSurvey. Only members of the usergroup(s) will be able to view and respond 
to surveys.

1. Log into Oracle iSupport as the Oracle iSupport Administrator. 

2. Navigate to Administration > Support > Survey. Select Add New Survey. The 
Survey Detail window appears with a drop-list of active surveys.

3. Select the desired survey from the drop-list, and then select a usergroup(s) to 
associate with the survey, by clicking on one or more of the check boxes.

4. Select Create to save the changes.

5. To take the created survey(s), log into Oracle iSupport as a member of a usergroup 
associated with a survey, and navigate to Support > Survey.

View Survey Results
Oracle iSurvey allows you to view the results of your surveys. The following steps can 
assist you in retrieving survey results. For complete information, refer to the Oracle 
Scripting Implementation Guide and the Oracle Scripting User Guide.
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Steps
1. Log in to iSurvey as a user with Survey Administrator responsibility. 

From Oracle iSupport, to switch current responsibility, select the Profile > 
Preferences menu to switch current responsibility to the Survey Administrator 
responsibility. You must select the Update button to save changes.

2. In iSurvey, navigate to Response > Survey. Follow the steps and guidelines 
documented in the Oracle Scripting User Guide to view and manage your survey 
results.

Enabling Employees to File Service Requests for Assets
Employees can request service on assigned assets, such as laptop computers, or shared 
internal assets, such as network printers. Thereby an enterprise can provide a complete 
set of service management capabilities for assets across channels.

Oracle Enterprise Asset Management maintains information about enterprise assets. An
enterprise can use the checkin and checkout capabilities of Oracle Enterprise Asset 
Management to assign assets to employees. Oracle Install Base replicates this asset 
information and makes it available in a common definition with customer products.

Perform the following steps in iSupport to integrate with Enterprise Asset Management.

Prerequisites
❒ Oracle Enterprise Asset Management must be fully configured to define assets.

Steps:
1. Set up the profile option Service: Default Maintenance Organization.

The default maintenance organization is a constraint on the list of assets that an 
employee user can view. An item that is associated with an asset should belong to 
this maintenance organization.

2. In Oracle TeleService, set up service request types and map them to the 
responsibility assigned to employee users. 

In the setup page for service request type, make sure to select both the Asset 
Maintenance check box and the Web Entry check box for the service request type 
being used for reporting a service request against assets.

3. Using AK regions, configure the service request user interface for the Create Service
Request page in Oracle iSupport to enable the asset-related fields. 

The related outermost regions are as follows:
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• IBU_CF_SR_ASSIGNED_ASSETS

• IBU_CF_SR_ALL_ASSETS

For instructions on configuring AK regions, refer to Appendix E and Configuring 
Oracle iSupport Service Request Pages, page E-1.

The assets that have been checked out for an employee now appear in the Assigned 
Asset LOV.

Setting Up Integration with iMarketing
Oracle iSupport supports both Oracle iMarketing Classic and Lite versions out of the 
box. After you have completed the Web campaign setup, perform following setup in 
iSupport:

1. Enable the profile Oracle iSupport: Page Level Configuration Option.

2. Update the Web HTML call of the corresponding function with:

• amsWebPlacement.jsp if you are using the iMarketing classic version.

• amsLitePlacement.jsp if you are using the iMarketing Lite version.

For a list of page configuration FND functions that map to individual sections on 
each page, refer to the section "Functions and Variables for Page-Level 
Configurability" in this guide.

3. Associate the menu IBU_DEFAULT_CONFIG_MENU with the root menu of the 
responsibility that displays the Web advertisement.

Setting Up Oracle iSupport Web Call-Back
The Web Call-Back (Call Me) feature allows users to submit a call-back request via the 
Oracle iSupport UI. The web call-back requires implementation of:

• CRM Interaction Center (formerly Call Center Technology - CCT) suite

• Oracle Universal Work Queue (UWQ)

• Oracle Customer Care

• Oracle CRM Foundation, Notes module

The purchase of call center hardware also is required.

This section provides an overview of the call-back functionality in Oracle iSupport. For 
more information, refer to the CRM Interaction Center documentation.
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Outside of Oracle iSupport, the call routing process is essentially this: After the call-
back entry is made by the user, Oracle iSupport sends the request to the CCT server 
group specified by the Oracle iSupport Administrator on the Oracle iSupport UI. The 
CCT applications and hardware route the request to the UWQ server. The UWQ server 
decodes the customer information (the Notes module captures comments from user) 
and assigns it to the UWQ client, and the call request immediately pops up in an agent's
window in Oracle Customer Care.

There are very few setups required in Oracle iSupport after the dependencies listed 
above are installed and functioning properly. Oracle iSupport simply calls one of the 
CCT APIs to provide the list of available call center server groups that appear the 
Oracle iSupport UI. 

Refer to Oracle CRM Interaction Center documentation for information on setting up 
the underlying products which enable the Web Call-Back functionality in Oracle 
iSupport.

After the CCT and UWQ applications and call center hardware are installed and 
implemented, you can use the steps below to set up Call Me in Oracle iSupport.

Steps:
1. Log into Oracle iSupport as the Oracle iSupport Administrator.

2. Navigate to Support > Call Me.

3. In the Call Me Administration window, select a call center server group from the 
LOV.

4. Select the default note type.

5. Select Update to save the data. 

Setting Up Customer Care
Set up and/or confirm the setup of Oracle Customer Care. Refer to Oracle TeleService 
Implementation and User Guide.

Setting Up Page-Level Look and Feel
An administrator can configure the look and feel ofOracle iSupport JavaServer Pages 
(JSPs) for different users without customizing these pages directly. This is accomplished
by putting customized material in the top, left, right, and bottom sections of the original
content pages that Oracle supplies. Oracle provides functions that you use to associate 
your own JSPs with each section of a given Oracle iSupportpage. Then such a page 
dynamically includes your pages in a user's browser. Refer to the Seeded Data appendix
for the table of pages that you can configure in this way together with their 
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corresponding functions.

General Steps to Perform JSP Configuration
Here are the general steps to configure the high-level look and feel of a content page.

Steps
1. Determine what you want to appear in the four regions around an Oracle iSupport 

content page. Regions can be intentionally left blank. If they are blank, then the 
content region expands into blank regions. 

2. Write the JSP that will provide the intended output. Probably write some simple 
HTML to test the configuration framework to see if the output is placed correctly. 
Pay attention to have matching end tags for all starting tags, especially for <table>, 
<tr>, and <td>. A mismatch of tags results a misplacing of the different regions in 
the standard user interface. Refer to the Appendix B table, page C-63 for variables 
that you can use in customizing a JSP.

3. Determine in which page or pages to place the custom JSP. Each page in Oracle 
iSupport has four sections corresponding to four different function names. 

4. Map the functions for the content page to the corresponding customized JSPs that 
you created. Refer to the mapping section, page 3-52 for details of this step.

5. Map the menu IBU_DEFAULT_CONFIG_MENU to the menu corresponding to the 
responsibility to which you want to expose a custom JSP. Refer to the 
responsibility-mapping section, page 3-52 for details on how do to this. 

The reason for this step is responsibility security. Responsibilities can show or not 
show a custom JSP by having a different configuration menu. For example, 
IBU_GUEST_CONFIG_MENU can contain several functions and can be attached to 
the menu corresponding to a guest user. A business use, for example, does not see a
custom JSP that is tied only to a guest user. 

6. Make sure that the functions that correspond to the custom JSPs are not part of 
excluded menu items. In the responsibility window, ensure that none of the 
functions that correspond to a custom JSP are in the excluded item table.

7. Copy your customized JSP into the $OA_HTML directory, which was established 
when the configuration files for your web server were set up. This is the location 
where the process looks to find customized JSPs.

8. Turn on the following profile option to enable page level configurations: Oracle 
iSupport: Page Level Configuration Option.

9. Restart your web server, navigate to the page that has a customized JSP, and check 
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the result.

Mapping Customized JSPs to Customizing Functions
Use this procedure to map your customized JSPs to regions of a content page in order to
alter the high-level look and feel of that page.

Steps
1. Using the Forms mode and the Application Developer responsibility, navigate to 

Application > Function. The Form Functions window appears.

2. Using Appendix B, determine the functions that correspond with the page sections 
that you want to customize.

3. In the Description tabbed page, query these functions. The results populate the 
window, including the Web HTML tabbed page.

4. In the Web HTML tabbed page, in the HTML Call column, enter the name of your 
customized JSP that corresponds with each listed function. Include ".jsp" in the 
name.

5. Save your work.

Mapping Page-Level Configuration Functions to Responsibilities
For a custom JSP to adjust the high-level look and feel of a content page, the mapping 
function for the JSP must be in the menu corresponding to the responsibility to which 
you want to expose the custom JSP. You can add functions individually, but often a 
more efficient way is to map the menu IBU_DEFAULT_CONFIG_MENU or a variant of
this menu. This is the case because IBU_DEFAULT_CONFIG_MENU is associated with 
full access and thus already contains all the configuration functions. As an example of 
mapping, the seeded responsibility iSupport Business User has the seeded menu 
IBU_BUS_USER_TOP_MENU. You must attach IBU_DEFAULT_CONFIG_MENU to 
IBU_BUS_USER_TOP_MENU for a custom JSP to appear. Use this procedure to map 
IBU_DEFAULT_CONFIG_MENU to the menu for a responsibility.

Steps
1. Using the Application Developer responsibility, navigate to Application > Menu. 

The Menus window appears.

2. Use the Menu or User Menu Name fields to query for the name of the menu that is 
associated with the responsibility to which you want to expose a custom JSP.
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3. Create a new sequence line with IBU_DEFAULT_CONFIG_MENU in the Submenu 
field. Doing so calls in the functions in this menu. Leave the Prompt field blank 
because normally you do not want a user to see the function list.

4. Save your work.

Setting Up Custom Menus
Oracle iSupport is fully integrated with the Custom Menu (custom navigation) feature 
of the JTT tech stack. You can write a new menu renderer by implementing a JTT 
custom menu class and associating it with different Oracle iSupport responsibilities. 
Thus you can create a different menu look and feel for different users. For details and 
sample code, refer to Appendix C. For more comprehensive information and sample 
code, refer to JTT developer documentation.
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4
 Integrating Oracle iSupport with Service 

Request

This chapter covers the following topics:

• Overview of Service Request Functionality in Oracle iSupport

• Overview of Dependencies

• Overview of Setup Steps

• Setting Up Oracle TeleService

• Setting Up Oracle Notes

• Set Visibility of Note Types as Publish to View in Oracle iSupport

• Restrict Note Types Viewed in Oracle iSupport

• Setting Up Service Requests in Oracle iSupport

• Set Up iSupport Service Request Profile Options

• Enabling Incident Addresses

• Set Up Service Request Defaults

• Set up Service Request Templates

• Setting Up Display of Service Request Type Categories

• Configuring Service Request Pages

• Viewing Service Requests Depending on Access Levels

• Editing Service Request Contacts

• Configuring Service Request Pages to Display Purchase Order Number

• The Service Request Creation Flow

• Defining Regions

• Contexts for Rendering Service Request Pages and the Creation Flow
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• Mapping Page Regions

• Editing Mappings for Page Regions

• Mapping Creation Flows

• Editing Creation Flows

• Setting Up Products

• Using Knowledge Management in iSupport Service Request

• Setting Up E-mail Submission of Service Request Details

Overview of Service Request Functionality in Oracle iSupport
Oracle iSupport features the ability to create, update, and track service requests. It does 
this through integration with Oracle TeleService. The service request feature of Oracle 
iSupport also includes optional product selection and association, knowledge 
management queries, and e-mail submission of service request details.

The main features of service request functionality in Oracle iSupport are:

• Customizable templates for gathering information from users during request 
creation.

• Enforceable or optional knowledge base search during request creation.

• Enforceable or optional product selection during request creation.

• Customer ability to re-open a closed request. Administrator ability to set a time 
limit on re-opening a closed request.

• Customer ability to update an existing request by adding notes, attachments, or re-
opening within a specific time frame.

• Customizable service request flows and pages

• Delivery of submitted service request information to users via e-mail.

Overview of Dependencies
Oracle TeleService provides the bulk of the service request functionality in Oracle 
iSupport. Oracle TeleService tracks all service issues reported by customers and 
employees of the merchant. It does this through agent and customer input and 
integration with other Oracle applications.

In addition to the dependency upon Oracle TeleService, other service request 
functionality within Oracle iSupport can be highly dependent upon additional 
applications, depending upon the features you elect to implement. These other 
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applications include:

• Oracle Workflow for processing e-mails.

• Oracle Inventory and Oracle Install Base for products data.

• The following Oracle Common Application Components:

Assignment Manager (Assignment Engine) - Manager is required for service 
request functionality in Oracle iSupport and Oracle TeleService. Oracle iSupport 
calls the assignment manager to determine the owner (resource) of a service 
request. Who the assignment engine picks as the owner is dependent upon: request 
type, severity, urgency, status, problem code, product, and answers to template 
questions. If the assignment engine is unable to find an appropriate owner, the 
system picks the default resource and resource type configured in the profile 
options. 

Notes - The Notes module is required for service request functionality in Oracle 
iSupport and Oracle TeleService. Service request processes use notes to capture data
during creation and update. Administrators must set up note types and map them 
to Oracle iSupport. 

Resource Manager - The Resources module is optional for service request 
functionality in Oracle iSupport, unless you are going to set up and use Resources 
as owners of service requests. 

Territory Manager - Territory Manager is optional for service request functionality 
in Oracle iSupport.Territory Manager allows you to define rules in Assignment 
Manager.

Task Manager - The Tasks module is optional for service request functionality in 
Oracle iSupport, unless you are going to assign Tasks based on service request 
activity. Tasks allows you to create and assign work items to Resources. You create 
tasks, for example, to call back a customer or dispatch a service engineer to the 
customer site to fix a problem. A task may be assigned to an individual employee, a
team, or a group.

Overview of Setup Steps
In order to use the service request functionality of Oracle iSupport, you must:

• Set up the Oracle TeleService application, which supplies the base functionality. See
Setting up Oracle TeleService, page 4-4.

• Set up the Notes module, which allows the capture of textual information in service 
request functionality. See Setting up Notes, page 4-4.

In addition to setting up the basic functionality, you can choose to implement 
additional, optional functionality, including:
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• Products integration (See Setting up Products.), page 4-19

• Knowledge base integration (See Knowledge Management in iSupport Service 
Request.) , page 4-19

• E-mail of service request data to users (See Setting up E-Mail Submission of Service 
Request Details.), page 4-19

Setting Up Oracle TeleService
Setting up Oracle TeleService includes, but is not limited to, the following setups for 
service request functionality:

• Status codes

• Severity

• Duplicate checking

• Automatic task creation

For information on performing service request setups, refer to the Oracle TeleService 
Implementation and User Guide.

Setting Up Oracle Notes
The Notes module of Oracle Common application Components enables the entire suite 
to create, maintain, and share notes related to customers, opportunities, service 
requests, and other business objects. Notes allows the capture of extensive, textual, 
project relevant information within Oracle applications. Notes comes seeded with 
predefined note types which you can use, or you can define new note types of your 
own. 

See the Oracle Common Application Calendar Implementation Guide for more information. 

Set Visibility of Note Types as Publish to View in Oracle iSupport
For a note to be viewed in Oracle iSupport, the visibility of the note must be set to 
Publish.

Restrict Note Types Viewed in Oracle iSupport
Because note types are used across Oracle products, it is important to restrict the note 
types that can be viewed in Oracle iSupport. If you do not do this, all note types used 
across applications are displayed in the service request default settings page in Oracle 
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iSupport.

Prerequisite
• Note types have been set up.

Steps
1. Log on to Oracle Forms as sysadmin and select the Customer Support 

responsibility. 

2. Navigate to Setup > Notes > Source and Note Type Mapping. The Mapping Objects 
window appears.

3. Find the Source Object Public Service Requests:

1. Enter Query mode (F11). 

2. Enter Public Service Requests in Source Object field.

3. Execute the query (Ctrl + F11).

4. Ensure that the note types you are using are mapped to iSupport in the Application 
column.

For more information on setting up Notes, see the Oracle Common Application Calendar 
Implementation Guide.

Setting Up Service Requests in Oracle iSupport
This section outlines the service request setups that are specific to Oracle iSupport. 
Topics include:

• Set up iSupport Service Request Profile Options, page 4-5

• Set up Service Request Defaults, page 4-6

• Set up Service Request Templates, page 4-7

Set Up iSupport Service Request Profile Options
There are profile options that control the user of some service request functionality in 
Oracle iSupport. See the appendix, Profile Options, for details.
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Enabling Incident Addresses
Oracle iSupport provides the ability to dispatch Field Service technicians to locations for
field related work regardless of whether the address is permanent or one-time. The 
term one-time incident address means that the incident address is only a temporary 
address to be used one time for the service request for which it was created as well as 
for the tasks created for that specific service request. Other Service applications such as 
Oracle Field Service can reference the address when they are performing tasks related 
to the resolution of the service request. However, the address is not visible from outside
the originating service request and its tasks and cannot be used by any other service 
request or application outside Service. For example, the one-time address cannot be 
displayed in any address LOV outside the service request for which it was created.

Incident addresses are stored in Oracle Trading Community Architecture. If real-time 
address validation is set up, then the address is validated during address entry and 
saved, or not saved, based on the validation process. For Oracle Trading Community 
Architecture, and other Oracle E-Business Suite applications, this validation is based on 
the information and setup of Geography Hierarchy. See: Geography Hierarchy Overview, 
Oracle Trading Community Architecture Administration Guide.

Oracle iSupport makes available the site name, site number, site phone, and addressee 
fields for the incident address. These four fields are in the AK incident address region, 
which administrators can expose and configure as desired. During service request 
creation, the site phone field is not displayed. In update service request mode, the site 
phone is a read-only field. The site name and addressee fields are enabled during the 
creation and update of a one-time incident address. A party site and location are created
for every new one-time incident address. The party site is associated with the service 
request customer party. 

In create service request mode, if the profile HZ: Generate Party Site Number is set to 
Yes, then the site number field is disabled, and the site number is auto-generated when 
the service request is saved. If the profile is set to No, then the site number field is 
enabled and is mandatory. For iSupport, after a service request is created, the incident 
address is not updatable using the iSupport UI.

Appendix E and Example 1: Customizing a Top-Level Attribute, page E-1

Set Up Service Request Defaults
Using the following steps, Oracle iSupport administrators can control service request 
default settings.

Steps
1. Log into Forms as System Administrator.

2. Navigate to Profile > System.
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3. Set defaults for the following:

4. Default Severity - Default Severity for new Service Requests.

5. Default Status - Set a Default Status for new Service Requests. The Default Status is
the status assigned to the Service Request at creation.

6. Closed Status - From the Closed Status list, set a default for closed Service Request.

7. Default Create Notetype - Set a default for the notetype used when a Service 
Request is created.

8. Default Update Notetype - Set a default for the notetype used when a Service 
Request is updated.

9. Default Escalate Notetype - Set a default for the notetype used when a Service 
Request is escalated.

10. Default Closed Notetype - Set a default for the notetype used when a Service 
Request is closed.

11. Default Resource Type - From the Default Resource Type list, set the default 
resource type. This indicates the resource type associated with the Default Resource
ID (see below).

12. Default Resource ID - From the Default Resource ID list, set the person/group who 
will be the default resource for Service Request routing.

13. Reopen SR Time Limit - Set the timeframe in hours during which a closed Service 
Request can be opened. 

Set up Service Request Templates
Service request templates provide a structured, formatted method of gathering 
information during Service Request creation. Templates characteristics include:

• Administrator-defined questions that gather information about service requests; 
these questions can be configured so that the user is required to answer them.

• Administrator-defined free-form and choice-type answers that relate to the 
questions posed on the template.

• Weighting of choice-type answers used to determine severity of service requests 
automatically.

• Ability to associate a template with a specific product and/or urgency.
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Templates are presented to the customer/user during request creation as questions and 
responses.

The information gathered from the templates assists in:

• Routing the service request to the appropriate support agent or support group in 
Oracle TeleService.

• Determining the severity of the service request in Oracle TeleService.

This topic area includes:

• Creating New Templates, page 10-15

• Setting Up a Default Template , page 10-21

Creating New Templates
Use the steps below to begin creating a new service request template.

Steps
1. Log in to the Applications login as Oracle iSupport Administrator. 

2. Navigate to Support tab and then Request Template tab.

3. In an empty text box in the Template Name column, enter a meaningful name for 
the new template. 

4. Select Add.

5. Next, select effective dates for the template. Click on the hyperlink of the template 
name. The Modify Template window appears.

6. In the Template Info area, select the calendar icon next to the Start Date field and 
choose an effective start date for the template. Do the same for End Date. (You can 
also use the End Date function to disable existing templates.) All of the date steps 
are optional.

7. Select Update.

8. Next, associate the template with a product. Select the underlined hyperlink of the 
appropriate template. The Modify Template window appears.

9. In the Associate Attribute, Attribute to Associate: Product area, select Modify. The 
Associate Product window appears.

10. From the Available Product list, select the desired association(s) and use the right 
(>) arrow button to move them to the Associated Product column. Select Update 
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and then Back (bottom of window) to return to the Associate Attribute area of the 
Modify Template window.

11. Next, associate an urgency to the template. Select the underlined hyperlink of the 
appropriate template. The Modify Template window appears.

12. In the Associate Attribute, Attribute to Associate: Urgency area, select Modify. The 
Associate Urgency window appears.

13. From the Available Urgencies list, select the desired association(s) and use the right 
(>) arrow button to move them to the Associated Urgencies column. Select Update 
and then Back (bottom of window) to return to the Associate Attribute area of the 
Modify Template window.

14. Next, define questions and answers for the template. Select the underlined 
hyperlink of the appropriate template. The Modify Template window appears.

15. Set up Questions on Template: In the Modify Template window, the Template 
Detail area will list any questions associated with the template. If none is associated,
there will be an empty text box. Enter a question for the template in the empty 
Question field.

16. Select Answer Type: You have two options for Answer types:

17. Choice - This is a pick-list type answer and can be used in scoring. Scoring is used 
for determining the Severity of the Service Request. 

18. Free Text - This is a free-form answer; you can specify the number of lines allowed 
for the answer (see below). This answer cannot be used in scoring.

19. If your question requires a Choice-type answer, select whether you wish the answer
to be used in scoring/weighting when determining severities for submissions which
use this template (see Set Severity Thresholds below). Answers to the question will 
be weighted from 1 to 9 during the Answer setup (see Set up Answers for a Choice 
Question below).

20. To enforce that the user is required to answer the question, select Yes in the 
Response Required field. Mandatory questions force the user to provide an answer 
before the application will continue creating the request. To make the question 
optional for the end user, choose No.

21. Select Add. The window refreshes, with the question appearing as an underlined 
link in the Template Detail area.

22. To sort the questions, select Sort and use the up and down arrows in the Sort 
Questions window to arrange the questions in the desired order. Use the back 
button to return to the Modify Template page.
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23. Optionally, to edit a question, click on the hyperlink of the question you wish to 
modify.

24. Set up Answers for a Choice Question: In the Template Detail area, click the 
underlined hyperlink of a question. The Define Question and Answer window 
appears. 

25. Enter an answer for the question in an empty textbox.

The answers you set up here becomes a pick-list for the end user, and the answer 
you select as a default appears as the default answer on the user side.

26. For each Choice-type answer, set a value of 1-9. After the end user answers the 
questions, the application will add up these values and the final score will be used 
to determine the severity of the Service Request, based on the Severity Thresholds 
you set (see below). 

27. For Text-type questions, you will not need to determine answers. Instead, in the 
Define Question and Answer window, select the number of rows the user will be 
limited to when answering. 

28. Select Update to save changes, and Back to return to the previous window.

29. Next, set up severity thresholds for the template. Select the underlined hyperlink of 
the appropriate template. The Modify Template window appears.

Use the Set Severity area to set Severity Thresholds for the template. The severities 
listed here come from the Severity setups in TeleService. For each Severity, enter a 
value in the Start and End Threshold boxes. Do not define overlapping thresholds 
or ranges (see examples, below). The weighting you gave to each scorable question 
in the defining answers step above will be calculated and used here. The user 
responses to all questions used in scoring are averaged, and the score determines 
the severity level. 

The sum score from all of the scorable answers is determined by the application and
compared to the total possible. The percentage is determined by the application, 
and the appropriate threshold is assigned. See the example below for clarification.

Note: You do not need to define thresholds for all of your severities, only the ones 
you wish to use. Also: You can select one of the severities as a default and all 
templates use that severity. Severities for which you do not define thresholds are 
ignored by the application.

Sample scenario related to this setup

You have defined a new template with two questions on it. Each question has three 
possible answers, for a total of six answers defined by the administrator, and two 
possible answers for the user (user can only select one answer per question). 

In this example, you have set up each of the question's three answers with identical 



 Integrating Oracle iSupport with Service Request    4-11

scores: 1, 4, and 5. Since the user can only select one answer per question, the 
highest possible score in this scenario would be 10 (highest score for each question 
is 5, and 5 plus 5 is 10). (The user cannot see these scores.)

The user selects an answer from the first question with a score of 1. He selects an 
answer from the second question with a score of 4. Thus, the total of the two 
answers is 5. The application find the score of 5 and compares it against the total 
possible answer points, which in this case is 10. From there, the application 
formulates a percentage of answers scored (5) verses a total possible score (10). The 
percentage in this case is be 50%. Then, based on the severity thresholds you set (see
the example below), the application determines the severity, for example, high, 
medium, and low. Here are the thresholds set for this example:

High - Start Threshold = 61%; End Threshold = 100%

Medium - Start Threshold = 31%; End Threshold = 60%

Low - Start Threshold = 0%; End Threshold = 30%

30. When finished entering severity thresholds, select Update. When finished entering 
severity thresholds, select Update.

Setting Up a Default Template
Oracle iSupport uses the Default Template you set up when users select a product and 
urgency combination for which a template does not exist. 

Only one default template is allowed, and it is shown regardless of any attributes.

Prerequisites
• A Service Request template has been created in Oracle iSupport. 

• The service request template feature has been enabled by selecting Yes in the Enable
Template LOV on the service request defaults window.

Steps
1. Set up a new template with general questions. The questions should be "catch all" 

type questions related to service requests. Use the following procedure to set the 
default template.

2. In the list of templates, in the Set as Default column, select the radio button next to 
the appropriate template.

3. Select Update.
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Setting Up Display of Service Request Type Categories
This section discusses the control of the display of service request type categories.

Prerequisites
The administrator of Oracle TeleService must have defined service request type 
categories.

Steps
1. Turn on or off the display of the name and the description of the service request 

type categories.

To do so, define the following attributes of region 
IBU_CF_SR_SELECT_REQUEST_TYPE:

o IBU_CF_SR_REQ_TYPE_CAT_NAME 

o IBU_CF_SR_REQ_TYPE_CAT_DESC 

Use attribute IBU_CF_SR_REQ_TYPE_CAT_NAME to control the display of the 
name of the service request type category. Use attribute 
IBU_CF_SR_REQ_TYPE_CAT_DESC to control the display the description of the 
service request type category. By default, the display boxes of these attributes are 
selected. If the display boxes of both attributes are cleared, service request type 
categories are not shown in the Service Request Type Selection page. Instead, the 
service request types are shown in the same way as they were shown immediately 
before this feature was available.

2. Set one-column or two-column layout.

Service request type categories and associated service request types can be 
displayed in one-column layout or two-column layout. If the number of categories 
exceeds the number defined in the profile Oracle iSupport: Select Service Request 
Type Layout Option, then categories are displayed in two-column layout. Whether 
service request type categories are shown in one-column layout or two-column 
layout, a service request type is always shown in one-column format under its 
category. If service request type categories are not shown, then use the same profile,
Oracle iSupport: Select Service Request Type Layout Option, to control the display 
of service request types in one-column layout or two-column layout. 

3. Define the Others category.

All service request types that do not belong to any category are displayed under 
Others if the service request type category is shown. To change the name and 
description of this category, change the values of the 
IBU_CF_SR_REQ_TYPE_NOTMAP and IBU_CF_SR_REQ_TYPE_NOTMAP_DESC 
attributes of the IBU_CF_SR_SELECT_REQUEST_TYPE region.



 Integrating Oracle iSupport with Service Request    4-13

4. Be aware of and optionally utilize the behavior of the parameter 
ibuSRRequestTypeCategoryID, which can be passed to the Service Request Type 
Selection page as a URL parameter. For details of what happens when a service 
request type category ID is passed through this parameter, see the Parameters 
section of the Profile Options and Parameters chapter.

Configuring Service Request Pages
Oracle iSupport provides a flexible framework with which merchants, system 
administrators, and customers can configure service request pages for their company 
use. You can configure the content of page regions, the regions that pages display, and 
the pages that appear in the create-service-request flow. Even without this ability, the 
default flow and pages support most of the desired functionality. Configurations can be
turned off easily with a profile option, Oracle iSupport: Region/Field Level 
Configuration Option. If they are turned off, then the application renders the default 
flow and page structure.

Viewing Service Requests Depending on Access Levels
Oracle iSupport administrators have the ability to configure the access levels of service 
requests for Oracle iSupport business and employee users. The service request type 
security option is used for viewing service requests for business and employee users. 
This option can be enabled using the Service system parameters. In addition to the 
service request type security, access to service requests is controlled by certain 
permissions.

Access to service requests is controlled by the following permissions for business users:

• IBU_REQUEST_VIEW_COMPANY: Allows a business user to view all the service 
requests created for the organization that the user belongs to

• IBU_REQUEST_VIEW_ACCOUNT: Allows a business user to view all the service 
requests created for the accounts assigned to the user and belonging to the user's 
organization

• IBU_REQUEST_VIEW_SELF: Allows a business user to view all the service 
requests created by the user and for which the user is a contact

Access to service requests is controlled by the following permissions for employees 
users:

• IBU_EMP_REQUEST_VIEW_INTERNAL: Allows an employee user to view only 
the internal service requests where the user is a contact

• IBU_EMP_REQUEST_VIEW_ALL: Allows an employee user to view all the 
external service requests where the user is a contact and all the internal service 
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requests, even those where the user is not an associated contact

You can view only the service requests whose request type is mapped to the your 
current responsibility:

• If multiple permissions are assigned, the permission with the highest privilege will 
be effective.

• If none of the permissions mentioned for employee users are assigned to an 
employee user, the employee user can view the internal service requests and 
external requests where the user is an associated contact.

Editing Service Request Contacts
You can edit service request contacts using Oracle iSupport.

• If a service request contact is inactive, it can be edited to make active. To make an 
inactive service request contact active, click the edit icon corresponding to the 
service request contact and disable the Inactive check box.

• If a service request contact is active, it can be made inactive. To make an active 
service request contact inactive, click the edit icon corresponding to the service 
request contact and enable the Inactive check box.

In order to view the Inactive check box, you should enable the 
IBU_CF_SR_CONT_INACTIVE attribute in the IBU_CF_SR_UPDATE_CONTACT AK 
region.

• A primary service request contact cannot be made inactive. The 
Inactive check box is displayed only if the service request contact is
not primary.

• The Inactive check box is displayed only after the service request 
contact is added and committed to the database.

• If the service request is closed, the edit icon of the service request 
contact will always remain disabled. 

Configuring Service Request Pages to Display Purchase Order Number
To display Purchase Order (PO) number, you should enable the following AK 
attributes:
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AK Region Names and Attributes to Display Purchase Order (PO) Number

AK Region Name AK Atrribute

IBU_CF_SR_IDENTIFY_PRODUCT IBU_CF_SR_ALL_PO_NUM

IBU_CF_SR_CR_PROBLEM_SUMMARY IBU_CF_SR_PO_NUM

IBU_CF_SR_DTL_OVERVIEW IBU_CF_SR_PO_NUM

For instructions on configuring AK regions, refer to Appendix E and Configuring 
Oracle iSupport Service Request Pages, page E-1.

The Service Request Creation Flow
The standard creation flow for a service request has five steps:

1. Identify Problem

2. Provide Problem Details

3. Get Suggested Solutions

4. Provide Contact Information

5. Review the service request

Users who have the responsibility Oracle iSupport: iSupport Self-Service Helpdesk have
their own seeded flow, which consists of the following three steps:

1. Identify Problem

2. Get Suggested Solutions

3. Review and submit the service request

During configuration you typically use a bottom-up procedure in the following order to
define:

1. Details of regions 

2. The combination of regions that define a page

3. The topmost region of a region combination for a displayed page

4. For the create-service-request flow only: the displayed pages and their names 
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Note: The Project-related fields are hidden out of the box and can be 
hidden or displayed based on the mapping of the AK region. For more 
information, see Configuring Oracle iSupport Service Request Pages, page 
E-1. The fields that are displayed are Expenditure Org, Project 
Number, Project Name, Project Task Number, and Project Task Name. 

Also check the profile Oracle iSupport: Available Repositories for Knowledge Search. 
This profile specifies the repositories to search for in the Suggested Solutions page 
during the Create Service Request flow

Defining Regions
In the setup of regions you define the details of regions and the combination of regions 
that define a page. To illustrate region configuration, consider this example. Suppose 
that a page contains one top region and that this top region contains two subregions, 
Customer Name and Customer Address. You can change the order of these two 
subregions, and, inside each subregion, you can change the order of the attributes and 
even hide some attributes. To do so, you select, copy, and edit the seeded service 
request regions defined in Appendix B. This requires using the Application Developer 
Common Modules responsibility, the Regions window, and other windows for this 
responsibility. For details on this setup, refer to documentation for Oracle self-service 
Web applications. For examples of configuring Oracle iSupport service request pages, 
see Appendix D.

Contexts for Rendering Service Request Pages and the Creation Flow
The appearance of the service request creation flow and the appearance of service 
request pages that are rendered depend on context. Context applies to all service 
request pages, not just those in the creation flow. The application checks a hierarchy of 
contextual states in the following order:

1. Service request type-responsibility

2. Service request type

3. Responsibility

4. Application

5. Global

The rendering process proceeds as follows. A user chooses a service request type when 
creating a service request. Given the page code that the user is trying to render, the 
service request type, and the user's current responsibility, the application determines 
the corresponding region that stores the configuration information. If no specific 
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configured region exists for this combination of page code, service request type, and 
responsibility, then the application seeks the configuration stored at the level of service 
request type. If the application cannot find it there, then it goes one level higher to the 
responsibility level for the user's current responsibility. The application continues in 
this manner, going up the chain to application level if needed. If none is available, then 
it fetches the global configuration information, which is provided out of the box. 

Mapping Page Regions
Use this procedure to map top-level region codes to pages.

Prerequisites
You must already have defined regions according to the mapping section, page 4-16.

Steps
1. Using the iSupport Administrator responsibility, navigate to Configuration > Page 

Region Mapping. The Page Region Mappings page appears.

2. Click Create Mapping. The Create Page Region Mapping page appears.

3. Use the Page LOV to select a page.

4. Use the Context LOV to select contexts. The remaining fields change to be 
compatible with a selected context.

5. Select values for the remaining mapping fields. Use the flashlight search icon as 
needed. The region code that you select is the code for the corresponding topmost 
region that you defined according to the section, page 4-16.

6. Click Create.

Editing Mappings for Page Regions
Use this procedure to edit mappings of page regions.

Steps
1. Using the iSupport Administrator responsibility, navigate to Configuration > Page 

Region Mapping. The Page Region Mappings page appears.

2. Search for the page and region mappings by entering your search criteria in the 
Page and Context fields, and click Go. The search results appear in the Results 
region.
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3. Click the Edit icon for the page that you want to update. The Update Page Region 
Mapping page appears.

4. Select a new region code and click Update. The Page Region Mappings page re-
appears and shows your updated mapping.

5. Click Update.

Mapping Creation Flows
Use this procedure to map creation flows:

Steps
1. Using the iSupport Administrator responsibility, navigate to Configuration > Flow 

Mapping. The Service Request Creation Flows page appears.

2. Click Create Flow. The Create Service Request Creation Flow page appears. Here 
you specify the pages to be displayed in the flow and the contexts for which the 
flow is available.

3. In the Flow Information region, enter a name for your flow.

4. In the Flow Pages region, select the Enabled Flag check box for each page that you 
want to appear in the flow. Clear a check box to remove a page from the flow.

5. As needed, change the name of a page to be consistent with the content that you 
have defined for it.

6. In the Flow Contexts region, click Add Context to define the contexts for the flow. 
The Service Request Creation Flow: Add Context page appears.

7. Use the LOVs and lookup features to enter the contexts for which the flow applies.

8. Click Add Context. The Create Service Request Creation Flow page appears and 
shows the added context.

9. Click Create.The Service Request Creation Flows page appears and contains the 
name of the new flow in the list of flows.

Editing Creation Flows
Use this procedure to edit flow mappings of service request pages.
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Steps
1. Using the iSupport Administrator responsibility, navigate to Configuration > Flow 

Mapping. The Service Request Creation Flows page appears.

2. Search for desired flow by entering your search criteria in the Flow Name and 
Context fields, and click Go. The search results appear in the Results region.

3. Click the Edit icon for the page that you want to update. The Update Service 
Request Creation Flow page appears.

4. Make the changes and click the Update. The Service Request Creation Flows page 
appears and shows the flow.

5. Click Update.

Setting Up Products
Service request functionality in Oracle iSupport allows users to associate products with 
service requests and allows administrators the option of enforcing product selection 
during request creation. Products also can be associated with service request templates 
set up by administrators. To enable product association, you must set up Oracle 
Inventory and Oracle Install Base. 

See the Integrating Oracle iSupport with Products and Returns chapter of this guide for 
more information.

Using Knowledge Management in iSupport Service Request
The creation of new service requests can be reduced by allowing or enforcing users to 
search a knowledge base prior to submission. Oracle Knowledge Management must be 
set up to facilitate this functionality in Oracle iSupport.

See the Oracle Knowledge Management Implementation and Administration Guide for more 
information.

Setting Up E-mail Submission of Service Request Details
Service request functionality in Oracle iSupport allows users to have the details of a 
service request e-mailed to them by clicking a button on the service request verification 
window. 

The application that facilitates the e-mail submission is Oracle Workflow. See the 
Integrating Oracle iSupport with Oracle Workflow chapter of this guide for more 
information.

Note: A valid e-mail address must be set up for the user in his profile in order for the e-
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mail feature to work.
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5
 Integrating Oracle iSupport with Products 

and Returns

This chapter covers the following topics:

• Understanding Integration with Products and Returns

• Setting Up Oracle Inventory

• Setting Up Bills of Materials

• Setting Up Oracle Install Base

• Enabling Returns Functionality

• Understanding Returns in Oracle Order Management

• Understanding Returns in Oracle iSupport

• Setting Up Oracle Quoting

• Setting Up Oracle Order Management

• Guidelines

• Troubleshooting Returns in Oracle iSupport

• Set Up Oracle Advanced Pricing

• Set Up Oracle Shipping

• Set Up Oracle Purchasing

Understanding Integration with Products and Returns
This chapter details how to integrate Oracle iSupport with the applications that provide 
products and returns functionality.

Several processes within Oracle iSupport require the use of products and purchasing-
related applications, including: 
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• Creating and processing returns

• Viewing invoice information

• Viewing payments data

• Viewing shipment information

• Creating and updating service requests

• Viewing the repair status of an item by repair order tracking

• Maintaining products databases, such as customer products and inventory items 

The information in this chapter is designed to provide the merchant implementing 
Oracle iSupport with setup details directly related to Oracle iSupport. 

The applications that integrate with Oracle iSupport and provide products repository 
and returns functionality include:

• Oracle Inventory

• Oracle Bills of Materials

• Oracle Install Base

• Oracle Order Management

• Oracle Order Capture APIs

• Oracle Shipping

• Oracle Advanced Pricing

• Oracle Purchasing

• Oracle Service Contracts

• Oracle Customer Care portion of Oracle TeleService

A full installation and setup of each product or purchasing application must be 
performed in order for the functionality to perform as described. For more information, 
refer to the specific product documentation for full implementation details.

Setting Up Oracle Inventory
Oracle Inventory supplies the infrastructure that holds an organization's entire product 
repository and configuration. It integrates closely with Install Base, which is the 
repository of customer- or party-purchased products. 
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Both Inventory and Install Base may be required for service request functioning, 
Products tab functionality, and Account tab functionality in Oracle iSupport. 

For information on how to set up Oracle Inventory, see the Oracle Inventory User's Guide 
for basic information and further references.

Setting Up Bills of Materials
Oracle Bills of Materials (BOM) is an application that allows the configuring of groups 
of products into coordinated and complementary systems. Within BOM, you can define 
product relationships and create products with multiple components and 
subcomponents. BOM integrates with Inventory and Install Base. 

BOM is an optional integration with products and returns functionality in Oracle 
iSupport.

If using BOM, setup Oracle Bills of Materials. Refer to Oracle Bills of Material User's 
Guide.

Setting Up Oracle Install Base
OracleOracle Install Base is a repository that maintains customer items in a tree 
structure. The application maintains all the customer details, installation details, 
product information, and applicable service agreements. The application uses the 
concurrent program, Install Base Interface, to populate tables when new data is added.

Oracle iSupport uses Oracle Install Base for:

• Retrieving customer item data in the Account tab

• Adding item instances to Oracle Install Base using the Item Instances tab

• Retrieving customer item instances while creating service requests

Confirm the setup of Oracle Install Base. Refer to Oracle Install Base Implementation Guide
.

Note: When setting up new users of the Oracle Install Base 
functionality, please add the role CSI_END_USER to them. This role 
contains the required permissions for Install Base general users.

Enabling Returns Functionality
The following applications and relevant dependencies are necessary for returns 
functionality in Oracle iSupport:

• Oracle Order Capture APIs
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• Oracle Order Management

Understanding Returns in Oracle Order Management
In Oracle Order Management, RMA is often used synonymously with Return or Credit 
Orders and Returned Material. An order can have a mix of outbound (regular) and 
inbound (return) lines, if not restricted by the order type definition. Credit order types 
are of the order type category Return, while an order with Mixed order type category 
can contain both regular and return lines. Each order type and each line type is 
associated with a workflow process. The Line Type Category associated with the Line 
Type determines if it is a return. Line types can be variations of Return, such as Return 
with Approval, Return for Credit Only, and have a line type category of Return.

Oracle Order Management supports a variety of methods for returning products. An 
agent or administrator decides at the time of authorizing the return how to process the 
request. For example, an agent can accept the return and process a credit for the 
customer, updating all sales activity and credit balances. Or, the agent may accept the 
return for replacement and enter a replacement order instead of issuing a credit.

Examples of returns supported by Oracle Order Management:

RMA with Credit Only - Company issues a credit without the customer returning the 
product.

RMA with Repair - Customer returns damaged product. Company repairs and returns 
the product to customer.

RMA with Replacement - Customer returns a product. Company sends a replacement 
product rather than issuing a credit.

RMA with Receipt and No Credit - Customer returns a product sent to him on a trial 
basis or at no charge. Company does not issue a credit.

RMA with Receipt and Credit - Customer returns a product. Company issues a credit.

Returned Item Fails Inspection - Customer returns product. Company inspects 
product and rejects it. Company either destroys product or sends product back to 
customer.

Process Flow:
1. Create an RMA in Oracle iSupport.

2. Book the RMA into Oracle Order Management through Oracle Order Capture API.

3. Receive the RMA using the Receipts form of Oracle Purchasing.

4. Check the on-hand quantity of the item in inventory to verify that the correct 
quantity was received.
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5. Fulfill the RMA line.

6. Generate a credit memo in Oracle Invoicing.

7. View the credit memo in Oracle Order Management.

8. Check the Shipped and Fulfilled quantity on the RMA line.

Understanding Returns in Oracle iSupport
Oracle iSupport allows users to create a return by providing a UI that calls Oracle Order
Capture APIs to submit the return to Oracle Order Management and perform customer 
validation. Oracle iSupport does not create the return to Oracle Order Management 
directly.

Navigation to the returns feature is Account tab > Return > Create Returns.

Process Flow:
Following is the process flow for creating a return within Oracle iSupport. For 
information on Oracle Workflow items associated with returns, refer to the chapter in 
this guide called Integrating Oracle iSupport with Oracle Workflow.

1. Within Oracle iSupport, the user accesses the Create Return window.

2. User enters orders associated with his account number(s). The user must have an 
exact order number to create a return. Only orders that have been ordered (booked)
can be returned. 

3. The user provides the following information:

• Account Number - This must be the account number associated with the order.

• Contact for the company returning the item, if appropriate.

• Bill to address - User must enter a bill to address. This indicates where the 
credit will be sent if the credit memo cannot be applied to an invoice. User can 
select alternate address using the drop list.

• Ship from address - User will be see a default ship from address; this indicates 
where the return is originating from. User can select alternate address using the
drop list.

• Return reason - A return reason must be specified for each line being returned.

4. User selects the lines to be returned. Only items that are "returnable" can be 
returned. Only returnable lines display a select check box. 
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5. The page calculates the credit amount for the user; this is the amount of the order 
line. The ordered amount is the net selling price per unit multiplied by the quantity 
ordered.

6. Having selected a valid order item and quantity, the user clicks Create Return, and 
Oracle iSupport submits the return to Oracle Order Management through the 
Oracle Order Capture API. If the return submission is successful, then the user 
receives an RMA number. If Oracle Order Management/Oracle Quoting return any 
errors, then Oracle iSupport captures and displays them on the next page. When the
return is booked, the same order line cannot be returned twice.

7. After creation of the return from Oracle iSupport, the return is handled by Oracle 
Order Capture API, Order Management, Oracle Purchasing, Workflow APIs, Oracle
Inventory (or Oracle Install Base), and Oracle Receivables.

Setting Up Oracle Quoting
Set up Oracle Quoting according to the latest Oracle Quoting Implementation Guide. This 
enables access to the Order Capture APIs that are required for returns functionality in 
Oracle iSupport.

Returns Profile Options
The following profile options must be set to allow returns functionality in Oracle 
iSupport:

• ASO: Default Order Type - Set to Mixed.

• ASO: Default Order State - Set to Booked.

Setting Up Oracle Order Management
Using the Oracle Order Management Suite, you can enter sales orders, calculate the 
price of items on order lines, fulfill the orders -- for example, by shipping the items -- 
and send information to an accounts receivable system so that invoices are created. The 
core Oracle Order Management products are: 

• Oracle Order Management - required for returns in Oracle iSupport

• Oracle Shipping Execution (SE) - required for returns in Oracle iSupport

• Oracle Pricing

These products are included when Oracle Order Management is purchased. Additional 
products are available which are also integrated with Oracle Order Management, and 
these include:
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• Oracle Advanced Pricing - required for returns in Oracle iSupport

• Oracle Configurator

• Oracle Accounts Receivable - a dependency for general Oracle iSupport setup

• Oracle Advanced Planning and Scheduling

Confirm the setup of Oracle Order Management. While the steps in this section can 
assist you in setting up Order Management, you will need to refer to  Oracle Order 
Management Implementation Manual for complete setup information.

Set Up Transaction Type Line Types
Order Management transaction types classify orders and returns. Credit order types are
of the order type category Return. 

In order for the returns feature to work properly, the default order type in Order 
Management must be set to Mixed. This is controlled by the profile option, ASO: 
Default Order Type = Mixed.

The following steps can assist you in setting up Order Management Line Types. For 
setup information, refer to the Oracle Order Management Implementation Manual.

Steps
1. Log in to Oracle Forms; select Order Management super user or administrator 

responsibility. 

2. Navigate to Setup > Transaction Types > Define. The Transaction Types window 
displays.

3. Query for Mixed (you must enter the word exactly as shown here) in the 
Transaction Type field. (Use F11 and Ctrl +F11 to query.) The Transaction Types 
window populates with the information for the Mixed transaction type.

4. Place the cursor in the Order Category field and select an Order Category of Mixed.

5. Place the cursor in the Default Return Line field and select a Default Return Line 
Type of Return (Receipt).

6. Place the cursor in the Default Order Line Type field and select a Default Order 
Line Type of Standard (Line Invoicing).

7. Access the Line Workflow Assignments window by selecting the Assign Line Flow 
button.

8. In the Access the Line Workflow Assignments window, add a new record.
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9. In the Set Line Type field, select Standard (Line Invoicing) from the LOV.

10. Select an appropriate Item Type to populate the Item Type field. 

11. In the Set Process Name field, select Line Flow Generic from the LOV.

12. Select an appropriate Start Date.

13. Add a second record. 

14. In the Set Line Type field, select Return (Receipt) from the LOV.

15. Select an appropriate Item Type to populate the Item Type field. 

16. In the Set Process Name field, select Line Flow Return for Credit with Receipt.

17. Select an appropriate Start Date for the record.

18. Select Ok. Save the changes.

Guidelines
Here are some useful guidelines when using the application:

• When the lot controlled and serialized items are returned, the serial number entered
by the user is not validated against an Inventory serial number or the original order
serial number. However, the serial number is captured in the RMA lines and is 
viewable in Oracle Receivables.

• Currently, Oracle Install Base does not get updated automatically when a serialized 
item is returned.

• ATO/PTO configurations are configured items. For example, a configuration such 
as a computer system can consist of many items. Fulfillment of the entire 
configuration is required before crediting. The usage of fulfillment set can achieve 
the result of triggering crediting only after the entire configuration is fulfilled.

• Oracle Order Management allows the return of freight and other special charges. 

Troubleshooting Returns in Oracle iSupport
To find out what is wrong in case the Create Return fails in Oracle iSupport, it is helpful
to properly generate a debug file from Oracle Quoting or Oracle Order Management 
when a return is created. Use the following procedure.
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Steps
1. Ensure that the debug file directory is defined as a database directory for PL/SQL 

file I/O. See My Oracle Support Knowledge Document 2525754.1, Using 
UTL_FILE_DIR or Database Directories for PL/SQL File I/O in Oracle E-Business Suite 
Releases 12.1 and 12.2.

2. Ensure the settings on the following Oracle Order Management (OM) and Order 
Quoting (ASO) profile options:

• OM: Debug Level

• OM: Debug Log Directory - This directory needs to be one of the database 
directories defined for PL/SQL file I/O as described in the previous step.

• ASO: Enable ASO Debug - Set to Yes.

Additional information on this topic is available in the Profile Options chapter of this 
guide.

Set Up Oracle Advanced Pricing
Order Management uses Oracle Advanced Pricing for determining prices of goods sold;
therefore, it is a mandatory module for returns execution. 

Confirm the setup of Oracle Advanced Pricing. Refer to Oracle Advanced Pricing 
Implementation Guide for setup details. 

Set Up Oracle Shipping
Oracle Shipping Execution provides shipping execution for Order Management and is 
necessary for the returns integration. It is mandatory for returns in Oracle iSupport. 

Refer to Oracle Shipping Execution User's Guide for setup details.

Set Up Oracle Purchasing
The Receipts form of Oracle Purchasing receives an RMA when it is booked. Therefore, 
it is a mandatory module for returns execution. 

Confirm the setup of Oracle Purchasing. Refer to Oracle Purchasing User's Guide.
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6
 Integrating Oracle iSupport with Oracle 

Workflow

This chapter covers the following topics:

• Oracle Workflow Overview

• Workflow Client

• Workflow Server

• Overview of Oracle Workflow Functionality in iSupport

• Service Request

• Returns

• Homepage Subscription E-mails

• Knowledge Management

• User Approvals

• Setting up Oracle Workflow

• Party Access Notification

Oracle Workflow Overview
Oracle Applications comes with Oracle Workflow (WF) already installed as part of the 
Applications Object Library (AOL). WF consists of two tiers: 

• Workflow Client (Workflow Builder)

• Workflow Server

The sections below provide an overview of these two tiers.
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Workflow Client
Workflow Client is the Workflow Builder which is used by Workflow developers to 
create or modify custom workflows. This is installed on selected Windows clients only.

Workflow Server
The Workflow Server consists of the following elements:

Workflow Engine: Monitors workflow states and coordinates the routing of activities 
for a process. Changes in workflow state -- such as the completion of workflow 
activities -- are signalled to the engine by a PL/SQL API or Java API. Based on flexibly-
defined workflow rules, the engine determines which activities are eligible to run, and 
then runs them. The Workflow Engine supports sophisticated workflow rules, 
including looping, branching, parallel flows, and subflows.

Workflow Notification Mailer (WFMAIL): Electronic mail (e-mail) users can receive 
notifications of outstanding work items and can respond to those notification using 
their e-mail application of choice.

• Note: Email notifications will only be sent if the Workflow mailer is setup and 
configured properly. The PHP/Self Service Workflow notifications page can also be 
used to view notifications. Please refer to the Workflow documentation for more 
information on how to start and configure the workflow mailer. 

Workflow Definitions Loader (WFLOAD): The Workflow Definitions Loader is a 
utility program that moves workflow definitions between the database and 
corresponding flat file representations. You can use it to move workflow definitions 
from a development to a production database, or to apply upgrades to existing 
definitions. In addition to being a standalone server program, the Workflow Definitions
Loader is also integrated into Oracle Workflow Builder, allowing you to open and save 
workflow definitions in both a database and a file.

Workflow Monitor: Workflow administrators and users can view the progress of a 
work item in a workflow process by connecting to the Workflow Monitor using a 
standard Web browser that supports Java. The Workflow Monitor displays an 
annotated view of the process diagram for a particular instance of a workflow process, 
so that users can get a graphical depiction of their work item status. The Workflow 
Monitor also displays a separate status summary for the work item, the process, and 
each activity in the process.

Message Delivery Scheduler Concurrent Program: 

Workflow Background Engine/Workflow Background Process Concurrent Program: 
A supplemental Workflow Engine that processes deferred or timed-out activities.

Purge Obsolete Workflow Runtime Data Concurrent Program (WF_PURGE): This 
program purges obsolete item types runtime status information.
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For more information on Oracle Workflow, see the Oracle Workflow User's Guide.

Overview of Oracle Workflow Functionality in iSupport
The sections that follow describe Oracle Workflow's relationship to Oracle iSupport. For
more information on Oracle Workflow, see the Oracle Workflow User's Guide.

Service Request
Oracle iSupport features the ability to create, update, and track service requests. It does 
this through integration with Oracle TeleService.

Service request types can be linked to an Oracle Workflow process that can be 
automatically launched when a service request is created, or manually launched in the 
service request window in Oracle TeleService. Oracle Workflow automatically notifies 
service personnel about their assignments based on service request. When a service 
request is escalated, Oracle Workflow processes and delivers the notifications regarding
escalation activity.

Oracle iSupport also uses Oracle Workflow to submit service request details to users. 
This is done via the Email this to me button during service request creation.

For more information, see:

• Oracle Workflow Guide

• Oracle TeleService Implementation and User Guide

• Oracle iSupport Implementation and Administration Guide: Integrating Oracle iSupport 
with Service Request

Returns
When a customer books a return in Oracle iSupport, Oracle Workflow picks it up using 
the seeded workflow, Order Flow - Return with Approval. Next, Oracle Workflow uses 
the Return for Credit with Receipt workflow to send the return to the Return Receiving 
Line stage. Then, the receiving agent from Oracle Purchasing uses Oracle Purchasing to 
pull up the Return Material Authorization (RMA) to verify and mark the items as 
received. The agent then selects a destination for the product(s), such as Oracle 
Inventory. As the receiving agent does this, a Workflow API is invoked to move the 
workflow to the next stage, and Order Management receives data that updates the 
RMA as appropriate. The workflow now waits in Oracle Inventory. It is here that an 
agent verifies and indicates in Inventory that the correct quantity has been received. 
When a configurable item set (BOM-enabled) is returned, the workflow will wait here 
until all items are checked into the inventory. The workflow will next invoke the 
Accounts Receivable interface APIs. After all of the items are fulfilled, an invoice is 
generated and a credit memo can be generated through the Oracle Invoice auto-invoice 
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master program. 

For more information, see the chapter, Integrating Oracle iSupport with Products and 
Returns.

Homepage Subscription E-mails
The Homepage e-mail subscription feature uses Oracle Workflow to process e-mails. 
This can be useful if a user is unable to access the Homepage for a period of time. The 
user signs up for the subscription e-mails through the Profile > Support menu. In the 
Support page, the user can select the days that the e-mails should be sent and whether 
the e-mails should be HTML or text-based. The system then uses Workflow to send the 
e-mails to the address setup in the Profile > Contact Points menu.

For more information, see the Setting up the Oracle iSupport Homepage topic in the 
Implementation Tasks chapter. 

Knowledge Management
Oracle Workflow is essential for the solution authoring feature of knowledge 
management. Using Workflow, the authoring process allows users to define the steps in
processing content. The process can be as simple as a single step, author-publish, or can 
include several approval stages prior to publication. In an approval-dependent process, 
Workflow allows content to be rejected back to the previous stage or a selected previous
stage. Individuals involved in solution authoring can be assigned to specific groups that
are aligned with specific stages and categories of content, and these groups can be sent 
e-mails notifying them of the status of content.

For more information, see the chapter, Integrating Oracle iSupport with Oracle Knowledge 
Management.

User Approvals
The approvals notifications used in the Oracle User Management Framework are 
dependent upon Oracle Workflow. The workflow notifications provide e-mails to user 
approvers notifying them that they have users in the queue waiting to be approved. 
Workflow also sends e-mails to users notifying them that they have been approved for 
an application. For more information, see the Oracle Workflow User's Guide.

Setting up Oracle Workflow
For instructions on setting up Oracle Workflow, refer to the Oracle Workflow User's 
Guide and the Oracle Workflow Developer's Guide.
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Party Access Notification
The multi-party access feature uses Oracle Workflow to send email notifications to an 
iSupport B2B user whenever a party is added, removed, disabled, or enabled for the 
user. 

Use this procedure to enable email notification:

Package Name: IBU_MULTIPARTY_PUB

Procedure Name: send_email_notification

(p_user_id IN SYSTEM.IBU_NUM_TBL_TYPE,

p_party_id IN SYSTEM.IBU_NUM_TBL_TYPE,

p_operation_type IN SYSTEM.IBU_VAR_3_TBL_TYPE)

Description: The public procedure is provided as a hook for sending the email 
notification to B2B users once the party access is added or removed. Value of 
p_operation_type:

A - for Adding party to the access list of the user

R - for removing party from the access list of the user

File Name: ibuspubs.pls, ibuspubb.pls
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7
Integrating Oracle iSupport with the Oracle 

Applications Framework (OAF)

This chapter covers the following topics:

• Overview of Integration with Oracle Applications Framework

• Conventions for Interoperability with OAF-Based Applications

• Setting Up an Oracle Shared Service Request Bin

Overview of Integration with Oracle Applications Framework
Interoperability with Oracle Applications Framework

Oracle iSupport is based on an existing, fully supported Oracle HTML standard, JTT. 
Other Oracle applications are based on a newer Oracle HTML standard, Oracle 
Applications Framework, OAF. Applications based on OAF, such as Oracle Internet 
Expenses, can initiate service requests through Oracle iSupport by using the 
interoperability feature that Oracle iSupport provides. More generally, OAF-based 
applications can call all the Oracle iSupport service request pages. Basically, all the FND
functions associated with the Oracle iSupport service request pages have been changed 
to type INTEROP so that OAF-based applications can properly render the JTT-based 
service request pages.

Selected Oracle iSupport pages have a Cancel or a Return button whose function is to 
return the application focus to the destination page defined by the parameter 
ibuReturnURL. OAF-based applications must pass this parameter to Oracle iSupport as 
defined in Conventions for Interoperability with OAF-Based Applications, page 7-2.

The Oracle Shared Service Request Bin

The sharable service request (SR) bin is an Oracle Applications Framework (OAF) 
region. Any OAF page can include this sharable region through personalization. No 
code is needed to include this region. This chapter contains the steps on how to include 
the sharable SR region in an OAF page as well as how to personalize your sharable 
service request bin. The guidelines require that you have a full understanding of the 
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functionality of the shared service request bin as well as OAF personalization.

Conventions for Interoperability with OAF-Based Applications
For the integration of Oracle iSupport and Oracle Application Framework (OAF), 
Oracle iSupport establishes the parameter ibuReturnURL to carry the return URL for 
Cancel buttons in the service request module. When a user clicks these Cancel buttons, 
the focus of the application goes to the destination page provided by this parameter. 
Therefore, an OAF-based application must specify this parameter and pass it to Oracle 
iSupport in a URL so that page flow can go back to the desired page.

For interoperability with OAF-based applications, Oracle iSupport has the following 
conventions for the ibuReturnURL parameter. The value for ibuReturnURL has this 
format: ibuReturnURL=PageFunc%26param1=v1%26Param2=v2%26param3=v3. For 
security reasons, ibuReturnURL must point to an FND function name instead of an 
actual JSP name or JRAD file name. PageFunc can be either a JTT function pointing to a 
JSP file or an OA function pointing to a JRAD file. You can also define the parameters 
inside the function as usual. Extra parameters like param1, param2, and param3 can be 
used as dynamic runtime parameters. Interoprability requires "%26" in front of these 
extra runtime parameters instead of '&'. "%26" is the standard encoded value for "&" 
and will be converted back to "&" automatically when Oracle iSupport gets the value 
from the requesting object. Whenever the Oracle iSupport code uses Redirect and needs
to put ibuReturnURL inside the URL, the code will convert "&" to "%26" again so that it 
can be passed correctly.

To return successfully to the page specified by parameter ibuReturnURL for both JTT 
and OAF cases, Oracle iSupport has the following logic for the Cancel button on the 
service request creation and detail pages. If the actual value for ibuReturnURL does not 
contain "OA.jsp", then Oracle iSupport treats it as one JTT page and uses Forward to 
return to that page. If it contains "OA.jsp", then Oracle iSupport treats it as one OAF 
page and uses SendRedirect to return. If the parameter ibuReturnURL is null, then it 
returns to the home page by using Forward.

In some integration cases, Oracle iSupport service request pages may be launched on a 
new window. In such cases, when a user clicks the Cancel button on the service request 
creation page or the main service request detail page, the new window should be closed
instead of returning to the destination URL. For this requirement, Oracle iSupport has 
the parameter ibuCloseWindow. If this parameter is set and its value is 'Y' and a user 
clicks the Cancel button, then the application closes the window regardless of whether 
the parameter ibuReturnURL is passed or not.

The service request confirmation page has a Return button. The functionality behind 
this button is the same as that for the Cancel button on the service request creation flow 
and detail flow. When user clicks the Return button, the focus returns to the destination 
page defined by parameter ibuReturnURL. If this parameter is null, then it goes back to 
the home page by default. Also, if parameter ibuCloseWindow is passed and its value is
'Y', then this parameter takes a higher priority, and the window is closed when the user 
clicks the Return button. Besides the logic included with this button, Oracle iSupport 
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also includes the item IBU_CF_RETURN in the seeded region 
IBU_CF_SR_CR_CONFIRMATION_BTN. By default its show flag is set to be false.

Setting Up an Oracle Shared Service Request Bin

Adding the Sharable Service Request Bin to Your OAF Page:
Use the following steps to include the sharable service request bin into your OAF page:

1. Ensure that the shared service request bin library is included in your class path. 
OAF cannot include this bin if it is not in its class path.

2. Logon as an administrator.

3. Using personalization, include the shared service request bin.

4. In the Personalization page, click Create Item for the region in which you want to 
include the SR bin.

5. Choose the Site level from the Level LOV.

6. Choose the Stack Layout style from the Item Style LOV.

7. In the Extends field, enter 
/oracle/apps/ibu/shared/sr/webui/SharedSRBin

8. Click Apply.

9. Click Return to Application to see the shared SR bin in the OAF page.

You should now be able to see the shared SR bin in your OAF application.

Creating Seeded Views:
Use the following steps to create a seeded view for your service request bin:

1. Click the Personalize Advanced Table: (SRTableRN) link from the OAF page.

2. Click Seeded User Views in the Advanced Table region.

3. Click Create View to take you to the Create View Personalization page.

4. Do the following in the Create View Personalization page:

1. Enter a view name.

2. Select the Set as Default check box if you want this view to be the default view.

3. Select the columns to be displayed by shuttling the columns to the left or right 
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in the region titled Attribute Properties.

4. In the region titled Search Query to Filter Data in your Table, provide the 
necessary criteria for your seeded view . You can additional criteria from the 
LOV.

5. Click Apply.

5. Click Apply again to take you to the Personalization page of the advanced table 
region.

6. Click Return to Application to return to your OAF page.

Personalizing Your Service Request Bin:
The following are guidelines to further personalize your service request bin. To begin, 
click Personalize Service Requests from the shared SR bin. In the Personalization page, 
click Expand All to see all the SR region parameters within the InputParameters region.

Personalizing the Create Service Request Button Destination
The Create Service Request button has a default destination of OA.jsp?
OAFunc=IBU_FROM_OAF_CREATE_SR. The IBU_FROM_OAF_CREATE_SR function 
points to the Create Service Request page of iSupport. If you would like to pass in more 
parameters to the Create SR page, such as the SR type ID, then create a function that 
contains the parameters and use this function as the destination for the Create SR 
button. To do so, click the Personalize icon of the Button: Create Service Request item, 
and provide an initial value in the Initial Value text input field. 

Example
Button: Create Service Request – Destination URI: OA.jsp?
OAFunc=IBU_CREATESR_TYPEID

Adding Object Code, Object ID, and Summary Parameters to the iSupport Create Service
Request Page

You may want to provide the object code, object ID, and summary parameters to the 
iSupport Create Service Request page when you click the Create Service Request 
button. To provide these parameters, you must personalize and type an initial value for 
the following:

• Create SR Source Object Code – for the object code

• Create SR Source Object ID' – for the object ID

• Create SR Source Object Num – for the summary, which includes the object number

If you do not provide a value for Create SR Source Object Code, then neither the object 
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code nor the object ID parameters are passed to the iSupport Create SR page. Similarly, 
if you do not provide values for the object code and the object number, then the 
summary parameter that contains these two values is not passed to the iSupport Create 
SR page.

Examples
• Create SR Source Object Code – Initial Value: EXPENSEREPORT

• Create SR Source Object ID – Initial Value: WebExpensesAM.
ExpenseReportHeadersVO.ReportHeaderId 

• Create SR Source Object Num – Initial Value: WebExpensesAM.
ExpenseReportHeadersVO.InvoiceNum

The object code must be defined as a JTF object. Steps to create a new JTF object are as 
follows:

1. Login to Forms Application as System Administrator. 

2. Navigate to Task Management Object.

3. Query an object such as EXPENSEREPORT. Verify whether this object already 
exists.

4. If the EXPENSEREPORT object does not exists, then create a new object with name 
and code for EXPENSEREPORT.

Adding Object Code and Object ID as Additional Search Criteria When Searching for a 
Particular Service Request

To view only those service requests that are associated with an object code and an object
ID, personalize and type an initial value for the following:

1. Search SR Source Object Code, for the object code

2. Search SR Source Object ID, for the object ID

If you do not provide a value for Search SR Source Object Code, then neither the object 
code nor the object ID values are used in the search regardless of whether the Search SR 
Source Object ID item has an initial value.

Examples
• Search SR Source Object Code – Initial Value: EXPENSEREPORT

• Search SR Source Object I' – Initial Value: WebExpensesAM.
ExpenseReportHeadersVO.ReportHeaderId
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Personalizing the Return Page of iSupport pages:
To specify the appropriate return page of the iSupport pages for creating service 
requests and viewing service requests, provide initial values using personalization for 
either of the following items:

• Return to Page (Format: FND_FUNCTION)

• Return to Page for a Particular Object ID (Format: FND_FUNCTION?ObjectID=)

The first item, Return to Page (Format: FND_FUNCTION), accepts only an 
FND_FUNCTION value.

The second item, Return to Page for a Particular Object ID (Format: FND_FUNCTION?
ObjectID=), accepts an FND_FUNCTION with an additional object ID parameter. If you 
provide a value to the second item, then you must specify an object ID for both Create 
SR Source Object ID and Search SR Source Object ID. See examples above for details on 
these items. The shared SR bin automatically appends the object ID to the value of the 
second item, and the object ID will be passed to the appropriate iSupport pages as its 
full return URL

Note: If both items have values, then the second item, Return to Page 
for a Particular Object ID (Format: FND_FUNCTION?ObjectID=), takes 
precedence over the first item, Return to Page (Format: 
FND_FUNCTION).

If you need the object ID to be encrypted for your return page, then specify this by 
providing an initial value of Y for the Encrypt Object ID item.

Examples
• Return to Page (Format: FND_FUNCTION) – Initial Value: OIEMAINPAGE

• Return to Page for a particular Object ID (Format: FND_FUNCTION?ObjectID=) – 
Initial Value: OIECONFIRMPAGE?dbiReportHeaderId=

• Encrypt Object ID (Y/N) – Initial Value: Y

Opening iSupport Pages in a New Window
Suppose that you want to open iSupport pages in a new window, for example, when 
creating a service request or viewing service request details. To do so, personalize and 
provide an initial value of Y for the Open iSupport Pages In New Window item.

Example
• Open iSupport Pages In New Window – Initial Value: Y
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8
Integrating Oracle iSupport with Oracle 

Knowledge (InQuira)

This chapter covers the following topics:

• Overview of Oracle Knowledge

• Setting Up Oracle Knowledge Search

Overview of Oracle Knowledge
Oracle Knowledge (InQuira) is a knowledge management system. It enables the service 
organizations to create, manage, and share content across languages. It provides a 
powerful Natural Language Search (NLS) to search unstructured content, structured 
data, and transactional business applications.

The integration of Oracle iSupport with Oracle Knowledge allows service organizations 
to perform knowledge base searches from the Oracle Knowledge application or the 
existing Oracle Knowledge Management system.

Setting Up Oracle Knowledge Search
To search the knowledge base using Oracle Knowledge, you must do the following:

• Install a licensed version of the Oracle Knowledge application.

• Set the Knowledge: Search to display for integrating applications profile option to Oracle 
Knowledge Search.

• In the Service: Oracle Knowledge Search URL profile option, set appropriate values in 
the following link:

<protocol>://<iconnecthost>:
<iconnectport>/<iconnectappname>/index?page=ccaEbs
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Example
http://slc05hgu.us.oracle.com:8226/iconnect/index?page=ccaEbs

• In the Service: Oracle Knowledge Homepage URL profile option, set appropriate values
in the following link:

<protocol>://<infocenterhost>:
<infocenterport>/<infocenterappname>

Example
http://slc05hgu.us.oracle.com:8226/infocenter

• In the Service: Oracle Knowledge Widget Homepage URL profile option, set appropriate
values in the following link:

<protocol>://<infocenterhost>:
<infocenterport>/<infocenterappname>

Example
http://slc05hgu.us.oracle.com:8226/infocenterEbs
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9
Using Oracle iSupport

This chapter covers the following topics:

• Overview

• User Interface Basics

• Performing Searches

• Using Quick Find

• Searching Account Information

• Searching Oracle Install Base

• Searching Forums

• Searching and Browsing the Knowledge Base

• Viewing Top Solutions from Oracle Knowledge Management

• Choosing Home Page Content

• Enabling Home Page E-mail Subscriptions

• Using the Bookmarked Solutions Quick Links Bin

• Using Service Requests

• Using Accounts

• Viewing Orders

• Viewing Invoices

• Viewing Payments

• Viewing Contracts

• Viewing Returns

• Viewing Repair Orders

• Using Returns

• Using Oracle Install Base
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• Viewing Oracle Install Base

• Editing a Product in Oracle Install Base

• Adding Products to Oracle Install Base

• Using Saved Searches

• Defining Saved Search Criteria

• Viewing Categories

• Posting New Messages to Forums

• Subscribing to Forums

• Setting Forums Signature

• Changing User Profile Information

• Changing/Resetting Password

• Adding to or Changing Contact Points (Phone/Email/Fax)

• Setting Display Preferences

• Changing Default Customer Account

Overview
This section provides process-oriented, task-based procedures for using Oracle 
iSupport. This section covers general user navigation and page functionality and 
explains how to use the fields and other relevant elements within the pages.

For conceptual information regarding the application, please see the Overview chapter 
(PDF version) of this guide. 

For task-based administrator procedures necessary for ongoing application 
maintenance, please see the Administering Oracle iSupport (online help) or chapter 
(PDF version) of this guide.

For setup information regarding the application, please see the setup chapters of this 
guide. The guide is released PDF, with the most recent version at My Oracle Support 
(http://support.oracle.com). Please visit the Oracle Technology Network (http://otn.
oracle.com/documentation) to order printed copies of the guides.

User Interface Basics
This section provides basic user interface (UI) concepts.

• Configurability - Because the user interface of Oracle iSupport is highly 
configurable, you may or may not see what is described in this guide. 
Configurability affects both the application content pages that Oracle delivers and 
local pages that your support group can attach to application pages. Examples of 
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the first category are pages, regions, buttons, and fields on application pages that 
are visible to different types of users. For example, the pages for the flow to create 
service requests are all configurable in this way. Examples of the second category 
are advertisement sections that are attached to the top, left, right, and bottom of 
application pages. Your system administrator, application administrator, and end 
users control what is appropriate to display to particular users.

• Go Button -The Go button next to certain text boxes allows you to access a list of 
values (LOV) associated with that field. It is used to select items to enter into the 
text box. After the LOV pops up, select the entry of your choice using the radio 
button. On most LOVs you need to select Submit for the text box to be populated.

• Drop-List - A box with a down arrow next to it indicates that you select an entry 
from a drop-down list. Select the down arrow and make your selection with the 
mouse.

• Required Fields - An asterisk next to any field indicates that the entry is 
mandatory.

• Calendar Icon - The Calendar icon is used to set start or end dates for applicable 
procedures. Select the icon to view a calendar, then select a date to populate 
appropriate field. 

• Using the Tabs - The business user interface has five main tabs, each with its own 
set of subtabs:

• Home - This tab accesses the home page for the application. Your personalized 
home page consists of bins containing links to frequently used information that 
you set up (such as tracked Service Requests), and items supplied by the 
application administrator, such as links to Technical Library documents or 
Support links. The home page has no subtabs. 

• Account - The Account tab gives users access to transactions information, such 
as order details, invoices, payments, returns, contracts, shipments, and 
products in Oracle Install Base. Account tab subtabs are: Orders, Invoices, 
Payments, Contracts, Returns, and Products. See Using Accounts, page 9-11 for
more information.

• Support - By accessing the Support tab, users can create and track service 
request information, search the knowledge base, request call-backs from 
support agents, and access online forums. Support tab subtabs are: Ask Me, 
Technical Library, Forum, View/Update Request, and Create Request. 

Note: Employee Users see only the Home and Support tabs.
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Performing Searches
This topic group provides instructions for performing searches within the application. 
Topics include:

• Using Quick Find

• Searching Accounts/Transactional Inquiries

• Searching Oracle Install Base

• Searching Forums

• Searching the MES Technical Library

• Searching and Browsing the Knowledge Base

• Viewing Top Solutions from Oracle Knowledge Management

Using Quick Find
Quick Find is the drop-down list displayed beneath the subtabs on all of the main 
application pages. To use Quick Find, select the appropriate item from the drop-down 
list, enter search criteria in the text field, and select Go. 

Note: You may use the % character as a wildcard when searching. 

Quick Find can help you locate:
Service Requests - Use the exact Service Request number; partial numerical values are 
not supported. To search by service request summary field, enter partial values, using 
the % sign as a wildcard. For example, t%% will find all service requests whose 
summary field begins with T.

Solutions - Enter partial or complete search criteria to find solutions in the knowledge 
base. For example, if you know the number of a solution in the database, enter it in the 
text box. Or, enter a partial alphabetical value, using the % sign as a wildcard, to find 
text entries.

Library - Enter partial or complete search criteria to locate documents in Marketing 
Encyclopedia System (MES)/Technical Library. Enter a partial alphabetical value, using 
the % sign as a wildcard, to find entries.

Forums - Search within Forums postings by entering full or partial values in the field. 
Enter a partial alphabetical value, using the % sign as a wildcard, to find forum entries. 
Forums also has an advanced search feature.

Install Base - Enter known criteria to find products in Oracle Install Base. Oracle Install 



Using Oracle iSupport    9-5

Base also has its own search feature. See Using Oracle Install Base, page 9-16 for more 
information.

Searching Account Information
The search function within the Account tab of Oracle iSupport allows you to search 
your orders, invoices, payments, contracts data, returns, products, and repair orders. 

To search for data within the Account tab, use the following procedure:

Steps
1. Within Oracle iSupport, navigate to the Account tab. 

2. Select one of the following subtabs: Orders, Invoices, Payments, Contracts, Returns, 
or Products.

3. Select an account number to search within. Account numbers are assigned when 
your username is created within the system. 

4. In the Search drop-down list, select a search criteria, for example, order number.

5. In the constraint operator drop-down list, select a criteria, for example, greater than.

6. In the field, enter search information that corresponds to the search criteria chosen 
in the drop-down list.

7. Select Go to perform the search.

Searching Oracle Install Base
Please see the topic Using Saved Searches for information on searching Oracle Install 
Base, page 9-19.

Searching Forums
Follow the guidelines below to use the Forums search function.

1. Within Oracle iSupport, navigate to Support > Forum > Advanced Search. The 
Advanced Search - Forum page appears.

2. Enter data in any one or all of the following fields:

Message Number - This is the system-generated message number.

Subject Keyword(s) - Enter (case insensitive) keywords that may be in the message 
headers (subject) of the appropriate messages. You can enter more than one word in
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this field, using the % sign as a wildcard, but your search criteria must match the exact 
order of the wording found in the subject field. 

Example: You are having a problem closing your CD-ROM tray and wish to search 
for messages that relate to this subject. In this example, there is a message with the 
subject, Unable to close CD-ROM tray. If you enter unable%CD in the search field, 
it will find the message. But, if you enter CD%unable, the system will not find the 
message because the search criteria is not in the exact order of the information from 
the subject field.

Message Keyword(s) - Enter (case-insensitive) keywords that may be in the bodies 
of applicable messages. You can enter as many words as you like, and there is no 
need to use a plus sign (+) here, although you can use it you like. Also, the words 
do not need to be in any particular order.

Category - Leave the drop-down list set to All to search all categories, or restrict the 
search to a particular category by choosing the category from the list.

Forum - Leave the drop-down list set to All to search all forums, or restrict the 
search to a particular forum by choosing the forum from the list.

Posted Between - Use the calendar icon to the right of the first field to select a date 
to begin searching from, and use the calendar icon to the right of the second field to 
select an end date.

Author - Select the Myself radio button to find messages posted by you. To find 
messages written by others, select the Others radio button and enter the name of the
author of the message. Use the format <first name> <space> <last name>.

Message Status - Choose from the radio buttons: Read searches only messages that 
have been viewed by a user. Unread searches only messages that have not been 
viewed by a user. All searches both types.

3. Select Search. The application returns a list of messages matching your search 
criteria. If no messages are found, the system returns the message: No messages 
were found to match the search criteria.

Forum Search Results
Forum search results are organized into a table with the following columns:

Subject Name -Message header or subject.

Author - Name of the person who posted the message.

Date - Date that the message was posted.

To view a message in the results list, select the hyperlink in the Subject Name column. 
You are now be able to reply to the message or start a new message thread within the 
forum.

To begin a new search, select the Search Again button and follow the steps above in 
Searching Forums.
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Searching and Browsing the Knowledge Base
Use this procedure to search and browse the knowledge base.

Steps
1. Within Oracle iSupport, navigate to Support >Ask Me.

The Knowledge Base page appears. 

2. In the Search region, enter any keyword as criteria in the Search field.

3. In the Using field, chose one of the following options:

• All of the words: To match all words in any sequence

• Fuzzy match: To match related words

• Exact Phrase: To precisely match word-by-word in the same sequence

• Synonym match: To match exact word and words mentioned in the thesaurus

4. Click Go.

5. To perform an advanced search, click Solution Advanced Search.

6. To browse a category and/or document, select the appropriate link in the Solution 
Categories region.

Viewing Top Solutions from Oracle Knowledge Management
The top problem solutions on the Other Recommended Solutions page are frequently 
used solutions and recommended solutions from Oracle Knowledge Management. 
Recommended solutions are those that knowledge workers recommend for users to 
review. For more information on searching the knowledge base, see the Oracle 
Knowledge Management User Guide. Use this procedure to view top problem solutions 
from Oracle Knowledge Management.

Steps
1. Within Oracle iSupport, navigate to Support > Top Solutions.

The Other Recommended Solutions page appears. 

2. In the Frequently Used Solutions region, use the View Solutions Used LOV to 
define the time period used in the region for this search.
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3. In both regions, click the description links to drill down to detail that is presented 
on the solution detail page.

This page provides access to more information about symptoms, causes, actions, 
and attachments.

4. Click available links or the View icons to obtain more details.

Choosing Home Page Content
A variety of content can be added to your home page. Some content is configured by 
the application administrator to appear mandatorily on your home page. Other content 
can be selected - and its layout chosen - by you.

Follow the steps below to select the content for your home page. 

1. Within Oracle iSupport, navigate to Home > Personalize: Content. A list of content 
choices appears.

2. Choose topics from the Optional Content list by selecting in the check box next to 
the content topic. Wide (W) content can only be displayed in a wide column; 
narrow (N) content can be displayed in either size column. A wide column is twice 
as wide as a narrow column.

3. After making your selections, select Update to save changes.

4. Return to the home page to verify that you can see the content.

Using the Edit Hyperlinks on Home Page Bins
Certain bins on your home page are editable, meaning you can choose which data items
appear in them. For example, for a Service Request Quick Links bin, you can select 
which fields to appear in the bin, such as service request number, submit date, and 
service request status. Bins that are editable/configurable by the user have an Edit 
hyperlink at the top of the bin.

Using the Close Hyperlinks on Home Page Bins
You can also close certain bins on your home page simply by clicking the Close 
hyperlink at the top of the bin.

Related topic:
Tracking Service Requests on the Home Page
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Enabling Home Page E-mail Subscriptions
Oracle iSupport allows users to receive the contents of their home page in an e-mail. 
This is useful when users are unable to log in to Oracle iSupport for whatever reason. 
This feature can be enabled by either the user himself or an administrator. Follow the 
steps below to enable or disable this feature.

Prerequisite
A valid e-mail account has been recorded for the user who will receive the home page 
e-mails (see Adding/Changing Contact Points, page 10-6).

Steps
1. With Oracle iSupport, select the Profile button at the top of the page. The Personal 

Profile page appears.

2. In the menu to the left, select Support. The Support page appears.

3. In the Email Subscription: Email Content area, a list of available home page content 
appears. From the list, select the desired home page content.

4. In the Email Delivery Preferences region, choose the delivery frequency and the 
delivery language.

5. Select Save. The application returns a confirmation message.

Using the Bookmarked Solutions Quick Links Bin
Knowledge base results can be bookmarked and organized into a bin on your home 
page by utilizing the Add to Quick Links button on applicable pages.

• To view one of the bookmarked items, select the underlined hyperlink of the item.

• To remove a quick link from the bin, select the Edit hyperlink on the bin itself, and 
then select the remove icon next to the appropriate quick link.

Use the following procedure to change the display properties of the bin.

Steps
1. Within Oracle iSupport, navigate to the home page. Select the Edit link on the 

Bookmarked Solutions Quick Links bin (not the Service Request Quick Links bin). 
The Edit Quick Link Content page appears.

2. Choose whether the name, description, or both name and description appear in the 
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bin. In the Display Options area, select:

• Quick Link Name - Activate this check box to display the name of the quick 
link in the bin. In the bin, quick link name shows up under the Quick Link 
column. The Quick Link Name is generated by the application when you 
bookmark an item.

• Quick Link Description - Activate this check box to display the descriptive text
name of the quick link in the bin. In the bin, the quick link description shows up
under the Description column. The Quick Link Description is generated by the 
application when you bookmark an item.

3. Choose how the content is sorted. In the Sort Options area:

• Sorted By LOV - Select the primary sort criteria, either Name or Description. If 
you select Name, the system will sort all content items by name. If you select 
Description, the system will sort all content items by the description. The 
Ascending/Descending choice tells the system to sort - alphabetically or 
numerically - the name or description either first-to-last or last-to-first.

• Then By LOV - Select the secondary sort criteria. The criteria chosen in the 
Sorted By LOV will take precedence over any sort criteria chosen here.

4. Enter the number of rows to appear in the Number of Rows Displayed text box.

5. Select Save to save changes.

Using Service Requests
Because the service request pages and the flow to create service requests are highly 
configurable, your administrator determines the appearance and online help content for
the pages involved. Typical topics include the following:

• Creating Service Requests

• Using Service Request Profiles

• Using Service Request Saved Views

• Changing Service Request Status

For implementation information on the configuration of service request pages and the 
flow to create service requests, see Configuring Service Request Pages, page 4-13 of the 
Oracle iSupport Implementation and User Guide.
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Using Accounts
This topic group provides information on how to access to account information, such as 
orders, invoices, payments, contracts, and shipments. For information on Returns, see 
Using Returns , page 9-15.

Topics include:

• Viewing Orders

• Viewing Invoices

• Viewing Payments

• Viewing Contracts

• Viewing Returns

• Viewing Repair Orders

Viewing Orders
Follow the steps below to access a list of your orders and related information.

Steps
1. Within Oracle iSupport, navigate to Account > Orders. A list of orders appears on 

the Track Orders page.

2. Select the Order Number hyperlink to see additional details about a particular 
order. From the resulting Order Details page, click the Item Details icon to get the 
details for a particular order item.

3. Optionally, select the icon in the Shipment Details column to view shipment 
details.

Searching Orders
Use the following procedure to search for orders.

Steps
1. Within Oracle iSupport, navigate to Account >Orders. A list of orders appears.

2. Select the appropriate number from the Accounts drop-down list.
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3. In the Search By drop-down list, select a search criteria, for example, order number.

4. In the Constraint Operator drop-down list, select a criteria, for example, greater 
than.

5. In the Orders Between and Orders in Last fields, select appropriate criteria.

6. Select Go to perform the search.

Viewing Invoices
Follow the steps below to access a list of your invoices and related information.

Steps
1. Within Oracle iSupport, navigate to Account >Invoices. A list of invoices appears.

2. Select the Invoice Number hyperlink to see the Invoice Details page.

3. Optionally, select Details in the Shipments column to view shipment details.

Searching Invoices
To search for invoices:

Steps
1. Within Oracle iSupport, navigate to Account >Invoices. A list of invoices appears.

2. Select the appropriate number from the Account Number drop-down list.

3. In the Search drop-down list, select a search criteria, for example, invoice number.

4. In the Constraint Operator drop-down list, select a criteria, for example, greater 
than.

5. In the field, enter search information that corresponds to the search criteria chosen 
in the drop-down list.

6. Select Go to perform the search.

Viewing Payments
Follow the steps below to access a list of your payments and related information.
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Steps
1. Within Oracle iSupport, navigate to Account >Payments. A list of payments 

appears.

2. Select the Payment Number hyperlink to view the Payment Details page.

3. Optionally, select Details in the Shipments column to view shipment details.

Searching Payments
To search for payments:

Steps
1. Within Oracle iSupport, navigate to Account >Payments. A list of payments 

appears.

2. Select the appropriate number from the Account Number drop-down list.

3. In the Search drop-down list, select a search criteria, for example, Payment Number.

4. In the Constraint Operator drop-down list, select a criteria, for example, Greater 
Than.

5. In the field, enter search information that corresponds to the search criteria chosen 
in the drop-down list.

6. Select Go to perform the search.

Viewing Contracts
Follow the procedure below to access your contracts information.

Steps
1. Within Oracle iSupport, navigate to Account > Contracts. 

The Contracts page appears and shows a list of contracts.

2. Select a Contract Number hyperlink to view the Contract Overview page for that 
contract.

3. Select Back to return to the Contracts page.
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Searching Contracts
To search for contracts, use the following procedure.

Steps
1. Within Oracle iSupport, navigate to Account > Contracts.

The Contracts page appears and shows a list of contracts.

2. Select Advanced Search. 

The Advanced Search page appears.

3. Use the LOVs, flashlight icon search aids, and other fields to define your search 
criteria for the desired contracts.

4. Define your desired display and sort options.

5. Select Search. 

The results appear in the Search Results region.

Viewing Returns
Use this procedure to search returns.

Steps
1. Within Oracle iSupport, navigate to Account > Returns.

The Returns summary page appears. By default, this page shows your returns 
sorted by creation date with the most recent date first.

2. Qualify your search by selecting values for the Returns in Last, Returns Between, 
and Search By fields. To search returns by date, either use the calendar icon or enter
dates manually in the format 15-NOV-2003.

3. In the All Returns region, click a return number to see details for the return on the 
Returns Details page.

4. From that page, click Item Details to see details of a return order line.

Viewing Repair Orders
You can view the repair status for an item that was delivered to a service organization 
to repair, either paid or as supported by a service agreement. Follow this procedure to 
view repair orders.
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Steps
1. Within Oracle iSupport, navigate to Account > Repair Orders.

The Repair Order Summary page appears. By default, this page shows your repair 
orders sorted by creation date with the most recent date first.

2. To view the details of a repair order, click its number in the Repair Order Number 
column.

3. To view a saved personalized search, choose your search name from the Saved 
Search LOV, and click Go.

4. To view the details of a service request that is associated with a repair order, click 
the service request number in the Service Request Number column.

5. To define a personalized search, click Personalize. 

The Search Repair Orders page appears.

1. Use the Searches region to run or remove a saved search.

2. Use the Search Attributes region to define, save, and run a new search.

Using Returns
Oracle iSupport allows you to create return material authorizations (RMAs), or returns. 
In order for you to create a return for an item, an order first must have been booked in 
Oracle Order Management. For more information, see:

• Oracle Order Management User's Guide

• Oracle Order Management Implementation Guide

Follow this procedure to create a return.

Prerequisite
An order has been booked in Oracle Order Management. 

Steps:
1. Within Oracle iSupport, navigate to Account > Returns > Return Items link. 

The Create Return: Search and Select Items page appears. 

2. Search for an item to return by selecting a part number, order number, or serial 
number and clicking Go. You can also search for items by multiple part numbers 
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and order numbers by separating query criteria with space example (AS54888 
AS32111) or by a Serial Number. The application shows order items with exact 
match of the query criteria. Wild-card characters such as "*" and "%" are not 
supported.

The Results region displays the results of the search.

3. Select the check box for any item that you want to return, and click Add to Return.

The Create Return: Review and Submit page appears and shows the proposed items
for the return order.

4. In the Returned Quantity column, enter the quantity to be returned for the 
corresponding line items.

5. Use the Return Reason LOV to enter the corresponding reason for the return of each
item.

6. Click the Billing icon to view and change the billing information for an item.

7. When you are satisfied the selection on the Create Return: Review and Submit page,
click Submit Return. 

A confirmation page appears and shows a return order number.

Using Oracle Install Base
Oracle Install Base is a repository of product information, location, status, party 
relationships, configuration, ownership, accounts, and change history for a customer 
product, an asset, or a software license. It offers life-cycle tracking of an item from the 
time that it is received, in inventory, in WIP, in projects, at customer sites, or during 
repair. Oracle Install Base also records a history of changes to tracked items and does so 
independently of their ownership, physical location, or accounting classification.

Definition: An instance in Oracle Install Base is an occurrence of an item entity. For 
example, an manufacturer has a part number for a TV he makes, each time he sells one 
TV, an occurrence of this part number is recorded in Oracle Install Base. 

Oracle Install Base is specifically designed to track serialized and non-serialized item 
instances for the following:

• Tangible products

• Tangible assets

• Software

• Communications and utility services

All Oracle Install Base functionality in Oracle iSupport is contained on the Products tab 
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in the interface for a general user.

Oracle iSupport allows you to view and search Oracle Install Base, as well as add 
products to it. This topic area includes:

• Viewing Oracle Install Base, page 9-17

• Editing a Product in Oracle Install Base, page 9-17

• Adding Products to Oracle Install Base, page 9-18

• Using Saved Searches, page 9-19

• Defining Saved Search Criteria, page 9-19

Viewing Oracle Install Base
Follow the procedure below to view product information in Oracle Install Base.

Steps
1. Within Oracle iSupport, navigate to Account > Products.

The Search Products page appears with a list of products in Oracle Install Base. 

2. To view details of a product, select the hyperlink for the product or use the View 
Details LOV for it.

For more information, see the Oracle Install Base User Guide.

Editing a Product in Oracle Install Base
Here are steps for editing a product in Oracle Install Base.

Steps
1. Within Oracle iSupport, navigate to Account > Products.

2. In the Search Products page, a list of products in your install base appears. Select 
the appropriate hyperlink in the Description column.

3. In the Product Details page, make changes as desired. See Adding Products to 
Oracle Install Base, page 9-18 for more information on the fields on the Product 
Details page.

4. Select Save.

5. Respond to the confirmation message.
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For more information, please see the Oracle Install Base User Guide.

Adding Products to Oracle Install Base
In the Create Product page you can create a product, or item instance. The page has 
regions for general item information, owner information, current location, item flags, 
and item views.

Use the following procedure to create a product.

Prerequisites
The item and item number for an item instance (product) must already be defined in the
Inventory Item Master as Install Base trackable.

Steps
1. Within Oracle iSupport, navigate to Account > Products.

2. Select Create. The Create Product page appears.

3. In each region, enter data in the fields. Fields marked with an asterisk (*) are 
required.

Note: Many fields within this page are followed by a Go button. The button 
indicates that you can enter a generic search value using % in the associated fields 
and then select Go to display a list of values that satisfy the generic criteria. When 
you select one of these results, it populates the associated field.

Select the calendar icon to help you enter dates.

Under Item Flags, sellable means orderable and reflects selecting the Orderable flag 
in the item master setup. The Merchant flag is automatically selected if an agent 
creates or changes the instance. The Customer flag is automatically selected if a 
customer creates or changes the instance.

As necessary, select Clear to clear out your test entries, and re-enter your values.

4. If your definition is complete, optionally select Creation Completed. 

Doing so means that it can be used for configuration and other applications.

5. Select Submit.

The Product Details page appears for your product with its new product (instance) 
number. If you provided values for all the required fields (with asterisks) but did 
not select Creation Completed, then the application selects it for you. If an instance 
is created without the mandatory fields, then Creation Completed is not selected. 
This means that the instance cannot be used in applications such as Service Request.
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6. Select Submit to save changes.

For more information, please see the Oracle Install Base User Guide.

Using Saved Searches
Oracle iSupport allows you to save searches in Oracle Install Base. With saved searches 
you can easily reuse a set of possibly complicated search criteria by assigning a name to 
the saved set of criteria. Use this procedure to display the results of a previously named 
set of search criteria.

Steps
1. Within Oracle iSupport, navigate to Products. The Search Products page displays a 

list of products in your Oracle Install Base. 

2. In the Saved Searches LOV, select the name of the predefined search that you want 
to use. See Defining Saved Search Criteria, page 9-19 for more information on how 
to set up a saved search.

3. Select Go. The search results appear in the lower part of the page.

4. As desired, select the link for an item description to display details about it. 

For more information, see the Oracle Install Base User Guide.

Defining Saved Search Criteria
With saved searches you can easily reuse a set of possibly complicated search criteria by
assigning a name to the saved set of criteria. Most of this defining process occurs on the 
Advanced Product Search page. This page is organized by regions of basic categories 
under which you can define and test various specific search criteria. After you are 
satisfied with intermediate or final results of your tests, then you can save the set of 
criteria with a name of your choice. The basic category regions are:

• General Attributes

• Current Location

• Party Accounts

• Other Information

• Table Personalization (defines the position of displayed columns)

Most fields within the regions are followed by a Go button. The button indicates that 
you can enter a generic search value using % in the associated fields and then select Go 
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to display a list of values that satisfy the generic criteria. When you select one of these 
results, it populates the associated field.

Use this procedure to define a named set of search criteria.

Steps
1. Within Oracle iSupport, navigate to Account > Products. The Search Products page 

displays a list of products in your install base. 

2. Select Personalize. The Advanced Product Search page appears.

3. In each basic category region, enter data in the fields. 

As necessary, use generic entries and the associated Go button to populate fields 
with specific values.

Select the calendar icon to help you enter dates.

As necessary, select Clear to clear out your test entries, and re-enter values.

4. In the Table Personalization region, use the Move and Remove commands and 
arrows to move selected columns between the list of available columns and 
columns that you select for display. 

5. Use the arrows in the right-hand column of the personalization table to arrange the 
display sequence of your selected columns. The column titles as arranged from top 
to bottom are displayed from left to right on the Search My Products page.

6. As appropriate select one of the following:

Search: Finds values that satisfy the current search criteria

Enter a name before selecting one of these two options:

Save: Saves the search criteria under the most recently used name for search criteria

Save and Apply Search: Saves the search criteria under the most recently used 
name for search criteria and then performs a search that uses those criteria

Viewing Categories
Forums are organized into larger groups called categories. Follow the steps below to 
view category listings.

Steps
1. Within Oracle iSupport, navigate to the Support > Forum tab. The Category Listing 

window appears. 

2. Use the View By drop-down list box to display either a list of categories containing 
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Forums that you have subscribed to, or a list of all categories. 

See Subscribing to Forums, page 9-21 for more information on this subject.

3. Categories containing forums show a plus sign (+) in the adjacent column. To 
expand the category listing and show the available forums, select the plus-sign next 
to the category name. 

Optionally, select Expand All to display all forums within all listed categories.

Optionally, select Collapse All to display only the category names.

Posting New Messages to Forums
Follow the steps below to post a new message to a forum.

Steps
1. Within Oracle iSupport, navigate to the Support > Forum tab. The Category Listing 

window appears.

2. In the category list, categories containing forums show a plus sign (+) in the 
adjacent column. To expand the category listing and show the available forums, 
select the plus-sign next to the category name. 

3. Forums names will appear as hyperlinks. Select a link to enter a forum.

4. Select New Thread.

5. Fill in the Subject name and type your message.

6. Select Post. Your message will be stored underneath the forum.

Note: Any information you have entered in the User Signature text box in the 
General Preferences area will appear when you post to Forums (see Setting Forums 
Signature, page 9-22).

Subscribing to Forums
Oracle iSupport gives you the option of listing on your forums page a set group of 
forums, presumably the ones you access most often and/or are most interested. This 
functionality is known as Subscribing to a Forum. Directions for enabling this feature 
are shown below.

Steps
1. Within Oracle iSupport, navigate to the Support > Forum tab.
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2. Enter a forum using the procedure detailed in Viewing Forums.

3. Select Subscribe. When you access the main Forums page, you will have the option 
displaying only the forums to which you have subscribed

Unsubscribing to Forums
Use the following procedure to unsubscribe to Forums to which you have subscribed.

Steps
1. Within Oracle iSupport, navigate to the Support > Forum tab.

2. Enter a forum using the procedure detailed in Viewing Forums.

3. Select Unsubscribe.

Setting Forums Signature
Use the following procedure to set the signature that appears when you post messages 
to forums.

Steps
1. Within Oracle iSupport, navigate to the Profile button at the top of the page. The 

Personal Profile page.

2. From the Personal Profile page, select the Support link in the side navigation menu.

3. In the User Signature text box, enter the desired information. 

4. Select Update to save changes.

Changing User Profile Information
This section provides information on changing user profile data, including:

• Changing/Resetting Password, page 10-5

• Adding/Changing Contact Points (Phone/Email/Fax), page 10-6

• Setting General Preferences, page 10-8

• Changing Default Responsibility, page 10-9

• Changing Default Customer Account, page 10-10
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Changing/Resetting Password
Follow the steps below to change or reset a password.

Steps
1. Within Oracle iSupport, select the Profile button at the top of the page. The Personal

Profile page appears.

Note: If you are an administrator performing this task, search for the user and then 
select the underlined hyperlink of the username to access the Personal Profile page 
for that user.

2. If the service organization has not turned on single sign-on, then do the following:

1. In the Personal Profile page, enter the new password in the New Password and 
Re-enter New Password fields.

2. Select Update to save the changes.

3. If the service organization has turned on single sign-on, then you may see a link 
called Change Password instead of the New Password and Re-enter New Password
fields. If so, then click the link and follow the instructions on the target page.

Adding to or Changing Contact Points (Phone/Email/Fax)
Add to or change contact points of users (such as phone, email, fax) by following the 
steps below.

Steps
1. Within Oracle iSupport, navigate to the Profile button at the top of the page. The 

Personal Profile page appears.

Note: If you are an administrator performing this task, search for the user and then 
select the underlined hyperlink of the username to access the Personal Profile page 
for that user.

2. From the Personal Profile page, select the Contact Points hyperlink from the User 
Profile region of the side navigation menu. 

To edit an existing contact point, select the underlined hyperlink of the appropriate 
contact point. 

To create a new contact point, select Create.

3. Make additions/alterations to the following:
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• Communication Type - Enter the type of communication; examples are email, 
phone, telex.

• Delivery Method

• Primary Contact Point

4. Save the changes by selecting Save.

Setting Display Preferences
Display preferences include default style sheet, language, currency, and date format. 

Follow the steps below to change general preferences. 

Steps
1. Within Oracle iSupport, click the Profile button at the top of the page. The Personal 

Profile page appears.

2. Select the Display Preferences hyperlink. The Display Preferences page appears.

For instructions on how to change default responsibilities, see Changing Default 
Responsibility, page 10-9.

3. In the General Display area, set the following as desired:

• Display Style - Select a default style sheet.

• Language - Select a default language.

• User Currency - Select a default currency.

• Date Format - Select a date format to use when entering dates. 

RRRR = year

DD = day

MM or MON = month

4. In the Table Display area, set the following as desired:

• Display Rows per Page - Select the number of rows to appear of any tables that
are displayed within the application.

• Display Blank Rows per Table - Select the number of blank rows to appear in 
any updateable tables that are used by the application.
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5. Select Update to save changes.

Changing Default Customer Account
Use the following procedure to change the default account number.

Steps
1. Within Oracle iSupport, click Profile button. The Personal Profile page appears.

Administrator Note: If you are an administrator performing this task, search for the 
user and then select the username to access the user's Personal Profile page.

2. Select the Accounts hyperlink. The Accounts page appears.

3. Select the radio button next to the desired account.

4. Save the changes by selecting Save.
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10
Administering Oracle iSupport

This chapter covers the following topics:

• Maintaining Users

• Creating Users

• Deleting Users

• Setting Effective Dates for Users

• Searching for Users

• Changing User Profile Information

• Changing/Resetting Password

• Adding/Changing Contact Points (Phone/E-mail/Fax)

• Adding/Changing Address Information

• Setting General Preferences

• Changing Default Responsibility

• Changing Default Customer Account

• Setting User Homepage E-mail Subscription

• Setting User Signature for Forums

• Adding/Changing Company Information

• Viewing Administrators Information

• Mapping Technical Library Categories

• Maintaining the Home Page

• Maintaining Service Request Templates

• Creating New Templates

• Defining Template Parameters

• Defining Template Questions and Answers



10-2    Oracle iSupport Implementation and Administration Guide

• Setting Severity Thresholds for Templates

• Setting the Default Template

• Using the Save Template Feature to Create New Templates

• Renaming Existing Templates

• Disabling Templates

• Configuring Surveys

• Setting Up Oracle Scripting

• Creating Surveys in Oracle Scripting

• Assigning Survey Administrator Responsibility

• Setting Up Oracle iSupport Survey in iSurvey

• Making Surveys Available in Oracle iSupport

• Viewing Survey Results

• Configuring Call Me (Web Call Back)

• Administering Forums

• Maintaining Categories

• Maintaining Forums

• Maintaining Messages

Maintaining Users
For current information on user implementation, user roles, user responsibilities, and 
seeded user types, see the Oracle E-Business Suite CRM System Administrator's Guide.

This section includes:

• Creating Users, page 10-3

• Deleting Users, page 10-3

• Setting Effective Dates for Users, page 10-3

• Searching for Users, page 10-4

Related topics:
• User Management, page 1-12

• Changing User Profile Information, page 10-5
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Creating Users
For directions on how to set up users, see the current setup information in Setting Up 
Oracle iSupport Users, page 3-12.

Deleting Users
Use the steps below to delete users from the application.

Steps
1. Log into the Applications login page as Oracle iSupport Administrator or Primary 

User. 

2. Navigate to Administration > User.

3. Find the user whom you wish to delete. See Searching for Users, page 10-4 for 
information on finding users. 

4. Select the underlined hyperlink of the appropriate username. The Personal Profile 
page appears.

5. In the Personal Profile page, enter an end date for the user. The username 
associated with the user will expire on the date you enter.

6. Select Update. The application returns a confirmation message.

Setting Effective Dates for Users
Use the steps below to change the effective dates for users of the application.

Steps
1. Log into the Applications login page as Oracle iSupport Administrator or Primary 

User. 

2. Navigate to Administration > User.

3. Find the user whose information you wish to change. See Searching for Users, page 
10-4 for information on finding users. 

4. Select the underlined hyperlink of the appropriate username. The Personal Profile 
page appears.

5. In the Personal Profile page, enter a start date or end date for the user. The 
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username associated with the user will be activated on the start date that you enter. 
The username associated with the user will expire on the end date you enter.

6. Select Update. The application returns a confirmation message.

Searching for Users
The user search function allows you to search for users by First Name, Last Name, or 
Username. Use the following procedure to search for users.

Steps
1. Login to the Applications login as Oracle iSupport Administrator or Primary User.

2. Navigate to Administration > User.

3. In the Find User drop-down list, select username, last name or first name.

4. In the field, enter your search string. Use the percent sign (%) as a wildcard(s). You 
can use as many wildcards as you like, but you must enter at least three characters. 
See examples below.

Note: To find all users, use three percent signs in row (%%%) as the search string.

5. Select Go.

6. The application returns a list of users based on your search criteria. 

Example 1: 

Search for all users whose username begins with B:

1. Select Username from the drop-down list.

2. Enter in the field: B%%.

3. Select Go.

Example 2:

Search for all users whose last name contains an X:

4. Select Last Name from the drop-down list.

5. Enter in the field: %X%.

6. Select Go.

Example 3:
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Search for all users whose first name ends in ON:

7. Select First Name from the drop-down list.

8. Enter in the field: %ON.

9. Select Go.

Changing User Profile Information
This section provides information on changing user profile data, including:

• Changing/Resetting Password, page 10-5

• Adding/Changing Contact Points (Phone/Email/Fax), page 10-6

• Adding/Changing Address Information, page 10-7

• Setting General Preferences, page 10-8

• Changing Default Responsibility, page 10-9

• Changing Default Customer Account, page 10-10

• Setting up Home Page E-mail Subscription, page 10-11

• Setting User Signature for Forums, page 10-12

• Adding/Changing Company Information, page 10-12

• Viewing Administrator Information, page 10-13

Changing/Resetting Password
Follow the steps below to change or reset a password.

Note: These steps are for administrative users of the application. 

Steps
1. Log into the Applications login page as Oracle iSupport Administrator or Primary 

User. 

2. Navigate to Administration > User.

3. Find the user whose information you wish to change. See Searching for Users, page 
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10-4 for information on finding users. 

4. Select the underlined hyperlink of the appropriate username. The Personal Profile 
page appears.

5. In the Personal Profile page, enter the new password in the New Password and Re-
enter New Password fields.

6. Select Update. The application returns a confirmation message.

Adding/Changing Contact Points (Phone/E-mail/Fax)
Add to or change contact points (such as phone, e-mail, fax) by following the steps 
below.

Note: These steps are for administrative users of the application.

Steps
1. Log into the Applications login page as Oracle iSupport Administrator or Primary 

User.

2. Navigate to Administration > User.

3. Find the user whose information you wish to change. See Searching for Users, page 
10-4 for information on finding users. 

4. Select the underlined hyperlink of the appropriate username. The Personal Profile 
page appears.

5. Under the User Profile area, select Contact Points. The Contact Points of User page 
appears.

6. To edit an existing contact point, select the underlined hyperlink of the appropriate 
contact point. 

7. To create a new contact point, select Create.

8. You can make additions/alterations to the following:

• Communication Type - Select the method of communication; examples are 
email, phone, fax.

• Phone Line Type - Select from the drop-down list the type of phone line, if 
appropriate. Examples are office, home, mobile.

• Phone Country Code - Optionally enter the phone country code.
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• Phone Area Code - Enter phone area code.

• Phone Number - Enter the phone number, without the area code.

• Primary Contact check box - If this is to be the preferred method of contact, 
activate this box.

Note: Note: There can be a primary contact point for each 
communication type. For example, here can be a primary e-
mail address and a primary phone number.

9. When finished making changes, select Save. The application returns a confirmation 
message.

Note: You can view the active and inactive contacts in the Status 
column.

Adding/Changing Address Information
Address information for users can be changed by either the users themselves or the 
administrator users (ibu admin or primary user). 

To change company information for a group of users, see Adding/Changing Company 
Information, page 10-12.

Steps
1. Log into the Applications login page as Oracle iSupport Administrator or Primary 

User.

2. Navigate to Administration > User.

3. Find the user whose information you wish to change. See Searching for Users, page 
10-4 for information on finding users. 

4. Select the underlined hyperlink of the appropriate username. The Personal Profile 
page appears.

5. Under the User Profile area, select Addresses. 

6. To edit an existing address, select the Update icon for the appropriate address. To 
create a new address, select Create.

7. Make desired changes to the following:
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• Country - This is the country that relates to the Address field. Using the 
Address flex field supported by Oracle Receivables, the Country LOV supplies 
an appropriate international address format. Thus the specific address fields 
displayed depend on the country chosen.

The application checks if an address style is associated with the country itself. If
no style is found, then the profile option Service: Default Address Style is 
checked. If still no style is found, then the application uses the default address 
style AS_DEFAULT provided by Oracle Receivables. A user's operating unit 
and the Oracle Receivables system properties determine the default country. 
The profile option MO: Operating Unit determines the operating unit.

• Address Type - Select the type of address, such as Bill to, Ship to, and Sold-to. 

The iSupport Customer Address Type lookup determines the content of the list 
in the Address Type column.

• Address 1 - This is the first line of the address that appears on an envelope or 
mailing label. You can use this line for primary address information, such as 
street address, post office box, or apartment number.

• Address 2 - This is the second line of the address that appears on an envelope 
or mailing label. You can use this line for secondary or non-critical information, 
such as a building name or number.

• City - This is the city that relates to the Address field.

• State - This is the state that relates to the Address field.

• Postal Code - This is the postal code or zipcode that relates to the Address field.

• Primary Address check box - Select this box if this is the preferred address to 
use for this user.

Note: Note: A primary address can exist for each address type. 
For example, there can be a primary bill to and a primary ship 
to address.

8. Select Save. The application returns a confirmation message.

Setting General Preferences
Follow the steps below to change general user preferences for the application, such as 
default language, currency, and date formats.

Note: The steps below are for administrator users.
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Steps
1. Login to the Applications login as Oracle iSupport Administrator or Primary User.

2. Navigate to Administration > User. 

3. Search for the user whose information you wish to alter. See Searching for Users, 
page 10-4 for directions. 

4. Select the underlined hyperlink of the appropriate username. The Personal Profile 
page appears.

5. Navigate to Preferences. The General Preferences page appears.

6. In the General Display area, set the following as desired:

• Display Style - Select a default style sheet.

• Language - Select a default language.

• User Currency - Select a default currency.

• Date Format - Select a date format to use when entering dates.

7. In the Table Display area, set the following as desired:

• Display Rows per Page - Select the number of rows to display of any tables that
are used by the application.

• Display Blank Rows per Table - Select the number of blank rows to display in 
any updateable tables that are used by the application.

8. Select Update to save your changes.

Changing Default Responsibility
Responsibilities define application privileges, controlling the presentation of menus, 
tabs, and screens. For more information, see User Management, page 1-12.

Note: The default responsibility that is active at the time that a user logs
in to the Applications login determines which application is initially 
accessed. 

Note: These steps are for administrative users of the application.
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Steps
1. Log in to the Applications login as the Oracle iSupport Administrator or Primary 

User.

2. Navigate to Administration > User. 

3. Search for the user whose information you wish to alter. See Searching for Users, 
page 10-4 for directions. 

4. Select the underlined hyperlink of the appropriate username. The Personal Profile 
page appears.

5. Select the Responsibilities link at the bottom of the page. The Responsibilities page 
appears. 

6. If the desired responsibility is already apparent, select the radio button next to the 
default responsibility you wish to assign. 

7. If the responsibility you wish to assign as the default is not already on the page:

1. Select the underlined word, Select, to bring up the Responsibility search 
page. 

2. Select the desired responsibility from the search results, and the Responsibilities
page will re-appear with the new responsibility listed.

3. You can then select the Default radio button next to the responsibility.

8. Select Save in the Responsibilities page to save changes.

Changing Default Customer Account
Use the following procedure to change the default customer account that appears when 
a user initially logs in. 

Note: These steps are for administrative users of the application.

Steps
1. Log in to the Applications login as Oracle iSupport Administrator or Primary User.

2. Navigate to Administration > User. 

3. Search for the user whose information you wish to alter. See Searching for Users, 
page 10-4 for directions. 
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4. Select the underlined hyperlink of the appropriate username. The Personal Profile 
page appears.

5. Navigate to the Accounts link. The Accounts page appears.

6. Select the check box next to the desired default account.

7. Select Save. The application returns a confirmation message.

Setting User Homepage E-mail Subscription
Oracle iSupport allows users to receive the contents of their home page in an e-mail. 
This is useful when users are unable to log in to Oracle iSupport for whatever reason. 
This feature can be enabled by either the user himself or an administrator. Follow the 
administrator steps below to enable or disable this feature.

Prerequisites
• A valid e-mail account has been recorded for the user who will receive the home 

page e-mails (see Adding/Changing Contact Points, page 10-6).

• Oracle Workflow has been set up and configured.

• To populate the tables required for this process, run the concurrent programs 
Notification Mailer and IBU_PRODUCT_EMGEN.

Steps
1. Login to the Applications login as Oracle iSupport Administrator or Primary User.

2. Navigate to Administration > User. 

3. Search for the user whose information you wish to alter. See Searching for Users, 
page 10-4 for directions.

4. Select the underlined hyperlink of the username. The Personal Profile page appears.

5. In the menu to the left, select Support. The Support page appears.

6. In the Email Management: Subscription Content area, a list of available home page 
content appears. From the list, select the desired home page content.

7. In the Delivery Frequency region, choose the desired frequency for e-mails.

8. From the Email Delivery Language LOV, select a language.
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9. In the Contact Point region, select either HTML or Text as the type of e-mail. 

10. Select Update Subscriptions. The application returns a confirmation message.

Setting User Signature for Forums
The forums signature is the text that appears automatically when a user posts a message
to a forum. Use the following steps to alter or add the Forums signature for a user.

Note: The steps in this section are administrator steps.

Steps
1. Login to the Applications login as Oracle iSupport Administrator.

2. Navigate to Administration > User. 

3. Search for the user whose information you wish to alter. See Searching for Users, 
page 10-4 for directions.

4. Select the underlined hyperlink of the username. The Personal Profile page appears.

5. In the menu to the left, select Support. The Support page appears.

6. In the User Signature for Forums field, enter any text that you wish to display at the
end of this user's forums postings.

7. Select Update. The application returns a confirmation message.

Adding/Changing Company Information
Modify company information by following the steps below. A user must be classified as
a B2B (business user) user for company information to display. 

Note: Note: When you update company information for any user of a 
company, the company information for all users associated with this 
company also changes. 

Steps
1. Log in to the Applications login as Oracle iSupport Administrator or Primary User.

2. Navigate to Administration > User. 

3. Search for a user within the company whose information you wish to alter. See 
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Searching for Users, page 10-4 for directions.

4. Select the underlined hyperlink of the username. The Personal Profile page appears.

5. From the Company Profile menu on the left, select Information. The Company 
Information page appears.

6. In the Company Information page, you can make changes to the following:

• Internal/External radio buttons - Select whether this company is an internal or 
external company.

• Name of company - Enter or change the name of the company.

• SIC - Select the flashlight icon to select from a LOV of Standard Industrial 
Codes or North American Industrial Classification System (NAICS).

• Duns Number - Record the DUNS number. The Dun & Bradstreet D-U-N-S 
Number is a unique nine-digit identification code, which is used to reference 
single business entities, while linking corporate family groups together. 

•  Number of Employees - Record the number of employees of the company.

• Customer Since - Record the date the company first became a customer.

• Current Revenue - Record the company's current revenue.

• Projected Revenue - Record the company's projected revenue.

• Analysis Year - Record the year the revenue was analyzed.

• Fiscal Year End - Record the date of the company's fiscal year end.

• Fiscal Code - Record the fiscal code of the company.

• Tax Reference Number - Record the tax reference number of the company.

7. Select Update to save changes.

Viewing Administrators Information
Use the steps below to view a list of administrators for the application. Generally, these 
are users who are Oracle iSupport Administrators or Primary Users.

Steps
1. Log in to the Applications login as Oracle iSupport Administrator.
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2. Navigate to Administration. Select the Profile button at the top of the page. 

3. Under Company Information on the left, select Administrators. A list of application 
administrators appears. For B2B users, the administrators are the primary users for 
the organization to which the B2B user belongs.

4. To view available contact information, select the username hyperlink of the 
administrator.

Mapping Technical Library Categories
You can display different Technical Library content to different sets of users like 
business users, individual users, employees, and guest users. This is achieved by 
associating a top-level category for Technical Library with multiple responsibilities and 
displaying to users the MES category linked to the responsibility with which they are 
currently logged in. With the Category Administration setup page you can select an 
MES category and assign it to a responsibility. The Technical Library page and the 
technical library bin then show the category that corresponds to the current 
responsibility of a user. Use this procedure to make the association.

Steps:
1. Log in to the Applications login as Oracle iSupport Administrator.

2. Navigate to Administration > Support > Technical Library. The Category 
Administration page appears.

3. Use the Category LOV to associate a responsibility name with a category. A 
category can be associated with multiple responsibilities.

4. Select Update to save your assignments.

Maintaining the Home Page
This section provides information on the following tasks:

• Using the Homepage administration pages

• Enabling Home Page E-mails

In the Homepage administration pages you can view all the contents defined for the 
home page and perform the following actions: 

• Design home page content and layout

• Edit content properties
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• Add content

• Add MES content

• Delete content

For details on these topics, refer to Setting Up Oracle iSupport Homepage, page 3-32.

Maintaining Service Request Templates
Service Request templates provide a structured, formatted method of gathering 
information during Service Request creation. 

Oracle TeleService, which now includes what was previously known as Oracle Support,
provides the bulk of service request functionality in Oracle iSupport. For any service 
request functionality in Oracle iSupport, you must do a full installation of Oracle 
TeleService/Support. 

For more information on Oracle TeleService, see the latest versions of the following 
documentation:

• Oracle TeleService Implementation and User Guide

• Section Service Requests, page 1-4 in this guide

• Integrating Oracle iSupport with Service Request chapter of this guide

This topic area includes:

• Creating New Templates, page 10-15

• Defining Template Parameters, page 10-16

• Defining Questions/Answers on Templates, page 10-18

• Setting Severity Thresholds for Templates, page 10-19

• Setting the Default Template, page 10-21

• Using the Save Template Feature, page 10-21

• Renaming Existing Templates, page 10-22

• Disabling Templates, page 10-22

Creating New Templates
Use the steps below to begin creating a new service request template.
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Prerequisites
None

Steps
1. Log in to the Applications login asOracle iSupportAdministrator.

2. Navigate to Administration > Support > Request Template.

3. Select Create Template.

4. In the Name field, enter a meaningful name for the new template.

5. Optionally, select the calendar icon next to the Effective Start Date field and choose 
an effective start date for the template. Do the same for Effective End Date.

Note: It is recommended that you use the Effective End Date function to disable 
existing templates as opposed to deleting them.

6. Select Continue.

7. Select Update.

8. Select Back.

9. Select the hyperlink of the template name and continue creating the template by:

• Defining Template Parameters, page 10-16

• Defining Questions/Answers on Templates, page 10-18

• Setting Severity Thresholds for Templates, page 10-19

Defining Template Parameters
You can associate products, urgencies, problem codes, and requests as parameters for a 
service request template. Use the steps below to associate these parameters with a 
template.

Prerequisites
• Oracle Support has been installed and configured. See the Oracle TeleService 

Implementation and User Guide for details.

• A service request template has been created in Oracle iSupport. 
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• Products have been set up in Oracle Inventory.

Steps
1. Log in to the Applications login asOracle iSupportAdministrator. 

2. Navigate to Administration > Support > Request Template. The Service Request 
Template page appears with a list of templates.

3. Select the underlined hyperlink of the appropriate template. The Template Details 
page appears.

4. In the Template Information region, select Template Parameters. The Template 
Parameters page appears.

5. In the Products region, select Add Products. The Available Products page appears.

6. Select the Add check box for each associated product that you want to add, and 
select Add. The page refreshes itself without the added products.

7. Select Back. The Template Parameters page appears showing the added products.

8. In the Urgencies region, select Add Urgencies. The Available Urgencies page 
appears.

9. Select the Add check box for each associated urgency that you want to add, and 
select Add. The page refreshes itself without the added urgencies.

10. Select Back. The Template Parameters page appears showing the added urgencies.

11. In the Problem Codes region, select Add Problem Codes. The Available Problem 
page appears.

12. Select the Add check box for each associated problem that you want to add, and 
select Add. The page refreshes itself without the added problems.

13. Select Back. The Template Parameters page appears showing the added problems.

14. In the Request Types region, select Add Request Types. The Available Request page
appears.

15. Select the Add check box for each associated request that you want to add, and 
select Add. The page refreshes itself without the added requests.

16. Select Back. The Template Parameters page appears showing the added requests.
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Defining Template Questions and Answers
Use the steps below to define questions and answers for a template. 

Prerequisites
• Oracle Support has been installed and configured. See the Oracle TeleService 

Implementation and User Guide for details.

• A service request template has been created in Oracle iSupport. 

Steps
1. Log in to the Applications login asOracle iSupportAdministrator. 

2. Navigate to Administration > Support > Request Template. The Service Request 
Template page appears with a list of templates.

3. Select the underlined hyperlink of the appropriate template. 

The Template Details page for the template appears. The Template Details region 
lists any questions associated with the template. If none is associated, then an 
empty list appears.

4. In the Template Details region, select one of these two options:

• Create Individual Note for Each Question

• Create a Single Note for all the Questions

Creating an individual note for each question has the advantage that the 
application can pass responses to Knowledge Management that have 
meaningful search criteria.

5. Select Add Question. The Define Question and Answer page appears.

6. In the Question region, enter a question for the template in the empty Question text 
box.

7. Select Answer Type: You have two options for answer types:

• Choice - This is a pick-list type answer and can be used in scoring. Scoring is 
used for determining the severity of the service request. 

• Free Text - This is a free-form answer. You can specify the number of lines 
allowed for the answer (see below). This answer cannot be used in scoring.
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8. Select Continue. The application updates the page.

9. To enforce that the user is required to answer the question, select Yes in the 
Response Required field. Mandatory questions force the user to provide an answer 
before the application will continue creating the request. To make the question 
optional for the end user, select No.

10. If your question requires a choice-type answer, then select (yes/no) whether you 
want the answer to be used in the severity scoring (see Set Severity Thresholds 
below). If you choose yes, then answers to the question will be weighted from 0 
through 10 during the answer setup (see Set up Answers for a Choice Question 
below).

11. In the Answer region, enter an answer for the question in an empty Value text box. 
The answers you set up here become an LOV for the end user, and the answer you 
select as a default will appear as the default answer on the user side.

12. For each choice-type answer, set a score of 0 through 10. 

After the end user answers the questions, the application will add up these values, 
and the final score will be used to determine the severity of the service request, 
based on the severity thresholds you set (see Defining Severity Thresholds, below). 

13. Select Add. The choice is added to the list of answers.

14. To sort the answers, select Sort and use the up and down arrows in the Sort 
Answers page to arrange the questions in the desired order for the LOV. Select 
Update.

15. Select Back to return to the Define Question and Answer page.

16. For text-type questions, you do not need to determine answers. Instead, in the 
Answer region, select the number of rows that the user is limited to when typing in 
the answer. 

17. Select Back. The Template Details page appears.

18. To sort the questions, select Sort and use the up and down arrows in the Sort 
Questions page to arrange the questions in the desired order. Select Back to return 
to the Template Details page.

19. To edit a question, select the hyperlink of the question that you wish to modify.

Setting Severity Thresholds for Templates
Use the following procedure to define severity thresholds for a template.
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Prerequisites
• Oracle Support has been installed and configured, including the setup of severities. 

See the Oracle TeleService Implementation and User Guide for details.

• A service request template has been created in Oracle iSupport. 

For more information, see:

• Oracle iSupport Implementation and Administration Guide: Integrating Oracle iSupport 
with Service Request

• Oracle TeleService documentation and courseware

Steps
1. Log in to the Applications login asthe Oracle iSupport Administrator. 

2. Navigate to Administration > Support > Request Template. The Service Request 
Template page appears with a list of templates.

3. Select the underlined hyperlink of the appropriate template. The Template Details 
page appears.

4. Use the Set Severity region to set severity thresholds for the template. The names of 
the severities listed on this page (for example, high, medium, and low) come from 
the severity setups in Oracle TeleService.

The application determines the sum score from all of the scorable answers assigned 
to answers in the Defining Template Questions and Answers, page 10-18 section 
and compares it to the total possible. The application then determines the difference
as a percentage and assigns the appropriate threshold. See the example below for 
clarification.

You do not need to define thresholds for all of your severities, only the ones you 
wish to use. You can select one of the severities as a default and all templates will 
use that severity. The application ignores severities for which you do not define 
thresholds.

Sample scenario related to this setup

You have defined a new template with two questions on it. Each question has three 
possible answers, for a total of six answers defined by the administrator and two 
possible answers for the user. The user can select only one answer per question. 

In this example, you have set up each of the question's three answers with identical 
scores: 1, 4, and 5. Because the user can select only one answer per question, the 
highest possible score in this scenario is 10 (The highest score for each question is 5, 
and 5 plus 5 is 10). The user cannot see these scores. 
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The user selects an answer from the first question with a score of 1. He selects an 
answer from the second question with a score of 4. Thus, the total of the two 
answers is 5. The application find the score of 5 and compares it against the total 
possible answer points, which in this case is 10. From there, the application 
formulates a percentage of answers scored (5) verses a total possible score (10). The 
percentage in this case is 50%. Then, based on the severity thresholds you set (see 
the example below), the application determines the severity, such as high, medium, 
or low. Here are the thresholds set for this example:

High - Start Threshold = 61%; End Threshold = 100%

Medium - Start Threshold = 31%; End Threshold = 60%

Low - Start Threshold = 0%; End Threshold = 30%

5. When you have finished entering severity thresholds, select Update.

Setting the Default Template
Oracle iSupport uses the Default Template that you set up when users select a 
parameter combination for which a template does not exist. 

Only one default template is allowed.

Prerequisites
• Oracle Support has been installed and configured. See the Oracle TeleService 

Implementation and User Guide for details.

• A Service Request template has been created in Oracle iSupport. 

Steps
1. Set up a new template with general questions. The questions should be "catch all" 

type questions related to service requests. Use the following procedure to set the 
default template.

2. In the list of templates, in the Set as Default column, select the radio button next to 
the appropriate template.

3. Select Update.

Using the Save Template Feature to Create New Templates
The Save Template feature of service request templates is helpful when you already 
have a template set up and wish to use it as a model or prototype when creating a new 
template. Use the following procedure to use the Save Template feature.
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Steps
1. At the Applications login, log in as the Oracle iSupport Administrator.

2. Navigate to Administration > Support > Request Template. The Service Request 
Template page appears with a list of templates.

3. Select the underlined hyperlink of the model template. The Template Details page 
appears.

4. In the Save Template region, enter a value for New Template Name.

5. Select Save Template.

6. Select Back. The Service Request Template page appears and shows the new 
template in the list of templates.

7. Edit the template as desired.

Renaming Existing Templates
Follow the steps below to rename a service request template.

Steps
1. At the Applications login, log in as Oracle iSupport Administrator.

2. Navigate to Administration > Support > Request Template.

3. Select a template. The Template Details page appears.

4. In the Name field, enter the new name for the template.

5. Select Update.

Disabling Templates
Follow these steps to disable a template.

Steps
1. Log in to the Applications login asOracle iSupportAdministrator. 

2. Navigate to Administration > Support > Request Template. The Service Request 
Template page appears with a list of templates.
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3. Select the underlined hyperlink of the template that you want to delete or disable. 
The Template Details page appears.

4. Select the calendar icon next to the Effective End Date field and choose an effective 
end date for the template. 

It is recommended that you end-date a template to disable it, rather than remove it 
by using the Remove check box on the Service Request Template page.

5. Select Update to save changes.

Configuring Surveys
The Surveys functionality of Oracle iSupport allows you to survey user groups on 
topics of your choice. Surveys require you to set up Oracle Scripting. Follow the steps 
below to implement Surveys.

Setting Up Oracle Scripting
Oracle Scripting presents scripted messages that guide interaction center agents 
through their interactions with customers. It has a survey component called iSurvey. 
Through the Scripting iSurvey component, enterprises can create, manage, and report 
on surveys to evaluate customer satisfaction, gain customer input on new initiatives, 
and gain other feedback from survey respondents. Oracle Scripting is one application 
module of Oracle's Interaction Center suite of applications.

Oracle Scripting consists of 3 components: 

• Scripting Engine - The simple graphical user interface that displays a script at an 
agent's workstation via a browser or within an Oracle Form. 

• Scripting Author - A script and survey development studio which is downloaded to
a user's workstation. Scripting Author uses visual layouts to allow a script 
developer to create, modify, and deploy scripts for agents at the interaction center. 

• Survey Component - An HTML user interface providing web-based surveys that 
can be deployed on the Internet, via email messages or direct links on enterprise 
web sites. The survey component contains all the tools needed to manage lists, set 
up survey campaigns, and provide result information. 

Set up Oracle Scripting according to the Oracle Scripting Implementation Guide. 

Creating Surveys in Oracle Scripting
Oracle iSupport uses only the non-list-based types of surveys. 

Create scripts in Oracle Scripting according to the steps and guidelines documented in 
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the Oracle Scripting Implementation Guide and Oracle Scripting User Guide. 

Assigning Survey Administrator Responsibility
Assign the responsibility, Survey Administrator, to either an existing Oracle iSupport 
user (such as the Oracle iSupport Administrator), or to a special user created just for 
this purpose. See the Setting up the Oracle iSupport Users topic in the Implementation 
Tasks chapter of the Oracle iSupport Implementation and Administration Guide for details 
on how to set up users.

Steps
1. Log into Oracle iSupport as the Oracle iSupport Administrator.

2. Select Administration > User. The All Users page appears.

3. Search for the user who will be the Survey Administrator, whether this is you as the
Oracle iSupport Administrator or another user. Select the underlined hyperlink of 
the username.

4. In the User Details page, select Responsibilities. 

5. In the Responsibilities page, select the underlined hyperlink of the word Select. A 
list of responsibilities appears. If necessary, search for the Survey Administrator 
responsibility. After you have found it, select the Survey Administrator 
responsibility. 

Do not set the Survey Administrator responsibility as the default unless you wish to
force the user to log into iSurvey the next time the user logs in to the HTML 
Applications login.

6. Save your work.

Setting Up Oracle iSupport Survey in iSurvey
Surveys have three parts:

• Header - this is the header area of the survey

• Error - this is the error page that is displayed when an error occurs during the 
survey

• Final - this is the final page displayed to the user after the survey is complete

All of these parts you create as JSPs in the steps outlined in this section.

Follow the steps below to set up Surveys in the Oracle iSurvey module.
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Steps
1. Log in to the Applications login page as the user with Survey Administrator 

responsibility. 

If you are already in Oracle iSupport, then you can change current responsibility: 
Navigate to Profile > Preferences and select the Survey Administrator responsibility
from the Current Responsibility LOV on the General Preferences page. Select 
Update.

2. Navigate to Survey Campaign > Survey Resources. In the Resources page, select 
Create.

3. In the Create Resource page, create a Header page, a Final page, and an Error page 
according to the steps and guidelines documented in the Oracle Scripting User Guide,
with the following exception:

• Be sure to enter ibupfbgl.jsp in the File Name field for the Final page file. This is
the Oracle iSupport JSP that lists the surveys that you set up.

4. Navigate to Survey Campaign > Survey Campaign. Select the Create button. 

5. In the Create Survey page, select the appropriate script using the Go button and the 
% as a wildcard.

6. Continue creating the survey by following the steps and guidelines documented in 
the Oracle Scripting User Guide, with the following exception:

• For the Final page field, using the Go button, select the resource, Oracle 
iSupport JSP (ibupfbgl.jsp), created in step 3 above.

7. Select Create to save the survey.

8. Navigate to Survey Campaign > Cycle and set up a cycle to associate with the 
survey by following the steps and guidelines documented in the Oracle Scripting 
User Guide.

9. Navigate to Survey Campaign > Deployment and create a deployment for the 
survey by following the steps and guidelines documented in the Oracle Scripting 
User Guide.

10. Deploy the survey by clicking the Deploy button. Oracle iSupport displays only 
surveys that have the status of Active and whose dates fall within current dates. See
the Oracle Scripting User Guide for additional information.
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Making Surveys Available in Oracle iSupport
After you have created the survey in iSurvey, you need to select it in Oracle iSupport 
and then associate a usergroup(s) with the survey. Follow the steps below to activate 
the survey in Oracle iSupport. This section contains three parts:

• Set up usergroup.

• Run Usergroup Creation concurrent program.

• Select the survey and usergroup in Oracle iSupport.

Set Up a Usergroup
Follow the steps below to set up a usergroup to associate with any surveys that you 
have created in iSurvey. Only the usernames that are associated with the usergroup(s) 
selected will be able to view the surveys that you have created.

Steps
1. Log in to the Applications login page as the Oracle iSupport Administrator. 

2. Navigate to Administration > Support > Usergroup > Create.

The User Group Detail page appears.

3. Enter a unique name for the usergroup in the Name field.

4. Select a effective date for the usergroup using the Start Date calendar icon.

5. Select an ending date for the usergroup using the End Date calendar icon. 

You can also end date a usergroup to disable it.

6. Enter a brief description for the usergroup in the Description text field.

7. In the SQL statement field, enter an appropriate SQL statement.

Sample SQL Usergroup Select Statement

select EMPLOYEE_ID from FND_USER where EMPLOYEE_ID > 0

This select statement retrieves all employee IDs greater than zero (that is, all 
employees) from the fnd_user table.

Note: Usergroup select statements support PARTY_ID and EMPLOYEE_ID, but not
USER_ID.

8. Select Save.
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Run Usergroup Creation Concurrent Program 
To populate necessary tables in the database, run the concurrent program Usergroup 
Creation Program, whose short name is IBUUG. This concurrent program must be run 
each time that you update or add users to a usergroup.

Select Survey and Usergroup to Associate with Survey
Use the following steps to associate the usergroups with surveys that you have created 
in iSurvey. Only members of the usergroups are able to view and respond to surveys.

Steps
1. Log into Oracle iSupport as the Oracle iSupport Administrator. 

2. Navigate to Administration > Support > Survey. 

The Survey Administration page appears with a list of selected survey deployment 
names and rows with blank fields for adding names. 

3. To select a new survey deployment name, select the flashlight icon in a blank row to
open a page with which you can pick a survey deployment name. 

After making your selection, you are returned to the Survey Administration page, 
and the new survey deployment name appears in the formerly blank row.

4. To associate a user group with a survey deployment, select the Associate link for 
that survey deployment name. 

The User Groups Associated with the Survey Deployment page appears with a list 
of associated groups and rows with blank fields for adding groups.

5. To add another user group name to the list of names, select the flashlight icon in a 
blank row to open the Search User Group page.

6. Use the page to search for a subset of user group names, and then select from the 
resulting set of displayed names. 

After making your selection, you are returned to the User Groups Associated with 
the Survey Deployment page, and the new user group name appears in the 
formerly blank row.

7. Select any user group that you want to remove from the association by selecting its 
Remove check box.

8. Select Save to make your changes to the list of user group names.

9. Select Back to return to the Survey Administration page.
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10. Select any survey deployment name that you want to remove from the page by 
selecting its Remove check box.

11. Select Save to save your changes.

12. To respond to a created survey, log into Oracle iSupport as a member of a user 
group associated with a survey, and navigate to Support > Survey.

Viewing Survey Results
iSurvey allows you to view the results of your surveys. The following steps can assist 
you in retrieving survey results. For complete information, refer to the Oracle Scripting 
Implementation Guide and the Oracle Scripting User Guide.

Steps
1. Log in to iSurvey as a user with Survey Administrator responsibility. 

From Oracle iSupport, to switch current responsibility, select the Profile > 
Preferences menu to switch current responsibility to the Survey Administrator 
responsibility. Select the Update button to save changes.

2. In iSurvey, navigate to Response > Survey Campaign. 

The Survey Campaign Responses page appears.

3. Follow the steps and guidelines documented in the Oracle Scripting User Guide to 
view and manage your survey results.

Configuring Call Me (Web Call Back)
The Web Call-Back (Call Me) feature allows users to submit a call-back request in 
Oracle iSupport. The web call-back requires implementation of the following:

• Oracle Interaction Center (formerly Call Center Technology - CCT) suite

• Oracle Universal Work Queue (UWQ)

• Oracle Customer Care portion of Oracle TeleService

• Oracle CRM Foundation, Notes module

The purchase of call center hardware also is required.

This section provides an overview of the call-back functionality in Oracle iSupport. For 
more information, refer to the Oracle Interaction Center documentation.

Outside of Oracle iSupport, the call routing process is essentially this: After a user 
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makes a call-back entry, Oracle iSupport sends the request to the CCT server group 
specified by the Oracle iSupport Administrator on the Oracle iSupport page. The CCT 
applications and hardware route the request to the UWQ server. The UWQ server 
decodes the customer information (the Notes module captures comments from the user)
and assigns it to the UWQ client, and the call request immediately pops up in an agent's
page in Oracle Customer Care.

There are very few setups required in Oracle iSupport after the dependencies listed 
above are installed and functioning properly. Oracle iSupport simply calls one of the 
CCT APIs to provide the list of available call center server groups that appear in the 
Oracle iSupport UI. 

Refer to Oracle CRM Interaction Center documentation for information on setting up 
the underlying products that enable the Web Call-Back functionality in Oracle iSupport.

After the CCT and UWQ applications and call center hardware are installed and 
implemented, you can use the steps below to set up Call Me in Oracle iSupport.

Steps:
1. Log into Oracle iSupport as the Oracle iSupport Administrator.

2. Navigate to Administration > Support > Call Me. 

The Call Me Administration page appears.

3. Select a call center server group from the LOV.

4. Select a default note type from the LOV.

5. Select Update to save the data. 

Administering Forums
Forums are interactive online discussion areas available to users. Forums are made up 
of categories containing forums or topic areas. 

This following ongoing activities in this section are also setup activities:

• Creating Categories

• Creating Forums

• Restricting Access to Categories or Forums

• Using Forum Moderators

For details, refer to Setting Up Oracle iSupport Forums, page 3-38.

This section also includes the following topics:
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• Maintaining Categories, page 10-30

• Maintaining Forums, page 10-31

• Maintaining Messages, page 10-34

Maintaining Categories
This section contains information on the following tasks:

• Deleting Categories, page 10-30

• Renaming Categories, page 10-30

For information on restricting access to categories (changing the status to restrict), see 
Restricting Access to Categories or Forums, page 3-39.

Deleting Categories
Use the steps below to delete a category. When you delete a category that has 
subcategories and/or forums within it, all of the associated subcategories/forums will 
also be deleted.

Steps
1. Log in to the Applications login page as the Oracle iSupport Administrator. 

2. Navigate to Administration > Forum > Category > Delete. The Remove Category 
page appears.

3. In the Choose a category to remove drop-down box, select the appropriate category.

4. Select Ok. Respond to the confirmation message.

Renaming Categories
Use the steps below to rename a category.

Steps
1. Log in to the Applications login page as the Oracle iSupport Administrator. 

2. Navigate to Administration > Forum > Category > Rename. The Rename Category 
page appears.

3. Select the category to rename from the drop-down list.
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4. Type the new name in the Enter the new name of the category field.

5. Select Modify. Respond to the confirmation message.

Maintaining Forums
This section includes instructions for common forum maintenance tasks performed by 
the Oracle iSupport Administrator, including:

• Deleting Forums, page 10-31

• Renaming Forums, page 10-31

• Moving Forums, page 10-32

• Modifying Forum Attributes, page 10-32

For information on restricting access to forums (changing status to restrict), see 
Restricting Access to Categories or Forums, page 3-39.

Deleting Forums
Use the steps below to delete a forum.

Steps
1. Log in to the Applications login page as the Oracle iSupport Administrator. 

2. Navigate to Administration > Forum > Forum > Delete. The Remove Forum page 
appears.

3. Select the forum to delete from the drop-down list.

4. Select Remove. Respond to the confirmation message.

Renaming Forums
Use the steps below to rename a forum.

Steps
1. Log in to the Applications login page as the Oracle iSupport Administrator. 

2. Navigate to Administration > Forum > Forum > Rename. The Rename Forum page 
appears.

3. In the Choose a forum to rename drop-down box, select the appropriate forum.
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4. Type a new name in the Enter new forum name text box.

5. Select Modify. Respond to the confirmation message.

Moving Forums
Use the steps below to move a forum from its current category to another category.

Steps
1. At the Applications login, log in as the Oracle iSupport Administrator or Forum 

Moderator.

2. Navigate to Administration > Forum > Forum > Move. The Move Forum page 
appears.

3. From the Choose a forum to move drop-down box, select the appropriate forum.

4. Select a destination category from the Choose its destination Category drop-down 
box.

5. Select Move. Respond to the confirmation message.

Modifying Forum Attributes
The administrator may add, modify or delete attributes to a forum in order to increase 
the organizational and searching capacities of the forum. This section includes:

• Add New Attribute, page 10-32

• Modify Existing Attribute, page 10-33

• Delete Attribute, page 10-33

Add New Attribute
Follow these steps to add an attribute.

Steps
1. At the Applications login, log in as the Oracle iSupport Administrator.

2. Navigate to Administration > Forum > Forum > Modify Attributes. The Modify 
Forum Attributes page appears.

3. Select the appropriate forum from the drop-down list.

4. Select Next. The Modify Forum Attribute page reappears. Under Attribute List, 
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select Add New Attribute. The Add Forum Attributes page appears.

5. Enter the name of the new attribute in the Header Name field.

6. Activate the Mandatory check box only if you want to require users to fill in an 
attribute when posting to the forum.

7. Enter the value of the attribute in the Header Value field. The optional header value
field will become the default value for this attribute.

8. Select Save. Respond to the confirmation message.

Modify Existing Attribute
Follow these steps to modify an existing forum attribute.

Steps
1. At the Applications login, log in as the Oracle iSupport Administrator.

2. Navigate to Administration > Forum > Forum > Modify Attributes. The Modify 
Forum Attributes page appears.

3. Select the forum whose attribute you wish to modify from the drop-down list.

4. Select Next. The Modify Forum Attribute page reappears. 

5. Select the Edit underlined link next to the appropriate attribute. 

6. Enter a new name in the Header Name field.

7. Activate the Mandatory check box only if you want to require users to fill in an 
attribute when posting to the forum.

8. Enter the value of the attribute in the Header Value field. The optional header value
field will become the default value for this attribute.

9. Select Save. Respond to the confirmation message.

Delete Attribute
Follow these steps to delete an attribute.

Steps
1. At the Applications login, log in as the Oracle iSupport Administrator.

2. Navigate to Administration > Forum > Forum > Modify Attributes. The Modify 
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Forum Attributes page appears.

3. Choose the forum whose attribute you wish to delete from the drop-down list.

4. Select Next. The Modify Forum Attribute page reappears. 

5. Select the Delete underlined link next to the appropriate attribute.

6. Respond to the confirmation message.

Maintaining Messages
This section includes information on the following forum moderator and/or application 
administrator tasks:

• Deleting Messages, page 10-34

• Moving Messages, page 10-35

• Changing the Active Status of Message Threads, page 10-35

• Changing the Distribution Status of Message Threads, page 10-36

Deleting Messages
Use the steps below to delete messages or message threads (groups of messages).

Steps
1. At the Applications login, log in as the Oracle iSupport Administrator or Forum 

Moderator.

2. Navigate to Administration > Forum > Messages. 

The Message Management page appears.

3. From the drop-down list, select the forum that contains message to be deleted.

4. Select Next. 

The Message Management page displays a list of all messages in the forum, the 
dates they were posted, and the authors' names. 

5. To expand all threads, select Expand All. To collapse all threads, select Collapse All.

6. To delete a message, select the check box next to the message and then select Delete.

7. To delete a message thread, select all of the messages in the thread and then select 
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Delete.

Moving Messages
Use the steps below to move messages from one forum to another forum.

Steps
1. At the Applications login, log in as the Oracle iSupport Administrator.

2. Navigate to Administration > Forum > Messages. 

The Message Management page appears.

3. From the drop-down list, select the forum that contains message to be moved.

4. Select Next. 

The Message Management page appears with a list of all messages, the dates they 
were posted. and the authors' names. 

5. To expand all threads, select Expand All. To collapse all threads, select Collapse All.

6. To move a message, select the check box next to the message you wish to move and 
then select Move. 

7. To move a message thread, select all of the messages in the thread and then select 
Move.

8. From the drop-down list, select the destination forum for the message and select 
Ok.

9. A confirmation page appears.

Changing the Active Status of a Message Thread
Use the steps below to change the active status of a message thread.

Steps
1. At the Applications login, log in as the Oracle iSupport Administrator or Forum 

Moderator.

2. Navigate to Administration > Forum > Messages. 

The Message Management page appears.

3. From the drop-down list, select the appropriate forum. 
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4. Select Next. 

The Message Management page appears with a list of all messages, the dates they 
were posted, and the authors' names. 

5. In the Active Status column, select either Open or Close from the drop-down list. 

Close status disables the message(s).

Changing the Distribution of a Message Thread
Use the steps below to change the distribution status of a message thread.

Steps
1. At the Applications login, log in as the Oracle iSupport Administrator or Forum 

Moderator.

2. Navigate to Administration > Forum > Messages. 

The Message Management page appears.

3. From the drop-down list, select the appropriate forum. 

4. Select Next. 

The Message Management page appears with a list of all messages, the dates they 
were posted and the authors' names. 

5. In the Distribution Column, select either Public or Internal from the drop-down list.

Public - All categories of users can see and reply to the message thread.

Internal - Only employees of the merchant and the application administrator (or 
forum moderator) can see and reply to the message thread.

6. Select Save.
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11
Overview of Oracle Marketing Encyclopedia 

System

This chapter covers the following topics:

• Introduction

• Planning your Implementation

• Prerequisites for Accessing MES

• Understanding the Access Manager

• Setting up the Privileges

• Understanding the Group Manager 

• Creating a Group

• Setting up Privilege for the Whole Group

• Understanding the Channel Manager

• Setting up Access for a Channel

• Setting up Channel Access for the User

• Setting up Channel Access for a Group

• Categories and Category Hierarchy

• Creating Categories

• Setting Up a Category Hierarchy

• Creating Content Types

• Creating Perspectives

• Creating Channels 

• Publishing to Categories or Groups

• Administering MES
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• Setting up Territories

• Setting up Workflow Time Out

• Changing the Default Values for Workflow Time Out 

• Setting up Proxy Information

• Setting up Concurrent Jobs

• Concurrent Programs as a Part of a Standard Request

• Scheduling Concurrent Programs

• Guidelines

Introduction
Oracle Marketing Encyclopedia System (MES) is a content repository management 
component of the CRM suite of applications that allows you to create, publish, and 
manage content. It also allows you to organize content in different hierarchies. 

Hierarchy of categories and channels are the means to store, organize, and distribute 
different types of content items in the MES repository. 

A hierarchy can have unlimited levels of categories. Channels are the lowest level in the
hierarchy of categories that contain published items. 

Access to the MES repository is controlled through the Access Manager. The MES 
administrator can set up access privileges for users. MES also has a concept of groups to
which access privileges can be setup. An administrator can define different groups and 
associate users to these groups. 

Depending on your access privileges, you can create categories or channels, publish 
items, and approve publishing items to a particular channel. 

Planning your Implementation
Before publishing content items and viewing these items in the MES repository, an 
administrator has to understand and complete the following steps: 

• Prerequisites for Accessing MES, page 11-3

• Setting up the Privileges, page 11-4

• Creating a Group, page 11-4

• Setting up Privilege For the Whole Group, page 11-5

• Setting up Access for a Channel, page 11-6

• Setting up Channel Access for the User , page 11-6
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• Setting up Channel Access for a Group, page 11-7

• Categories and Category Hierarchy , page 11-7

• Creating Content Types , page 11-8

• Creating Perspectives , page 11-9

• Creating Channels, page 11-9

• Setting up Territories, page 11-10

• Setting up Workflow Time Out, page 11-11

• Setting up Proxy Information, page 11-12

• Setting up Concurrent Jobs, page 11-12

Prerequisites for Accessing MES
MES is embedded as a part of other CRM applications. MES is not a stand alone 
application. See the documentation of the particular application that MES is embedded 
in for more information about accessing MES from that application. 

Note: The user logging into MES has to be associated with a resource.

Understanding the Access Manager
At the center of the MES application is the Access Manager. It is used to: 

• Create and maintain groups (Group Manager)

• Assign user and group privileges (Privilege Manager) 

• Give channel access privileges (Channel Manager) for every user that needs to 
access MES

Understanding the Privilege Manager
The MES administrator can assign privileges to users or groups of users depending on 
the operations that the users or groups would be performing. 
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Setting up the Privileges
Use this procedure to set up privileges for an MES user. When users log on, they will be
able to perform only those operations specified by the administrator.

Steps:
1. Log on to a specific application.

2. Navigate to MES > Administration > Privilege. The Privilege Manager screen 
appears.

3. Query the user or the group that you want to give access to. Give the user or group 
the desired privilege(s). The privileges that the administrator can assign are:

• Administrative privileges 

• Publishing content

• Approving content

• Setting up a Channel (Create, Update, Delete, View Channel)

• Setting up a Category (Create, Update, Delete, View Category)

• Publishing to a Territory.

Understanding the Group Manager 
A group comprises of one or more users. A published document or a message may be 
distributed to many users. Additionally, groups may contain different types of users, 
that is, users who have different levels of security or privileges.

Creating a Group
Use this procedure to create a group for a MES user.

Steps:
1. Log on to a specific application.

2. Navigate to MES > Administration > Group. 

3. Add a group by entering a group name
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4. Click Update. 

5. Click View Member List

The Edit Group Members for <Group Name> screen appears.

6. You can either query the users that are a part of this group or add new group 
members.

Setting up Privilege for the Whole Group
The MES administrator can setup common privileges for all the users in a particular 
group. 

Steps:
1.  Log on to a specific application

2.  Navigate to MES > Administration > Group.

3.  Query the group that you want to assign the privilege to.

4.  Give the group the desired privilege. The privileges that an administrator can 
assign are:.

• Administrative 

• Publishing Content 

• Approving Content 

• Setting up a Channel (Create, Update, Delete, Channel)

• Setting up a Category (Create, Update, Delete, Category)

• Publishing to a Territory

Note: When a group is created through the MES user interface, a group 
channel is implicitly created for it with the same group name. Users can
publish to a group, by publishing to a group channel. Since multiple 
users can be associated to a group, this is a means of distributing 
documents to more than one user. If a group is created externally, for 
example, through a Resource Manager, no group channel is 
automatically created.
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Understanding the Channel Manager
The MES administrator may create channels and control the access over these channels. 
Channels have View, Update, and Delete privileges. An administrator can assign these 
privileges to either a channel, a user, or a group.

Setting up Access for a Channel
Use this procedure to set up access for a channel.

Steps:
1. Log on to a specific application.

2. Navigate to MES > Administration > Channel Access. The Channel Access Manager 
screen appears.

3. If you know the channel name, enter it and click Setup Access for This Channel 
button or leave it blank and click Setup Access for This Channel button. A list of 
all the channels in the system appears.

4. Select a channel name from the list and click Setup Access for Channel button.

5. Query the user or the group to whom you want to give privilege for this channel.

6. Give the group or user the desired privilege. The privileges that an administrator 
can assign are:

• Delete: delete this channel 

• Update: update contents of this channel

• View: view the channel

• Approve content: approve content for this channel

Setting up Channel Access for the User
Use this procedure to set up channel access for the user.

1. Log on to a specific application.

2. Navigate to MES > Administration > Channel Access.

3. If you know the user name, enter it and click Setup Access for this User button or 
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leave it blank and click Setup Access for this User button. A list of users appears.

4. Select the user name from the list and click Setup Access for User button.

5. Query the channel to which you want to give privilege for this user.

6. Give the channel the desired privilege. The privileges that the administrator can 
assign are:

• Delete: delete this channel

• Update: update contents of this channel

• View: view the Channel 

• Approve Content: approve content for this channel

Setting up Channel Access for a Group
Use this procedure to set up channel access for a group.

1. Log on to a specific application.

2. Navigate to MES > Administration > Channel Access.

3. If you know the group name, enter it and click Setup Access for this Group button 
or leave it blank and click Setup Access for this Group button. A list of group 
names appears.

4. Select the group name from the list and click Setup Access for Group button.

5. Query the channel to which you want to give privilege for this group.

6. Give the channel the desired privilege. The privileges that the administrator can 
assign are:

• Delete: delete this channel

• Update: update contents of this channel

• View: view the Channel 

• Approve Content: approve content for this channel

Categories and Category Hierarchy
Categories in Oracle Marketing Encyclopedia System are a means to store, organize, 
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and distribute different types of content items in the MES repository e.g., Company 
News, Marketing, Sales etc. 

You can view the different categories that are available from this screen. The MES 
administrator has to create categories and setup category hierarchies based on how it 
will be used by MES users. Administrator will have permissions to setup categories and
category hierarchies.

Creating Categories
Use this procedure to create categories.

Steps:
1. Log on to a specific application.

2. Navigate to Administration > MES > Categories.

3. Add or update the category information.

Setting Up a Category Hierarchy
Use this procedure to set up a category hierarchy.

Steps:
1. Log on to a specific application.

2. Navigate to Administration > MES > CategoriesManager. 

This page allows an administrator to define the parent categories of each category. 
If the parent category is set to None, then this category becomes the root of a 
hierarchy. 

Creating Content Types
Content type is an attribute assigned to all content. Content types allow you to refine 
the definition of content, thereby creating attributes which channels can receive. There 
are some seeded content types which will be provided. An administrator will have 
permissions to create new content types or modify/delete the existing content types.

Steps:
1. Log on to a specific application.

2. Navigate to MES >Administration > Content Type.
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3. Add or update the content type information.

Creating Perspectives
Perspectives are attributes which can be assigned to all content. Perspectives allow you 
to refine the definition of content and create attributes that the channels can receive. 
Administrators will have permissions to create and maintain perspectives. 

Steps:
1. Log on to a specific application.

2. Navigate to MES >Administration > Content Perspective.

3. Add or update the perspectives information.

Creating Channels 
Channels are the lowest level in the hierarchy of categories that contain published 
items. The My Channels page displays all the categories and channels to which you 
have subscribed.

Channels are used by MES to distribute content items to users and to classify content in 
MES repository. An Administrator will have permissions to create new channels. The 
administrator can also optionally define if permission is needed for subscribing to or 
publishing content to the channel being created and the group of users who are to be 
the approvers for those privileges.

Note: While defining a channel, you can optionally define content 
types, perspectives, item types, authors, and key words. These 
attributes are used by the matching engine to identify if any published 
item can implicitly be pushed into this channel by mapping these 
attribute values with the item attribute values. You can also indicate if 
an approval process is needed for publishing and subscribing to this 
channel. If approval is needed, and the user wants to change the default
approvers, then the user can select the primary and secondary 
approvers. 

Steps:
1. Log on to a specific application.

2. Navigate to Administration > MES > Create Channel. Each channel has a parent, 
which is either a category or a subcategory. 
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3. Enter information in the required fields. 

Publishing to Categories or Groups
You can publish an item type of a file, URL, or a message to various categories or 
groups. 

Navigation:Administration > MES > Publish.

Notes:

• Effective Start Date:The content will not be visible through the category hierarchy 
before the Effective Start Date. 

• Channels section: You can move a value from the Available table to the Selected 
table. The item gets published to the selected channels. If publishing to any of those 
channels requires approval, then the appropriate work flow is started. 

• Groups section: Move a value from the Available table to the Selected table. The 
item is published to the selected group(s) and appears on the My Channels page.

Administering MES
You can perform all the administrative tasks associated with Oracle Marketing 
Encyclopaedia System from this tab.

Navigation: Administration > MES > Administration

Notes

• Content Type: Used to create and manage content types for published items. 

• Category Manager: Used to create and manage new categories. 

• Hierarchy Manager: Used to establish hierarchical relationship among categories. 

• Content Perspective: Used to create and manage perspectives for published items. 

• Create Channel: Used to create and assign properties to new channels.

Setting up Territories
Users can belong to different territories. Whenever any content item is published, the 
publisher can optionally specify to which territories the item should be published. For 
setting up territories, see the Oracle CRM Foundation Implementation Guide.
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Setting up Workflow Time Out
MES administrators have to set up the Time out Workflow definitions, which direct the 
workflow engine the time that an item that needs approval has to wait in an approver's 
inbox. If the approver does not respond within the configured time, then the workflow 
engine performs the next action defined in the workflow process. 

Changing the Default Values for Workflow Time Out 
Use the workflow builder to change the time out value for any node in the work flow 
time out process. 

Steps:
1. Start the workflow builder. 

2. Connect to the application database. 

3. In Show Item Types screen, move MES Approvals from the Hidden section to the 
visible section. 

4. Under MES Approvals > Processes, you can see the following four processes: 

• Content Approval Process 

• Subscription Approval Process 

• Notify Approver- Publishing

• Notify Approver- Subscription

Note: Content Approval Process uses Notify Approver - Publishing
and Subscription Approval Process uses Notify Approver - 
Subscription.

5. To change the default time out values, select the corresponding process. For 
example, if you want to change time out duration in Content Approval Process, 
double click Notify Approver - Publishing. To change time out values in 
Subscription Approval Process, double click Notify Approver - Subscription. 
Depending on the selection made, either the Notify Approver - Publishing or Notify
Approver - Subscription screen appears.

6. Select and double click the Notification which has a prefix, Publishing Approval 
Notification... in its display name. The Navigator Control properties screen 
appears.
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7. Select the Node tab. The Node tab has a Time out section that you can modify.

8. Modify the Time out section.

Setting up Proxy Information

Intermedia Index
If your application users will publish items of URL type, then you have to make sure 
that the intermedia indexes are properly generated. Proxy information is needed by 
Intermedia index for URL type item while regenerating the index to extract meta data 
information of the URL in the item. If the proxy information is not correctly setup, then 
MES will not be able to search the repository for URL type items because index 
regeneration would have failed on these items. 

To setup proxy information, run $JTF_TOP/patch/115/sql/jtfiimt.sql using the following 
command. 
sqlplus <apps-user>/<apps-password> @$JTF_ TOP/patch/115/sql/jtfiimt.sql
<jtf-user> <jtf-password> <proxy_ server_name:port> 
<no_proxy_domain_name[,no_proxy_domain_name]>

Example
For Example:

sqlplus apps/apps @$JTF_TOP/patch/115/sql/jtfiimt.sql jtf jtf "www-proxy.us.oracle.
com:80" "us.oracle.com" 

It will set up the intermedia media preference object. Once the above script is run 
successfully, run the following command to create the intermedia index. 
sqlplus <apps-user>/<apps-password> @$JTF_TOP/patch/115/sql/jtfiaibu.sql
<jtf-user> <jtf-password>

Example
For Example:

sqlplus apps/apps @$JTF_TOP/patch/115/sql/jtfiaibut.sql jtf jtf 

Setting up Concurrent Jobs
The MES administrator has to setup the concurrent jobs and the frequency at which 
they should run. MES provides context search on items stored in the MES repository. 
For the search functionality to work, there are some concurrent jobs that have to be 
configured in MES to perform InterMedia index generation for all the published items 
that are new. MES uses Oracle interMedia search functionality to do content level 
search. If this concurrent job is not run, then all the published items that are new cannot
be searched through the Search user interface. 

MES Intermedia Sync and Optimization Operation configures intermedia search on 
channel name and channel description. 
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The Rebuild Help Search Index Concurrent Program configures intermedia search on 
item name, description, URL string, and text message. 

There are two types of concurrent programs bundled with MES. To configure 
InterMedia search, the following concurrent programs have to be run: 

• MES InterMedia Index Sync Operation/JTF InterMedia Sync Operation

The more frequently you run the Sync Concurrent Program, the faster your newly - 
reindexed text will be available for your searches. However, the more frequently 
the indexes are synchronized, slower the query performance due to fragmented 
indexes.

Note: You should run the concurrent program based on how 
quickly you want the new or updated information made available 
to your searchers. This depends on how often your customer 
publishes an item. If the load is low, you can run the concurrent 
program as quickly as possible. If the load is heavy, run the 
concurrent program every two to three hours.

• MES InterMedia Index Optimizing Operation/JTF Item Intermedia Optimizing 
Operation

This concurrent program defragments the intermedia indexes (that were 
fragmented by the sync operation). Running this concurrent program will take a 
couple of hours and it should be run once every week, when there is less traffic in 
the system. 

For MES InterMedia Index Optimizing Operation and JTF Item InterMedia Optimizing 
Operation, there are additional parameters that need to be run: 

1. p_optimize_level: There are two types of optimization levels: fast optimization and 
full optimization.

• Fast Optimization: deals only with fragmented rows. Fast optimization cannot 
be limited by time and it often takes a long time to complete, if it is being run 
for the first time on a badly fragmented index. 

• Full Optimization: glues rows back together in the same manner as fast 
optimization, but it also removes unrequired information related to deleted 
rows. It takes longer to run than fast optimization. 

2. p_runtime: While running the optimization at full level, you can specify the time 
duration. This implies that it can be limited to quite times of the day (or week) for 
your application and the table can be optimized in stages. Many customers 
therefore prefer to always use full optimization.

• MES Matching Engine
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This concurrent program matches newly published content items with the existing 
channels to which the items are not explicitly published. If newly published items 
match any of these channels, this concurrent program publishes them to these 
channels. Also, in a newly created channel, it verifies if any existing published items
in the repository can be included. If the items can be included, then it will publish 
those items in that channel. If an item gets published to a channel implicitly and if 
that channel needs approvals to publish items, then approval process gets started 
automatically. 

Concurrent Programs as a Part of a Standard Request
Use this procedure to include a concurrent program as a part of a standard request. 

1. Log on to Self Service Application as:

Username: SYSADMIN 

Password: SYSADMIN 

Select the System Administrator responsibility. 

2. Click Security > Responsibility > Define. The Responsibilities window appears.

3. Search the Responsibility Name of System Administration. Check the Request 
Group section. Write down the Request Group Name and Application. For 
example, System Administrator Reports, Application Object Library.

4. Close this window. 

5. Click Responsibility > Request. The Request Groups window appears.

6. Search for the Request Group that you wrote in Step 3. Example: System 
Administrator Reports Group.

7. Add all the Concurrent Programs mentioned in this guide in the Requests table. For
example, MES InterMedia Index Optimizing operation, MES Matching Engine, MES
InterMedia Index Sync Operation, JTF Item InterMedia, Index Sync Operation, and 
JTF Item InterMedia Index Optimizing operation.

Note: When you go to Submit a Request, you will see the 
concurrent programs that you added in the list. 

Scheduling Concurrent Programs
1. Log on to Self Service Application.



Overview of Oracle Marketing Encyclopedia System    11-15

2. Switch the responsibility to System Administrator.

3. Click Concurrent > Requests.

4. Click View. The Find Requests window appears. 

5. Click Submit a New Request button.

6. Select the name of the concurrent program that you want to submit.

7. If a schedule is already setup, select the appropriate schedule or create your own 
schedule based on the information described above. 

8. To create a schedule, click the Schedule button.

9. Enter information in the mandatory fields.

Guidelines
There is also an index on FND_LOBS table. A script has to be run to alter the index on 
this table whenever a File is stored. This index should be rebuilt periodically depending
on the volatility of the data and after large uploads, otherwise it can get out of date.

Run the following script under $FND_TOP/sql/aflobbld.sql
sqlplus <APPSUSER>/<APPS_USER>@$FND_TOP/SQL/aflobbld.sql

Example
For example:
sqlplus apps/apps@$FND_TOP/sql/aflobbld.sql
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A
 System Profile Options

This appendix covers the following topics:

• Before You Begin

• About User Profile Options

• How to Set Profile Options

• Setting Oracle User Management Profile Options

• Oracle Common Application Components (JTT) Profile Options

• Oracle iSupport Profile Options

• Oracle TeleService Profile Options

• Oracle iStore Profile Options

• Returns Profile Options

• Oracle Knowledge Management Profile Options

• Miscellaneous Profile Options

• Oracle iSupport Parameters

Before You Begin
Before making Oracle Forms application settings, ensure that Oracle Forms application 
is up and running. All of the steps in this section require you to log onto Oracle 
Applications with the sysadmin login.

About User Profile Options
A user profile is a set of changeable options that affect the way Oracle applications 
appear and how they function. Oracle Applications uses a set of user profile options 
that are common to all the applications. In addition, each module has its own unique set
of user profile options. 
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For a complete list of profile options in the Oracle Application Object Library, see Oracle
E-Business Suite Setup Guide.

The system administrator sets user profile options at four levels that have a set 
hierarchy. From lowest level to highest, the profiles categories are:

1. Site - Option settings pertain to all users at an installation site; has the lowest 
priority.

2. Application - Option settings pertain to all users of any responsibility associated 
with the application; has the next-to-lowest priority.

3. Responsibility - Option settings pertain to all users currently signed on under the 
responsibility; has the second-highest priority.

4. User - Option settings pertain to an individual user, identified by application 
username; has the highest priority.

Each user profile ordinarily exists at each level. For example, Oracle Applications 
provides a site-level Printer option, an application-level Printer option, a responsibility-
level option, and so on. Oracle Applications enforces the level hierarchy to ensure that a
higher-level option value overrides a lower-level value, with Site being the lowest and 
User the highest in the hierarchy. If, for example, you set your site-level Printer option 
to print to Printer 1, but your user-level Printer option is set to Printer 2, then printing 
occurs at Printer 2. 

Site-level option values are generally set by the system administrator before profile 
options are specified at the other three levels. The options specified at site-level work as 
defaults until the same options are specified at the other levels. 

Changes to the user profile option values take effect as soon as your users log on again 
or change responsibilities.

How to Set Profile Options
Use the following procedure to set any profile option.

Steps
1. Log in to Oracle Applications with System Administrator responsibility.

2. Navigate to Profile > System.

3. Select the level(s) at which you wish to set the profile option. 

• Site

• Application - If you choose this level, from the Application LOV, select the 
application for which you wish to set the profile option.
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• Responsibility - If you choose this level, from the Responsibility LOV, select 
the responsibility for which you wish to set the profile option.

• User - If you choose this level, from the User LOV, select the user for whom you
wish to set the profile option.

4. In the Profile field, enter the a partial profile name followed by the percent sign as a 
wildcard. Example: %iSUPPORT%. 

5. Select Find. The System Profile Values window opens with the results of your 
search.

6. Verify or set the profile option(s) at the levels that you selected.

7. Save your work.

Setting Oracle User Management Profile Options
Several profile options affect the behavior of the Oracle (JTF) User Management 
module. Set these profile options at the site level according to your requirements. 

For information on profile options for Oracle User Management, see the Oracle E-
Business Suite CRM System Administrator's Guide. For more general information, see the 
user management and user setup chapters of this book.

• JTA: User Management: Automatic Account Creation- This profile option disables 
the automatic creation of an account when a user registers.

• JTF_UM_APPROVAL_URL - Defines the absolute path of the login page (jtflogin.
jsp) that an approver must go to in order to accept or reject a request. The URL is 
included in the workflow notification sent to each approver. The same URL is sent 
to the user after their request is accepted or rejected.

• JTF_UM_MERCHANT_NAME - Defines the name of your organization. The 
workflow inserts this name into the request approvals and rejections when they are 
sent to the user.

• JTF_UM_APPROVAL_OWNER - Set by default to sysadmin, this profile option is 
used in the approval process. If the last approver in a predefined approval 
definition fails to approve a request, the person defined in this profile option will be
the escalation point of contact and will receive the request. The user specified as the 
value for this profile option must have the CRM_HTML_ADMINISTRATION 
responsibility and the JTF_REG_APPROVAL and JTF_SECURITY_ASSIGN_ROLE 
permissions.

• JTF_UM_APPROVAL_TIMEOUT_MINS - Defines (in minutes) how long a 
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workflow notification remains in a queue before it is timed out. The default is 1440 
(1 day). If you enter 0 as the value, no time out occurs. If no value is set, the profile 
option is defaulted to 0.

Note: The Process Timeout field in the parameters window when starting the JTF 
Approval workflow must be set to Yes for this profile option to take effect.

• JTF_REGISTRATION_CACHE - Determines whether the browser will cache the 
data entered by a user during the registration flow. The default value is Yes. If set to
Yes and if the user presses the Back button, then the data entered on the previous 
page is available. If the profile option is set to No, then the data (page) expires as 
soon as the user leaves the page.

• JTF_PRIMARY_USER - Predetermines the username that corresponds with the 
Universal Primary User Approver. 

• JTF_INDIVIDUALUSER_ACCOUNT - When set to Yes, this profile option creates 
a new account (in the HZ_CUST_ACCOUNTS table) for each individual user. It 
also associates the user with the corresponding account. Users must have an 
account in order to purchase products through Oracle iStore.

Oracle Common Application Components (JTT) Profile Options
Several Oracle Common Application Components (JTT) profile options must be set for 
the Oracle iSupport UI to appear. The values of the JTT profiles set the basic JTT 
Foundation default elements and values. These profiles are seeded in the Profiles 
window in ERP, and values are defined by the user (as System Administrator). 

These affect all users logged in with any responsibility that is associated with the 
application.

Steps
1. Log on to Oracle Applications as sysadmin/sysadmin.

2. Select the System Administrator responsibility.

3. Navigate to Profile > System > Find System Profile Values window.

4. Query the system for JTF profile options:

1. Check the Application check box. Clear the Site check box, if necessary.

2. Enter iSupport in the Application field.

3. In the Profile field, enter JTF_PROFILE%, and select Find.

5. Verify and/or set the following JTF profile option for Oracle iSupport. Use the topic 
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below, Finding Responsibility ID and Application ID Values, for assistance.

• JTF_PROFILE_DEFAULT_RESPONSIBILITY - This value tells the system 
which responsibility to grant to users who are automatically approved by the 
system. This default responsibility ID is different in every instance. Use the 
following steps to find this value.

Finding Responsibility ID and Application ID Values

Use the following steps to find the APPLICATION_ID and 
RESPONSIBILITY_ID value of a responsibility.

• Log in to the Oracle Applications as sysadmin. Select System Administrator 
responsibility. Navigate to Security > Responsibility > Define. The 
Responsibilities window opens.

• From the top menu, select View > Find. Search for the responsibility that you 
wish to be the default responsibility, highlight it, and click Ok in the search 
window. The Responsibilities window is populated with the record for the 
selected responsibility.

• With the cursor in any field of the record, select Help > Diagnostics > Examine. 
The Examine Field and Variable Values window opens.

• In the Examine Field and Variable Values window, select APPLICATION_ID 
from the Field LOV. The Value field displays the value of APPLICATION_ID.

• In the Examine Field and Variable Values window, select RESPONSIBILITY_ID
from the Field LOV. The Value field displays the value of 
RESPONSIBILITY_ID.

6. Verify and/or set these additional JTF profile options for Oracle iSupport:

• JTF_PROFILE_DEFAULT_APPLICATION - 672.

This sets the default application. This must be set to the Oracle iSupport 
application ID, 672.

• JTF_PROFILE_DEFAULT_BLANK_ROWS - 3

This sets the default number of blank rows in tables on the Oracle iSupport UI. 
It can be set to any integer greater than zero. The recommended value is 3.

• JTF_PROFILE_DEFAULT_CSS - jtfucss.css

This designates the default cascading style sheet to use for HTML display. The 
recommended value is jtfucss.css.

• JTF_PROFILE_DEFAULT_CURRENCY - USD
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This tells the application which country's monetary currency to use as a default.
Set it to USD for U.S. Dollars if this is what you wish the default currency to be.

• JTF_PROFILE_DEFAULT_NUM_ROWS - 10

This tells the application how many rows to display when displaying tables on 
the UI. The recommended value is 10.

• JTF_NAV_CUSTOM_RENDERER

This enables a custom menu with the java class name.

Oracle iSupport Profile Options
Some profile options are classified by Oracle iSupport profile category. The following 
table, page A-6 defines the profile option categories for the application.

Profile Option Categories for Oracle iSupport

Profile Category Profile Option

iSupport Integration Service: Default System Resource

iSupport Service Request Service: Auto Launch Web Workflow

iSupport Service Request Service: Publish Flag Update Allowed

iSupport Service Request Service: Real-Time Automatic Assignment of 
Service Requests from iSupport

This section describes the profile options in Oracle iSupport. Many of them are required
for the service request functionality to work in Oracle iSupport. You must set profile 
options in Oracle Forms. These profile values are specific to Oracle iSupport. For Oracle 
TeleService profile options, see the Oracle TeleService Implementation Guide.
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Oracle iSupport Profile Options

Name of Profile Option Description

Oracle iSupport: Assign Service Request to 
Default Owners when Auto Assignment is Off

Specifies whether the service request to be 
assigned to the default owners when Auto 
Assignment is Off.

Default = Y.

Oracle iSupport: Authenticated Guest 
Responsibility

Stores the authenticated guest responsibility.

Oracle iSupport: Authenticated Guest User 
Responsibility

Determines what responsibility is assigned to 
an authenticated guest user when entering 
iSupport guest-enabled pages. This is used for
the case where a user has a valid login but 
does not have the proper roles to use 
iSupport. Therefore, if such users view the 
iSupport public or guest pages, you give them
this responsibility.

Default value = 
IBU_AUTH_GUEST_USER_RESP 

Oracle iSupport: Available Repositories for 
Knowledge Search

Specifies available repositories for knowledge 
search.

Default = Solutions, Forums.

Oracle iSupport: Default Closed Service 
Request Status 

This is the closed status of a service request 
when the user selects the Close button. 
However, when status transition is used, 
sysadmin needs to make sure that this status 
is a valid next status. Otherwise the 
applications error out. This value is 
mandatory and can be set at application and 
site levels.

Oracle iSupport: Default Contact Point Type 
for Service Request

Default = email.

Oracle iSupport: Default KM Solution Note 
Type

Used to define the default Oracle Knowledge 
Management solution note type.

Oracle iSupport: Default Mode while Showing
Progress for a Service Request

Default = expanded.
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Name of Profile Option Description

Oracle iSupport: Default Note Type for Web 
Call Back Note

Stores the default note type for the callback 
note. The callback note is the question or 
statement that the customer enters while 
placing a callback request. 

Oracle iSupport: Default Note Type when 
Service Request Escalation Is Requested

Specifies the default note type when a service 
request escalation is requested.

Oracle iSupport: Default Note Type when 
Service Request Is Closed

Specifies the default note type when a service 
request is closed.

Oracle iSupport: Default Note Type when 
Service Request Is Created

Specifies the default note type when a service 
request is created.

Default = CS_PROBLEM

Oracle iSupport: Default Note Type when 
Service Request Is Updated

Specifies the default note type when a service 
request Is updated.

Default = CS_PROBLEM.

Oracle iSupport: Default number of rows in 
support site dashboard bin

Default = 10.

Oracle iSupport: Default Reopened Service 
Request Status

Specifies the default reopened service request 
status.

Oracle iSupport: Default Service Request 
Attachment Category

Possible Values: Miscellaneous (default value)

Can be set at all levels – Site, Application, 
Responsibility, and User

Oracle iSupport: Default Solved Service 
Request Status 

This value determines the status of the service 
request when it is solved after a knowledge 
base search in Oracle iSupport. This value is 
mandatory, and can be set at application and 
site levels.
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Name of Profile Option Description

Oracle iSupport: Default Updated Service 
Request Status

During service request update, automatically 
highlights a particular service request status in
the Status dropdown list on the Service 
Request Details page. A user does not need to 
explicitly select a status when updating a 
service request. However, the user still has the
option to select a status from the status 
dropdown field if needed.

Oracle iSupport: Display Only Return Lines in
Return Detail

Displays only return lines or return lines plus 
order lines in return detail.

Oracle iSupport: Enable Automatic Contract 
Entitlement

Determines whether contract entitlement is 
used when Oracle iSupport creates the service 
request. The default value is Yes.

Oracle iSupport: Enable Guest User Indicates whether a service organization 
wants to utilize guest user functionality. 

Possible Values:

• No (default value) – guest user feature 
not enabled

• Yes – guest user feature enabled 

Oracle iSupport: Enable Interaction Logging Specifies whether to log interaction while 
creating or updating a service request.

Oracle iSupport: Enable iStore-iSupport 
Integrated Mode (Support Site)

Default = N.

Oracle iSupport: Enable Multi Party Access Determines if multi-party access is enabled. 
This profile option can be set at Site and 
Responsibility levels.

Default = N (at site level).

Oracle iSupport: Enable Platform in Template 
Search

Determines whether to use a platform in the 
criteria to search a template.

Default = Y.
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Name of Profile Option Description

Oracle iSupport: Enable Problem Code in 
Template Search

Determines whether to use a problem code in 
the criteria to search a template. 

Default = N.

Oracle iSupport: Enable Product in Template 
Search

Determines whether to use a product in the 
criteria to search a template. 

Default = Y.

Oracle iSupport: Enable Request Type, 
Product, and Problem Code Mapping

Determines whether, in Oracle iSupport, 
problem codes can be associated with service 
request types and/or inventory items in a 
many to many relationship. This profile 
option can be set at all levels – Site, 
Application, Responsibility, and User.

Possible values:

• Yes: Enable the mapping between 
problem code, request type, and product.

• No: Do not enable the mapping between 
problem code, request type, and product.

Oracle iSupport: Enable Service Request Type 
in Template Search

Determines whether to use a service request 
type in the criteria to search a template. 

Default = N.

Oracle iSupport: Enable Urgency in Template 
Search

Determines whether to use urgency in the 
criteria to search a template. 

Default = Y.

Oracle iSupport: Field Level Help Option Specify Field Level Help Option.

Default = ON.

Oracle iSupport: Field Level Tip Option Specify Field Level Tip Option.

Default = ON.
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Name of Profile Option Description

Oracle iSupport: Guest User Responsibility 
Name

Determines what responsibility is assigned to 
a guest user when entering iSupport guest 
enabled pages.

Valid Values: Any valid responsibility

Default Value: IBU_GUEST_USER_RESP 
(iSupport Guest User)

Oracle iSupport: Homepage multithread Indicates if a home page will be rendered in 
multithread context.

Default = N.

Additional Information: Although this 
profile is still present, it is no longer is use.

Oracle iSupport: Implementation Class to 
Populate Service Request Extended Attributes

Specifies the Java implementation class, which
implements the interface provided, to 
populate service request extended attributes. 
The specified interface is used to take the 
responses provided by a user to the template 
questions during service request creation in 
iSupport and use them to populate the CIC 
extended attributes table after the service 
request is created. Based on these responses 
provided by the user, the CIC extended 
attributes functionality may launch tasks.

Oracle iSupport: Internal Organization for 
Employee Created Service Request

This defines the internal organization that an 
employee can select for employee-created 
service requests. The internal organization 
then determines the incident address. This 
profile overrides the default address supplied 
by Oracle Human Resources.

Oracle iSupport: Long List of Values of All 
Products

Specifies whether list of values of all products 
is long or not.

Oracle iSupport: Long List of Values of 
Customer Addresses

Specifies whether list of values of customer 
addresses is long or not. 

Oracle iSupport: Long List of Values of 
Customer Contacts

Specifies whether list of values of customer 
contacts is long or not.
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Name of Profile Option Description

Oracle iSupport: Long List of Values of 
Employees

Specifies whether list of values of employees 
is long or not.

Oracle iSupport: Long List of Values of 
Registered Products

Specifies whether list of values of registered 
products is long or not.

Oracle iSupport: Mandatory Layout Time 
Stamp

Determines the value for the time stamp 
recorded on creation of a mandatory layout.

Oracle iSupport: Menu Name for Login bin on
home page

Responsibility level default:

• iSupport Guest User:
IBU_GUEST_LOGINBIN_MENU

• iSupport Site: Guest User:
IBU_SITE_GUEST_LOGINBIN_MENU
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Name of Profile Option Description

Oracle iSupport: Menu Name for support 
resources bin on home page

 Homepage Quick Menu name for iSupport.

Responsibility level default:

• iSupport Primary User:
IBU_PRI_USER_HELP_MENU

• iSupport Individual User:
IBU_IND_USER_HELP_MENU

• iSupport Business User:
IBU_BUS_USER_HELP_MENU

• iSupport Employee User:
IBU_EMP_USER_HELP_MENU

• iSupport Guest User:
IBU_GUEST_USER_HELP_MENU

• iSupport Site: Primary User:
IBU_PRI_USER_HELP_MENU

• iSupport Site: Business User:
IBU_BUS_USER_HELP_MENU

• iSupport Site: Individual User:
IBU_IND_USER_HELP_MENU

• iSupport Site: Guest User:
IBU_GUEST_USER_HELP_MENU

Oracle iSupport: Name of the Service 
Organization

Displays the name of the service organization 
in service request log for updates made by 
support agents or the system. If this profile 
option is not set, Oracle iSupport service 
request log will display the actual resource 
name.

Oracle iSupport: Number of Expanded Rows 
when Progress of a Service Request is Shown 
Collapsed

Default = 3.
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Name of Profile Option Description

Oracle iSupport: Option to display Quick Find
to a guest user

Possible Values: 

• No (default value) – Quick Find is not 
displayed to guest users 

• Yes – Quick Find is displayed to guest 
users

This profile option can be set only at the Site 
level.

Oracle iSupport: Option to Track Solutions 
Viewed During Service Request Creation

This profile can be set at the Site and 
Responsibility levels. Its possible values are:

• Do not track: Do not record the 
information about the solution viewed by
a user with service request

• Track as Note: Create a note only. This is 
the site default.

• Track as Linked Solutions: Create a 
solution link for each solution viewed by 
a user along with feedback. 

• Track as both Note and Linked Solutions: 
Create both a note and linked solutions.

Oracle iSupport: Page Level Configuration 
Option

Possible values:

• Off (default value) 

• On 

Oracle iSupport: Product option for Solve a 
Problem bin on home page

Indicates if Home Page Solve a Problem Bin 
will show product selection.

Default = Y. To achieve the expected result, 
you must also adjust correspondingly the 
profile option Knowledge: Display Product 
Search Criteria.
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Name of Profile Option Description

Oracle iSupport: Region/Field Level 
Configuration Option

Determines whether standard or customized 
mapping is used.

Default = STANDARD.

Oracle iSupport: Select Service Request Type 
Layout Option

If the number of service request type 
categories exceeds the number defined in this 
profile, then they are displayed in two-column
format. Whether service request type 
categories are shown in one-column layout or 
two-column layout, service request types are 
always shown in one-column format under 
their category. If service request type 
categories are not shown, then this same 
profile is used to control the display of service 
request types in one-column format or two-
column format. 

Oracle iSupport: Service Request Attachment 
Security Function

Site level default = CSXSRISR.

Oracle iSupport: Service Request Incident 
Address Validation Class

Specifies the Java class to validate an incident 
address when creating a service request. 

Oracle iSupport: Service Request Reopen Time
Limit in Hours

Set to the time limit in hours within which one
can reopen a service request.

Default = 0.

Oracle iSupport: Service Request Status when 
Escalation is Requested

-
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Name of Profile Option Description

Oracle iSupport: Service Request Template 
Option

Possible values

• Do not Include Default and Highlight 
"Select One" Option

• Do not Include Default and Highlight 
First One

• Include Default and Highlight "Select 
One" Option (default value) 

• Include Default and Highlight Default

• Include Default and Highlight First One

Can be set at all levels – Site, Application, 
Responsibility, and User.

Site level default = INCLDEFLTHLFIRST.

Oracle iSupport: Show Progress of a Service 
Request Ascending or Descending by Date

Specifies whether to show progress of a 
service request ascending or descending by 
date.

Default = DESC.

Oracle iSupport: Show Welcome Text to Guest
User on home page

Specifies whether or not to isupport home 
page show welcome text to a guest user.

Default = N.

Oracle iSupport: Workflow Administrator Specifies the workflow role to receive 
iSupport Home Page e-mail subscription 
errors. This profile option can be set at site 
and application level. The possible values are 
all the available workflow roles. 
Administrators may pick a role that is 
responsible for monitoring Oracle iSupport 
workflow activities. 

JTF_SEARCH_DETAIL Enables Quick Find functionality. The value 
must be set to On.
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Oracle TeleService Profile Options
Several Oracle TeleService profile options can be set according to your business 
requirements. Many of them concern service requests. See the Oracle TeleService 
Implementation and User Guide for further information about these profile options. 

Oracle iStore Profile Options
If you are using the site framework, then you need to set Oracle iStore profile options 
relating to the following:

• Registration

• Site definition

• Site hierarchy

• Section layout and the template manager

• Pages such as Orders, Invoices, and Returns

For details on setting profile options from Oracle iStore, refer to the Oracle iStore 
Implementation and Administration Guide.

Returns Profile Options
The following profile options allow returns functionality in Oracle iSupport:

• ASO: Default Order Type - This profile determines how the order is to be 
processed in Oracle Order Management. The order types are set up in Oracle Order 
Management. This profile also determines what price list and currency code appear 
by default in the main Quoting window. If this profile value is null, no default 
value is assumed. Set to Mixed.

• ASO: Default Order State - Set to Booked.

• ASO: Enable ASO Debug - Set to Yes to allow returns debugging. 

• ASO: Product Organization - Defines which product organization to look for 
products. Note the space between the name ASO and the colon (:) in the name of the profile.
Set this to your master organization.

• ASO: Validate Salesrep - This profile is used to determine whether a Sales 
representative must be specified on a quote prior to creating an order. If this profile 
is set to Yes, a sales representative must be specified on the quote prior to creating 
an order. If this profile is set to No, then a sales representative will be defaulted 
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from ASO: Default Salesrep. If this profile value is null, a default value of Yes is 
assumed. For Oracle iSupport, set this value to No.

• OM: Debug Level - This profile option determines the level of debug messages 
printed in a OE Debug log file. To print all messages set it to 5 and for no messages 
set it to NULL. The default value is NULL.

• OM: DEBUG LOG Directory - The directory path of the OM debug log file. Specify
one of the database directories defined for PL/SQL file I/O. The default value is 
NULL. See My Oracle Support Knowledge Document 2525754.1, Using 
UTL_FILE_DIR or Database Directories for PL/SQL File I/O in Oracle E-Business Suite 
Releases 12.1 and 12.2.

Oracle Knowledge Management Profile Options
Oracle Knowledge Management has its own set of profile options. If you are 
implementing it, refer to the Oracle Knowledge Management Implementation and 
Administration Guide for information on its profile options.

Miscellaneous Profile Options
A number of profile options categorized here as miscellaneous should be set at the site-
level.

• APPS_SERVLET_AGENT - This is the URL that is used to call JSP forms from 
applications menus. Set it to the URL for the Apache server.

• HZ: Generate Party Site Number - This is a TCA profile used by the One-Time 
Address feature to determine how the site number should be derived. In the mode 
of creating a service request, if this profile is set to Yes, then the Site Number field is
disabled. If the profile is set to No, then this field is enabled and is mandatory. 
Because Incident Address is not updatable after a service request is created in 
iSupport, in that case this field is display only.

• OE: Item Validation Organization - Set this to your master organization.

• MO: Operating Unit - Set this to your master organization.

• Service: Default Address Style - This determines the default address style for 
countries that have no address style for use in the address fields of service requests.

Oracle iSupport Parameters
This section describes the Oracle iSupport parameters, which all involve service 
requests.
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• IbuSRRequestTypeCategoryID: This parameter can be passed to the Service 
Request Type Selection page as a URL parameter.

If a service request type category ID is passed through this parameter and is 
associated with only one service request type, then the current page is directly 
routed to the first page in the service request creation flow.

If a service request type category ID is passed through this parameter, and more 
than one associated service request type exists, then only this service request type 
category and the associated service request types for this category are shown.

If a service request type category ID is passed to the Service Request Type Selection 
page and is not associated with any type, then an error message is shown in the 
service request selection page, and all of the eligible service request type categories 
and the associated service request types are shown in the Select Request Type 
region.

If a service request type category ID and a service request type ID are passed, then 
the service request type category ID is not used, and the way to show service 
request types has same the logic as in release 11.5.10.

• IbuSRInvItemID: This parameter can be passed to the Service Request Type 
Selection page as URL parameter. When an inventory item ID is passed through 
this parameter, it is validated. If it is a valid inventory item ID, then it is accepted. 
Otherwise, it is not used.
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B
Lookups

This appendix covers the following topics:

• Lookup Types

Lookup Types

Lookup Types for Oracle iSupport

Lookup Types Lookup codes Meaning

IBE_UM_PARTNER_USER_TYPES IBU_BUSINESS_PARTN
ER

Register as a user of an 
existing partner

IBE_UM_PRIMARY_USER_TYPES IBU_PRIMARY Register your company

IBE_UM_SECONDARY_USER_TYPES IBU_BUSINESS Register as a user of 
existing company

IBU_BUSINESS_PARTIA
L

Need online access to 
your existing corporate 
account?

IBU_BUSINESS_PARTN
ER

 

IBE_UM_STORE_USER_TYPES IBU_PRIMARY Register your company

IBU_BUSINESS Register as a user of 
existing company
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Lookup Types Lookup codes Meaning

IBU_BUSINESS_PARTIA
L

Need online access to 
your existing corporate 
account?

IBE_UM_INDIVIDUAL_USER_TYPES IBU_INDIVIDUAL Register as individual

IBU_INDIVIDUAL_PAR
TIAL

Need online access to 
your existing individual
account?

IBE_UM_PARTIAL_USERTYPES IBU_INDIVIDUAL_PAR
TIAL

Need online access to 
your existing individual
account?

IBU_BUSINESS_PARTIA
L

Need online access to 
your existing corporate 
account?
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C
 Seeded Information

This appendix covers the following topics:

• Menus

• Oracle iSupport Menus

• Oracle iSupport Top Menus by Responsibility

• Oracle iSupport Functions

• User Responsibilities

• Registration

• Roles and Permissions

• Configurability

Menus
This section lists seeded menus associated with the application.

Oracle iSupport Menus
The following table shows Oracle iSupport main menus and their descriptions.

Oracle iSupport Menus

Menu Description

IBU_ACCOUNT_MENU Account tab 

IBU_ADMINISTRATION iSupport Administration



C-2    Oracle iSupport Implementation and Administration Guide

Menu Description

IBU_ADMIN_ROOT_MENU iSupport Administrator Menu Containing 
MES

IBU_ASKME_MENU Ask Me submenu

IBU_A_APPS iSupport Application Link

IBU_A_FB_MENU Administration->Survey

IBU_A_FORUM_MENU Administration->Forum

IBU_A_FR_CATEGORY_MENU Forum Category subtab

IBU_A_FR_FORUM_MENU Forum subtab

IBU_A_FR_USER_GROUP_MENU User Group subtab

IBU_A_PROFILE_MENU Administration->Homepage

IBU_A_ROOT_MENU Administration

IBU_A_SUB Administration->Homepage->Subscription

IBU_A_SUPPORT_MENU Administration->Support

IBU_A_TOP_MENU iSupport App Top Menu

IBU_A_USER_MENU Administration->User

IBU_BUS_USER_HELP_MENU Used for iSupport How Can We Help You bin 
for business users

IBU_BUS_USER_PROFILE_MENU Profile-->

IBU_BUS_USER_TOP_MENU Top menu for IBU Business User

IBU_CONFIG_ADMINISTRATION iSupport Configuration Administration

IBU_DEFAULT_CONFIG_MENU Configuration UI Menu
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Menu Description

IBU_EMPL_ISUPPORT_MENU iSupport menu for IBU Employee

IBU_EMPL_REQ_MENU REQ menu for IBU Employee

IBU_EMPL_USER_TOP_MENU Top menu for IBU Employee

IBU_EMP_DEFAULT_CONFIG_MENU Employee User Configuration UI Menu

IBU_EMP_USER_HELP_MENU Used in iSupport How Can We Help You bin 
for employee users

IBU_EMP_USER_PROFILE_MENU User Profile for Employees

IBU_GUEST_DEFAULT_CONFIG_MENU Guest User Configuration UI Menu

IBU_GUEST_LOGINBIN_MENU Login Menu

IBU_GUEST_SUPPORT_MENU Support tab for Guest introduced in 1159

IBU_GUEST_USER_HELP_MENU Used in iSupport How Can We Help You bin 
for guest users

IBU_GUEST_USER_TOP_MENU Top menu for guest user

IBU_HLP_CALLME_ROOT_MENU Contact Us - Root Menu

IBU_HLP_FEEDBACK_ROOT_MENU Feedback - Root Menu

IBU_HOM_MENU iSupport->Home

IBU_H_SITE_SELECT_ROOT_MENU Site Selection Root Menu

IBU_IB_MENU Home->Products

IBU_IND_USER_HELP_MENU Used in iSupport How Can We Help You bin 
for individual users

IBU_IND_USER_PROFILE_MENU User profile menu for IBU individual user

IBU_IND_USER_TOP_MENU Top menu for IBU Individual User
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Menu Description

IBU_INQ_MENU iSupport->Account

IBU_INQ_RMA_CRT iSupport->Account->Returns->View/Create 
Returns

IBU_ISUPPORT_MENU iSupport-->

IBU_NORMAL_USER_TOP_MENU Top menu

IBU_PRIMARY_USER_ROOT_MENU -

IBU_PRIMARY_USER_TOP_MENU -

IBU_PRI_USER_HELP_MENU Used in iSupport How Can We Help You bin 
for primary users

IBU_PRI_USER_REQ_MENU iSupport-->Support-->

IBU_PRI_USER_TOP_MENU Top menu for IBU Primary User

IBU_PROFILE_ACCOUNT_MENU Menu for Account Setting

IBU_PROFILE_COMPANY_MENU Company Profile Menu

IBU_PROFILE_EMP_MENU Profile Menu for Employees (User portion 
only)

IBU_PROFILE_MENU Menu for iSupport Settings

IBU_PROFILE_USER_MENU User Profile Menu

IBU_REQ_MENU Home->Support

IBU_REQ_MENU_GUEST Support

IBU_ROOT_MENU iSupport

IBU_ROOT_MENU_GUEST -

IBU_ROOT_PROFILE_MENU Root Menu for Profile
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Menu Description

IBU_SELF_SERVICE_TOP_MENU Top Menu for iSupport Self Service User

IBU_SITE_ACCOUNT_ROOT_MENU iSupport Site: Account Root Menu

IBU_SITE_ACCOUNT_TAB_MENU iSupport Site: Account Menu

IBU_SITE_BUS_HOME_MENU iSupport Site: Business User Home Menu

IBU_SITE_BUS_HOME_ROOT_MENU iSupport Site: Business User Home Root Menu

IBU_SITE_BUS_USER_TOP_MENU iSupport Site: Business User Top Menu

IBU_SITE_GUEST_HOME_MENU iSupport Site: Guest User Home Menu

IBU_SITE_GUEST_HOME_ROOT_MENU iSupport Site: Guest User Home Root Menu

IBU_SITE_GUEST_LOGINBIN_MENU Site Login Menu

IBU_SITE_GUEST_USER_TOP_MENU iSupport Site: Guest User Top Menu

IBU_SITE_PRI_HOME_MENU iSupport Site: Primary User Home Menu

IBU_SITE_PRI_HOME_ROOT_MENU iSupport Site: Primary User Home Root Menu

IBU_SITE_PRI_USER_TOP_MENU iSupport Site: Primary User Top Menu

IBU_SITE_REG_HOME_MENU iSupport Site: Regular User Home Menu

IBU_SITE_REG_HOME_ROOT_MENU iSupport Site: Regular User Home Root Menu

IBU_SITE_REG_USER_TOP_MENU iSupport Site: Regular User Top Menu

IBU_SUPPORT_MENU Support tab introduced in 1159

IBU_SYS_ADMIN_TOP_MENU iSupport Administrator Top Menu

Oracle iSupport Top Menus by Responsibility
The following table shows the top menus by responsibility. 
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Oracle iSupport Top Menus by Responsibility

Responsibility Top Menu Description

IBU_ADMINISTRATOR IBU_ADMINISTRATION Top menu for iSupport 
Administrator

IBU_BUSINESS_USER_RESP IBU_BUS_USER_TOP_MENU Top menu for iSupport 
Business (B2B) User

IBU_EMPLOYEE_USER_RES
P

IBU_EMPL_USER_TOP_ME
NU

Top menu for iSupport 
Employee (B2E) User

IBU_GUEST_USER_RESP IBU_GUEST_USER_TOP_ME
NU

Top menu for iSupport Guest 
User

IBU_AUTH_GUEST_USER_R
ESP

IBU_AUTH_GUEST_USER_T
OP_MENU

Top menu for authorized 
iSupport Guest User

IBU_INDIVIDUAL_USER_RE
SP

IBU_IND_USER_TOP_MENU Top menu for iSupport 
Individual (B2C) User

IBU_PRIMARY_USER_RESP IBU_PRI_USER_TOP_MENU Top menu for iSupport 
Primary User

IBU_SELF_SERVICE_HELPD
ESK_RESP

IBU_SELF_SERVICE_TOP_M
ENU

Top menu for the iSupport 
Self Service User

IBU_SITE_B2B_USER_RESP IBU_SITE_BUS_USER_TOP_
MENU

Top menu for iSupport Site 
Business User

IBU_SITE_B2C_USER_RESP IBU_SITE_REG_USER_TOP_
MENU

Top menu for iSupport Site 
Individual User

IBU_SITE_GUEST_USER_RE
SP

IBU_SITE_GUEST_USER_TO
P_MENU

Top menu for iSupport Site 
Guest User

IBU_SITE_PRIMARY_USER_
RESP

IBU_SITE_PRI_USER_TOP_
MENU

Top menu for iSupport Site 
Primary User

IBU_SYS_ADMIN IBU_SYS_ADMIN_TOP_ME
NU

Top menu for iSupport 
System Administrator
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Oracle iSupport Functions
The following table shows the functions that are linked to menus, along with a 
description of each function. 

Oracle iSupport Functions

Function Description

IBU_ACCOUNT_CONTACT not used

IBU_A_CAT_FN Administration > Support > Technical Library

IBU_A_CM_FN Administration > Support > Call Me

IBU_A_FB_LIST_FN Administration > Survey > Feedback List

IBU_A_FR_CT_CREATE_FN Administration > Category > Create

IBU_A_FR_CT_DELETE_FN Administration > Category > Delete

IBU_A_FR_CT_MODSTATUS_FN Administration > Category > Modify

IBU_A_FR_CT_RENAME_FN Administration > Category > Rename

IBU_A_FR_FR_CREATE_FN Administration > Forum > Create

IBU_A_FR_FR_DELETE_FN Administration > Forum > Delete

IBU_A_FR_FR_MODATTR_FN Administration > Forum > Modify Attribute

IBU_A_FR_FR_MODSTATUS_FN Administration > Forum > Modify Status 

IBU_A_FR_FR_MOVE_FN Administration > Forum > Move 

IBU_A_FR_FR_RENAME_FN Administration > Forum > Rename 

IBU_A_FR_MESSAGE_FN Administration > Forum > Messages 

IBU_A_FR_UG_ASSC_FN Administration > Forum > Associate 
Usergroup 
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Function Description

IBU_A_FR_UG_DISASSC_FN Administration > Forum > Disassociate 
Usergroup 

IBU_A_PZ_FN Administration > Homepage > Personalize

IBU_A_RPT_FN Not used in generic product.

IBU_A_SUB_FN Administration > Homepage > Subscription 
subtab

IBU_A_TM_FN Administration > Subscription > Template

IBU_A_UG_FN Administration > Support > Usergroup

IBU_A_USER_APPROVALS_FN Administration > User > Pending Approvals

IBU_A_USER_FN Administration > Users

IBU_CMN_FORUM Forum tab 

IBU_COMPANY_ADDRESS Profile > Company address

IBU_COMPANY_ADMIN Profile > Company Administrators 

IBU_COMPANY_CONTACT_POINTS Profile > Contact points of company 

IBU_COMPANY_INFORMATION Profile > Company Information 

IBU_GEN_PREF Profile > General Preferences 

IBU_HLP_CALLME Support > Contact Us

IBU_HLP_FEEDBACK Support > Survey

IBU_HOM_HOME iSupport Home

IBU_INQ_ACCOUNT Account

IBU_INQ_CONTRACTS Account > Contracts
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Function Description

IBU_INQ_DEFECTS Defects

IBU_INQ_INSTALLBASE Install Base

IBU_INQ_INSTALLBASEREPORT Install Base Report

IBU_INQ_INSTALLBASE_ADDPRODUCT Install Base Add Product

IBU_INQ_INSTALLBASE_BUILT Install Base as Built

IBU_INQ_INSTALLBASE_SUMMARY Install Base Summary

IBU_INQ_INVOICES Account > Invoices

IBU_INQ_ORDERS Account > Orders

IBU_INQ_PAYMENTS Account > Payments

IBU_INQ_RMAS Account > Returns

IBU_LOGIN_FN Applications Login page. If you want to use 
your own login page or to use the guest user 
home page as the login page, then you can 
customize IBU_LOGIN_FN to point to the 
appropriate JSP.

IBU_PERSONAL_PROFILE Profile button

IBU_PROFILE_CONTRACT not used

IBU_PROFILE_GENERAL Profile > User Profile > Support

IBU_REGISTER_FN JTF Register page

IBU_REQ_ASKME Search Knowledge Base

IBU_REQ_CREATESR Support > Create Service Requests

IBU_REQ_VIEWSR Support > View Service Requests
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Function Description

IBU_SYSTEM_ADD not used

IBU_SYSTEM_ADM not used

IBU_SYSTEM_CSI not used

IBU_SYSTEM_LIC not used

IBU_SYSTEM_PRF not used

IBU_SYSTEM_ROL not used

IBU_SYSTEM_USR not used

IBU_USER_ACCOUNTS Profile > User Profile > Account

IBU_USER_ADDRESSES Profile > User Profile > Addresses

IBU_USER_CONTACTPOINTS Profile > User Profile > Contact Points

IBU_USER_CONTRACTS not used

User Responsibilities
The following table  displays seeded user responsibilities and their descriptions.

Oracle iSupport User Responsibilities

Responsibility Key Responsibility Name Description

IBU_ADMINISTRATOR iSupport Administrator iSupport Administrator

IBU_AUTH_GUEST_USER_R
ESP

iSupport Authenticated Guest
User

Guest user responsibility that 
is dynamically assigned to 
authenticated users not set up
in iSupport when accessing a 
public page.
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Responsibility Key Responsibility Name Description

IBU_BUSINESS_USER_RESP iSupport Business User Access privileges for 
receiving web support for a 
business user

IBU_EMPLOYEE_USER_RES
P

iSupport Employee User Access privileges for 
receiving web support for an 
employee of the support 
organization

IBU_GUEST_USER_RESP iSupport Guest User Access privileges for 
receiving web support for a 
guest user

IBU_INDIVIDUAL_USER_RE
SP

iSupport Individual User Access privileges for 
receiving web support for an 
individual user

IBU_PRIMARY_USER_RESP iSupport Primary User Access privileges for 
receiving web support for a 
primary user

IBU_SELF_SERVICE_HELPD
ESK_RESP

iSupport Self-Service 
Helpdesk

Access privileges for 
receiving web support for a 
self-service user

IBU_SITE_B2B_USER_RESP iSupport Site: Business User Access privileges for support 
sites for a business user

IBU_SITE_B2C_USER_RESP iSupport Site: Individual User Access privileges for support 
sites for an individual user

IBU_SITE_GUEST_USER_RE
SP

iSupport Site: Guest User Access privileges for support 
sites for a guest user

IBU_SITE_PRIMARY_USER_
RESP

iSupport Site: Primary User Access privileges for support 
sites for a primary user

IBU_SYS_ADMIN iSupport System 
Administrator

iSupport System Admin
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Registration
This section contains information about seeded user types and enrollments that are 
required for registration.

Oracle iSupport User Types

Registration User Types for Standalone Oracle iSupport

User Type Key Activate Enrollments Comment

IBU_INDIVIDUAL IBU_INDIVIDUAL (self service)  

IBU_INDIVIDUAL_PA
RTIAL

IBU_INDIVIDUAL (self service) This user type is not active out 
of box. If you activate this user 
type, then select and activate 
enrollment IBU_INDIVIDUAL 
for this user type.

IBU_PRIMARY IBU_PRIMARY (self service), 
IBU_BUSINESS (automatic)

 

IBU_BUSINESS IBU_BUSINESS (self service)  

IBU_BUSINESS_PARTI
AL

IBU_BUSINESS (self service) This user type is not active out 
of box. If you activate this user 
type, then select and activate 
enrollment IBU_BUSINESS for 
this user type. 

IBU_BUSINESS_PART
NER

IBU_BUSINESS(self service) This user type is not active out 
of box. If you activate this user 
type, then select and activate 
enrollment IBU_BUSINESS for 
this user type. 

Integrated Registration User Types for Oracle iSupport and Oracle iStore

User Type Key Activate Enrollments Comment

IBE_INDIVIDUAL IBU_SITE_INDIVIDUAL_USER  
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User Type Key Activate Enrollments Comment

IBE_INDIVIDUAL_PA
RTIAL

IBU_SITE_INDIVIDUAL_USER This user type is not active out 
of box. If you activate this user 
type, then select and activate 
enrollment 
IBU_SITE_INDIVIDUAL_USER
for this user type.

IBE_PRIMARY IBU_SITE_BUSINESS_USER  

IBU_SITE_PRIMARY_USER

IBE_BUSINESS IBU_SITE_BUSINESS_USER  

IBE_BUSINESS_PARTI
AL

IBU_SITE_BUSINESS_USER This user type is not active out 
of box. If you activate this user 
type, then select and activate 
enrollment 
IBU_SITE_BUSINESS_USER for
this user type. 

IBE_PARTNER_BUSIN
ESS

IBU_SITE_BUSINESS_USER This user type is not active out 
of box. If you activate this user 
type, then select and activate 
enrollment 
IBU_SITE_BUSINESS_USER for
this user type.

Additional Information about User Types

Other Info: User Type Key Description

IBU_INDIVIDUAL Individual users include new and existing users with 
no specific relationship to or representation of a 
business entity. 

IBU_INDIVIDUAL_PARTIAL Create an online user account for existing individual 
customers. 
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Other Info: User Type Key Description

IBU_PRIMARY Primary users are points of contacts for businesses and 
organizations. Select this option if you are the first 
person to register your business entity. You will be 
responsible for managing all users within your 
organization. This includes the validation and 
approval of users. Thus, you will serve as the 
administrator for your business entity.

IBU_BUSINESS Business users have their organizations already 
registered in the system. To register, you will need 
your Registry ID. Please register as a primary user if 
you are the point of contact or first user for your entity.

Note: Using this user type requires a Registry ID 
from a previously registered business entity.

IBU_BUSINESS_PARTIAL Create online user account for existing contacts of a 
company 

IBU_BUSINESS_PARTNER Create an online user account for a non-primary user of
an already registered partner organization. 

Note: To register, you need an organization 
Registry ID. 

Oracle iSupport Enrollments
This section provides the enrollment information for Oracle iSupport:

• Enrollment: IBU_PRIMARY 

• Responsibility: iSupport Primary User

• Role: IBU_B2B_PRIMARY_USER_MANAGEMENT, IBU_REG_USER

• Enrollment: IBU_INDIVIDUAL (B2C User)

• Responsibility: iSupport Individual User

• Role: IBU_REG_USER
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• Enrollment: IBU_BUSINESS

• Responsibility: iSupport Business User

• Role: IBU_REG_USER

• Enrollment: IBU_SITE_BUSINESS_USER

• Name: Support Site: Business User

• Description: Sign up to receive self-service support from our Web site using 
your organization account.

• Responsibility: IBU_SITE_B2B_USER_RESP

• Apply changed to existing subscribers: No

• Assigned Roles: IBU_BUSINESS_USER

• Application Owner: Oracle iSupport

• Approval By: No Approval is required

• Enrollment Template: Generic Template

• Delegation Role: None

• Enrollment: IBU_SITE_INDIVIDUAL_USER

• Name: Support Site: Individual User

• Description: Sign up to receive self-service support from our web site.

• Responsibility: IBU_SITE_B2C_USER_RESP

• Apply changed to existing subscribers: No

• Assigned Roles: IBU_REGULAR_USER

• Application Owner: Oracle iSupport

• Approval By: No Approval is required

• Enrollment Template: Generic Template

• Delegation Role: None

• Enrollment: IBU_SITE_PRIMARY_USER (Primary User)
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• Name: Support Site: Primary User

• Description: Sign up to receive self-service support and manage users directly 
from our web site.

• Responsibility: IBU_SITE_PRIMARY_USER_RESP

• Apply changed to existing subscribers: No

• Assigned Roles: IBU_PRIMARY_USER, IBU_BUSINESS_USER

• Application Owner: Oracle iSupport

• Approval By: No Approval is required

• Enrollment Template: Generic Template

• Delegation Role: None

Roles and Permissions
 The following table lists Oracle iSupport roles and permissions.

Oracle iSupport Roles and Permissions

Role Permission Description

IBU_B2B_PRIMARY_USER_
MANAGEMENT

IBU_ADMIN_UPDATE IBU ADMIN UPDATE

IBU_B2B_PRIMARY_USER_
MANAGEMENT

IBU_ADMIN_VIEW IBU ADMIN VIEW

IBU_B2B_PRIMARY_USER_
MANAGEMENT

IBU_Account_Create To Create an Account to a 
party or organization

IBU_B2B_PRIMARY_USER_
MANAGEMENT

IBU_USER_MGMT Permission for User 
Management

IBU_B2B_PRIMARY_USER_
MANAGEMENT

IBU_USER_MGMT_VIEW_C
OMPANY_USER

Permission to view company 
user

IBU_B2B_PRIMARY_USER_
MANAGEMENT

IBU_USER_MGMT_VIEW_M
Y_ROLE

Permission to view only my 
role



 Seeded Information    C-17

Role Permission Description

IBU_B2B_PRIMARY_USER_
MANAGEMENT

JTF_PRIMARY_USER_SUM
MARY

JTF Primary User 

IBU_BUSINESS_USER CSI_ACCT_ACCESS_ONLY Restricts the users access to 
Install Base products based on
an Account 

IBU_BUSINESS_USER CSI_ADDI_ATTR_UPDATE Update permission for csi 
Additional Attributes page.

IBU_BUSINESS_USER CSI_ADDI_ATTR_VIEW View permission for csi 
Additional Attributes page.

IBU_BUSINESS_USER CSI_CONTACT_DETAIL_UP
DATE

Update permission for 
Contact Detail page

IBU_BUSINESS_USER CSI_CONTACT_DETAIL_VI
EW

View permission for Contact 
Detail page

IBU_BUSINESS_USER CSI_CONTRACT_UPDATE Update permission for 
Contract page

IBU_BUSINESS_USER CSI_CONTRACT_VIEW View permission for Contract 
page

IBU_BUSINESS_USER CSI_CREATE_INST_UPDAT
E

Update permission for Create 
Instance page

IBU_BUSINESS_USER CSI_CREATE_INST_VIEW View permission for Create 
Instance page

IBU_BUSINESS_USER CSI_GENERAL_ATTRIB_CU
ST_ONLY

Makes certain Customer 
product attributes read only

IBU_BUSINESS_USER CSI_INST_CONFIG_UPDAT
E

Update permission for Instant
Config page

IBU_BUSINESS_USER CSI_INST_CONFIG_VIEW View permission for Instant 
Config page

IBU_BUSINESS_USER CSI_INST_GENERAL_UPDA
TE

Update permission for Instant
General page
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Role Permission Description

IBU_BUSINESS_USER CSI_INST_GENERAL_VIEW View permission for Instant 
General page

IBU_BUSINESS_USER CSI_LATEST_TRANSACTIO
N_UPDATE

Update permission for Latest 
Transaction page

IBU_BUSINESS_USER CSI_LATEST_TRANSACTIO
N_VIEW

View permission for Latest 
Transaction page

IBU_BUSINESS_USER CSI_PARTY_CONTACT_UP
DATE

Update permission for Party 
Contact page

IBU_BUSINESS_USER CSI_PARTY_CONTACT_VIE
W

View permission for Party 
Contact page

IBU_BUSINESS_USER CSI_PERZ_EDIT_UPDATE Update Permission for 
personalization edit page

IBU_BUSINESS_USER CSI_PERZ_EDIT_VIEW View permission for 
personalization edit page

IBU_BUSINESS_USER CSI_PRICING_UPDATE Update permission for Pricing
page

IBU_BUSINESS_USER CSI_PRICING_VIEW View permission for Pricing 
page

IBU_BUSINESS_USER CSI_PROPERTY_READ Read the CSI Properties

IBU_BUSINESS_USER CSI_REPAIR_ORDER_UPDA
TE

Update permission for Repair 
Order page

IBU_BUSINESS_USER CSI_REPAIR_ORDER_VIEW View permission for Repari 
Order page

IBU_BUSINESS_USER CSI_SEARCH_PRODUCT_U
PDATE

Update permission for Search 
Product page

IBU_BUSINESS_USER CSI_SEARCH_PRODUCT_VI
EW

View permission for Search 
Product page



 Seeded Information    C-19

Role Permission Description

IBU_BUSINESS_USER CSI_SERVICE_REQUEST_UP
DATE

Update permission for Service
Request page

IBU_BUSINESS_USER CSI_SERVICE_REQUEST_VI
EW

View permission for Service 
Request page

IBU_BUSINESS_USER CSI_SHOW_EXT_CONTACT
S

Restricts Install Base User to 
view only the external 
contacts

IBU_BUSINESS_USER CSI_SHOW_EXT_LOCATIO
NS

Restricts the Install Base user 
to view only external 
locations

IBU_BUSINESS_USER CSI_SHOW_EXT_PARTIES Restricts the user to View 
only the External parties

IBU_BUSINESS_USER CSI_SHOW_INST_CUSTOM
ER_MENU

Permission to have the Install 
Base Customer facing 
instance details Menu

IBU_BUSINESS_USER CSI_SPLIT_QUANTITY_UPD
ATE

Update permission for Split 
Quantity page

IBU_BUSINESS_USER CSI_SPLIT_QUANTITY_VIE
W

View permission for Split 
Quantity page

IBU_BUSINESS_USER CSI_TRANSACTION_DETAI
L_UPDATE

Update permission for 
Transaction Detail page

IBU_BUSINESS_USER CSI_TRANSACTION_DETAI
L_VIEW

View permission for 
Transaction Detail page

IBU_BUSINESS_USER CSI_TRANSACTION_INSTA
NCE_UPDATE

Update permission for 
Transaction Instance page

IBU_BUSINESS_USER CSI_TRANSACTION_INSTA
NCE_VIEW

View permission for 
Transaction Instance page

IBU_BUSINESS_USER CS_Advanced_Search Knowledge:Search: 
Permission to view the KM 
Advanced Search Page
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Role Permission Description

IBU_BUSINESS_USER CS_Freq_Used_Sol_View Knowledge:Search: 
Permission to View 
frequently used solutions

IBU_BUSINESS_USER CS_Products_Add Add New Products Not 
through OM

IBU_BUSINESS_USER CS_Products_Delete Delete product from customer
view

IBU_BUSINESS_USER CS_Products_Report Install Base Report

IBU_BUSINESS_USER CS_Products_Update Change purchased product 
status and location

IBU_BUSINESS_USER CS_Products_View View Purchased Products

IBU_BUSINESS_USER CS_Rec_Sol_View Knowledge:Setup: Permission
to view recommended 
solutions

IBU_BUSINESS_USER CS_Solution_View Knowledge:Search: 
Permission to view solution

IBU_BUSINESS_USER CS_Solution_View_Public Knowledge Management 
view public solutions 

IBU_BUSINESS_USER CS_Statement_View Knowledge:Search: 
Permission to view statement

IBU_BUSINESS_USER CS_USED_COUNT_UPDATE Knowledge:Search: 
Permission to update solution
used count

IBU_BUSINESS_USER IBE_CHANGE_BILLTO_CO
NTACT

Permission to change the bill-
to contact while placing the 
order for an organization

IBU_BUSINESS_USER IBE_CREATE_RETURN Permission to create return

IBU_BUSINESS_USER IBE_INT_ADMINISTRATOR
S

Permission to view primary 
users of the organization
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Role Permission Description

IBU_BUSINESS_USER IBE_INT_ORG_ADDRESS_B
OOK

Permission to view 
organization address book

IBU_BUSINESS_USER IBE_INT_ORG_DETAILS Permission to view 
organization details

IBU_BUSINESS_USER IBE_INT_ORG_EMAIL_ADD
RESSES

Permission to view 
organization email addresses

IBU_BUSINESS_USER IBE_INT_ORG_PHONE_NU
MBERS

Permission to view 
organization phone number 
functionality

IBU_BUSINESS_USER IBE_INT_ORG_TELEX_NUM
BERS

Permission to view 
organization telex numbers 
functionality

IBU_BUSINESS_USER IBE_VIEW_INVOICE Permission to view invoice

IBU_BUSINESS_USER IBE_VIEW_ORDER Permission to view order

IBU_BUSINESS_USER IBE_VIEW_PAYMENT -

IBU_BUSINESS_USER IBE_VIEW_RETURN_ORDER Permission to view return 
order

IBU_BUSINESS_USER IBU_CallMe Submit a request for an agent 
to call back

IBU_BUSINESS_USER IBU_Contracts_View View Customer Contracts

IBU_BUSINESS_USER IBU_DEPOT_VIEW Depot Repair Orders View 
Permission. Used for depot 
repair summary, detail, and 
search pages. 

IBU_BUSINESS_USER IBU_Defects_View View Product Defects

IBU_BUSINESS_USER IBU_Homepage -

IBU_BUSINESS_USER IBU_Homepage_Update IBU Homepage Update
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Role Permission Description

IBU_BUSINESS_USER IBU_Invoices_View View Customer Invoices

IBU_BUSINESS_USER IBU_Orders_View View Customer Orders

IBU_BUSINESS_USER IBU_Payments_View View Payments

IBU_BUSINESS_USER IBU_Profile_Update Update 
profile/personalization 
information

IBU_BUSINESS_USER IBU_Profile_View View customer 
profile/personalization 
information

IBU_BUSINESS_USER IBU_Request_Add_Contact Add a Contact to Service 
Request 

IBU_BUSINESS_USER IBU_Request_Close Close a service request

IBU_BUSINESS_USER IBU_Request_Create Create a service request

IBU_BUSINESS_USER IBU_Request_Email_To_Me Request Service Request 
Details by Email

IBU_BUSINESS_USER IBU_Request_Escalate Change service request 
urgency

IBU_BUSINESS_USER IBU_Request_Manage_Templ
ates

Create, Update Service 
Request Templates

IBU_BUSINESS_USER IBU_Request_Manage_Views Create, Update Service 
Request Views/Saved 
Searches.

IBU_BUSINESS_USER IBU_Request_Reopen Reopen a Service Request

IBU_BUSINESS_USER IBU_Request_Search Search Service Requests

IBU_BUSINESS_USER IBU_Request_Update Add a comment to an open 
service request
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Role Permission Description

IBU_BUSINESS_USER IBU_Request_Update_Solutio
n_Usefulness

Update Usefulness of the 
Solutions Suggested for a 
Service Request

IBU_BUSINESS_USER IBU_Request_View View service requests

IBU_BUSINESS_USER IBU_Request_View_Account View all the service requests 
for the accounts assigned to 
the user

IBU_BUSINESS_USER IBU_Request_View_Compan
y

View all the service requests 
created for the user's 
organization

IBU_BUSINESS_USER IBU_Request_View_Self View service requests created 
by the user for which the user 
is an active contact

IBU_BUSINESS_USER IBU_Returns_Add Create Return for a Product

IBU_BUSINESS_USER IBU_Returns_View View Customer Returns

IBU_BUSINESS_USER IBU_SR_SEND_EMAIL permission for user to send 
email (Service Request)

IBU_BUSINESS_USER IBU_SR_TASK_VIEW_PUBLI
SH

The permission to view only 
publish tasks 

IBU_BUSINESS_USER IBU_SR_UPLOAD_ATTACH
MENT

Upload Attachment to Service
Request

IBU_BUSINESS_USER IBU_SR_VIEW_PROFILE_UP
DATE

View and profile update 
permission

IBU_BUSINESS_USER IBU_Survey_Create Fill in a pre-defined survey

IBU_BUSINESS_USER IBU_Technical_Library_View View technical 
documentation

IBU_BUSINESS_USER IBU_UPDATE_SUPPORT_PR
EFERENCES

iSupport Site: Profile: Support
Preferences: Update
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Role Permission Description

IBU_BUSINESS_USER IBU_VIEW_SUPPORT_PREF
ERENCES

iSupport Site: Profile: Support
Preferences: View

IBU_EMPLOYEE CS_Advanced_Search Knowledge:Search: 
Permission to view the KM 
Advanced Search Page

IBU_EMPLOYEE CS_Freq_Used_Sol_View Knowledge:Search: 
Permission to View 
frequently used solutions

IBU_EMPLOYEE CS_Products_Add Add New Products Not 
through OM

IBU_EMPLOYEE CS_Products_Delete Delete product from customer
view

IBU_EMPLOYEE CS_Products_Report Install Base Report

IBU_EMPLOYEE CS_Products_Update Change purchased product 
status and location

IBU_EMPLOYEE CS_Products_View View Purchased Products

IBU_EMPLOYEE CS_Rec_Sol_View Knowledge:Setup: Permission
to view recommended 
solutions

IBU_EMPLOYEE CS_Solution_View Knowledge:Search: 
Permission to view solution

IBU_EMPLOYEE CS_Solution_View_All Knowledge Management 
view all solutions

IBU_EMPLOYEE CS_Solution_View_B -

IBU_EMPLOYEE CS_Solution_View_Internal Knowledge:Search: 
Permission to view public and
internal solutions

IBU_EMPLOYEE CS_Statement_View Knowledge:Search: 
Permission to view statement
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Role Permission Description

IBU_EMPLOYEE CS_USED_COUNT_UPDATE Knowledge:Search: 
Permission to update solution
used count

IBU_EMPLOYEE IBU_EMP_REQUEST_VIEW_
INTERNAL

View only the internal service
requests where the user is a 
contact

IBU_EMPLOYEE IBU_EMP_REQUEST_VIEW_
ALL

View all the external service 
requests where the user is a 
contact and all the internal 
service requests even where 
the user is not an associated 
contact

IBU_EMPLOYEE IBU_Homepage -

IBU_EMPLOYEE IBU_Homepage_Update IBU Homepage Update

IBU_EMPLOYEE IBU_Profile_Update Update 
profile/personalization 
information

IBU_EMPLOYEE IBU_Profile_View View customer 
profile/personalization 
information

IBU_EMPLOYEE IBU_Request_Add_Contact Add a Contact to Service 
Request 

IBU_EMPLOYEE IBU_Request_Close Close a service request

IBU_EMPLOYEE IBU_Request_Create Create a service request

IBU_EMPLOYEE IBU_Request_Email_To_Me Request Service Request 
Details by Email

IBU_EMPLOYEE IBU_Request_Escalate Change service request 
urgency

IBU_EMPLOYEE IBU_Request_Manage_Templ
ates

Create, Update Service 
Request Templates
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Role Permission Description

IBU_EMPLOYEE IBU_Request_Manage_Views Create, Update Service 
Request Views/Saved 
Searches.

IBU_EMPLOYEE IBU_Request_Reopen Reopen a Service Request

IBU_EMPLOYEE IBU_Request_Search Search Service Requests

IBU_EMPLOYEE IBU_Request_Update Add a comment to an open 
service request

IBU_EMPLOYEE IBU_Request_Update_Solutio
n_Usefulness

Update Usefulness of the 
Solutions Suggested for a 
Service Request

IBU_EMPLOYEE IBU_Request_View View service requests

IBU_EMPLOYEE IBU_REQUEST_VIEW_SELF View service requests created 
by the employee for which 
the employee is an active 
contact

IBU_EMPLOYEE IBU_SR_TASK_VIEW_PUBLI
C

Oracle iSupport: show public 
task only

IBU_EMPLOYEE IBU_SR_TASK_VIEW_PUBLI
SH

The permission to view only 
publish tasks 

IBU_EMPLOYEE IBU_SR_UPLOAD_ATTACH
MENT

Upload Attachment to Service
Request

IBU_EMPLOYEE IBU_SR_VIEW_PROFILE_UP
DATE

View and profile update 
permission

IBU_EMPLOYEE IBU_Survey_Create Fill in a predefined survey

IBU_EMPLOYEE IBU_Technical_Library_View View technical 
documentation

IBU_FORUM_ADMINISTRA
TOR

IBU_Forum View and post threads
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Role Permission Description

IBU_FORUM_ADMINISTRA
TOR

IBU_Forum_Category_Edit  

IBU_FORUM_ADMINISTRA
TOR

IBU_Forum_Edit  

IBU_FORUM_ADMINISTRA
TOR

IBU_Forum_View HA enabled page view 
permission for forum client.

IBU_FORUM_ADMINISTRA
TOR

IBU_Forum_View_Open  

IBU_FORUM_ADMINISTRA
TOR

IBU_Forum_View_Restrict  

IBU_FORUM_USER IBU_Forum View and post threads

IBU_FORUM_USER IBU_Forum_View HA enabled page view 
permission for forum client.

IBU_FORUM_USER IBU_Forum_View_Open  

IBU_FORUM_USER IBU_Forum_View_Restrict  

IBU_GUEST_USER CS_Solution_View Knowledge:Search: 
Permission to view solution

IBU_GUEST_USER IBU_Guest_User Guest user permission

IBU_GUEST_USER IBU_Homepage -

IBU_GUEST_USER IBU_Homepage_Hide_Custo
mize

Permission to hide 
personalization link

IBU_GUEST_USER IBU_Technical_Library_View View technical 
documentation

IBU_PRIMARY_USER CSI_ACCT_ACCESS_ONLY Restricts the users access to 
Install Base products based on
an Account 
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Role Permission Description

IBU_PRIMARY_USER CSI_ADDI_ATTR_UPDATE Update permission for csi 
Additional Attributes page.

IBU_PRIMARY_USER CSI_ADDI_ATTR_VIEW View permission for csi 
Additional Attributes page.

IBU_PRIMARY_USER CSI_CONTACT_DETAIL_UP
DATE

Update permission for 
Contact Detail page

IBU_PRIMARY_USER CSI_CONTACT_DETAIL_VI
EW

View permission for Contact 
Detail page

IBU_PRIMARY_USER CSI_CONTRACT_UPDATE Update permission for 
Contract page

IBU_PRIMARY_USER CSI_CONTRACT_VIEW View permission for Contract 
page

IBU_PRIMARY_USER CSI_CREATE_INST_UPDAT
E

Update permission for Create 
Instance page

IBU_PRIMARY_USER CSI_CREATE_INST_VIEW View permission for Create 
Instance page

IBU_PRIMARY_USER CSI_GENERAL_ATTRIB_CU
ST_ONLY

Makes certain Customer 
product attributes read only

IBU_PRIMARY_USER CSI_INST_CONFIG_UPDAT
E

Update permission for Instant
Config page

IBU_PRIMARY_USER CSI_INST_CONFIG_VIEW View permission for Instant 
Config page

IBU_PRIMARY_USER CSI_INST_GENERAL_UPDA
TE

Update permission for Instant
General page

IBU_PRIMARY_USER CSI_INST_GENERAL_VIEW View permission for Instant 
General page

IBU_PRIMARY_USER CSI_LATEST_TRANSACTIO
N_UPDATE

Update permission for Latest 
Transaction page
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Role Permission Description

IBU_PRIMARY_USER CSI_LATEST_TRANSACTIO
N_VIEW

View permission for Latest 
Transaction page

IBU_PRIMARY_USER CSI_PARTY_CONTACT_UP
DATE

Update permission for Party 
Contact page

IBU_PRIMARY_USER CSI_PARTY_CONTACT_VIE
W

View permission for Party 
Contact page

IBU_PRIMARY_USER CSI_PERZ_EDIT_UPDATE Update Permission for 
personalization edit page

IBU_PRIMARY_USER CSI_PERZ_EDIT_VIEW View permission for 
personalization edit page

IBU_PRIMARY_USER CSI_PRICING_UPDATE Update permission for Pricing
page

IBU_PRIMARY_USER CSI_PRICING_VIEW View permission for Pricing 
page

IBU_PRIMARY_USER CSI_PROPERTY_READ Read the CSI Properties

IBU_PRIMARY_USER CSI_REPAIR_ORDER_UPDA
TE

Update permission for Repair 
Order page

IBU_PRIMARY_USER CSI_REPAIR_ORDER_VIEW View permission for Repari 
Order page

IBU_PRIMARY_USER CSI_SEARCH_PRODUCT_U
PDATE

Update permission for Search 
Product page

IBU_PRIMARY_USER CSI_SEARCH_PRODUCT_VI
EW

View permission for Search 
Product page

IBU_PRIMARY_USER CSI_SERVICE_REQUEST_UP
DATE

Update permission for Service
Request page

IBU_PRIMARY_USER CSI_SERVICE_REQUEST_VI
EW

View permission for Service 
Request page
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Role Permission Description

IBU_PRIMARY_USER CSI_SHOW_EXT_CONTACT
S

Restricts Install Base User to 
view only the external 
contacts

IBU_PRIMARY_USER CSI_SHOW_EXT_LOCATIO
NS

Restricts the Install Base user 
to view only external 
locations

IBU_PRIMARY_USER CSI_SHOW_EXT_PARTIES Restricts the user to View 
only the External parties

IBU_PRIMARY_USER CSI_SHOW_INST_CUSTOM
ER_MENU

Permission to have the Install 
Base Customer facing 
instance details Menu

IBU_PRIMARY_USER CSI_SPLIT_QUANTITY_UPD
ATE

Update permission for Split 
Quantity page

IBU_PRIMARY_USER CSI_SPLIT_QUANTITY_VIE
W

View permission for Split 
Quantity page

IBU_PRIMARY_USER CSI_TRANSACTION_DETAI
L_UPDATE

Update permission for 
Transaction Detail page

IBU_PRIMARY_USER CSI_TRANSACTION_DETAI
L_VIEW

View permission for 
Transaction Detail page

IBU_PRIMARY_USER CSI_TRANSACTION_INSTA
NCE_UPDATE

Update permission for 
Transaction Instance page

IBU_PRIMARY_USER CSI_TRANSACTION_INSTA
NCE_VIEW

View permission for 
Transaction Instance page

IBU_PRIMARY_USER CS_Advanced_Search Knowledge:Search: 
Permission to view the KM 
Advanced Search Page

IBU_PRIMARY_USER CS_Freq_Used_Sol_View Knowledge:Search: 
Permission to View 
frequently used solutions
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IBU_PRIMARY_USER CS_Products_Add Add New Products Not 
through OM

IBU_PRIMARY_USER CS_Products_Delete Delete product from customer
view

IBU_PRIMARY_USER CS_Products_Report Install Base Report

IBU_PRIMARY_USER CS_Products_Update Change purchased product 
status and location

IBU_PRIMARY_USER CS_Products_View View Purchased Products

IBU_PRIMARY_USER CS_Rec_Sol_View Knowledge:Setup: Permission
to view recommended 
solutions

IBU_PRIMARY_USER CS_Solution_View Knowledge:Search: 
Permission to view solution

IBU_PRIMARY_USER CS_Solution_View_Public Knowledge Management 
view public solutions 

IBU_PRIMARY_USER CS_Statement_View Knowledge:Search: 
Permission to view statement

IBU_PRIMARY_USER CS_USED_COUNT_UPDATE Knowledge:Search: 
Permission to update solution
used count

IBU_PRIMARY_USER IBE_CHANGE_BILLTO_CO
NTACT

Permission to change the bill-
to contact while placing the 
order for an organization

IBU_PRIMARY_USER IBE_CREATE_RETURN Permission to create return

IBU_PRIMARY_USER IBE_INT_ADMINISTRATOR
S

Permission to view primary 
users of the organization

IBU_PRIMARY_USER IBE_INT_ASSIGN_ACCOUN
TS

Permission to assign accounts
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IBU_PRIMARY_USER IBE_INT_ASSIGN_ROLES Permission to assign roles

IBU_PRIMARY_USER IBE_INT_CONTACT_DETAI
LS

Permission to view contact 
details info

IBU_PRIMARY_USER IBE_INT_MANAGE_CONTA
CT

Permission to create or 
update a new contact and 
user

IBU_PRIMARY_USER IBE_INT_MANAGE_CONTA
CT_INFO

Permission to update, create, 
delete corporate addresses, 
email and phone numbers

IBU_PRIMARY_USER IBE_INT_ORG_ADDRESS_B
OOK

Permission to view 
organization address book

IBU_PRIMARY_USER IBE_INT_ORG_DETAILS Permission to view 
organization details

IBU_PRIMARY_USER IBE_INT_ORG_EMAIL_ADD
RESSES

Permission to view 
organization email addresses

IBU_PRIMARY_USER IBE_INT_ORG_PHONE_NU
MBERS

Permission to view 
organization phone number 
functionality

IBU_PRIMARY_USER IBE_INT_ORG_TELEX_NUM
BERS

Permission to view 
organization telex numbers 
functionality

IBU_PRIMARY_USER IBE_INT_PENDING_APPRO
VAL

Permission to approve users 
of the organization

IBU_PRIMARY_USER IBE_INT_PRIMARY_USER Permission to identify a user 
as primary user

IBU_PRIMARY_USER IBE_INT_ROLE_MANAGEM
ENT

Permission to create and 
update roles

IBU_PRIMARY_USER IBE_INT_UPDATE_ORG_DE
TAILS

Permission to update 
organization details
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IBU_PRIMARY_USER IBE_INT_USER_MANAGEM
ENT

Permission to access user 
management functionality

IBU_PRIMARY_USER IBE_VIEW_INVOICE Permission to view invoice

IBU_PRIMARY_USER IBE_VIEW_ORDER Permission to view order

IBU_PRIMARY_USER IBE_VIEW_PAYMENT -

IBU_PRIMARY_USER IBE_VIEW_RETURN_ORDER Permission to view return 
order

IBU_PRIMARY_USER IBU_CallMe Submit a request for an agent 
to call back

IBU_PRIMARY_USER IBU_Contracts_View View Customer Contracts

IBU_PRIMARY_USER IBU_DEPOT_VIEW Depot Repair Orders View 
Permission. Used for depot 
repair summary, detail, and 
search pages. 

IBU_PRIMARY_USER IBU_Defects_View View Product Defects

IBU_PRIMARY_USER IBU_Homepage -

IBU_PRIMARY_USER IBU_Homepage_Update IBU Homepage Update

IBU_PRIMARY_USER IBU_Invoices_View View Customer Invoices

IBU_PRIMARY_USER IBU_Orders_View View Customer Orders

IBU_PRIMARY_USER IBU_Payments_View View Payments

IBU_PRIMARY_USER IBU_Profile_Update Update 
profile/personalization 
information

IBU_PRIMARY_USER IBU_Profile_View View customer 
profile/personalization 
information



C-34    Oracle iSupport Implementation and Administration Guide

Role Permission Description

IBU_PRIMARY_USER IBU_Request_Add_Contact Add a Contact to Service 
Request 

IBU_PRIMARY_USER IBU_Request_Close Close a service request

IBU_PRIMARY_USER IBU_Request_Create Create a service request

IBU_PRIMARY_USER IBU_Request_Email_To_Me Request Service Request 
Details by Email

IBU_PRIMARY_USER IBU_Request_Escalate Change service request 
urgency

IBU_PRIMARY_USER IBU_Request_Manage_Templ
ates

Create, Update Service 
Request Templates

IBU_PRIMARY_USER IBU_Request_Manage_Views Create, Update Service 
Request Views/Saved 
Searches.

IBU_PRIMARY_USER IBU_Request_Reopen Reopen a Service Request

IBU_PRIMARY_USER IBU_Request_Search Search Service Requests

IBU_PRIMARY_USER IBU_Request_Update Add a comment to an open 
service request

IBU_PRIMARY_USER IBU_Request_Update_Solutio
n_Usefulness

Update Usefulness of the 
Solutions Suggested for a 
Service Request

IBU_PRIMARY_USER IBU_Request_View View service requests

IBU_PRIMARY_USER IBU_Request_View_Account iSupport view account service
requests

IBU_PRIMARY_USER IBU_Request_View_Compan
y

-

IBU_PRIMARY_USER IBU_Request_View_Self -
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IBU_PRIMARY_USER IBU_Returns_Add Create Return for a Product

IBU_PRIMARY_USER IBU_Returns_View View Customer Returns

IBU_PRIMARY_USER IBU_SR_SEND_EMAIL permission for user to send 
email (Service Request)

IBU_PRIMARY_USER IBU_SR_TASK_VIEW_PUBLI
SH

The permission to view only 
publish tasks 

IBU_PRIMARY_USER IBU_SR_UPLOAD_ATTACH
MENT

Upload Attachment to Service
Request

IBU_PRIMARY_USER IBU_SR_VIEW_PROFILE_UP
DATE

View and profile update 
permission

IBU_PRIMARY_USER IBU_Survey_Create Fill in a pre-defined survey

IBU_PRIMARY_USER IBU_Technical_Library_View View technical 
documentation

IBU_PRIMARY_USER IBU_UPDATE_SUPPORT_PR
EFERENCES

iSupport Site: Profile: Support
Preferences: Update

IBU_PRIMARY_USER IBU_VIEW_SUPPORT_PREF
ERENCES

iSupport Site: Profile: Support
Preferences: View

IBU_REGULAR_USER CSI_ACCT_ACCESS_ONLY Restricts the users access to 
Install Base products based on
an Account 

IBU_REGULAR_USER CSI_ADDI_ATTR_UPDATE Update permission for csi 
Additional Attributes page.

IBU_REGULAR_USER CSI_ADDI_ATTR_VIEW View permission for csi 
Additional Attributes page.

IBU_REGULAR_USER CSI_CONTACT_DETAIL_UP
DATE

Update permission for 
Contact Detail page

IBU_REGULAR_USER CSI_CONTACT_DETAIL_VI
EW

View permission for Contact 
Detail page
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IBU_REGULAR_USER CSI_CONTRACT_UPDATE Update permission for 
Contract page

IBU_REGULAR_USER CSI_CONTRACT_VIEW View permission for Contract 
page

IBU_REGULAR_USER CSI_CREATE_INST_UPDAT
E

Update permission for Create 
Instance page

IBU_REGULAR_USER CSI_CREATE_INST_VIEW View permission for Create 
Instance page

IBU_REGULAR_USER CSI_GENERAL_ATTRIB_CU
ST_ONLY

Makes certain Customer 
product attributes read only

IBU_REGULAR_USER CSI_INST_CONFIG_UPDAT
E

Update permission for Instant
Config page

IBU_REGULAR_USER CSI_INST_CONFIG_VIEW View permission for Instant 
Config page

IBU_REGULAR_USER CSI_INST_GENERAL_UPDA
TE

Update permission for Instant
General page

IBU_REGULAR_USER CSI_INST_GENERAL_VIEW View permission for Instant 
General page

IBU_REGULAR_USER CSI_LATEST_TRANSACTIO
N_UPDATE

Update permission for Latest 
Transaction page

IBU_REGULAR_USER CSI_LATEST_TRANSACTIO
N_VIEW

View permission for Latest 
Transaction page

IBU_REGULAR_USER CSI_PARTY_CONTACT_UP
DATE

Update permission for Party 
Contact page

IBU_REGULAR_USER CSI_PARTY_CONTACT_VIE
W

View permission for Party 
Contact page

IBU_REGULAR_USER CSI_PERZ_EDIT_UPDATE Update Permission for 
personalization edit page
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IBU_REGULAR_USER CSI_PERZ_EDIT_VIEW View permission for 
personalization edit page

IBU_REGULAR_USER CSI_PRICING_UPDATE Update permission for Pricing
page

IBU_REGULAR_USER CSI_PRICING_VIEW View permission for Pricing 
page

IBU_REGULAR_USER CSI_PROPERTY_READ Read the CSI Properties

IBU_REGULAR_USER CSI_REPAIR_ORDER_UPDA
TE

Update permission for Repair 
Order page

IBU_REGULAR_USER CSI_REPAIR_ORDER_VIEW View permission for Repair 
Order page

IBU_REGULAR_USER CSI_SEARCH_PRODUCT_U
PDATE

Update permission for Search 
Product page

IBU_REGULAR_USER CSI_SEARCH_PRODUCT_VI
EW

View permission for Search 
Product page

IBU_REGULAR_USER CSI_SERVICE_REQUEST_UP
DATE

Update permission for Service
Request page

IBU_REGULAR_USER CSI_SERVICE_REQUEST_VI
EW

View permission for Service 
Request page

IBU_REGULAR_USER CSI_SHOW_EXT_CONTACT
S

Restricts Install Base User to 
view only the external 
contacts

IBU_REGULAR_USER CSI_SHOW_EXT_LOCATIO
NS

Restricts the Install Base user 
to view only external 
locations

IBU_REGULAR_USER CSI_SHOW_EXT_PARTIES Restricts the user to View 
only the External parties
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IBU_REGULAR_USER CSI_SHOW_INST_CUSTOM
ER_MENU

Permission to have the Install 
Base Customer facing 
instance details Menu

IBU_REGULAR_USER CSI_SPLIT_QUANTITY_UPD
ATE

Update permission for Split 
Quantity page

IBU_REGULAR_USER CSI_SPLIT_QUANTITY_VIE
W

View permission for Split 
Quantity page

IBU_REGULAR_USER CSI_TRANSACTION_DETAI
L_UPDATE

Update permission for 
Transaction Detail page

IBU_REGULAR_USER CSI_TRANSACTION_DETAI
L_VIEW

View permission for 
Transaction Detail page

IBU_REGULAR_USER CSI_TRANSACTION_INSTA
NCE_UPDATE

Update permission for 
Transaction Instance page

IBU_REGULAR_USER CSI_TRANSACTION_INSTA
NCE_VIEW

View permission for 
Transaction Instance page

IBU_REGULAR_USER CS_Advanced_Search Knowledge:Search: 
Permission to view the KM 
Advanced Search Page

IBU_REGULAR_USER CS_Freq_Used_Sol_View Knowledge:Search: 
Permission to View 
frequently used solutions

IBU_REGULAR_USER CS_Products_Add Add New Products Not 
through OM

IBU_REGULAR_USER CS_Products_Delete Delete product from customer
view

IBU_REGULAR_USER CS_Products_Report Install Base Report

IBU_REGULAR_USER CS_Products_Update Change purchased product 
status and location

IBU_REGULAR_USER CS_Products_View View Purchased Products
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IBU_REGULAR_USER CS_Rec_Sol_View Knowledge:Setup: Permission
to view recommended 
solutions

IBU_REGULAR_USER CS_Solution_View Knowledge:Search: 
Permission to view solution

IBU_REGULAR_USER CS_Solution_View_Public Knowledge Management 
view public solutions 

IBU_REGULAR_USER CS_Statement_View Knowledge:Search: 
Permission to view statement

IBU_REGULAR_USER CS_USED_COUNT_UPDATE Knowledge:Search: 
Permission to update solution
used count

IBU_REGULAR_USER IBE_CHANGE_BILLTO_CO
NTACT

Permission to change the bill-
to contact while placing the 
order for an organization

IBU_REGULAR_USER IBE_CREATE_RETURN Permission to create return

IBU_REGULAR_USER IBE_VIEW_INVOICE Permission to view invoice

IBU_REGULAR_USER IBE_VIEW_ORDER Permission to view order

IBU_REGULAR_USER IBE_VIEW_PAYMENT -

IBU_REGULAR_USER IBE_VIEW_RETURN_ORDER Permission to view return 
order

IBU_REGULAR_USER IBU_CallMe Submit a request for an agent 
to call back

IBU_REGULAR_USER IBU_Contracts_View View Customer Contracts

IBU_REGULAR_USER IBU_DEPOT_VIEW Depot Repair Orders View 
Permission. Used for depot 
repair summary, detail, and 
search pages. 
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IBU_REGULAR_USER IBU_Defects_View View Product Defects

IBU_REGULAR_USER IBU_Homepage -

IBU_REGULAR_USER IBU_Homepage_Update IBU Homepage Update

IBU_REGULAR_USER IBU_Invoices_View View Customer Invoices

IBU_REGULAR_USER IBU_Orders_View View Customer Orders

IBU_REGULAR_USER IBU_Payments_View View Payments

IBU_REGULAR_USER IBU_Profile_Update Update 
profile/personalization 
information

IBU_REGULAR_USER IBU_Profile_View View customer 
profile/personalization 
information

IBU_REGULAR_USER IBU_Request_Add_Contact Add a Contact to Service 
Request 

IBU_REGULAR_USER IBU_Request_Close Close a service request

IBU_REGULAR_USER IBU_Request_Create Create a service request

IBU_REGULAR_USER IBU_Request_Email_To_Me Request Service Request 
Details by Email

IBU_REGULAR_USER IBU_Request_Escalate Change service request 
urgency

IBU_REGULAR_USER IBU_Request_Manage_Templ
ates

Create, Update Service 
Request Templates

IBU_REGULAR_USER IBU_Request_Manage_Views Create, Update Service 
Request Views/Saved 
Searches.

IBU_REGULAR_USER IBU_Request_Reopen Reopen a Service Request
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IBU_REGULAR_USER IBU_Request_Search Search Service Requests

IBU_REGULAR_USER IBU_Request_Update Add a comment to an open 
service request

IBU_REGULAR_USER IBU_Request_Update_Solutio
n_Usefulness

Update Usefulness of the 
Solutions Suggested for a 
Service Request

IBU_REGULAR_USER IBU_Request_View View service requests

IBU_REGULAR_USER IBU_Request_View_Account iSupport view account service
requests

IBU_REGULAR_USER IBU_Request_View_Compan
y

-

IBU_REGULAR_USER IBU_Request_View_Self -

IBU_REGULAR_USER IBU_Returns_Add Create Return for a Product

IBU_REGULAR_USER IBU_Returns_View View Customer Returns

IBU_REGULAR_USER IBU_SR_SEND_EMAIL permission for user to send 
email (Service Request)

IBU_REGULAR_USER IBU_SR_TASK_VIEW_PUBLI
SH

The permission to view only 
publish tasks 

IBU_REGULAR_USER IBU_SR_UPLOAD_ATTACH
MENT

Upload Attachment to Service
Request

IBU_REGULAR_USER IBU_SR_VIEW_PROFILE_UP
DATE

View and profile update 
permission

IBU_REGULAR_USER IBU_Survey_Create Fill in a pre-defined survey

IBU_REGULAR_USER IBU_Technical_Library_View View technical 
documentation
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IBU_REGULAR_USER IBU_UPDATE_SUPPORT_PR
EFERENCES

iSupport Site: Profile: Support
Preferences: Update

IBU_REGULAR_USER IBU_VIEW_SUPPORT_PREF
ERENCES

iSupport Site: Profile: Support
Preferences: View

IBU_REG_USER CSI_ACCT_ACCESS_ONLY Restricts the users access to 
Install Base products based on
an Account 

IBU_REG_USER CSI_ADDI_ATTR_UPDATE Update permission for CSI 
Additional Attributes page.

IBU_REG_USER CSI_ADDI_ATTR_VIEW View permission for CSI 
Additional Attributes page.

IBU_REG_USER CSI_CONTACT_DETAIL_UP
DATE

Update permission for 
Contact Detail page

IBU_REG_USER CSI_CONTACT_DETAIL_VI
EW

View permission for Contact 
Detail page

IBU_REG_USER CSI_CONTRACT_UPDATE Update permission for 
Contract page

IBU_REG_USER CSI_CONTRACT_VIEW View permission for Contract 
page

IBU_REG_USER CSI_CREATE_INST_UPDAT
E

Update permission for Create 
Instance page

IBU_REG_USER CSI_CREATE_INST_VIEW View permission for Create 
Instance page

IBU_REG_USER CSI_GENERAL_ATTRIB_CU
ST_ONLY

Makes certain Customer 
product attributes read only

IBU_REG_USER CSI_INST_CONFIG_UPDAT
E

Update permission for Instant
Config page

IBU_REG_USER CSI_INST_CONFIG_VIEW View permission for Instant 
Config page
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IBU_REG_USER CSI_INST_GENERAL_UPDA
TE

Update permission for Instant
General page

IBU_REG_USER CSI_INST_GENERAL_VIEW View permission for Instant 
General page

IBU_REG_USER CSI_LATEST_TRANSACTIO
N_UPDATE

Update permission for Latest 
Transaction page

IBU_REG_USER CSI_LATEST_TRANSACTIO
N_VIEW

View permission for Latest 
Transaction page

IBU_REG_USER CSI_PARTY_CONTACT_UP
DATE

Update permission for Party 
Contact page

IBU_REG_USER CSI_PARTY_CONTACT_VIE
W

View permission for Party 
Contact page

IBU_REG_USER CSI_PERZ_EDIT_UPDATE Update Permission for 
personalization edit page

IBU_REG_USER CSI_PERZ_EDIT_VIEW View permission for 
personalization edit page

IBU_REG_USER CSI_PRICING_UPDATE Update permission for Pricing
page

IBU_REG_USER CSI_PRICING_VIEW View permission for Pricing 
page

IBU_REG_USER CSI_PROPERTY_READ Read the CSI Properties

IBU_REG_USER CSI_REPAIR_ORDER_UPDA
TE

Update permission for Repair 
Order page

IBU_REG_USER CSI_REPAIR_ORDER_VIEW View permission for Repair 
Order page

IBU_REG_USER CSI_SEARCH_PRODUCT_U
PDATE

Update permission for Search 
Product page
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IBU_REG_USER CSI_SEARCH_PRODUCT_VI
EW

View permission for Search 
Product page

IBU_REG_USER CSI_SERVICE_REQUEST_UP
DATE

Update permission for Service
Request page

IBU_REG_USER CSI_SERVICE_REQUEST_VI
EW

View permission for Service 
Request page

IBU_REG_USER CSI_SHOW_EXT_CONTACT
S

Restricts Install Base User to 
view only the external 
contacts

IBU_REG_USER CSI_SHOW_EXT_LOCATIO
NS

Restricts the Install Base user 
to view only external 
locations

IBU_REG_USER CSI_SHOW_EXT_PARTIES Restricts the user to View 
only the External parties

IBU_REG_USER CSI_SHOW_INST_CUSTOM
ER_MENU

Permission to have the Install 
Base Customer facing 
instance details Menu

IBU_REG_USER CSI_SPLIT_QUANTITY_UPD
ATE

Update permission for Split 
Quantity page

IBU_REG_USER CSI_SPLIT_QUANTITY_VIE
W

View permission for Split 
Quantity page

IBU_REG_USER CSI_TRANSACTION_DETAI
L_UPDATE

Update permission for 
Transaction Detail page

IBU_REG_USER CSI_TRANSACTION_DETAI
L_VIEW

View permission for 
Transaction Detail page

IBU_REG_USER CSI_TRANSACTION_INSTA
NCE_UPDATE

Update permission for 
Transaction Instance page

IBU_REG_USER CSI_TRANSACTION_INSTA
NCE_VIEW

View permission for 
Transaction Instance page
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IBU_REG_USER CS_Advanced_Search Knowledge:Search: 
Permission to view the KM 
Advanced Search Page

IBU_REG_USER CS_Freq_Used_Sol_View Knowledge:Search: 
Permission to View 
frequently used solutions

IBU_REG_USER CS_Products_Add Add New Products Not 
through OM

IBU_REG_USER CS_Products_Delete Delete product from customer
view

IBU_REG_USER CS_Products_Report Install Base Report

IBU_REG_USER CS_Products_Update Change purchased product 
status and location

IBU_REG_USER CS_Products_View View Purchased Products

IBU_REG_USER CS_Rec_Sol_View Knowledge:Setup: Permission
to view recommended 
solutions

IBU_REG_USER CS_Solution_View Knowledge:Search: 
Permission to view solution

IBU_REG_USER CS_Solution_View_Public Knowledge Management 
view public solutions 

IBU_REG_USER CS_Statement_View Knowledge:Search: 
Permission to view statement

IBU_REG_USER CS_USED_COUNT_UPDATE Knowledge:Search: 
Permission to update solution
used count

IBU_REG_USER IBE_CHANGE_BILLTO_CO
NTACT

Permission to change the bill-
to contact while placing the 
order for an organization
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IBU_REG_USER IBE_CREATE_RETURN Permission to create return

IBU_REG_USER IBE_VIEW_INVOICE Permission to view invoice

IBU_REG_USER IBE_VIEW_ORDER Permission to view order

IBU_REG_USER IBE_VIEW_PAYMENT -

IBU_REG_USER IBE_VIEW_RETURN_ORDER Permission to view return 
order

IBU_REG_USER IBU_CallMe Submit a request for an agent 
to call back

IBU_REG_USER IBU_Contracts_View View Customer Contracts

IBU_REG_USER IBU_DEPOT_VIEW Depot Repair Orders View 
Permission. Used for depot 
repair summary, detail, and 
search pages. 

IBU_REG_USER IBU_Defects_View View Product Defects

IBU_REG_USER IBU_Homepage -

IBU_REG_USER IBU_Homepage_Update IBU Homepage Update

IBU_REG_USER IBU_Invoices_View View Customer Invoices

IBU_REG_USER IBU_Orders_View View Customer Orders

IBU_REG_USER IBU_Payments_View View Payments

IBU_REG_USER IBU_Profile_Update Update 
profile/personalization 
information

IBU_REG_USER IBU_Profile_View View customer 
profile/personalization 
information
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IBU_REG_USER IBU_Request_Add_Contact Add a Contact to Service 
Request 

IBU_REG_USER IBU_Request_Close Close a service request

IBU_REG_USER IBU_Request_Create Create a service request

IBU_REG_USER IBU_Request_Email_To_Me Request Service Request 
Details by Email

IBU_REG_USER IBU_Request_Escalate Change service request 
urgency

IBU_REG_USER IBU_Request_Manage_Templ
ates

Create, Update Service 
Request Templates

IBU_REG_USER IBU_Request_Manage_Views Create, Update Service 
Request Views/Saved 
Searches.

IBU_REG_USER IBU_Request_Reopen Reopen a Service Request

IBU_REG_USER IBU_Request_Search Search Service Requests

IBU_REG_USER IBU_Request_Update Add a comment to an open 
service request

IBU_REG_USER IBU_Request_Update_Solutio
n_Usefulness

Update Usefulness of the 
Solutions Suggested for a 
Service Request

IBU_REG_USER IBU_Request_View View service requests

IBU_REG_USER IBU_Request_View_Self -

IBU_REG_USER IBU_Returns_Add Create Return for a Product

IBU_REG_USER IBU_Returns_View View Customer Returns

IBU_REG_USER IBU_SR_SEND_EMAIL permission for user to send 
email (Service Request)
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IBU_REG_USER IBU_SR_TASK_VIEW_PUBLI
SH

The permission to view only 
publish tasks 

IBU_REG_USER IBU_SR_UPLOAD_ATTACH
MENT

Upload Attachment to Service
Request

IBU_REG_USER IBU_SR_VIEW_PROFILE_UP
DATE

View and profile update 
permission

IBU_REG_USER IBU_Survey_Create Fill in a predefined survey

IBU_REG_USER IBU_Technical_Library_View View technical 
documentation

IBU_SELF_SERVICE_HELPD
ESK

  

IBU_SYSTEM_ADMIN CS_Advanced_Search Knowledge:Search: 
Permission to view the KM 
Advanced Search Page

IBU_SYSTEM_ADMIN CS_Assoc_Ext_Obj_To_Sol Knowledge:Authoring: 
Permission to associate 
external object to solution

IBU_SYSTEM_ADMIN CS_Assoc_Ext_Obj_To_Stmt Knowledge:Authoring: 
Permission to associate 
external object to statement

IBU_SYSTEM_ADMIN CS_Categories_Update Knowledge:Setup: Permission
to update solution categories

IBU_SYSTEM_ADMIN CS_Categories_View Knowledge:Setup: Permission
to view solution categories 
setup pages

IBU_SYSTEM_ADMIN CS_EMPLOYEE_CONTACT_
ADD

Permission to add an 
Employee as a contact for a 
Customer product
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IBU_SYSTEM_ADMIN CS_Freq_Used_Def_Update Knowledge:Setup: Permission
to update frequently used 
solution definitions

IBU_SYSTEM_ADMIN CS_Freq_Used_Def_View Knowledge:Setup: Permission
to view frequently used 
solution definitions

IBU_SYSTEM_ADMIN CS_PROPERTY_UPDATE CS Property Update

IBU_SYSTEM_ADMIN CS_Personal_Profile_Update Knowledge:Other: Permission
to update Knowledge 
Management Personal Profile

IBU_SYSTEM_ADMIN CS_Products_Add Add New Products Not 
through OM

IBU_SYSTEM_ADMIN CS_Products_Delete Delete product from customer
view

IBU_SYSTEM_ADMIN CS_Products_Report Install Base Report

IBU_SYSTEM_ADMIN CS_Products_Update Change purchased product 
status and location

IBU_SYSTEM_ADMIN CS_Products_View View Purchased Products

IBU_SYSTEM_ADMIN CS_Rec_Sol_Update Knowledge:Setup: Permission
to update recommended 
solutions

IBU_SYSTEM_ADMIN CS_Sol_Auth_Profile_Update Knowledge:Authoring: 
Permission to update solution
authoring profile

IBU_SYSTEM_ADMIN CS_Solution_Comments_Add Knowledge:Authoring: 
Permission to add solution 
comments

IBU_SYSTEM_ADMIN CS_Solution_Create Knowledge:Authoring: 
Permission to create solution
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IBU_SYSTEM_ADMIN CS_Solution_Delete Knowledge:Authoring: 
Permission to delete solution

IBU_SYSTEM_ADMIN CS_Solution_Get_Lock Knowledge:Authoring: 
Permission to get solution 
lock from user

IBU_SYSTEM_ADMIN CS_Solution_Update Knowledge:Authoring: 
Permission to update solution

IBU_SYSTEM_ADMIN CS_Solution_View_Restricted Knowledge:Search: 
Permission to view public, 
internal, and restricted 
solutions

IBU_SYSTEM_ADMIN CS_Statement_Create Knowledge:Authoring: 
Permission to create 
statement

IBU_SYSTEM_ADMIN CS_Statement_Delete Knowledge:Authoring: 
Permission to delete 
statement

IBU_SYSTEM_ADMIN CS_Statement_Global_Update Knowledge:Authoring: 
Permission to update 
Statements globally

IBU_SYSTEM_ADMIN CS_Statement_Update Knowledge:Authoring: 
Permission to update 
statement

IBU_SYSTEM_ADMIN CS_Types_Edit Knowledge:Setup: Permission
to edit solution and statement
types

IBU_SYSTEM_ADMIN CS_Types_View Knowledge:Setup: Permission
to view solution and 
statement types setup pages

IBU_SYSTEM_ADMIN CS_Workflow_Setup_Update Knowledge:Setup: Permission
to update solution authoring 
workflow setup
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Role Permission Description

IBU_SYSTEM_ADMIN CS_Workflow_Setup_View Knowledge:Setup: Permission
to view solution authoring 
Workflow setup pages

IBU_SYSTEM_ADMIN IBE_CHANGE_BILLTO_CO
NTACT

Permission to change the bill-
to contact while placing the 
order for an organization

IBU_SYSTEM_ADMIN IBE_CREATE_RETURN Permission to create return

IBU_SYSTEM_ADMIN IBE_VIEW_INVOICE Permission to view invoice

IBU_SYSTEM_ADMIN IBE_VIEW_ORDER Permission to view order

IBU_SYSTEM_ADMIN IBE_VIEW_PAYMENT -

IBU_SYSTEM_ADMIN IBE_VIEW_RETURN_ORDER Permission to view return 
order

IBU_SYSTEM_ADMIN IBU_ADMIN_UPDATE IBU ADMIN UPDATE

IBU_SYSTEM_ADMIN IBU_ADMIN_VIEW IBU ADMIN VIEW

IBU_SYSTEM_ADMIN IBU_Account_Create To Create an Account to a 
party or organization

IBU_SYSTEM_ADMIN IBU_Call_Me_Edit Edit call me

IBU_SYSTEM_ADMIN IBU_Category_Edit Edit category

IBU_SYSTEM_ADMIN IBU_DEPOT_VIEW Depot Repair Orders View 
Permission. Used for depot 
repair summary, detail, and 
search pages. 

IBU_SYSTEM_ADMIN IBU_Personalized_Homepage
_Edit

Edit personalized homepage

IBU_SYSTEM_ADMIN IBU_Request_Management_E
dit

Edit request management
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Role Permission Description

IBU_SYSTEM_ADMIN IBU_Subscription_Edit Edit subscriptions

IBU_SYSTEM_ADMIN IBU_Survey_Create Fill in a pre-defined survey

IBU_SYSTEM_ADMIN IBU_Survey_Import Import survey

IBU_SYSTEM_ADMIN IBU_TEMPLATE_MANAGE
MENT

Permission for template 
Service Request

IBU_SYSTEM_ADMIN IBU_USER_MGMT Permission for User 
Management

IBU_SYSTEM_ADMIN IBU_USER_MGMT_VIEW_A
LL_ROLE

Permission to view all roles

IBU_SYSTEM_ADMIN IBU_USER_MGMT_VIEW_A
LL_USER

Permission to view all users

IBU_SYSTEM_ADMIN IBU_USER_MGMT_VIEW_C
OMPANY_USER

Permission to view company 
user

IBU_SYSTEM_ADMIN IBU_USER_MGMT_VIEW_M
Y_ROLE

Permission to view only my 
role

IBU_SYSTEM_ADMIN IBU_User_Group_Edit Edit user group

IBU_SYSTEM_ADMIN JTF_DAC_Maintain Maintain Data Access Control

IBU_SYSTEM_ADMIN JTF_REG_APPROVAL -

IBU_SYSTEM_ADMIN JTF_SECURITY_ASSIGN_RO
LE

Permission to assign roles

Configurability

Functions and Variables for Page-Level Configurability

Functions for Page-Level Configurability
The tables in this section list the functions that are used to place your customized Java 
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service pages (JSPs) around content pages that Oracle supplies. With these functions, 
you can configure the high-level look and feel of yourOracle iSupport web pages. The 
end of function names relates to the placement of a customized JSP on an Oracle content
page as follows:

• TOP means that a customized JSP will go at the top of the content page.

• LEFT means that a customized JSP will go at the left of the content page.

• RIGHT means that a customized JSP will go at the right of the content page.

• BOTTOM means that a customized JSP will go at the bottom of the content page.

All functions initially point to a dummy JSP page, gen_ibuConfigHolder.jsp.

The following table shows the initial list of configuration functions.

Functions to Configure the Look and Feel of Oracle Content Pages

 Name of Oracle Content Page Associated Function Name

Active Conferences IBU_OWC_SUMMARY_SECTION_TOP 
IBU_OWC_SUMMARY_SECTION_LEFT 
IBU_OWC_SUMMARY_SECTION_RIGHT 
IBU_OWC_SUMMARY_SECTION_BOTTOM

Contact Us (Call Me) IBU_CALLBACK_SECTION_TOP 
IBU_CALLBACK_SECTION_LEFT 
IBU_CALLBACK_SECTION_RIGHT 
IBU_CALLBACK_SECTION_BOTTOM

Create Service Request Confirmation IBU_SR_CNFG_CREATE_CNFM_TOP 
IBU_SR_CNFG_CREATE_CNFM_LEFT 
IBU_SR_CNFG_CREATE_CNFM_RIGHT 
IBU_SR_CNFG_CREATE_CNFM_BOTTOM

Create Service Request First Page IBU_SR_CNFG_CREATE_MAIN_TOP 
IBU_SR_CNFG_CREATE_MAIN_LEFT 
IBU_SR_CNFG_CREATE_MAIN_RIGHT 
IBU_SR_CNFG_CREATE_MAIN_BOTTOM

Create Service Request Template Page IBU_SR_CNFG_CREATE_TMPL_TOP 
IBU_SR_CNFG_CREATE_TMPL_LEFT 
IBU_SR_CNFG_CREATE_TMPL_RIGHT 
IBU_SR_CNFG_CREATE_TMPL_BOTTOM
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 Name of Oracle Content Page Associated Function Name

Create Service Request Verification IBU_SR_CNFG_CREATE_VRFY_TOP 
IBU_SR_CNFG_CREATE_VRFY_LEFT 
IBU_SR_CNFG_CREATE_VRFY_RIGHT 
IBU_SR_CNFG_CREATE_VRFY_BOTTOM

Home Page IBU_HOME_SECTION_TOP 
IBU_HOME_SECTION_LEFT 
IBU_HOME_SECTION_RIGHT 
IBU_HOME_SECTION_BOTTOM

Invoice Detail IBU_INVDT_SECTION_TOP 
IBU_INVDT_SECTION_LEFT 
IBU_INVDT_SECTION_RIGHT 
IBU_INVDT_SECTION_BOTTOM

Invoice Payment IBU_INVPT_SECTION_LEFT 
IBU_INVPT_SECTION_RIGHT 
IBU_INVPT_SECTION_TOP 
IBU_INVPT_SECTION_BOTTOM

Invoice Summary IBU_INVSU_SECTION_TOP 
IBU_INVSU_SECTION_LEFT 
IBU_INVSU_SECTION_RIGHT 
IBU_INVSU_SECTION_BOTTOM

Knowledge Management Browse CS_KB_BROWSE_TOP_FN 
CS_KB_BROWSE_LEFT_FN 
CS_KB_BROWSE_RIGHT_FN 
CS_KB_BROWSE_BOTTOM_FN

Refer to OracleKnowledge Management 
Implementation and Administration Guide for 
details on using these functions.

Knowledge Management Search Result CS_KB_SEARCH_RESULT_TOP_FN 
CS_KB_SEARCH_RESULT_LEFT_FN 
CS_KB_SEARCH_RESULT_RIGHT_FN 
CS_KB_SEARCH_RESULT_BOTTOM_FN

Refer to OracleKnowledge Management 
Implementation and Administration Guide for 
details on using these functions.
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 Name of Oracle Content Page Associated Function Name

Knowledge Management Solution Detail CS_KB_SOLN_DETAIL_TOP_FN 
CS_KB_SOLN_DETAIL_LEFT_FN 
CS_KB_SOLN_DETAIL_RIGHT_FN 
CS_KB_SOLN_DETAIL_BOTTOM_FN 

Refer to OracleKnowledge Management 
Implementation and Administration Guide for 
details on using these functions.

Line Details (from the Order Details page) IBU_ORDERLD_SECTION_TOP 
IBU_ORDERLD_SECTION_LEFT 
IBU_ORDERLD_SECTION_RIGHT 
IBU_ORDERLD_SECTION_BOTTOM

Order Details IBU_ORDERDT_SECTION_TOP 
IBU_ORDERDT_SECTION_LEFT 
IBU_ORDERDT_SECTION_RIGHT 
IBU_ORDERDT_SECTION_BOTTOM

Order Shipment IBU_ORDERSH_SECTION_LEFT 
IBU_ORDERSH_SECTION_RIGHT 
IBU_ORDERSH_SECTION_TOP 
IBU_ORDERSH_SECTION_BOTTOM

Order Summary IBU_ORDERSU_SECTION_TOP 
IBU_ORDERSU_SECTION_LEFT 
IBU_ORDERSU_SECTION_RIGHT 
IBU_ORDERSU_SECTION_BOTTOM

Payment Detail IBU_PAYDT_SECTION_LEFT 
IBU_PAYDT_SECTION_RIGHT 
IBU_PAYDT_SECTION_TOP 
IBU_PAYDT_SECTION_BOTTOM

Payment Summary IBU_PAYSU_SECTION_TOP 
IBU_PAYSU_SECTION_LEFT 
IBU_PAYSU_SECTION_RIGHT 
IBU_PAYSU_SECTION_BOTTOM

Return Confirmation IBU_RETCONF_SECTION_TOP 
IBU_RETCONF_SECTION_LEFT 
IBU_RETCONF_SECTION_RIGHT 
IBU_RETCONF_SECTION_BOTTOM
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 Name of Oracle Content Page Associated Function Name

Return Creation IBU_RETCRT_SECTION_TOP 
IBU_RETCRT_SECTION_LEFT 
IBU_RETCRT_SECTION_RIGHT 
IBU_RETCRT_SECTION_BOTTOM

Return Detail IBU_RETDET_SECTION_TOP 
IBU_RETDET_SECTION_LEFT 
IBU_RETDET_SECTION_RIGHT 
IBU_RETDET_SECTION_BOTTOM

Return Search IBU_RETSRCH_SECTION_TOP 
IBU_RETSRCH_SECTION_LEFT 
IBU_RETSRCH_SECTION_RIGHT 
IBU_RETSRCH_SECTION_BOTTOM

Return Summary IBU_RETSUM_SECTION_TOP 
IBU_RETSUM_SECTION_LEFT 
IBU_RETSUM_SECTION_RIGHT 
IBU_RETSUM_SECTION_BOTTOM

Service Request Details IBU_SR_CNFG_DETAILS_TOP 
IBU_SR_CNFG_DETAILS_LEFT 
IBU_SR_CNFG_DETAILS_RIGHT 
IBU_SR_CNFG_DETAILS_BOTTOM

Service Request Search IBU_SR_CNFG_SEARCH_TOP 
IBU_SR_CNFG_SEARCH_LEFT 
IBU_SR_CNFG_SEARCH_RIGHT 
IBU_SR_CNFG_SEARCH_BOTTOM

Service Request Summary IBU_SR_CNFG_SUMMARY_TOP 
IBU_SR_CNFG_SUMMARY_LEFT 
IBU_SR_CNFG_SUMMARY_RIGHT 
IBU_SR_CNFG_SUMMARY_BOTTOM

Technical Library IBU_TECHLIB_SECTION_TOP 
IBU_TECHLIB_SECTION_LEFT 
IBU_TECHLIB_SECTION_RIGHT 
IBU_TECHLIB_SECTION_BOTTOM

The following table augments the content of the previous one with more functions.
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More Functions to Configure the Look and Feel of Oracle iSupport Content Pages

Name of Oracle Content Page Associated Function Name

Add/Update Service Request Contacts: 
Bottom

IBU_SR_CNFG_DTL_CONTACT_BOTTOM

Add/Update Service Request Contacts: Left IBU_SR_CNFG_DTL_CONTACT_LEFT

Add/Update Service Request Contacts: Right IBU_SR_CNFG_DTL_CONTACT_RIGHT

Add/Update Service Request Contacts: Top IBU_SR_CNFG_DTL_CONTACT_TOP

Close Service Request: Bottom IBU_SR_CNFG_DTL_CLOSE_BOTTOM

Close Service Request: Left IBU_SR_CNFG_DTL_CLOSE_LEFT

Close Service Request: Right IBU_SR_CNFG_DTL_CLOSE_RIGHT

Close Service Request: Top IBU_SR_CNFG_DTL_CLOSE_TOP

Create Service Request Contact Information: 
Bottom

IBU_SR_CNFG_CREATE_CI_BOTTOM

Create Service Request Contact Information: 
Left

IBU_SR_CNFG_CREATE_CI_LEFT

Create Service Request Contact Information: 
Right

IBU_SR_CNFG_CREATE_CI_RIGHT

Create Service Request Contact Information: 
Top

IBU_SR_CNFG_CREATE_CI_TOP

Create Service Request Request Type 
Selection: Bottom

IBU_SR_CNFG_CREATE_TYPE_BOTTOM

Create Service Request Request Type 
Selection: Left

IBU_SR_CNFG_CREATE_TYPE_LEFT

Create Service Request Request Type 
Selection: Right

IBU_SR_CNFG_CREATE_TYPE_RIGHT
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Name of Oracle Content Page Associated Function Name

Create Service Request Request Type 
Selection: Top

IBU_SR_CNFG_CREATE_TYPE_TOP

Create Service Request Template Request 
Type Selection: Bottom

IBU_SR_CNFG_TEMP_TYPE_BOTTOM

Create Service Request Template Request 
Type Selection: Left

IBU_SR_CNFG_TEMP_TYPE_LEFT

Create Service Request Template Request 
Type Selection: Right

IBU_SR_CNFG_TEMP_TYPE_RIGHT

Create Service Request Template Request 
Type Selection: Top

IBU_SR_CNFG_TEMP_TYPE_TOP

Create Service Request Template: Bottom IBU_SR_CNFG_TEMP_CREATE_BOTTOM

Create Service Request Template: Left IBU_SR_CNFG_TEMP_CREATE_LEFT

Create Service Request Template: Right IBU_SR_CNFG_TEMP_CREATE_RIGHT

Create Service Request Template: Top IBU_SR_CNFG_TEMP_CREATE_TOP

Create Service Request View: Bottom IBU_SR_CNFG_VW_CREATE_BOTTOM

Create Service Request View: Left IBU_SR_CNFG_VW_CREATE_LEFT

Create Service Request View: Right IBU_SR_CNFG_VW_CREATE_RIGHT

Create Service Request View: Top IBU_SR_CNFG_VW_CREATE_TOP

Depot Details: Bottom IBU_DEPOTDT_SECTION_BOTTOM

Depot Details: Left IBU_DEPOTDT_SECTION_LEFT

Depot Details: Right IBU_DEPOTDT_SECTION_RIGHT

Depot Details: Top IBU_DEPOTDT_SECTION_TOP

Depot Search: Bottom IBU_DEPOTSRCH_SECTION_BOTTOM
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Name of Oracle Content Page Associated Function Name

Depot Search: Left IBU_DEPOTSRCH_SECTION_LEFT

Depot Search: Right IBU_DEPOTSRCH_SECTION_RIGHT

Depot Search: Top IBU_DEPOTSRCH_SECTION_TOP

Depot Summary: Left IBU_DEPOTSU_SECTION_LEFT

Depot Summary: Bottom IBU_DEPOTSU_SECTION_BOTTOM

Depot Summary: Right IBU_DEPOTSU_SECTION_RIGHT

Depot Summary: Top IBU_DEPOTSU_SECTION_TOP

Order Details: Line Billing Details: Bottom IBU_SHIP_LINEBILL_DTL_BOTTOM

Order Details: Line Billing Details: Left IBU_SHIP_LINEBILL_DTL_LEFT

Order Details: Line Billing Details: Right IBU_SHIP_LINEBILL_DTL_RIGHT

Order Details: Line Billing Details: Top IBU_SHIP_LINEBILL_DTL_TOP

Order Details: Line Shipping Details: Bottom IBU_SHIP_LINESHP_DTL_BOTTOM

Order Details: Line Shipping Details: Left IBU_SHIP_LINESHP_DTL_LEFT

Order Details: Line Shipping Details: Right IBU_SHIP_LINESHP_DTL_RIGHT

Order Details: Line Shipping Details: Top IBU_SHIP_LINESHP_DTL_TOP

Reopen Service Request: Bottom IBU_SR_CNFG_DTL_REOPEN_BOTTOM

Reopen Service Request: Left IBU_SR_CNFG_DTL_REOPEN_LEFT

Reopen Service Request: Right IBU_SR_CNFG_DTL_REOPEN_RIGHT

Reopen Service Request: Top IBU_SR_CNFG_DTL_REOPEN_TOP

Returns: Billing Details Page For B2B 
customer: Bottom

IBU_RET_BILLDTL_BOTTOM
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Name of Oracle Content Page Associated Function Name

Returns: Billing Details Page For B2B 
customer: Left

IBU_RET_BILLDTL_LEFT

Returns: Billing Details Page For B2B 
customer: Right

IBU_RET_BILLDTL_RIGHT

Returns: Billing Details Page For B2B 
customer: Top

IBU_RET_BILLDTL_TOP

Returns: Review and Submit Page: Bottom IBU_RET_REVIEW_BOTTOM

Returns: Review and Submit Page: Left IBU_RET_REVIEW_LEFT

Returns: Review and Submit Page: Right IBU_RET_REVIEW_RIGHT

Returns: Review and Submit Page: Top IBU_RET_REVIEW_TOP

Returns: Search & Select item (Multi Order 
Flow): Bottom

IBU_RET_CREMULTI_ORD_BOTTOM

Returns: Search & Select item (Multi Order 
Flow): Left

IBU_RET_CREMULTI_ORD_LEFT

Returns: Search & Select item (Multi Order 
Flow): Right

IBU_RET_CREMULTI_ORD_RIGHT

Returns: Search & Select item (Multi Order 
Flow): Top

IBU_RET_CREMULTI_ORD_TOP

Returns: Select Items (Single Order Flow): 
Bottom

IBU_RET_CRESINGLE_ORD_BOTTOM

Returns: Select Items (Single Order Flow): Left IBU_RET_CRESINGLE_ORD_LEFT

Returns: Select Items (Single Order Flow): 
Right

IBU_RET_CRESINGLE_ORD_RIGHT

Returns: Select Items (Single Order Flow): Top IBU_RET_CRESINGLE_ORD_TOP

Returns: View Address Main Page: Bottom IBU_RET_ADDRESS_BOTTOM
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Name of Oracle Content Page Associated Function Name

Returns: View Address Main Page: Left IBU_RET_ADDRESS_LEFT

Returns: View Address Main Page: Right IBU_RET_ADDRESS_RIGHT

Returns: View Address Main Page: Top IBU_RET_ADDRESS_TOP

Returns: View Contacts Main Page: Bottom IBU_RET_CONTACT_BOTTOM

Returns: View Contacts Main Page: Left IBU_RET_CONTACT_LEFT

Returns: View Contacts Main Page: Right IBU_RET_CONTACT_RIGHT

Returns: View Contacts Main Page: Top IBU_RET_CONTACT_TOP

Service Request Request Escalation: Bottom IBU_SR_CNFG_DTL_ESC_BOTTOM

Service Request Request Escalation: Left IBU_SR_CNFG_DTL_ESC_LEFT

Service Request Request Escalation: Right IBU_SR_CNFG_DTL_ESC_RIGHT

Service Request Request Escalation: Top IBU_SR_CNFG_DTL_ESC_TOP

Service Request Solution Detail: Bottom IBU_SR_CNFG_SOL_DETAIL_BOTTOM

Service Request Solution Detail: Left IBU_SR_CNFG_SOL_DETAIL_LEFT

Service Request Solution Detail: Right IBU_SR_CNFG_SOL_DETAIL_RIGHT

Service Request Solution Detail: Top IBU_SR_CNFG_SOL_DETAIL_TOP

Service Request Suggested Solutions: Bottom IBU_SR_CNFG_SUG_SOL_BOTTOM

Service Request Suggested Solutions: Left IBU_SR_CNFG_SUG_SOL_LEFT

Service Request Suggested Solutions: Right IBU_SR_CNFG_SUG_SOL_RIGHT

Service Request Suggested Solutions: Top IBU_SR_CNFG_SUG_SOL_TOP

Service Request Template Summary: Bottom IBU_SR_CNFG_TEMP_SUMM_BOTTOM
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Name of Oracle Content Page Associated Function Name

Service Request Template Summary: Left IBU_SR_CNFG_TEMP_SUMM_LEFT

Service Request Template Summary: Right IBU_SR_CNFG_TEMP_SUMM_RIGHT

Service Request Template Summary: Top IBU_SR_CNFG_TEMP_SUMM_TOP

Service Request View Summary: Bottom IBU_SR_CNFG_VW_SUMMARY_BOTTOM

Service Request View Summary: Left IBU_SR_CNFG_VW_SUMMARY_LEFT

Service Request View Summary: Right IBU_SR_CNFG_VW_SUMMARY_RIGHT

Service Request View Summary: Top IBU_SR_CNFG_VW_SUMMARY_TOP

Shipment Details for Shipment Number: 
Bottom

IBU_SHIP_DLVY_DTL_BOTTOM

Shipment Details for Shipment Number: Left IBU_SHIP_DLVY_DTL_LEFT

Shipment Details for Shipment Number: Right IBU_SHIP_DLVY_DTL_RIGHT

Shipment Details for Shipment Number: Top IBU_SHIP_DLVY_DTL_TOP

Site Selection: Bottom IBU_H_SITE_SECTION_BOTTOM

Site Selection: Left IBU_H_SITE_SECTION_LEFT

Site Selection: Right IBU_H_SITE_SECTION_RIGHT

Site Selection: Top IBU_H_SITE_SECTION_TOP

Survey: Bottom IBU_SURVEYSU_SECTION_BOTTOM

Survey: Left IBU_SURVEYSU_SECTION_LEFT

Survey: Right IBU_SURVEYSU_SECTION_RIGHT

Survey: Top IBU_SURVEYSU_SECTION_TOP

Technical Library Download: Bottom IBU_TECHLIB_D_SECTION_BOTTOM
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Name of Oracle Content Page Associated Function Name

Technical Library Download: Left IBU_TECHLIB_D_SECTION_LEFT

Technical Library Download: Right IBU_TECHLIB_D_SECTION_RIGHT

Technical Library Download: Top IBU_TECHLIB_D_SECTION_TOP

Technical Library Search: Bottom IBU_TECHLIB_S_SECTION_BOTTOM

Technical Library Search: Left IBU_TECHLIB_S_SECTION_LEFT

Technical Library Search: Right IBU_TECHLIB_S_SECTION_RIGHT

Technical Library Search: Top IBU_TECHLIB_S_SECTION_TOP

Update Service Request Template: Bottom IBU_SR_CNFG_TEMP_UPDATE_BOTTOM

Update Service Request Template: Left IBU_SR_CNFG_TEMP_UPDATE_LEFT

Update Service Request Template: Right IBU_SR_CNFG_TEMP_UPDATE_RIGHT

Update Service Request Template:Top IBU_SR_CNFG_TEMP_UPDATE_TOP

Update Service Request View: Bottom IBU_SR_CNFG_VW_UPDATE_BOTTOM

Update Service Request View: Left IBU_SR_CNFG_VW_UPDATE_LEFT

Update Service Request View: Right IBU_SR_CNFG_VW_UPDATE_RIGHT

Update Service Request View: Top IBU_SR_CNFG_VW_UPDATE_TOP

Variables for Page-Level Configurability
The table in this section lists the variables that are available to use in your customized 
Java service pages (JSPs). The variables provide access to elements of the content that 
Oracle supplies. 
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Context Variables Available for Custom JSPs

Context Variable for a Logged-In User Java Method to Retrieve the Context 
Variable

UserID ((Long)pageContext.getAttribute 
("ibuConfigUserID", PageContext.
REQUEST_SCOPE))

RespID id ((Long)pageContext.getAttribute 
("ibuConfigRespID",PageContext.
REQUEST_SCOPE))

AppID id ((Long)pageContext.getAttribute 
("ibuConfigAppID", PageContext.
REQUEST_SCOPE))

RespAppID ((Long)pageContext.getAttribute 
("ibuConfigRespAppID", PageContext.
REQUEST_SCOPE))

CustomerID ((Long)pageContext.getAttribute 
("ibuConfigCustomerID", PageContext.
REQUEST_SCOPE))

CompanyID ((Long)pageContext.getAttribute 
("ibuConfigCompanyID", PageContext.
REQUEST_SCOPE))

CompanyName (String)pageContext.getAttribute 
("ibuConfigCompanyName", PageContext.
REQUEST_SCOPE

UserName (String)pageContext.getAttribute 
("ibuConfigUserName", PageContext.
REQUEST_SCOPE))

FirstName (String)pageContext.getAttribute 
("ibuConfigFirstName", PageContext.
REQUEST_SCOPE))

LastName (String)pageContext.getAttribute 
("ibuConfigLastName", PageContext.
REQUEST_SCOPE))
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Context Variable for a Logged-In User Java Method to Retrieve the Context 
Variable

user session ((oracle.apps.jtf.base.session.FWSession)
pageContext.getAttribute 
("ibuConfigFWSession", PageContext.
REQUEST_SCOPE))

AppsContext ((oracle.apps.jtf.base.session.FWAppsContext)
pageContext.getAttribute 
("ibuConfigFWAppsContext", PageContext.
REQUEST_SCOPE)).

Connection ((oracle.apps.jtf.base.session.FWAppsContext)
pageContext.getAttribute 
("ibuConfigFWAppsContext", PageContext.
REQUEST_SCOPE)).getConnection()

Service Request

Seeded Configurable Pages
The following table lists the Oracle iSupport configurable service request pages and 
their associated top-level regions. Use this table in conjunction with the utility UI, 
which lists the attributes for top-level regions.

Oracle iSupport Top-Level Regions for Service Request Pages

Page Name Code for Top-Level Region

Close Service Request IBU_CF_SR_CLOSE

Create Service Request Template IBU_CF_SR_TEMP_CREATE_TEMPLATE

Create Service Request Template: Additional 
Contacts

IBU_CF_SR_TEMP_ADDL_CONTACTS

Create Service Request Template: Select 
Request 

IBU_CF_SR_TEMP_TYPE_SELECTION

Create Service Request View IBU_CF_SR_VW_CREATE
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Page Name Code for Top-Level Region

Create Service Request: Additional Contacts IBU_CF_SR_ADDITIONAL_CONTACTS

Create Service Request: Confirmation IBU_CF_SR_CR_CONFIRMATION

Create Service Request: Contact Information IBU_CF_SR_CR_CONTACT_INFO

Create Service Request: Identify Problem IBU_CF_SR_CR_IDENTIFY_PROBLEM

Create Service Request: Problem Details IBU_CF_SR_CR_PROBLEM_DETAILS

Create Service Request: Problem Resolved IBU_CF_SR_PROBLEM_RESOLVED

Create Service Request: Review IBU_CF_SR_CR_REVIEW

Create Service Request: Select Request Type IBU_CF_SR_CR_TYPE_SELECTION

Create Service Request: Suggested Solutions IBU_CF_SR_SUGGESTED_SOLUTIONS

Delete/Remove Confirmation IBU_CF_SR_REMOVE_CONFIRMATION

Edit Service Request Quick Link IBU_CF_SR_VW_QL_UPDATE

Field Level Help IBU_CF_SR_FIELD_LEVEL_HELP

List of Values: All Products IBU_CF_SR_LOV_ALL_PRODUCTS

List of Values: Bill To Address IBU_CF_SR_LOV_BILL_TO_ADDRESS

List of Values: Bill To Contact IBU_CF_SR_LOV_BILL_TO_CONTACT

List of Values: Contact Points IBU_CF_SR_LOV_CONTACT_POINTS

List of Values: Contacts IBU_CF_SR_LOV_CONTACTS

List of Values: Incident Address IBU_CF_SR_LOV_INCIDENT_ADDRESS

List of Values: Installed At Address IBU_CF_SR_LOV_INSTALL_ADDRESS

List of Values: Problem Type IBU_CF_SR_LOV_PROBLEM_TYPE
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Page Name Code for Top-Level Region

List of Values: Product Version IBU_CF_SR_LOV_PROD_VERSION

List of Values: Registered Products IBU_CF_SR_LOV_REG_PRODUCTS

List of Values: Ship To Address IBU_CF_SR_LOV_SHIP_TO_ADDRESS

List of Values: Ship To Contact IBU_CF_SR_LOV_SHIP_TO_CONTACT

Reopen Service Request IBU_CF_SR_REOPEN

Search Service Request IBU_CF_SR_VW_SEARCH

Service Request Details IBU_CF_SR_DETAILS

Service Request Escalation Request IBU_CF_SR_REQUEST_ESCALATION

Service Request Summary IBU_CF_SR_SUMMARY

Service Request Template Summary IBU_CF_SR_TEMP_SUMMARY

Service Request View Summary IBU_CF_SR_VW_SUMMARY

Service Request: Add Contact IBU_CF_SR_ADD_CONTACT

Service Request: Update Contact IBU_CF_SR_UPDATE_CONTACT

Solution Details (During Create Service 
Request)

IBU_CF_SR_CR_SOLUTION_DETAIL

Solution Details (Linked to Service Request) IBU_CF_SR_SOLUTION_DETAIL

Update Service Request Template IBU_CF_SR_TEMP_UPDATE_TEMPLATE

Update Service Request View IBU_CF_SR_VW_UPDATE

Online Help Targets
The following table shows the online help targets for pages in Oracle iSupport. Use the 
targets in the help pages that you customize for the service request pages that you 
configure and in other help pages whose text you want to change.
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Online Help Targets for Oracle iSupport Pages

Page Description Target Name for Online Help

Active Conferences ibuConfSummary

Create Service Request: Select Request Type IbuSRSelectRequestType

Create Service Request: Identify Problem IbuSRIdentifyProblem

Create Service Request: Problem Details IbuSRProblemDetails

Create Service Request: Suggested Solutions IbuSRSuggestedSolutions

Solution Details IbuSRSolutionDetail

Create Service Request: Problem Resolved IbuSRProblemResolved

Create Service Request: Contact Information IbuSRContactInformation

Create Service Request: Additional Contacts IbuSRAdditionalContacts

Create Service Request: Review IbuSRReview

Create Service Request: Confirmation IbuSRCRConfirmation

Service Request Summary IbuSRServiceRequestSummary

Service Request Details IbuSRDetails

Service Request Details: Add Contact IbuSRDetailsAddContact

Service Request Details: Update Contact IbuSRDetailsUpdateContact

Close Service Request, Service Request 
Escalation Request, Reopen Service Request

IbuSRDetailsActions

Service Request View Summary IbuSRViewSummary

Create Service Request View IbuSRCreateView

Update Service Request View IbuSRUpdateView
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Page Description Target Name for Online Help

Search Service Request IbuSRSearch

Service Request Template Summary IbuSRTemplateSummary

Create Service Request Template: Select 
Request Type

IbuSRTempSelectRequestType

Create Service Request Template IbuSRCreateTemplate

Create Service Request Template: Additional 
Contacts

IbuSRTempAddContacts

Update Service Request Template IbuSRUpdateTemplate

Delete/Remove Confirmation. (For now it is 
used for Service Request Quick Links, Views, 
and Templates.)

IbuSRRemoveConfirmation

Edit Service Request Quick Links IbuSRQLEdit

Order Summary IBUIORD

Order Detail IBUIORDD

Order Shipments IBUIORDS

Order Shipments Details IBUIORDSD

Order Line Details IBUIORDL

Returns Summary IBUIRET

Returns Detail IBUIRETD

Returns Line Details IBUIRETL

Return Create IBUIRETC

Return Create Review and Submit IBUIRETCR
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Page Description Target Name for Online Help

Return Create Confirmation IBUIRETCC

Technical Library Administration IBUACAT

Configuring Call Me IBUACM

Configuring Surveys/Feedback: Create IBUAFBC

Surveys administration IBUAFBX

Administering Forums IBUAFCC

Maintaining Categories IBUAFCR

Creating Forums IBUAFFC

Maintaining Forums IBUAFFNC

Maintaining Messages IBUAFMM

Using Forum Moderators IBUAFMOD

Maintaining Users IBUALLUSER

Enabling Homepage E-Mails IBUASUB

User group Administration IBUAUGSP

Searching within Forums IBUFADSE

Using Forums IBUFCATV

Posting New Messages to Forums IBUFMSGP

Viewing Forums IBUFMSGV

Maintaining the Homepage IBUHACNT

Changing Mandatory Bin Layout/Display IBUHALYT
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Page Description Target Name for Online Help

Adding MES Content to Homepage IBUHAMES

Using the Homepage IBUHPAGE

Tracking Service Requests on Homepage IBUHSREDT

Choosing Homepage Content IBUHUCNT

Changing Homepage Display IBUHULYT

Viewing Invoices IBUIINVS

Using Accounts IBUIORD

Viewing Payments IBUIPMTS

Technical Library IBUKTL

Replying to Forum Messages IBUMSGR

Requesting a Support Call Back IBUPCMP

Responding to Surveys IBUPFBGL

Enabling Homepage E-mail Subscriptions IBUPROFGENERAL

Service Request Templates IBUTPTMS

Changing Default Customer Account IBUUMPROFACCOUNT

Adding/Changing Address Information IBUUMPROFADDR

Viewing Administrators Information IBUUMPROFADMINV

Adding/Changing Company Information IBUUMPROFCMPY

Adding/Changing Contact Points (Phone/E-
mail/Fax)

IBUUMPROFCTPTV

Setting User Homepage E-mail Subscription IBUUMPROFGENERAL
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Page Description Target Name for Online Help

Changing/Resetting Password IBUUMPROFPP

Setting General Preferences JTFGENPREF

Viewing Contracts OKCWKTOP

Support Language Administration IBUALANGMAP

Site Selection Page IBUSITESELECTION

Java Classes for Seeded Bins
The following table shows the Java classes for seeded Oracle iSupport bins. Use these 
class files to create new bins if you remove these bins from the default setup.

 Java Classes for Seeded Oracle iSupport Bins

Bin Name Associated Java Class

Alert oracle.apps.ibu.homepage.AlertBinRenderer 

Solve a Problem oracle.apps.ibu.homepage.
FindSolBinRenderer

Help oracle.apps.ibu.homepage.HelpBinRenderer 

Join Conference oracle.apps.ibu.homepage.
WebConferenceBinRenderer

Language Picker oracle.apps.ibu.homepage.
LanguagePickerRenderer 

Login oracle.apps.ibu.homepage.LoginBinRenderer 

MES oracle.apps.ibu.homepage.MesBinRenderer 

Service Request Quick Link oracle.apps.ibu.homepage.
QLServiceRequestBinRenderer 
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Bin Name Associated Java Class

Solution Quick Link oracle.apps.ibu.homepage.
QuickLinkBinRenderer 

Quick Navigation oracle.apps.ibu.homepage.
QuickNavBinRenderer 

Responsibility Picker oracle.apps.ibu.homepage.
ResponsibilityPickerRenderer 

Service Request oracle.apps.ibu.homepage.
ServiceRequestBinRenderer 

Technical Library oracle.apps.ibu.homepage.
TechLibBinRenderer
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D
Custom Look and Feel Configuration

This appendix covers the following topics:

• Overview of Custom Look and Feel Configuration

• Implementation Steps

• Sample Code

Overview of Custom Look and Feel Configuration
This appendix provides the technical design of a sample implementation of an Oracle 
iSupport custom menu (custom navigation) utilizing the custom navigation framework.
Its sole purpose is to demonstrate the custom navigation features in Oracle iSupport. 
Customers of Oracle iSupport should not adapt any sample source code from this 
document to production environments without further testing of functionality and 
performance.

Implementation Steps
This section lists the implementation steps needed to implement the custom menu in 
Oracle iSupport at a responsibility level and provides the sample source code and the 
resultant screenshots for this implementation. Oracle assumes that the reader of this 
document is familiar with the Oracle JTT Framework used by Oracle iSupport and the 
HTML, JSP, and Java technologies.

The custom navigation framework provides access to all menu objects that are currently
available under the Oracle look and feel implementation. The purpose of this 
framework is to delegate the HTML rendering portion in a page to a customer-defined 
rendering java class. The menu definition attached to a responsibility continues to be 
retrieved in the same manner as is currently done.

The custom menu framework gives a developer control of the menu-rendering area on 
a page by inserting custom HTML and menu-rendering code in the highlighted regions 
of the page. The support organizations should refer to the JTT custom navigation 
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developer guide for the details regarding this framework. 

The following pictures show the before and after look and feel of a page for which a 
custom menu renderer is implemented:

The following figure shows a home page before implementation of a custom menu 
class. The figure descriptions refer to color, which may be available in some media.

The periphery of the page will be changed and appears in yellow as follows:

1. The page title, Oracle iSupport, appears in the upper left of the yellow header 
region.

2. In the yellow header region, the following links appear horizontally in the upper 
right corner:

1. iSupport

2. Contact Us

3. Feedback

4. Profile

5. Sign Out

6. Help

3. Immediately below these links, the following tabs appear horizontally:

1. Home

2. Account

3. Support

4. The Quick Find LOV and the Go button appear centered below the darkened tab 
bar.

5. The narrow left and right yellow borders are blank.

6. In the yellow footer region, the following links appear centered horizontally:

1. Home

2. Account

3. Support

4. iSupport
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5. Contact Us

6. Feedback

7. Profile

8. Sign Out

9. Help

Home Page before Implementation of a Custom Menu Class

The following figure shows the home page after implementation of a custom menu 
class.

The periphery of the page has changed and appears in yellow as follows:

1. The page title, Vision Enterprises, appears in the upper left of the yellow header 
region.

2. The tabs are gone from their former location.

3. In the yellow header region about where the tab bar appeared, the following links 
appear horizontally in a darkened bar in the following order:
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1. iSupport

2. Contact Us

3. Feedback

4. Profile

5. Sign Out

6. Help

4. The left and right yellow borders are wider than before and squeeze the central 
region to make it narrower horizontally. The right border remains blank.

5. The left border is titled iSupport and has the following links arranged vertically:

1. Name

2. Account

3. Support

6. In the yellow footer region, the following links appear horizontally in a darkened 
bar in the following order: 

1. iSupport

2. Contact Us

3. Feedback

4. Profile

5. Sign Out

6. Help
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Home Page after Implementation of a Custom Menu Class

Steps Performed
1. Identified all the HTML codes that were required to serve as the page header and 

page footer in the prototype. In this example, we stripped out HTML codes that 
were used to render the yellow regions from the source web site. In an actual 
implementation, the support organization may write this code.

2. Retrieved all style sheet classes for the sample site and saved them in the 
$OA_HTML directory. Additionally, we overrode some JTT style sheet classes in 
this custom style sheet for the prototype. For example, we overrode style sheet 
classes for the following elements in this style sheet: 

• Table background

• Table cell color

• Page title (and so on)

3. A support organization must create a new java class to implement the menu 
feature. For the purpose of this document, a new java class, oracle.apps.ibu.menu.
VisionRenderer, was created to implement the JTT CustomRenderer class. The 
following two methods were used to render the above yellow regions for the 
prototype:
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• public void renderBegin(CustomRenderingContext crc) - Yellow header region

• public void renderEnd(CustomRenderingContext crc) - Yellow footer region

The HTML codes collected from step 1 were embedded in the following 
rendering methods for page header and footer. In both these methods, the 
developer has access to the following menu data, including the menu-
highlighting indicator:

• Global icons

• Tab navigation bar

• Second level tab navigation

• Side navigation menu

4. To use this custom menu class, register the following profile option, and set the 
custom menu class for the Oracle iSupport responsibility used for the prototype: 

JTF_NAV_CUSTOM_RENDERER - oracle.apps.ibu.menu.VisionRenderer

This profile option should be created under the CRM Foundation, not Oracle 
iSupport. After it is created, you can set the value of the profile option at the Oracle 
iSupport responsibility level.

5. After you bounce the middle tier, the new menu renderer will be used when a user 
logs in using the responsibility for which the custom menu class has been set in the 
profile option.

Sample Code
The following sample code, VisionRenderer.java, demonstrates the custom menu class. 
A support organization should not adapt any sample source codes from this document to 
production environments without further testing of functionality and performance. 

The custom class for the prototype does not render the following elements that a 
support organization could add when it defines a custom class:

• Quick Find

• Application switcher

• Bottom menu

• Privacy link



Custom Look and Feel Configuration    D-7

VisionRenderer.java
 |  FILENAME
|

 |    VisionRenderer.java
|

 |
|

 |  DESCRIPTION
|

 |    Custom Menu Renderer - Sample
|

 |
|

 |  NOTES
|

 |
|

 |  DEPENDENCIES
|

 |
|

 |  HISTORY
|

 |    4/25/2002  ktma  created.
|

 
+=======================================================================
===*/

package oracle.apps.ibu.menu;

import java.io.PrintWriter;

import oracle.apps.fnd.common.VersionInfo;

import oracle.apps.jtf.ui.menu.CustomRenderer;

import oracle.apps.jtf.ui.menu.CustomRenderingContext;

import oracle.apps.jtf.ui.menu.MenuItem;
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import oracle.apps.jtf.ui.menu.MenuItemList;

import oracle.apps.jtf.ui.menu.QuickSearch;

import oracle.apps.jtf.ui.menu.MenuURI;

import oracle.apps.jtf.ui.menu.blaf.PageNavigation;

/**

 * custom renderer for Vision Company

 */

public class VisionRenderer extends CustomRenderer {

  /** The version control ID. */

  public final static String RCS_ID =

    "$Header: $";

  public static final boolean RCS_ID_RECORDED =

    VersionInfo.recordClassVersion(RCS_ID, "oracle.apps.ibu.menu");

  /**

   * Constructs a demo custom renderer.

   */

  protected VisionRenderer() {}

  /**

   * Gets an instance of this custom renderer.

   *

   * @return an instance of this custom renderer

   */

  public static CustomRenderer getInstance() {

      // we maintain only one instance in this demo

      if (singleInstance == null) singleInstance = new VisionRenderer();
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      return singleInstance;

  }

  // if a menu item has a MenuURI object,

  // we can add extra parameters to the URI

  // some menu item URI cannot be modified,

  // getURI() returns null in that case

  private static String getURI(MenuItem mi) {

      MenuURI muri = mi.getURI();

      if (muri != null) {

          muri.addParameter("custom", "y");

          return muri.getURI();

      } else {

          return mi.getDestination();

      }

  }

  /**

   * Renders the top part of the navigation.

   * In Oracle browser look and feel, this is the part from the top of 
the

   * page to the end of the side navigation.

   * The caller of this method

   * should ensure that the given rendering context is not null; 
otherwise

   * a <code>NullPointerException</code> may be thrown.

   *

   * @param crc the rendering context used for rendering
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   */

  public void renderBegin(CustomRenderingContext crc) {

    PrintWriter out = crc.getOutput();

    PageNavigation pn = crc.getNavigationData();

    StringBuffer sb = new StringBuffer();

    // override oracle stylesheet for this custom menu

    out.println("<link rel='stylesheet' href='index_files/Vision.
css'>");

    // get all sub-components

    String branding = pn.getBranding();

    MenuItemList appSwitcher = pn.getApplicationSwitcher();

    // top icons iSupport, Register, logout

    MenuItemList globalButtons = pn.getGlobalButtons();

      StringBuffer gBhtml = new StringBuffer();

    // Home/Forum...

    MenuItemList tabBar = pn.getTabBar();

      StringBuffer tBhtml = new StringBuffer();

    // Sub tabs under Home/Forum...      

    MenuItemList hNav = pn.getHorizontalNavigation();

      StringBuffer hNhtml = new StringBuffer();

    MenuItemList sideNav = pn.getSideNavigation();

      StringBuffer sNhtml = new StringBuffer();

    QuickSearch qkSearch = pn.getQuickSearch();

    StringBuffer sideSub = new StringBuffer();

    // render application switcher if there's more than one item

/*
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    if (appSwitcher != null && appSwitcher.getSize() > 1) {

      out.print("<form name=appsw>");

      out.print("<select name=appswslct>");

      // output an empty option in case nothing is selected

      out.print("<option value='#'>&nbsp;</option>");

      for (int i = 0; i < appSwitcher.getSize(); i++) {

        MenuItem mi = appSwitcher.getMenuItemAt(i);

        if (!mi.isVisible()) out.print("<!-- ");

        out.print("<option value=\"");

        out.print(mi.getDestination());

        out.print("\"");

        if (i == appSwitcher.getSelectedIndex())

          out.print(" selected ");

        out.print(" >");

        out.print(mi.getText());

        out.print("</option>");

        if (!mi.isVisible()) out.print(" -->");

      }

      out.println("</select>");

      out.print("<input type=button value=Switch onClick=\"document.
location");

      out.print("=document.appsw.appswslct.options[document.appsw.
appswslct.");

      out.print("selectedIndex].value;\">");

      out.print("</form>");

    }
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*/    

    // render global buttons only when it's not null or empty

    if (globalButtons != null && globalButtons.getSize() > 0) {

      MenuItem[] mis = globalButtons.getAllMenuItems();

      String gBStyle = new String();

      for (int i = 0; i < mis.length; i++) {

        // a global button may wish to be hidden

        if (mis[i].isVisible()) {

          // selected?

          if (i == globalButtons.getSelectedIndex())

            gBStyle = LEVEL_1S;

          else 

            gBStyle = LEVEL_1;

          // normally global buttons always have text and destination

          gBhtml.append("<li><a class=\""+gBStyle+"\" href=\"");

          gBhtml.append(getURI(mis[i]));

          gBhtml.append("\">");

          if (mis[i].getText().equals("iSupport"))

            gBhtml.append("Home");

          else

            gBhtml.append(mis[i].getText());

          gBhtml.append("</a>");

        } // visible 

      } // for

    } // if
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    // render tab bar only when it's not null or empty

    if (tabBar != null && tabBar.getSize() > 0) {

      MenuItem[] mis = tabBar.getAllMenuItems();

      String tBStyle = new String();

      for (int i = 0; i < mis.length; i++) {

        // selected

        if (i == tabBar.getSelectedIndex())

          tBStyle = LEVEL_2S;

        else 

          tBStyle = LEVEL_2;

        // normally tab bar items always have text and destination

        tBhtml.append("<li><a class=\""+tBStyle+"\" href=\"");

        tBhtml.append(getURI(mis[i]));

        tBhtml.append("\">");

        tBhtml.append(mis[i].getText());

        tBhtml.append("</a>");

        tBhtml.append(MENU_SPACE);

        if (mis[i].getText().equals("Home"))

          break;

      } // for

    } // if

    // render horizontal navigation only when it's not null or empty

    if (hNav != null && hNav.getSize() > 0) {

      MenuItem[] mis = hNav.getAllMenuItems();

      String hNStyle = new String();
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      for (int i = 0; i < mis.length; i++) {

        // selected

        if (i == hNav.getSelectedIndex())

          hNStyle = LEVEL_3S;

        else 

          hNStyle = LEVEL_3;

        // normally horizontal navigation items always have

        // text and destination

        hNhtml.append("<li><a class=\""+hNStyle+"\" href=\"");

        hNhtml.append(getURI(mis[i]));

        hNhtml.append("\">");

        hNhtml.append(mis[i].getText());

        hNhtml.append("</a>");

        hNhtml.append(MENU_SPACE);

      } // for

    } // if

    // render side navigation only when it's not null or empty

    if (sideNav != null && sideNav.getSize() > 0 && sideNav.isVisible())
{

      MenuItem[] mis = sideNav.getAllMenuItems();

      String sNStyle = new String();

      for (int i = 0; i < mis.length; i++) {

        // selected

        if (i == sideNav.getSelectedIndex())

          sNStyle = LEVEL_3S;

        else
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          sNStyle = LEVEL_3;

        // the destination may be null if there are sub menu items

        String destination = getURI(mis[i]);

       if (destination != null) {

          sNhtml.append("<li><a class=\""+sNStyle+"\" href=\"");

          sNhtml.append(destination);

          sNhtml.append("\">");

          sNhtml.append(mis[i].getText());

          sNhtml.append("</a>");

        } else {

          // you can use the destination of the first sub menu item

          // if you want

          sNhtml.append("<li><font class=\""+sNStyle+"\">");

          sNhtml.append(mis[i].getText());

          sNhtml.append("</font>");

        }

        sNhtml.append(MENU_SPACE);

    // get child menu for the selected side nav

      MenuItemList submil = mis[i].getSubMenuItems();

    // render sub menu items only when they exist

      if (submil != null && submil.getSize() > 0) {

         sNhtml.append("<br>");          

        for (int j = 0; j < submil.getSize(); j++) {

          MenuItem mii = submil.getMenuItemAt(j);

        // selected
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     if (j == submil.getSelectedIndex())

         sNStyle = LEVEL_3S;

     else

       sNStyle = LEVEL_3;

         sNhtml.append("&nbsp;&nbsp;");          

      sNhtml.append("- <a class=\""+sNStyle+"\" href=\"");

         sNhtml.append(getURI(mii));

     sNhtml.append("\">");

     sNhtml.append(mii.getText());

     sNhtml.append("</a><br>");

       sNhtml.append(MENU_SPACE); out.println("<!-- "+mii.getText()+" --
>"); 

     } // for sub_menu

   } // if sub_menu

   } // for side nav main

  } // if side nave main

    // render quick search when it exists

/*

    if (qkSearch != null) {

      out.println("<br>");

      // quick search is selected when search result is being displayed

      if (qkSearch.isSelected()) {

        out.println("<font color=blue>Quick Search<br></font>");

      } else {

          out.println("Quick Search<br>");

      }
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      // print out advanced search link if any

      if (qkSearch.getAdvancedSearchURI() != null) {

        out.print("<sub><a href=\"");

        out.print(qkSearch.getAdvancedSearchURI());

        out.print("\">");

        out.print(qkSearch.getAdvancedSearchPrompt());

        out.print("</a></sub>");

      }

      out.println(qkSearch.getFormBegin());

      out.println("Enter keywords and press a category: ");

      out.print("<input type=text name=\"");

      out.print(qkSearch.getQueryElementName());

      out.print("\"");

      if (qkSearch.isSelected()) {

        out.print(" value=\"");

        out.print(qkSearch.getQueryString());

        out.print("\"");

      }

      out.print(" size=30>");

      out.println("<br>");

      // getCategoryNames never returns null, but it can be empty

      String[] catNames = qkSearch.getCategoryNames();

      String[] catValues = qkSearch.getCategoryValues();

      for (int i = 0; i < catNames.length; i++) {

        // if the category is currently selected



D-18    Oracle iSupport Implementation and Administration Guide

        if (qkSearch.getSelectedCategoryValue().equals(catValues[i])) {

          out.print("<font color=blue>*</font>");

        }

        out.print("<a href=\"");

        out.print("javascript:document.forms['");

        out.print(qkSearch.getFormName());

        out.print("'].");

        out.print(qkSearch.getCategoryElementName());

        out.print(".value='");

        out.print(catValues[i]);

        out.print("';");

        out.print(qkSearch.getSubmitJavaScript());

        out.print("\">");

        out.print(catNames[i]);

        out.println("</a>");

        out.println("&nbsp;&nbsp;&nbsp;");

      }

      out.print("<input type=hidden name=\"");

      out.print(qkSearch.getCategoryElementName());

      out.println("\">");

      out.println(qkSearch.getFormEnd());

    }

*/    

    // Build HTML code here

    sb.append("<link rel='stylesheet' href='index_files/Vision.css'>");
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    sb.append("<SCRIPT language=JavaScript src=\"index_files/Vision_1.
js\"></SCRIPT>");

    sb.append("<TABLE cellSpacing=0 cellPadding=0 border=0>");

    sb.append("  <TBODY>");

    sb.append("  <TR vAlign=top>");

    sb.append("    <TD colSpan=3>");

    sb.append("      <TABLE cellSpacing=0 cellPadding=0 border=0 
width=\"100%\">");

    sb.append("        <TBODY>");

    sb.append("        <TR vAlign=top>");

    sb.append("          <TD bgColor=#ffffff colSpan=2><A ");

    sb.append("            href=\"http://www.Vision.com/e/index.cfm\"
><IMG height=53 alt=Vision ");

    sb.append("            src=\"index_files/logo_sub.gif\" width=172 
border=0 name=Image9></A></TD>");

    sb.append("          <TD align=right bgColor=#ffffff valign=top 
class=\"linkSmall\">");

    sb.append("<!-- Global icons -->    ");

    sb.append("          <img src=\"images/topnav_sep.gif\" border=0 
align=middle><A href=\"http://www.Vision.com/e/resource_center/index.
cfm\" class=\"linkSmall\">Resource Center</A>");

    sb.append("          <img src=\"images/topnav_sep.gif\" border=0 
align=middle><A href=\"http://www.Vision.com/e/search/index.cfm\" 
class=\"linkSmall\">Search</A>");

    sb.append("          <img src=\"images/topnav_sep.gif\" border=0 
align=middle><A href=\"http://www.Vision.com/e/search/index.cfm\" 
class=\"linkSmall\">Site Map</A>");

    sb.append("          <img src=\"images/topnav_sep.gif\" border=0 
align=middle><A href=\"http://www.Vision.com/e/contactus/index.cfm\" 
class=\"linkSmall\">Contact Us</A>");

    sb.append("          </TD>          ");

    sb.append("        </TR>            ");

    sb.append("        <TR vAlign=top bgcolor=\"#003366\">");
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    sb.append("          <TD colSpan=3 nowrap><A ");

    sb.append("            onmouseover=\"MM_swapImage('Image1','','..
/images/nav_home_hl.gif',1)\" ");

    sb.append("            onmouseout=MM_swapImgRestore() ");

    sb.append("            href=\"http://www.Vision.com/e/index.cfm\"
><IMG height=26 alt=Home ");

    sb.append("            src=\"index_files/nav_home.gif\" width=45 
border=0 name=Image1></A><A ");

    sb.append("            onmouseover=\"MM_swapImage
('ImageSOLUTIONS','','../images/nav_solutions_hl.gif',1)\" ");

    sb.append("            onmouseout=MM_swapImgRestore() ");

    sb.append("            href=\"http://www.Vision.
com/e/solutions/index.cfm\"><IMG ");

    sb.append("            alt=solutions src=\"
index_files/nav_solutions.gif\" border=0 ");

    sb.append("            name=ImageSOLUTIONS></A><A ");

    sb.append("            onmouseover=\"MM_swapImage
('ImagePARTNERS','','../images/nav_partners_hl.gif',1)\" ");

    sb.append("            onmouseout=MM_swapImgRestore() ");

    sb.append("            href=\"http://www.Vision.
com/e/partners/index.cfm\"><IMG alt=partners ");

    sb.append("            src=\"index_files/nav_partners.gif\" border=0
");

    sb.append("            name=ImagePARTNERS></A><A ");

    sb.append("            onmouseover=\"MM_swapImage
('ImageINDUSTRIES','','../images/nav_industries_hl.gif',1)\" ");

    sb.append("            onmouseout=MM_swapImgRestore() ");

    sb.append("            href=\"http://www.Vision.
com/e/industries/index.cfm\"><IMG ");

    sb.append("            alt=industries src=\"
index_files/nav_industries.gif\" border=0 ");

    sb.append("            name=ImageINDUSTRIES></A><A ");
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    sb.append("            onmouseover=\"MM_swapImage
('ImageCUSTOMERS','','../images/nav_customers_hl.gif',1)\" ");

    sb.append("            onmouseout=MM_swapImgRestore() ");

    sb.append("            href=\"http://www.Vision.
com/e/customers/index.cfm\"><IMG ");

    sb.append("            alt=customers src=\"
index_files/nav_customers.gif\" border=0 ");

    sb.append("            name=ImageCUSTOMERS></A><A ");

    sb.append("            href=\"ibuhpage.jsp\"><IMG ");

    sb.append("            alt=servicessupport src=\"
index_files/nav_servicessupport_on.gif\" ");

    sb.append("            border=0 name=ImageSERVICESSUPPORT></A><A ");

    sb.append("            onmouseover=\"MM_swapImage
('ImageCOMPANY','','../images/nav_company_hl.gif',1)\" ");

    sb.append("            onmouseout=MM_swapImgRestore() ");

    sb.append("            href=\"http://www.Vision.com/e/company/index.
cfm\"><IMG alt=company ");

    sb.append("            src=\"index_files/nav_company.gif\" border=0 
name=ImageCOMPANY></A><A ");

    sb.append("            onmouseover=\"MM_swapImage('ImageNEWS','','..
/images/nav_news_hl.gif',1)\" ");

    sb.append("            onmouseout=MM_swapImgRestore() ");

    sb.append("            href=\"http://www.Vision.com/e/news/index.
cfm\"><IMG alt=news ");

    sb.append("            src=\"index_files/nav_news.gif\" border=0 
name=ImageNEWS></A></TD></TR>");

    sb.append("        <TR vAlign=top>");

    sb.append("          <TD><IMG height=10 src=\"index_files/space.
gif\" width=190></TD>");

    sb.append("          <TD><IMG height=10 src=\"index_files/space.
gif\" width=10></TD>");

    sb.append("          <TD><IMG height=10 src=\"index_files/space.
gif\" ");
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    sb.append("        width=580></TD></TR></TBODY></TABLE></TD></TR>");

    sb.append("  <TR vAlign=top>");

    sb.append("    <TD>                 ");

    sb.append("      <TABLE cellSpacing=0 cellPadding=0 width=190 
border=0>");

    sb.append("        <TBODY>          ");

    sb.append("        <TR>             ");

    sb.append("          <TD>&nbsp;</TD>");

    sb.append("          <TD vAlign=top><SPAN 
class=subNavHeader><BR>Services &amp; Support</SPAN><BR><BR>");

    sb.append("<!-- side nav begin -->  ");

    sb.append("<!-- Global icons -->");

    sb.append(gBhtml.toString()); // top navigation --- global button

    sb.append("<Br>");

    if (!hNhtml.toString().equals("")) {

      sb.append(hNhtml.toString());

    }

    sb.append("<Br>");

    if (!sNhtml.toString().equals("")) {

      sb.append(sNhtml.toString());

    }

    sb.append("<Br>");

    if (!sideSub.toString().equals("")) {

      sb.append(sideSub.toString());

    }

    sb.append("<!-- side nav end -->");
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    sb.append("          </TD>");

    sb.append("        </TR>");

    sb.append("        <TR>");

    sb.append("          <TD><IMG height=5 src=\"index_files/space.gif\"
width=10></TD>");

    sb.append("          <TD><IMG height=5 src=\"index_files/space.gif\"
");

    sb.append("        width=180></TD></TR></TBODY></TABLE>");

    sb.append("      <P class=paragraphPad>&nbsp;</P></TD>");

    sb.append("    <TD>&nbsp;&nbsp;</TD>");

    sb.append("    <TD>");

    sb.append("<!-- Content begin -->");

    out.println(sb.toString());    

  } // renderBegin

  /**

   * Renders the bottom part of the navigation.

   * In Oracle browser look and feel, this is the part that contains

   * a footer, copyright text and privacy statement link.

   * The caller of this

   * method should ensure that the given rendering context is not null; 
otherwise

   * a <code>NullPointerException</code> may be thrown.

   *

   * @param crc the rendering context used for rendering

   */

  public void renderEnd(CustomRenderingContext crc) {

    PrintWriter out = crc.getOutput();
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    PageNavigation pn = crc.getNavigationData();

        // override stylesheet...

    out.println("<link rel='stylesheet' href='index_files/Vision.
css'>");

    // get copyright and privacy information

    //String copyrightText = pn.getCopyrightText();

    //String privacyText = pn.getPrivacyText();

    //String privacyURI = pn.getPrivacyURI();

    // footer HTML from Vision.com

    out.print("<!-- Content End -->
");

    out.print("    </TD>
");

    out.print("  </TR>
");

    out.print("  <TR vAlign=top>
");

    out.print("    <TD>&nbsp;</TD>
");

    out.print("    <TD>&nbsp;</TD>
");

    out.print("    <TD>&nbsp;</TD></TR>
");

    out.print("  <TR vAlign=top>
");

    out.print("    <TD colSpan=3>
");

    out.print("      <TABLE cellSpacing=0 cellPadding=0 width=100% 
border=0>                                 ");

    out.print("        <TBODY>
");

    out.print("        <TR>
");
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    out.print("          <TD vAlign=top align=right bgcolor=\"#003366\"
><IMG height=23                                          ");

    out.print("            alt=\"Unlocking the Motion of Industry\" 
src=\"index_files/footer.gif\"          ");

    out.print("            width=780><BR><SPAN 
class=linkCopyright></td</tr>");

    out.print("          <tr><TD vAlign=top align=right><A
");

    out.print("            href=\"http://www.Vision.
com/e/company/privacy.cfm\"><SPAN                       ");

    out.print("            class=linkCopyright>Privacy Policy</SPAN></A>
| <A                               ");

    out.print("            href=\"http://www.Vision.
com/e/resource_center/index.cfm\"><SPAN                 ");

    out.print("            class=linkCopyright>Resource 
Center</SPAN></A> | <A                              ");

    out.print("            href=\"http://www.Vision.com/e/search/index.
cfm\"><SPAN                          ");

    out.print("            class=linkCopyright>Search</SPAN></A> | <A
");

    out.print("            href=\"http://www.Vision.com/e/search/index.
cfm\"><SPAN                          ");

    out.print("            class=linkCopyright>Site Map</SPAN></A> | <A
");

    out.print("            href=\"http://www.Vision.
com/e/contactus/index.cfm\"><SPAN                       ");

    out.print("            class=linkCopyright>Contact 
Us</SPAN></A><BR><A                                  ");

    out.print("            href=\"http://www.Vision.com/e/index.cfm\"
><SPAN                                 ");

    out.print("            class=linkCopyright>Home</SPAN></A> | <A
");

    out.print("            href=\"http://www.Vision.
com/e/solutions/index.cfm\"><SPAN                       ");

    out.print("            class=linkCopyright>Solutions</SPAN></A> | <A
");
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    out.print("            href=\"http://www.Vision.
com/e/partners/index.cfm\"><SPAN                        ");

    out.print("            class=linkCopyright>Partners</SPAN></A> | <A
");

    out.print("            href=\"http://www.Vision.
com/e/industries/index.cfm\"><SPAN                      ");

    out.print("            class=linkCopyright>Industries</SPAN></A> | 
<A                                   ");

    out.print("            href=\"http://www.Vision.
com/e/customers/index.cfm\"><SPAN                       ");

    out.print("            class=linkCopyright>Customers</SPAN></A> | <A
");

    out.print("            href=\"ibuhpage.jsp\"><SPAN
");

    out.print("            class=linkCopyright>Services &amp; 
Support</SPAN></A> | <A                       ");

    out.print("            href=\"http://www.Vision.com/e/company/index.
cfm\"><SPAN                         ");

    out.print("            class=linkCopyright>Company</SPAN></A> | <A
");

    out.print("            href=\"http://www.Vision.com/e/news/index.
cfm\"><SPAN                            ");

    out.print("            class=linkCopyright>News &amp; 
Events</SPAN></A><BR><BR>Vision,                  ");

    out.print("            Inc.<BR>Copyright 2003, All Rights Reserved.
</SPAN>                              ");

    out.print("      </TD></TR></TBODY></TABLE></TD></TR>
");

    out.print("  <TR vAlign=top>
");

    out.print("    <TD><IMG height=5 src=\"index_files/space.gif\" 
width=190></TD>                          ");

    out.print("    <TD><IMG height=5 src=\"index_files/space.gif\" 
width=10></TD>                           ");

    out.print("    <TD><IMG height=5 src=\"index_files/space.gif\" 
width=580></TD></TR></TBODY></TABLE>     ");
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    // footer HTML from Vision.com

  }

  private static VisionRenderer singleInstance;

  /**

   * Stylesheet constant for menu highlight

   */

  private static final String LEVEL_1 = "linkBold";

  private static final String LEVEL_1S = "linkBold";

  private static final String LEVEL_2 = "linkBold";

  private static final String LEVEL_2S = "linkBold";

  private static final String LEVEL_3 = "linkBold";

  private static final String LEVEL_3S = "linkBold";

  private static final String LEVEL_3A = "linkBold";

  private static final String LEVEL_3AS = "linkBold";

  private static final String MENU_SPACE = "";

  private static final String TOP_NAV_SPACE = "<img src=\"
images/topnav_sep.gif\" border=0 align=middle>";

}
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E
 Configuration of AK Regions

This appendix covers the following topics:

• Configuring Oracle iSupport Service Request Pages

• Example 1: Customizing a Top-Level Attribute

• Example 2: Customizing a Nested Region Attribute

Configuring Oracle iSupport Service Request Pages
The following examples show how to customize and configure Oracle iSupport Service 
Request pages.

Note: Oracle recommends that you do not customize regions that are 
provided out-of-the-box. Changes made to these regions can be 
overwritten by subsequent applications of patches. Make all 
customizations to regions that are cloned and created specifically to 
avoid loss or change of data. Additionally, always copy the regions that
have been seeded out of the box rather than one of the regions you 
have created, even though they were copied from the seeded ones. 

Example 1: Customizing a Top-Level Attribute
Consider, for example, that you want to customize the Create Service Request: Identify 
Problem page to display the field for Project Number (which, by default, is hidden) 
under the Problem Summary section for users of responsibility iSupport Business User. 

Steps

Part 1: Customizing the Region
1. Determine the top level region that is associated with this page. 
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To determine what top region is associated with a page that you are viewing, view 
the source of the page through your browser and search for Top Region Code. This 
code is the topmost AK region used to render the page. All the relevant UI 
attributes on that page are either under that region or in the nested region that it 
includes. In this case, the top level region is 
IBU_CF_SR_CR_IDENTIFY_PROBLEM.

2. Log into the AK application through Oracle Forms and bring up the Define Regions
window.

3. Query up the region IBU_CF_SR_CR_IDENTIFY_PROBLEM and click the Copy... 
button.

4. Enter the Application Name Oracle iSupport and an identifier for the new region, 
not exceeding 30 characters, say cUST_SR_CR_IDENT_PROBLEM, and click OK. 

All seeded regions begin with the prefix IBU_CF, and it is recommended that 
customized regions not use the same prefix.

5. Requery up the newly cloned region and overwrite the existing region name with a 
new identifier.

6. Click the Region Items button to bring up the attributes for this region.

7. Look for the attribute name IBU_CF_SR_PROJECT_NUMBER. 

Note that the Node Display column for this attribute is cleared to indicate that this 
field is not currently displayed.

8. Select the check box under Node Display to display this column.

9. Save the change.

Note: To make a field mandatory, select the Required field for the 
corresponding attribute. To move the order of the fields within the 
region, modify the Sequence field for the attribute. To change the 
label for the attribute, modify the Long Label field for the attribute.

Part 2: Customizing the Page
1. Bring up the iSupport administration page Page Region Mapping.

2. Enter the page and context level for which you want the region to be customized, 
and click Go. 

For example, the page name can be Create Service Request: Identify Problem, and 
the context level can be Responsibility. You can also choose All for context to 
display all the different context levels that are currently configured for this page.
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3. In the results table, if an entry exists for the context of Responsibility, then click the 
corresponding Edit icon. If the entry does not exists, then click Create Mapping.

4. If you are creating a new mapping, then choose and enter the appropriate values for
the fields, mapping the newly cloned region to the proper page and context level, 
and click Create. If you are editing an existing mapping, then simply choose the 
newly cloned region and click Update.

Part 3: Setting the Profile
1. Set the profile option iSupport: Region/Field Level Configuration Option to 

Custom. 

Customizations do not take effect unless this profile value is set appropriately.

2. Clear the mid-tier cache so that the system picks up the new configuration. 

Example 2: Customizing a Nested Region Attribute
The steps for customizing a nested region attribute are very similar to the steps in 
Example 1. Parts 2 and 3 are identical. Therefore, this example shows only the steps 
required for Part 1.

Consider, for example, that a customer wants to display the Preferred Language field in
the Primary Region region in the Create Service Request: Identify Problem page for 
Oracle iSupport users with responsibility iSupport Business User. 

The following are the steps required to make this change:

Steps

Part 1: Customizing the Region
1. Determine the top-level region that is associated with this page. In this case, the top 

level region is IBU_CF_SR_CR_IDENTIFY_PROBLEM.

2. Log into the AK application through Forms and bring up the Define Regions 
window.

3. Query up the region IBU_CF_SR_CR_IDENTIFY_PROBLEM and click the Region 
Items button.

4. Identify the nested region name for the Primary Contact region identified by the 
attribute code IBU_CF_SR_PRIMARY_CONTACT_RG. In this case, it is 
IBU_CF_SR_CR_PRIMARY_CONTACT.

5. Query up this region in the Define Regions window, and click the Copy... button.
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6. Enter the Application Name Oracle iSupport and an identifier for the new region, 
not exceeding 30 characters, say CUST_SR_CR_PRIM_CONTACT, and click OK.

7. Requery up the newly cloned region and overwrite the existing region name with a 
new identifier.

8. Click the Region Items button to bring up the attributes for this region.

9. Look for the attribute name IBU_CF_SR_PREFERRED_LANG. Note that the Node 
Display column for this attribute is unselected to indicate that this field is not 
currently displayed.

10. Select the check box under Node Display to display this column.

11. Save the change.

12. Requery up the region IBU_CF_SR_CR_IDENTIFY_PROBLEM, and clone this 
region following the steps to clone a region.

13. Bring up the region items for this region.

14. Find the attribute IBU_CF_SR_PRIMARY_CONTACT_RG for this region and 
modify the Nested Region Name field to the newly cloned region for the Primary 
Contact (that is, CUST_SR_CR_PRIM_CONTACT).

15. Save the changes.

Note the major difference between this example and Example 1 is that this one requires 
the cloning of two regions instead of one because the attribute that needs to be 
customized is in a nested region within the page. All other steps remain the same.
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Glossary

account

Account refers to the details or attributes of a deploying company's selling relationship 
with a party. A selling relationship can include orders or negotiated prices. Account 
attributes do not describe a party; they only exist when a selling relationship is present 
between the deploying company and the party. 

account number

Number designated in the Trading Community Architecture (TCA) or Accounts 
Receivable (AR) and used to group account information about a party.

account site

A party site that is used within the context of an account, e.g., for shipping or billing 
purposes.

business entity

A branch, subsidiary, division, etc. of a company.

company

The entire business, including all business entities in the organizational structure.

contact point

A means of contacting a party other than sending physical mail, e.g., a phone number, 
e-mail address, telex number, fax number, etc.

customer

A person or organization with whom the deploying company has a selling relationship, 
regardless of whether anything has actually been purchased or serviced. A selling 
relationship may be established by actually selling products, or it may be established by
simply negotiating terms that will be used if you later sell products. In both scenarios, a 
selling relationship exists.
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deploying company

The Oracle customer that has, or will, install, implement, and run all or part of the 
Oracle E-Business suite. 

DUNS Number

A unique identifier used by Dun & Bradstreet, a major business data content provider. 
The DUNS number is an attribute in the TCA.

GUI

An acronym for Graphical User Interface.

instance, item instance

In Oracle Install Base, an instance is an occurrence of an item entity. For example, a 
manufacturer has a part number for a television he makes; each time he sells one 
television, an occurrence of this part number is recorded in Install Base

location

A point in geographical space described by a street address.

merchant

An Oracle E-business suite customers. Used to alleviate confusion with the term 
customers, which refers to customers of a business using Oracle products.

multiple organizations (multi org)

The ability to define multiple organizations and the relationships among them within a 
single installation of Oracle Applications. These organizations can be sets of books, 
business groups, legal entities, operating units, or inventory organizations.

party

An entity in the TCA that can enter into business relationships. A party is a real person, 
an organization, a branch, a subsidiary, a legal entity, a holding company, etc. In TCA, 
the attributes of a party are considered universal, i.e., they are independent of your 
selling or buying relationship with the party.

party access list

A list of parties, which a user can access.

party relationship

In TCA, a binary relationship between two parties, such as a partnership. A party 
relationship can be a party itself, meaning certain party relationships can enter into 
relationship themselves.



Glossary-3

party site

In TCA, the link between a party and a location that indicates the location is valid for 
that party. A party site is not intended to represent a distinct business entity with which
you can do business.

registration

Refers to the process by which any user would gain access to application functionality.

Registration Admin UI

User Interface (UI) used by merchant administrator or any person granted privileges to 
maintain users and accounts.

Registration Self-Service User UI

User Interface (UI) that is used by individual users or business users to register 
themselves.

registration template

Part of the Oracle CRM JTF User Management Framework (JUMF), registration 
templates are JSP pages set up by the application administrator to capture 
accommodate user information-gathering requirements.

responsibilities

A grouping of application menus that determine the user interface accessible to a 
particular user.

roles

Groupings of permissions which are page- and function-level, granular privileges used 
to maintain application security.

self-service registration

Refers to the process of user self-registration through a self-service UI, as opposed to 
being registered by an administrator. Self-service registration includes the UI and 
background processes used to complete the registration processes (including assigning 
users the appropriate data access and UI access privileges).

service request view

A saved query of service requests.

system administrator

Also called sysadmin, the system administrator is a user who performs the highest-level
administrator tasks in Oracle applications. 
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TCA

An acronym for Trading Community Architecture, sometimes used interchangeably 
with the Oracle Trading Community Model.

Trading Community Model

The Oracle Trading Community Model, also known as Trading Community 
Architecture (TCA).

UI

An acronym for User Interface.

user

Refers to any person who needs access to any application. This includes various types 
of customers, partners, suppliers, and employees.

user types

Users are categorized into types based on their registration requirements and access 
privileges. User types can be associated with default roles, responsibilities, accounts, 
registration templates, and approval requirements.

user type, business

A user with a selling relationship to the deploying company.

user type, employee

A user who is an employee of the deploying company.

user type, individual

A user with no selling relationship to the deploying company.

user type, primary

A designated person of a party, business entity, or internal group (for example, sales 
department) who is responsible for approving other users and resetting passwords.
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Index

A
Account Management

overview, 1-6
searching, 9-5
setup, 5-1
using, 9-11

accounts, changing default, 10-10
Accounts Receivable, 3-4
address, how to change, 10-7
administrator for iSupport, 1-15
administrator for Knowledge Management, 1-16
administrator information, 10-13
administrator user setup, 3-13
answer types, 4-9
APIs

Call Center, 3-50, 10-29
Order Capture, 5-3

Application Object Library, 2-3
approval process, 1-18, 3-11, 6-4
Assignment Manager, 4-3

B
Bills of Materials

setup, 5-3
bookmarks, 3-32
Business flows, 1-8
business user setup, 3-22
business user type, 1-14

C
Call-Back (Call Me)

dependencies, 2-9
setup, 3-49, 10-28

Call Center Technology, 3-49, 10-28
company information, 10-12
concurrent programs

Homepage e-mails, 3-37
usergroup, 3-41, 3-47, 10-27

configurability, 1-22
contact points, 10-6
Contracts

in accounts tab, 1-6
setup, 3-43

CRM Foundation
as dependency, 2-3

CRM Foundation Tech Stack
as dependency, 2-3
confirming setup, 3-4

CRM Interaction Center (CCT)
as dependency, 3-49, 10-28

CRM User Management Framework, 1-12, 3-5, 3-
8
Customer Care

and Call-Back, 3-49, 10-28
setup, 3-50

D
default settings

Homepage, 3-32
dependencies, 2-2

conditional/optional, 2-4
mandatory, 2-2
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E
employees, defining, 3-4
employee user, 1-15
employee user setup, 3-20
enrollments, 1-17

overview, 3-9
seeded, 3-10
Self-Service Support Over the Web, 3-10

F
Forums

moderators, 3-41
restricting access, 3-39
searching, 9-5
setting user signature, 10-12
setup, 3-38

functions, C-7
functions, iSupport, 3-4

G
General Ledger

as dependency, 2-5
glossary, Glossary-1

H
Homepage

and Workflow, 6-4
concurrent programs, 3-37
e-mail of content, 3-36
functionality in iSupport, 1-3
setup, 3-32

home page
adding MES content, 3-35
default content layout, 3-33
disable content, 3-34, 3-35
maintaining, 10-14
mandatory content layout, 3-33
setting e-mail subscription, 10-11
update content page, 10-14

Human Resources Management System
as dependency, 2-5
employees, 3-4

I

IBU_PRODUCT_EMGEN concurrent program, 
3-37
ibupfbgl.jsp, 3-45, 10-25
individual user setup, 3-24
individual user type, 1-14
Install Base

functionality in iSupport, 5-3, 5-3
Inventory

functionality in iSupport, 5-2
Invoices

view, 9-12

K
knowledge base

options, 1-5
Knowledge Management

administrator-user, 3-25
and Workflow, 6-4
overview, 3-37
profile options, A-18
top solutions, 9-7
using quick links bin, 9-9

knowledge management administrator, 1-16

L
line types, 5-7

M
Marketing Encyclopedia System

searching, 1-5
menus, C-1
menus, iSupport, 3-4
Message Delivery Scheduler concurrent 
program, 3-37
multi-party access, 1-19

setting up, 3-27

N
Notes

and Call-Back, 3-49, 10-28
and service request, 4-3, 4-4
publish, 4-4
restrict view of types, 4-4

Notification Mailer concurrent program, 3-37
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O
Oracle Applications

confirming setups, 3-3
Oracle Bills of Materials, 2-5
Oracle Contracts Suite, 2-7
Oracle Customer Care, 2-8
Oracle Enterprise Asset Management, 2-4
Oracle iMarketing, 2-9
Oracle Inventory, 2-4
Oracle iStore, 2-6
Oracle iSupport

application ID, 3-14
Call-Back setup, 3-49, 10-28
Forums setup, 3-38
overview, 1-1
product code, 3-6
properties, 3-5, 3-8
responsibilities, C-10
returns, 5-3
seed data, C-xvi
service request, 1-4
Survey setup, 3-44, 10-23
user search functions, 9-4
user setups, 3-13

Oracle Knowledge
Overview, 8-1
Search, 8-1

Oracle Knowledge Management, 2-9
Oracle Marketing Encyclopedia System, 2-9
Oracle Order Management, 2-6
Oracle Purchasing, 2-6
Oracle Quoting, 2-6
Oracle Receivables, 2-5
Oracle TeleService, 2-4
Order Capture

APIs, 5-3
Order Management

and Advanced Pricing, 5-9
and Shipping, 5-9
functionality in iSupport, 5-6
transaction line types, 5-7

Orders
view, 9-11

P

party access
notification, 6-5

password, resetting, 10-5
Payments

view, 9-12
preferences, setting, 10-8
primary user setup, 3-17
primary user type, 1-13
Products

associate with SR template, 4-8
functionality in iSupport, 1-7
implementation, 5-1
setup, 3-43

profile options
CRM Tech. Foundation (JTT), A-4
how to set, A-2
iSupport service request, 4-5, A-6
Knowledge Management, A-18
miscellaneous, A-18
Returns, A-17
Service Core, A-17
understanding, A-1
user management, A-3

Public Service Requests source object, 4-5

Q
Quick Find, 3-6

R
registration templates, 1-18, 3-10
Resource Manager

and service request, 4-3
responsibilities

assigning additional iSupport, 3-16
changing default, 10-9
customizing, 3-5
finding responsibility ID, 3-14
seeded, C-10
understanding, 1-17, 3-5

returns
complete, 9-16
partial, 9-16

Returns
and Oracle Purchasing, 5-9
and Workflow, 6-3
functionality in iSupport, 5-5
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functionality in OM, 5-4
implementation, 5-1
profile options, 5-6
setup, 5-3
troubleshooting, 5-8

roles
assigning additional iSupport, 3-16
customizing, 3-5
understanding, 1-17, 3-5

S
scoring answers in service request templates, 4-9
Scripting

overview, 3-44, 10-23
setup, 2-9, 3-43, 10-23
usage in iSupport, 3-44, 10-23

searching
accounts, 9-5
forums, 9-5
MES/Technical Library, 1-5
performing searches, 9-4
Quick Find, 9-4

Service Request
and Knowledge Management, 4-19
and Products, 4-3
and Workflow, 4-3, 6-3
configurability of creation flow and pages, 1-4,
1-4, 4-13, 4-19, E-1, E-4
default template, 4-11, 10-21
dependencies, 4-3
editing contacts, 4-14
e-mail feature setup, 4-19
functionality in iSupport, 1-4
maintaining, 10-15
setup, 3-37
setup overview, 4-3
severity thresholds, 4-10
templates, 10-15
templates overview, 4-7
viewing based on access levels, 4-13

Service Request Pages
configuring to display purchase order 
number, 4-14

site management, 1-19
software installation, 2-2
solution

recommended, 9-7
survey administrator, 1-16, 3-25
Surveys

administrator responsibility, 3-44, 10-24
and usergroups, 1-7, 3-43, 10-23
associate usergroup, 3-47, 10-27
overview, 1-7, 3-43, 10-23
results, 3-47, 10-28
setup, 1-7, 3-43, 10-23

system administrator, 1-14, 3-4

T
Tasks Manager, 4-3
Technical Library content

mapping to user responsibility, 10-14
templates in service request, 4-7
Territory Manager, 4-3
Trading Community Architecture

confirming setups, 3-3
overview, 2-3

transaction line types, 5-7
Troubleshooting

returns, 5-8

U
UI basics, 9-2
Universal Work Queue

as dependency, 3-49, 10-28
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